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KIRISH

Wcb-saytlarni yaratish va undan foydalanish ta’lim tizimida ham 
niиhini ahamiyat kasb etadi. Ta'limda web-saytlardan nafaqat tijorat 
\ nk i namoyish vositasi sifatida, balki bilim berish maqsadlarida ham 
invdalaniladi. Albatta bunda ta’lim masofadan turib amalga oshiriladi. 
Miuulay ta’lim berish jarayoni o'qituvchi va o‘quvchi to‘g‘ridan-to‘g‘ri 
nuiloqot qilmasdan olib boriladi. Buning uchun ta’lim beruvchi (oliy
• i i|iiv yurti, maktab va boshqalar) o'qitiladigan predmetga tegishli 
m,i lumotlarni web-sahifalarga har xil ko‘rinishlarda (matn, rasm, 
link ;il, animatsiya, tovushli ma’lumot va xatto video tasma ko‘rinishida) 
|n\lashi kerak. 0 ‘quvchi esa dunyoning xohlagan joyidan turib 
I ni i net orqali bu ma’lumotlardan bilim olishi mumkin. Ta’limning 
I>iiinluy ko'rinishi masofaviy ta’lim deb yuritiladi. Bugungi kunda 
mns<ilaviy ta’lim dunyoning ko‘plab rivojlangan davlatlarida qo‘llaniiib 
i ■ Immoqda. Masofaviy ta’limdan foydalanish natijasida vaqt va pulni 
h м li. ortiqcha ovvoragarchiliklarsiz bilim olish imkoniyatlariga 
«)>;! hoiinadi. Bunday imkoniyatlarni bizga web-sahifalar yaratib 
I" i in I i. Ma’lum predmetga tegishli ma’lumotlarni (matn, rasm, jadval, 
immalsiya va boshqalarni) sahifalarga joylab, ularni doimiy ravishda 
i" Mu ib. yangilab borish, o‘quvchilarni bilimlarini baholash uchun 
пи/>>i at test savollarini kiritish imkoniyatlari mavjud. Buning natijasida 
.1 nuvi'hining olgan bilimini nazorat qilish, baholash imkoniyatlari 
I»11\ (lit bo’ladi. Bu esa web-texnologiyadan ta’limda foydalanishning eng 
«i|>limal variantlaridan biri hisoblanadi.

I Ishbu qollanmada ana shunday Web-saytlarni yaratishda qo‘l!ani- 
liiilii'an Macromedia Dreamweaver, Macromedia Flash, Corel Draw, 
AJhIu- PhotoShop dasturlari va HTML -  gipermatnlarni belgilash
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tilidan foydalanish imkoniyatlari haqida ma’lumot berilgan. Professional 
dasturlar qatoriga kiruvchi Dreamweaver dasturi o'zining barchii 
imkoniyatlari bilan har qanday murakkablik va masshtabdagi Web-! 
sahifalarni yaratish va o'zgartirishga qodir. U vizual loyihalash 
(WYSIWYG) rejimini ta’minlab, dastlabki matnli WEB -  hujjatlarning 
juda aniq ishlashi bilan ajralib turadi va katta tarmoqli loyihalarni 
qo‘llab-quvvatlovchi ichki qurilgan vositalarga ega.

Dasturda matnlar hamda obyektlarning obrazlari ustida olibj 
boriladigan ishlar bevosita kodlashtirishdan ustun turadigan gipermatnli 
hujjatlar yaratish usulini vizual deb atash qabul qilingan. Dastur 
nafaqat vizual loyihalash vositalarining kuchli bazasiga ega, balki 
web -  sahifalarni deyarli maxsus ko‘rib chiqish dasturlari yordamida 
aks ettirishga ham qodir: Microsoft Internet Explorer yoki Netscape 
Navigator.

Dastur web-dizayn sohasida gipermatnli hujjatlarni to‘g‘ridan-to'g‘ri 
kodlashtirish yordamida yaratishni afzal ko‘ruvchi mutaxassislarga 
ham ma’qul keladi. Dreamweaver qobigiga gipermatnlarni belgilovchi 
diskreptorlar bilan ishlash uchun zarur barcha uskunalarga ega to‘liq 
funksional HTML tahrirlagichi integratsiya qilingan.

Dreamweaver dasturi «ochiq arxitektura» prinsiplariga asoslangan. 
Bu amaliy dasturni interfeysi (Application Programming Interface, API) 
to‘liq ochiq ekanligini bildiradi. Uning yordamida tashqi dasturchilar 
hamda dasturiy ta’minot bilan shug‘ullanuvchi firmalar, dastur va uning 
interfeysiga radikal funksional o'zgartirishlar kiritishi: yangi uskuna 
qo‘shish, menyu palitrasi yoki boiim ini yaratish, yangi obyekt yoki 
multimedia roligini dasturlashtirish va hokazolar.

Dreamweaver ti/'imi tarkibiga multimedia roliklarini qo‘yishga 
mo‘ljallangan qo‘shimcha dastur kiradi, shuning uchun Flash -  
texnologiyaning interfaol imkoniyatlarini tahrirlagichdan chiqmay turib 
kobrib chiqish mumkin.

Ta’lim tizimida esa, axborot texnologiyalarini qoilab, ta’lim- 
tarbiya berish va unga tegishli barcha jarayonlarni axborotlashtirish 
bilan ta’lim samaradorligini oshirishga olib kelinadi. Bunda — axborot 
texnologiyalaridan dars jarayonidagi ko‘rgazmalilik imkoniyatlari oshib 
o’quvchilarning mazmunni tushunish darajasi ortadi. 0 ‘quvchi dars 
vaqtida biror murakkab jarayonni ko‘z oldiga keltirishi qivin bo'lib, uni
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iii... 111 qiln olmaydi. Ana shunday paytda kompyuterning maxsus 
tin tin lnii yordamida shu murakkab jarayonni aynan o'zidek qilib 
til ii l ib I)l-i ish mumkin. Bunda o‘quvchilarda usbbu murakkab jarayon 
hii'H'i H i liisavvurni hosiI qiladi. Bu kabi dasturlar ko'pincha inson ko'zi 
IhIhii Ini tit olmaydigan (masalan, mashina dvigateli ichidagi harakatlar, 
||liiiii i|ni) avlanish tizimi va boshqalar) murakkab jarayonlarni tasvirlab 
In i ili iu Inin xizmat qiladi. Bunday dasturlarga misol qilib Flash 
МЧ И > MAX kabi dasturlarni aytishimiz mumkin. Ushbu dasturlar 
|i  и! и и и In nafaqat murakkab jarayonlarning tasvirlarini, balki barcha 
Mill.1.1,4 dcktron darsliklarni yaratish imkoniyatlari ham mavjud.

nii| ,i nnimatsiyali ma’lumotlarni keltirish va bezashda keng qo‘llash 
tIH IO lk  III

I .him qo'llanmada shuningdek Flash MX dasturini o‘rganishga 
Имг ili lungan ma’lumotlar ham berilgan. Qo‘llanmada dastur imko- 
OlVitiIni I uning interfeysi, flash-filmlar, flash-saytlar yaratish va 
tyl.ii.lnii lurli jarayonlarda foydalanish to‘g‘risidagi ma’lumotlar berilgan. 
Hum! ни lashqari web dizaynning eng muhim ajralmas qismlaridan 
It.. i In''Ifjan kompyuter grafikasi haqida ham ma’lumot beriladi. Bizga 
Hi.i luniki web muharrirlar saytning asosini yaratishda ishlatilsa, 
tini hiiinlar, grafiklar va turli illustratsiyalar bilan boyitish uchun esa 
gnilil. muharrirlariga murojat qilamiz. Bunda Adobe PhotoShop, Corel 
jli m Kabi grafik muharrirlarning o‘rni tengsiz. Qo‘llanmani yozishda 
ш Him bu dasturlarning tanlab olinishiga sabab, birinchidan ularning 
jjjiii|« v.ional dasturlar qatoriga kirishi bo‘lsa, ikkinchidan Adobe 
Blit ili i‘>liop rastrli grafika bilan, Corel Draw esa vektorli grafika bilan 
||lil i .lii'a inoljallanganligi uchundir.
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I-b o b . WEB-DIZAYN

1.1. Web-dizayn. Web-dizayn qo‘llaniladigan dasturlash vositalar

Dizayn (ingliz tilidan design injener-konstruktor, lotinchadan 
designare oichab ko‘rmoq, oichab bermoq) -  bu ijodiy faoliyat boiib, 
uning asosiy maqsadi sanoat buyumlarini formal sifatini belgilaydi. 
Bu sifat shuningdek buyumning tashqi qirralarini o‘z ichiga olish bilan 
birga, asosan shu tuzilmaviy va funksional aloqadoriik xaridor hamda 
ishlab chiqaruvchi ko'zi bilan qaraganda buyumni yagona holatga 
keltiradi. Dizayn sanoat ishlab chiqarishi bilan boglangan insonni o‘rab 
turgan atrof-muhitning barcha jabhalarini qurshab oladi [21], [22], [23].

Dizaynning turlari -  dizaynerlik faoliyati loyihalash predmetining 
farqlanishi, loyiha ishining maqsadlari va metodlari hamda uning 
yakuniy natijasi bilan farqlanadi. Dizaynning quyidagi turlari 
mavjud:

-  grafik dizayn,
-  sanoat dizayn,
-  web-dizayn.
Grafik dizayn
Grafik dizaynda -  informatsion grafika, reklama va boshqalar 

bilan ishlanadi. Web-dizayn va grafik dizayn nomining o’xshashligiga 
qaramasdan, dizaynning turli yo'nalishlari hisoblanadi. Web-dizayn 
ma’lumotni saytda tasvirlash uchun ishlatiladi. Ammo grafik dizayn 
bilan web-dizayn o‘zaro bog‘langan. Grafik dizaynda tayyorlangan 
illyustratsiyalar saytlarni bezashda keng ishlatiladi. Grafik dizayn aslida 
foydalanuvchiga uzatiladigan ma’lumotni qabul qilinishini loyihalashi 
kerak. Grafik dizaynning yo‘nalishlari:

1. Firma stili,
2. Shriftlar,



3. Plakat,
4. Grafik reklama,
5. Kitobiy grafika,
6. Gazeta grafikasi,
7. Jurnal grafikasi.
Sanoat dizayni -  maishiy buyumlar va asbob-uskunalarni ishlab 

i hiqishda, mashinasozlik obyektlarida, transport vositalarida va bosh- 
qnlni'da ishlatiladi.

Bulardan tashqari dizaynning bir qancha ko‘rinishlari mavjud. 
Mular: arxitektura dizayni, kiyim va aksessuarlar dizayni, art- 
tli/avn, reklama dizayni.

Web-dizayn (ingliz tilidan olingan bo‘lib, web-design -  web- 
.iliilani loyihalash ma'nosini bildiradi) -  bu web-sahifani jihoz- 

liinishidir. Web dizayn sayt uchun huddi poligrafiya dizayni va qog‘ozli 
nnsluiar dastgohlari singari muhim rol o‘ynaydi. Web-dizayn deganda 
niiliiqat web sayt uchun grafikli elementlarni yaratish, balki uning 
nukturasini loyihalash, unda harakatlanish vositalari, ya'ni butun 

i n  tni yaratish tushuniladi. Shu sababli ham biz ushbu qollanmada 
m ii.u|at web muharrirlarni, balki grafik muharrirlar, animator das- 
liuliirni ham gapirib o‘tishni ma'qul ko‘rdik.

Sayt qancha ajoyib bezatilgan boMmasin, unda qulay va tu- 
«linnarli harakatlanish chizmasi mavjud bo‘lmasa, hammabop ke-
• iik li matnlar boim asa, agar sayt yaxshi dasturchilar tomonidan 
luyyorlangan samarali dasturiy vositalarga ega bo‘lmasa -  bunday 
..in I tczda o'z foydalanuvchilarini yo‘qotadi va undagi noqulaylik
ih.illoki u professional va munosib stilda tayyorlangan bo‘lsa ham) 
muvofaqiyatsizlikka mahkum bo'ladi. Yaxshi web-dizayn saytning 
iiihilalarini hamohanglik bilan birlashtiradi. Boshqacha aytganda, web- 
ili/ayn saytning joylashish o‘rnini belgilaydi.

Wcb-dizaynni o‘rganishda quyidagi uchta tushuncha muhim 
ili imiyat kasb etadi: Web-sahifa, Web-sayt va Web-server.

Web-sahifa -  o‘zining unikal adresiga ega bo’lgan va maxsus 
kn i ish dasturi yordamida (brauzer) ko'riluvchi hujjatdir. Unga matn, 
ru lika , ovoz, video yoki animatsiya ma’lumotlar birlashmasi -  
mullimediyali xujjatlar, boshqa hujjatlarga gipermurojaatlar kirishi 
nuimkin.
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Web-sayt -  bir qancha web-sahifalarning mantiqiy birlashmasi. 
Inglizcha «site» (tarjimasi «joy») so‘zining o‘zbekcha talaffuzi. Umum- 
jahon o‘rgimchak to'ri ma’lum axborot topish mumkin bo"lgan va 
noyob URL bilan belgilangan virtual joy. Mazkur URL web-saytning 
bosh sahifasi manzilini ko‘rsatadi. 0 ‘z navbatida, bosh sahifada web- 
saytning boshqa sahifalari yoki boshqa saytlarga murojaatlar boiadi. 
Web-sayt sahifalari HTML, ASP, PHP, JSP. grafik va boshqa fayllardan 
tashkil topgan boiishi mumkin. Web-saytni ochish uchun brauzer 
dasturidan foydalaniladi. Web-sayt shaxsiy, tijorat, axborot va boshqa 
ko‘rinishlarda bo‘lishi mumkin.

Web-server -  tarmoqqa ulangan kompyuter va undagi dastur 
hisoblanib. umumiy resurslarni mijozga taqdim etish yoki ularni 
boshqarish vazifalarini bajaradi. Web-serverlar ma’lumotlar bazalari 
va multimediyali ma’lumotlarni bir biriga moslashtiradi. Web- 
serverda Web-sahifa va Web-saytlar saqlanadi. Web-server -  Internet 
yoki Internetga ulangan umumfoydalanishdagi axborot served. Unda 
hujjatlar va fayllar -  audio, video, grafik va matn fayllari -  saqlanib, 
ular foydalanuvchilarga HTTP vositalar orqali taqdim etiladi. Web­
server nomi u umumjahon tarmogMning qismi bo‘lgani uchun kelib 
chiqqan. Maxsus dasturiy ta’minotga ega bo‘lgan, bir yoki bir necha 
web-sayt fayllarini saqlash va ularga ishlov berish mumkin. Bir necha 
web-sayt bitta kompyuterda ishlaganda, web-server deganda web- 
sayt ishlovchi virtual makon (dasturiy ta'minot va kompyuterdagi joy) 
tushuniladi. Shunga ko‘ra ko‘pchilik uchun «web-server» deganda 
«web-sayt» tushuniladi. Ko‘p axborotni saqlovchi web-saytlar bir 
paytning o‘zida bir necha kompyuterda saqlanishi va ularga ishlov 
berilishi mumkin. Web-server mijozlarning web-saytga so‘roviga javob 
beradi.

Bu tushunchalarga qo‘shimcha web hujjat tushunchasini ham ko‘rib 
o‘tamiz.

Odatda, maxsus HTML (Hypertext Markup Language) tilidagi 
hujjat. Web-hujjat jahon o'rgimchak uyasining asosini tashkil qiladi. 
Ular gipermatndan iborat bo‘lib, foydalanuvchiga ajratib ko‘rsatilgan 
so‘z yoki jumlaga qaratib, ma'lumotlarni o‘qish. hujjatning boshqa 
qismiga yoki ayni hujjat bilan giperhavola yordamida bog‘langan 
boshqa web-hujjatga o'tish imkonini beradi. Web-hujjat, shuningdek,
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matn, tasvir, tovush, videolarni mujassamlovchi gipennuhit ma’lumotni 
ham o‘z ichiga olishi mumkin. Web-hujjatni ochish, ularni o‘qish yoki 
aks ettirish Internet brauzerlari yordamida amalga oshiriladi. Web- 
hujjat tushunchasi «web-sahifalar» va «web-saytlar» tushunchalari 
bilan chambarchas bog'liq. Odatda «web-sahifa» atamasi web-hujjat 
ntamasining sinonimini bildiradi, «web-sayt» atamasi esa yagona mavzu 
ostida birlashtirilgan yoki bitta tashkilot, muallif yoki foydalanuvchiga 
tegishli bo‘lgan sahifalar majmuasiga tegishlidir.

Munosib web-dizaynni yaratishda qatnashuvchi quyidagi element- 
larni sanab o‘tish mumkin:

Shrift -  web sayt ichida imkoni boricha bitta shrift, yoki odatda 
ikki-uchta bir-biriga ovxshash (oson qorishadigan) shriftlarni qo‘shib 
ishlatish mumkin bo‘lgan xususiyatlar va tanlangan fonda o‘qish 
mumkin boigan ranglarga ega bo‘lishi lozim.

Abzats -  imkoni boricha web saytning barcha sahifalarida 
matn va boshqa vizual materiallarni tekislashning (sozlashning) bir 
ko‘rinishlarida boiishi maqsadga muvofiq.

Web-saytning rangli sxemasi -  sahifaning oddiy matnini, havola 
va tashrif buyurilgan havolalarni taqdim qilishning uch xil ranglarini 
belgilaydi. Rangli sxema, yoki turli mavzudagi saytning bo‘limlari 
uchun bunday sxemalarning bir nechta ko‘rinishi saytning barcha 
sahifalarida takrorlanishi lozim.

Web-dizayn o‘zida belgilangan rangli va mantiqiy sxemani bir- 
lashtirgan qandaydir grafikli jihozlashni nazarda tutadiki, shuning 
uchun ish boshida saytni jihozlashning umumiy konsepsiyasini o‘ylab 
ko‘rish kerak bo‘ladi. Barcha grafik elementlarni ikkita katta sinfga 
;ijratish mumkin: chizilgan va biror real voqelik fotosuratlari. Saytni 
bezash ishlarida bu ikki tipni aralashtirib yubormaslik yoki ularni 
web saytning tematik yoki mantiqiy qismlariga to‘g‘ri taqsimlash 
maqsadga muvofiq. Shuni alohida ta’kidlab o‘tish kerakki, saytda har 
qanday tipdagi foto suratlarni illustratsiya sifatida ishlatishdan oldin, 
ularni tegishli tarzda qayta ishlash (rang va tonda tuzatish, korreksiya) 
/  arur.

Web-dizaynning asosiy maqsadi -  saytni egasiga foyda (moddiy, 
ma’naviy) keltiradigan ko‘rinishda taqdim qilishdan iborat. Foyda sayt 
nrqali mollarni to‘g'ridan-to’g‘ri sotisli orqali bo'lishi. shuningdek utiga
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qo‘shimcha firmalarni, mahsulotlarni reklama orqali yangi mijozlarni 
o‘ziga tortish yo‘li bilan ham kelishi mumkin. Ta’limda esa bularga 
qo‘shimcha o‘quv resurslarini yetkazib berish, ta’limni boshqarish 
ishlarini amalga oshirish mumkin.

Bizga ma’lumki web-dizayner boshqa kasblarga nisbatan yosh 
(yangi) kasb hisoblanadi. Internetga bo'lgan talabning ortishi bilan, 
saytlarning dizayniga bo'lgan talab va web-dizaynerlar soni ham ortib 
bormoqda.

Endi web loyihalarning asosiy tiplari va ularni har birini vizual 
bezashga qo'yiladigan talablar bilan tanishib chiqamiz. Saytlar tarkibiga 
ko'ra quyidagi asosiy tiplarga bo'linadi:

Uy sahifasi (Домашняя страница) tushunchasining bir nechla 
ko‘rinishi mavjud:

1. Alohida shaxsga tegishli web-sayt. Bu saytda shaxs haqidagi 
bir necha mavzudagi ma’lumotlar, matnlar, foto jamlanmalar berilislii 
mumkin. Odatda bunday saytlarga turli sohalarning (masalan, fan- 
texnika, madaniyat, sport va boshqa sohalarda) mashhur kishilari ega 
boiadi.

2. Brauzerda birinchi yuklanadigan web-sahifa. Saytdan foydalanish 
undan boshlanadi. Odatda, foydalanuvchi o‘zining qayerda ekanligi va 
saytning boshqa sahifalarida nimalarni ko‘rishi mumkinligi haqida uy 
sahifasidan ma’lumot oladi. Brauzer tomonidan dastur yuklangandan 
so‘ng terminalda paydo bo'ladigan web-sahifaning, portalning. maj- 
muaning birinchi sahifasi. Odatda, prezentatsiya va navigatsiya bo'yicha 
ham asosiy ish bajaradi.

Prezentatsion sayt -  nomidan ko‘rinib turibdiki, sayt firma / 
xizmatlar / mahsulotlar haqidagi ma’lumotlarni taqdim qiladi. Ma’lum 
sondagi sahifalarni o‘zida birlashtirib, kamdan-kam holatda yangilanadi. 
Saytning asosiy vazifasi -  taqdim qilinayotgan xizmatlar va uning 
afzalliklarini tashrif buyuruvchilargacha vizual jihozlash yordamida 
maksimal tezlik va samara bilan yetkazib bera olishdan iborat. Bunday 
loyihalar tartib qoidalar bo‘yicha aniq, noyob dizayn, grafikli jihozlanish 
matnli ma’lumotlar oldida ustunlik qiladi.

Misol sifatida http://www.loyalstudios.com va http://www.de- 
signchapel.com saytlarida keltirilgan sahifalarni aytish mumkin.

Korporativ saytlar -  tashkilotning (firmalar, korporatsiyalar) inter­
net tarmog‘idagi vakolatxonasi hisoblanadi va binobarin, bunday

http://www.loyalstudios.com
http://www.de-


Invihalarda eng asosiy talab ma’lumotni ya’ni grafika yoki matnning 
jilwzlanishiga qaratiladi.

Informatsion resurslar -  bu elektron kutubxonalar va gazetalar. 
Hunday tipdagi saytlarda ma’lumotlar bir sutkada bir necha marta 
\ mgilanadi. Ma’lumotlarning hajmi juda ham katta, va bunday saytlarni 
ishlab chiqishda sliuni ta'kidlash kerakki, tashrif buyuruvchi saytni 
inmosha qilish uchun emas -  ular mazmuni uchun kelishadi. Yangiliklar 
Mishri (misol uchun -  http://www.cnews.ru') yoki http://sight.nmi.ru 
mgari rasmlar galereyasida, loyihaning bosh maqsadi -  yuqori tezlikda 

m.riumotni tashrif buyuruvchiga taqdim qilish yoki bu ma’lumotni
■ iitlirish imkoniyatidan iborat. Har qanday grafikli bezaklar sahifaning
h.ijmini oshirib yuboradi -  ya’ni sahifaning yuklanish vaqtini oshirib 
\ uboradi. Shuning uchun mumkin qadar bunday loyihalarda dizayn 
iiuitnli ko‘rinishda ishlab chiqiladi. Kartinkalar, fotografiyalar, grafiklar, 
vm alar illustratsiyalar hisoblanadi.

Elektron tijorat -  axborot texnologiyalariga asoslangan biznes 
hisoblanadi. Elektron tijorat (ingliz tilidan e-commerce) -  internetda 
ii'/ining sayti va virtual magazini, shuningdek o‘zining (firma yoki 
I ompaniyaning) boshqaruv tizimi mavjudligi bilan asoslanadi. Elektron 
lijorutga quyidagilar kiradi:

elektron ma’lumot almashish (Electronic Data Interchange, EDI),
elektron jamg'arma ko‘chirish (Electronic Funds Transfer, EFS),
elektron savdo (e-trade),
elektron karmon (e-cash),
elektron marketing (e-marketing),
elektron banking (e-banking),
elektron sug‘urta xizmatlari (e-insurance).

Web-dizaynda qo‘llaniladigan dasturiy vositalar

Ikigungi kunning talablaridan kelib chiqib to‘laqonli web-saytlar 
' hi  Mtishda bir qancha turdagi dasturiy vositalardan foydalaniladi. Ularni 
lo'riia katta guruhga ajratish mumkin (1.1-rasm) [II], [12], [13].

Undan tashqari web m uharrirlarning ham turlari juda ko‘p. Ular 
o'/ining imkoniyati, tezkorligi, interfeysi va boshqa xususiyatlari 
bilim farqlanadi. 1-jadvalda shunday dasturlardan asosiylari kel- 
111 ilgan.

u
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1.1-rasm. Web saytlar yaratishda qo'llaniladigan dasturiy vositalar guruhlari.

1.1-jadval
Web-muharrirlar ro‘yxati

№ dastur nomi izoh
1. Bloknot (Notepad) Windows operatsion tizimi standart vositala- 

ridan bo‘lib, undan HTML tilini yaxshi bilgan 
o'rganuvchilar foydalanadi.

2. HomeSite 4.5 HTML-muharrir. Teglarni ranglar bilan ajratish, 
bir vaqtning o‘zida bir nechta faylda qidirish, 
almashtirish va boshqalar.

3. UltraEdit-32 Dasturchilar uchun keng imkoniyatli matn 
muharriri. Bir vaqtning o‘zida bir nechta faylni 
tahrirlash imkoniyati mavjud.

4. Web Page Maker Dastur Software Inc mahsuloti hisoblanadi. 
Qisqa vaqt ichida web-sahifa yaratish va 
yuklash imkoniyatini beradi. Unda HTML tilini 
bilish shart emas.

5. DTM Lome 1.2 Ish boshlovchilar va professionallar uchun 
oddiy, tezkor va qulay HTML-muharrir.

12



6, Artisteer.2.3.0.10943 Dastlabki web-dizaynni avtomatlashtirgan das­
tur. Photoshop, CSS, HTMLlarni bilish talab 
qilinmaydi.

7, Codelobster 
PHP Edition 3.3

Juda qulay PHP, HTML, CSS muharriri

К. Amaya web-brauzer va HTML-muharrir The World 
Wide Web Consortium (W3C) -  tomonidan 
ishlab chiqilgan.

•> Neon HTML 0 ‘zida vizual uskunalarni birlashtirgan HTML 
va CSS muharrir.

10. Serif WebPlus X2 Professional darajadagi web-saytlar yaratishga 
mo‘ljallangan web-dizayn dasturi

II. PHP Designer 2008 
Professional 6.2.5.2

PHP tilida ish boshlayotgan va professional 
foydalanuvchilar uchun dastur PHPdan tash- 
qari, dasturda HTML, MySQL, XML, CSS, 
JavaScript, VBScript. JAVA, C, Python va 
Rubylarni ham ishlatish mumkin.

12. Dreamweaver CS4 Murakkab strukturali web-saytlarni loyihalash, 
yaratish va boshqarishga moljallangan profes­
sional dastur.

13. Wap Editor 0.6d Qulay va ko‘p funksiyali web-sahifalar yara­
tishga moijaliangan dastur.

14. BestAddress 
HTML Editor 2008 
Professional 12.12.0

Ko'p funksiyali HTML-muharrir. Dasturda 
DHTML kodlari yordamida menyu yaratish 
imkoniyatlari mavjud.

15. DzSoft PHP Editor 
4.2.1

PHP -  skriptlar yozishga va HTML-sahifalar 
yaratishga mo‘ljallangan dastur.

16. SaveChm 1.2 Rasmli web-sahifalarni tezkorlik bilan CHM 
(Windows-help) formatida saqlovchi dastur.

17. MenuEditor
1.0.3.231

Web-saytlarda harakatlanish uchun qulay men- 
yularni yaratishga mo‘ljallangan dastur

18. Quick Page 2008 
(3.0.3.254)

Web-saytlar yaratishga mo‘ljallangan profes­
sional dasturiy vosita.

19. AAA Web Album Bu dasturiy vosita web-sahifalar uchun foto 
albomlar yaratish uchun mo'ljallangan.
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davom i

20. Multiple File Search 
and Replace 2.0

Bir vaqtning o‘zida web-saytning bir nechta 
fayllari bilan ishlashga mo‘ljallangan dasturiy 
vosita

21. Incomedia Website 
Evolution X5 7.0.9

Foydalanish uchun qulay bo‘lgan. tushunarli 
interfeys va qadamba-qadam yordamchidan 
foydalanib bir necha minutda web-sayt yaratish 
mumkin

22. Arachnophilia
5.3.2177

Java asosida qurilgan HTML-muharrir Sun Mi­
crosystems mahsuloti hisoblanadi

23. Web Page Maker 
v2.5 Rus

Dasturning arxivida bir qancha tayyor sayt 
shablonlari mavjud boiib, bir necha daqiqada 
HTML sahifalar yaratish imkonini beradi

24. Incomedia WebSite 
X5 Evolution 7.0

Shaxsiy web-saytlar yaratishga moijallangan 
dastur

25. AceHTML Pro 
V6.03.0

Web-saytlar yaratish va ularga xizmat ko'r- 
satuvchi dasturlar paketi

26. Sothink
DHTMLMenu 8.3 
build 71210

Web-ustalar uchun moTjallangan dasturlar pa­
keti

27. HtmlReader 2.5 html-sahifalarni yaratish, tuzatish va ko'rishga 
moijallangan dastur.

28. PHP Designer 2008 
Professional v6.0.0

PHP, HTML. XHTML, CSS, Perl, C*, jav- 
Script, VB, java va SQL muharriri.

29. Atani 4.3.4 Rus Web-sahifalar uchun bannerlar yaratishga moi- 
jallangan dastur

30. Sothink
DHTMLMenu

DHTML menyular yaratishga moijallangan 
dastur. Dasturdan foydalanishda DHTML yoki 
JavaScript bilish talab qilinmaydi

31. TIGER CMS vl.O 
Lite

Shaxsiy web-sahifalar yaratishga moijallangan 
dastur

Web-dizaynda qo‘llaniladigan bir qancha dasturiy vositalar va yana 
ko'plab uskunaviy dasturlar, turli dasturlash tillari mavjud. Eng k<yp 
qo‘llaniladigan tillarga misol qilib, HTML-gipermatnlarni belgilash tili, 
PHP, ASP, Java, JavaScript, DHTML va boshqa tillarni aytish mumkin.
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1.2-rasm. Web-dasturlash tillarining guruhlarga boiinishi.

Web-dasturlash tillari ikki guruhga bo‘linadi: mijoz va server tillari. 
Hi/ yuqorida web-serverga ta’rif berdik. Unga ko'ra server sizning 
tii' Imgiz saqlanadigan, brauzerning so‘rovlari qayta ishlanadigan 
t|tt\Mdir sahifadagi dasturlar saqlanadi. Undan tashqari serverga 
•|n\ idagicha ta'rif berish mumkin: Server -  tarmoq ishini ta'minlovchi 
m i ч .us kompyuter. Server disklarida kompyuterlarni birgalikda ishlash 
iinkonini beruvchi dasturlar, ma’lumotlar omborlari va boshqalar 
»|i|itlanadi. Bundan tashqari serverlar modemli va faksli aloqalarni, 
inn  lumotlarni bosmaga chiqarish ishlarini amalga oshiradi. Serverda 
и lnshgan dasturlardan foydalanish doirasi umumiy masalaning
• I" \ ilishiga ko‘ra cheklangan boiishi mumkin.

Mijoz tomonidagi senariylar 
JavaScript nima?

Mijoz tillaridan eng ko‘p tarqalgani JavaScript tili bo‘lib, Netscape 
I NiMscape Navigator, www.netscape.com) SunMicrosystems (www.sun. 
11пи) kompaniyalari hamkorligida ishlab chiqilgan. JavaScript faol 
111 ML-sahifalar uchun senariylar yozishga mo‘ljallangan. JavaScript 
n lonom ravishda ishlaydigan ilovalarni yaratishga mo‘ljallanmagan. 
Iiiv iiScriptdagi dasturlar bevosita HTML-hujjat kodi ichiga quriladi va 
liniuzerda sahifani yuklanishi vaqtida faollashadi. Sodda qilib aytganda 
111 MLning cheklangan, sodda imkoniyatlarini kengaytirish va to‘laqonli
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sahifalar yaratishga moijallangan. JavaScript yordamida odatda 
maiumotli va muloqot oynalarini chiqarish, animatsiyalarni ko‘rsatish 
kabi vazifalarni bajarish mumkin. Bundan tashqari, JavaScript- 
senariyda ba'zan o‘zi ishlab turgan brauzer va platforma tipini aniqlash 
mumkin. JavaScript-senariylar foydalanuvchi tomonidan kiritilayotgan 
ma’lumotlarni to‘g’riligini tekshirishda ham qulay hisoblanadi.

ActionScript nima?

ActionScript -  obyektga yo'naltirilgan dasturlash tili boiib, Flash- 
ilovalar tarkibida interfaollik, ma’lumotlarni qayta ishlash va boshqa 
ko‘plab imkoniyatlarni beradigan ECMAScript dialektlaridan biri 
hisoblanadi.

Silverlight nima?

Microsoft Silverlight -  bu dasturiy platforma boiib, R1A (Rich 
Internet application)ga xos boigan animatsiyalar, vektorli grafika va 
audio-video roliklardan tarkib topgan ilovalarni yuklash imkonini 
beradigan brauzer uchun plaginlarni o‘z ichiga oladi. Bu esa 
Silverlight barcha brauzerlarda WMV, WMA va MP3 kabi formatlarni 
Windows Media Player singari qo’shimcha komponentlarsiz ijro qilish 
imkoniyatini beradi. Dasturning 2.0 versiyasi 2008 yil oktyabrda ishlab 
chiqilgan boiib. unga .NET tillari bilan ishlash imkoniyati qo'shilgan. 
Bundan tashqari Microsoft kompaniyasi 2009-yil iyulda IDE bilan 
integratsiyalashgan Silverlight 3 va Microsoft Expression Studio 3 
dasturlarini ishlab chiqdi.

Silverlight platformasi Windows 2000, Windows XP, Windows 
Server 2003, Windows Vista, Windows 7, Mac OS X 10.4, Mac OS 
X 10.5, Mac OS X 10.6 operatsion tizimlariga va Internet Explorer 
6.0/7.0/8.0, Mozilla Firefox 1.5/2.0/3, Safari 3.1, Google Chrome 3.0, 
Opera 9.50 brauzerlariga moijallangan.

VBScript nima?

VBScript tili Microsoft korporatsiyasi tomonidan yaratilgan boiib. 
Visual Basic tilining bir qismi hisoblanadi. VBScript tili Internet 
Explorer va Microsoft Internet Information Server (IlS)lar bilan
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islilnshga moijallangan tildir. VBScript tilining JavaScript tili bilan 
timumiy qismlari bir nechta. Jumladan, u aynan Microsoft Internet 
I splorer bilan ishlash va uning qo‘llanish sohasini cheklay olish 
imkoniyatiga ega. VBScript interpretatorli (sharhlovchi, izohlovchi, 
m .lumtirib beruvchi) til hisoblanib, Microsoftning Web-texnologiyalari 
imasalan ASP (Active Server Page)) bilan hamkorlikda ishlay
* iliuii. Shunga qaramay VBScript klient tomonida ishlovchi senariy 
hisoblanadi, ASP esa server tomonida ishlaydi.

Server tomonidagi senariylar

Dasturning ishlashi to iiq  sayt joylashtirilgan serverga bogiiq. 
Sriver tillarini ishlashining muhim jihatlaridan biri bu serverda 
i и I iblangan holda saqlanuvchi va xohlagan paytda chaqirilishi mumkin 
Im'lgan ma’lumotlarni bevosita ma’lumotlar bazalarini boshqarish 
11/ 1mlari bilan o‘zaro bogiangan holda faoliyat yuritadi. Eng ko‘p 
i .hlatiladigan ma’lumotlar bazasini boshqarish tizimlari quyidagilar:
I ncbird, IBM DB2, IBM DB2 Express-С, Microsoft SQL Server, 
Microsoft SQL Server Express, mSQL, MySQL, Oracle, PostgreSQL 
S(.)I ite, Sybase Adaptive Server Enterprise.

Server tomonida bajarilishi kerak boigan senariylar odatda sayt
ii.ipkasining ichidagi maxsus papkaga joylashtiriladi. Foydalanuvchi 

i roviga asosan server bu senariyni bajaradi. Bajarilgan senariy natijasi 
\ub-serverga uzatiladi va undan so'ng mijoz (klient)ga uzatiladi. Server 
iiinmnidagi senariylarni tashkil etish uchun odatda Perl, ASP. PHP, JSP,
• SI kabi tillar va texnologiyalardan foydalaniladi.

Perl nima?

l’erl -  bu protsedurali dasturlash tili boiib, juda keng qamrovli 
Uipshiriqlarni yechish uchun moijallangan universal uskunadir.
I’ ii boshqa toiaqonli tillar singari platformalarga, operatsion tizim 
\.i boshqa vositalarga bogiiq boimagan funksiyalar va qoidalar 
inplamiga ega yadrodan tashkil topgan. Perl tili Web-ilovalar 
Miiatishda eng ommabop tillardan biri hisoblanadi. Matnlarni qidirish 
\ л tahrirlash, fayllar bilan qulay ishlay olish qoidalari uchun Perl tili 
Inlernetning asosiy tillaridan biri boiib  qoldi. Perl -  interpretatorli til 
hisoblanadi, shu bois unda yaratilgan
> I’i'Jagogik web-dizayn j AXB O R O T-R ES U R S  M ARK ‘ Z| П
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kompyuterda Perl-interpretator o'rnatilgan boiishi kerak. Bevosita 
Perl-kodning interpretatsiya qilinish jarayoni uning samaradorligini 
pasaytiradi. Bugungi kunda Perilling asosiy yutuqlaridan, uning barcha 
platformalar uchun ishlay olishi va uning barcha resurslari bepul 
tarqatilayotganligidir. Ko‘pgina web-serverlar UNIXda ishlaydi, Perl 
interpretator esa bu operatsion tizimning bir qismi hisoblanadi.

ASP nima?

ASP (Active Server Pages) -  ma’lumotlar bazalari tashkil etish 
va ular bilan ishlash vazifalarini bajarishda juda moslashuvchan, 
qulay vositadir. ASP vositalari server tomonida ishlaydi va HTML- 
kod va senariylar kabi fayllarni qayta ishlaydi. ASP texnologiyasi 
VBScript, Java va JavaScript tillarini qoilab quvvatlaydi. ASP- 
kod joylashtirilgan Web-sahifalar fayllari kengaytmasi .asp boiadi. 
ASP texnologiya Windows NT va Microsoft IIS web-serveriga 
moijallangan boiib , imkoniyatlari va samaradorligi yuqori boiganligi 
bois ko‘pgina kompaniyalar o‘z vositalariga ASPni qoilab-quvvatlash 
imkoniyatlarini kiritmoqdalar. Ko‘pgina HTML-muharrirlar, masalan, 
Adobe GoLive ham ASPni qoilab-quvvatlaydi. ASP texnologiyasi 
bir nechta qulayliklarni o‘zida jamlagan: HTML-hujjatni dinamik 
generatsiyalaydi, formalarni qoilab-quvvatlaydi, ma’lumotlar bazasiga 
ruxsatni tashkil etadi va u bilan ishlay oladi. ASP -  dasturlash tili 
ham, ilova ham emas, u interfaol web-sahifa hosil qilish texnologiyasi 
hisoblanadi.

PHP nima?

PHP -  bu serverda qayta ishlanuvchi senariylar tilidir. ASP kabi 
PHP kodlar ham bevosita HTML-hujjatni tarkibiga qo‘shiladi. Ushbu 
tilning nomi Personal Home Page Tools so‘zlarining qisqartmasidan 
olingan. PHPda С va Perl tillarida uchragan bir qator muammolar hal 
etilgan. Bundan tashqari, PHP ma’lumotlar bazasi bilan ishlash uchun 
juda qulay vositadir. Umuman olganda Perl, PHP -  ochiq tizimli tillar 
hisoblanadi va ularni dasturchilar modernizatsiyalashtira oladi.

Ko'pgina boshqa dasturlash tillaridan farqli ravishda. PHP qandaydir 
tashkilot yoki kuchli dasturchi tomonidan yaratilgan emas. Uni oddiy
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I*. . 1,1 Lmuvchi Rasmus Lerdorf 1994-yili o‘zining bosh sahifasini 
tin' il iol uslubda ko‘rsatish uchun yaratgan. Unga Personal Home Page 
IИ II' shaxsiy bosh sahifa) deb nom bergan.

l'V)S-yili Rasmus PHPni o'zining HTML formalari bilan ishlaydigan 
In Ih|n dastur bilan umumlashtirib PHP/FI Version 2 («Form 
I nit i pu lator») hosil qildi. 1997-yilga borib PHPdan foydalanuvchi 
Ц|\ Iliti 50 mingdan oshdi. Shundan so'ng web texnologiya ustalari 
I'lll' r ‘«>yasi asosida mukammal til yaratishga Ziva Suraski va Endi 
Hiiimans asoschiligida kirishildi. PHPni samarali deb hisoblanmagani 
in IH i и deyarli noldan boshlab, mavjud С va Perl tillaridan ibrat olib 
1*111* i lalqinini yaratildi. 1999-yilga kelib PHP asosida qurilgan saytlar 
milliundan oshib ketdi. 2000-yilda esa Zend Technologies shirkati yangi 
In' |и 'та funksiyalarni qo’shgan holda PHP 4 sharhlovchisini yaratdi.

I'lll’ -  web texnologiya tili. PHPni o’rganish uchun avval HTML 
Vm • I i 1 urlash tilidan habardor bo'lish talab qilinadi. HTML/CSS va 
ln\ uScript tillarini mukammal biladiganlar uchun PHPni o‘rganish 
nun ikUablik tug'dirmaydi. PHPning vazifasi HTML faylini yaratib 
bcir.h. JavaScript yordamida bajariladigan ko‘pgina operatsiyalarni 
1*1 II' orqali ham amalga oshirish mumkin.

I.ivaScript -  mijoz tomonda bajariladi, PHP esa serverda bajariladi. 
I'lll’ila yozilgan kod serverning o‘zida bajarilib, klientga HTML 
ImUida etib boradi. Bu havfsizlik jihatdan ancha maqsadga muvofiq.

lavaScript yordamida kod yozish, ma’lumot uzatish va qabul qilishni 
lilin/ tezlashtirsa-da, kodni mijoz ko‘rish imkoniyatiga ega bo‘ladi.

"I’lIPda har qanday dasturni bajarsa boiadi» -  degan edi uning 
\ 11 и uvchisi. Birinchi navbatda PHP tili server tomonidan bajariladigan 
l npllar yaratish uchun foydalaniladi va aynan shuning uchun u 

Vtiiulilgan. PHP tili ixtiyoriy CGI-skriptlari masalalarini yechishga va 
i'■ 11ulan tashqari html formali ma'lumotlarni qayta ishlashga hamda 
im.imik ravishda html sahifalarni ishlab chiqishga qodir. Biroq PHP tili 
lnsdalaniladigan boshqa sohalar ham mavjud. Bu sohalarni biz uchta 
п .п .iv qismga bo‘lamiz:

Itirinchi soha -  biz yuqorida aytib o‘tganimizdek, server tomonidan
i..11■ 11 iladigan ilovalar (skriptlar) yaratish. PHP tili bunday turdagi 
il npllarni yaratish uchun juda keng qo‘llaniladi. Bunday ish ko'rsatish 
i h  Ihiii PHP-skriptlarni qayta ishlovchi va skriptlarni qayta ishlovchi
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web-server, skriptlarni natijasini ko‘rish uchun brauzer va albatta php- 
kodini yozish uchun qanday bo‘lsa ham matn muharriri kerak bo‘ladi. 
PHP- skriptlarni qayta ishlovchi CGI-dasturlar ko‘rinishida yoki server 
modullari ko‘rinishida tarqalgan.

Ikkinchi soha -  buyruqlar satrida bajariladigan skriptlarni yara­
tish. Ya’ni PHP tili yordamida biror-bir kompyuterda brauzer va 
web-serverlardan mustaqil ravishda o*zi bajariladigan skriptlarni 
ham yaratish mumkin. Bu ishlarni bajarish uchun hech boimaganda 
PHP-skriptlarni qayta ishlovchi (bu holatda biz uni buyruqlar satri 
interpretatori (CLI. command line interpreter) deb ataymiz) talab 
etiladi. Bunday ishlash uslubi turli masalalarni rejalashtirish yordamida 
bajarilishi uchun kerak bo‘lgan skriptlar yoki oddiy matnni qayta 
ishlash uchun kerak bo‘lgan masalaga o‘xshash ishlaydi.

Uchinchi soha -  bu mijoz tomonidan bajariladigan GUl-ilovalarni 
(grafik interfeys) yaratish. Bu soha PHP tilini endigina o‘rganayotgan 
foydalanuvchilar uchun uncha muhim bo'lmagan sohadir.

PHP tilini qo'llanilish sohalari keng va turlichadir. Yuqoridagi 
masalalarni yecha oladigan boshqa turlicha dasturlash tillari ham 
mavjud. Unda nima uchun PHP tilini o‘rganishimiz kerak? U til bizga 
nima beradi? Birinchidan, PHP tili o‘rganish uchun juda qulay. PHP 
tilini sintaksisi asosiy qoidalari va ishlash prinsipi bilan yetarlicha 
tanishib chiqib o’zingizni shaxsiy dasturingizni tuzib ko‘rib, so'ngra 
uni boshqa dasturlash tillarida tuzilgan variantlari bilan solishtirsangiz 
bunga guvoh bo‘lasiz. Ikkinchidan, PHP tili barcha bizga ma’lum 
platformalarda, barcha operatsion tizimlarda hamda turlicha serverlarda 
erkin ishlay oladi.

PHP dasturlash tilini turli dasturlash tillari o‘rtasidagi o'zaro 
aloqasiga diqqatni qaratsak, bunga Java dasturlash tilini aytib o'tish 
lozim, chunki Java dasturlash tili obyektlarini PHP tili o‘z obyektlari 
sifatida qaraydi. Obyektlarga murojaat sifatida CORBA kengaytmasidan 
foydalaniladi.

JSP

JSP (JavaServerPage) texnologiyasi o'zining funksional imkoniyat- 
lariga ko‘ra ASPga o‘xshashdir. Asosiy farqi shundaki, bunda VBScript 
va JavaScript bilan birga Java tili ham qo'llanila oladi. Shunga qaramay
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14' liivadan oldinroq qo41anilgan va ushbu texnologiya mukammal 
NVk'l* ilovalar yaratish uchun yetarli imkoniyatga ega.

SSI

SSI (Server Side Include) HTML-faylni dastlab serverda qayta 
IfthLivdi va undan so‘ng uni mijozga uzatadi. Dastlabki qayta ishlash 
Vin|iKla hujjatga dinamik generatsiya qilingan ma’lumotlar qo‘shiladi. 
M i Нам joriy vaqt haqidagi ma’lumot. Umuman olganda SSI 
Hhimlogiyasi HTML-faylning tarkibiga qo‘shimchalar qo‘shishga 
пи, l|«llangan HTMLning qismi hisoblanadi.

DHTML nima?

IHITML (dinamik HTML) -  bu serverga ortiqcha bog‘lanishlarsiz 
iiiii i laol Web-sahifalar yaratish imkonini beradigan vositalar to"p- 
Irtiulilir.

I HI I ML tili HTML va JavaScriptlardan farqli ravishda bir qancha 
i|n ilumcha internet texnologiyalariga ega. Dinamik HTML -  Netscape 
ы  Microsoft tomonidan o‘ylab topilgan tijorat termini bo‘lib, unda 
Wob -biauzerlarning dinamik imkoniyatini kengaytirish maqsadida 
i и ililgan. Bu texnologiyalar HTML yordamida Web-sahifa yaratishdagi 
Him |lid imkoniyatning cheklanganligi va ana shu cheklovdan o'tib 
kfllMh uchun yaratilgan yoki qo'shilgan hisoblanadi. Chunki bizga 
in i lumki HTMLning faqatgina o‘zidan foydalanib bugungi kunda 
•iiiiU inimal Web-sahifalar yaratib bolmaydi. Boshqacha aytganda 
flinviiid Internetda matnli ma’lumotlar va grafik ma’lumotlarga 
lim'liallangan juda yaxshi texnologiyalar mavjud edi. Ammo multimedia 
liiilumiyatlariga ko‘nikib qolgan odamlar esa bunga ko‘nika olmadi. Shu 
«til< il>li Internet imkoniyatlarini kengaytirish kerak edi.

DIITML asosida yaratilgan sahifa serverdagi qo‘shimcha ma’- 
luniollarga murojaat qilmasdan turib ham o‘zgarish imkoniyatiga ega. 
I ill I ML o'zida turli xildagi standartlarga (CSS, DOM, JavaScript va 
l)l|u i matnlarni belgilash tillariga) asoslangan kombinatsiyalarni namoyon 
illlmli. Bu standartlarning kombinatsiyasi sizning web-sahifangizni 
tui i laolligini oshirish imkonini beradi. Boshqacha aytganda, sahifaga 
In In 11 buyurgan foydalanuvchi uning tashqi ko‘rinishi va mazmunini 

S|i'i\iTga murojaatlarsiz o’zgartira olish imkoniyatidir.
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Bizga ma’lumki, har qanday murakkablikdagi web-saytlar HTML I 
tiliga asoslangan boTib, bu tilni bilmasdan turib to‘laqonli web-saytlar 
yaratib bo‘lmaydi. Endi HTML tilining asoslari bilan tanishib chiqamiz. I

HTML (Hyper Text Markup Language) -  giper matnlarni belgilash 
tili degan ma’noni anglatadi. HTML -  web sahifada matn, tasvir va 
boshqa ma’lumotlarni qanday ko‘rinishda joylashtirilishini belgilovchi 
vosita. Bu til 1989-yilda Jenevada Tim Berners-Li (Tim Berners-Lee) I 
tomonidan yaratilgan. Keyinchalik Tim Berners-Li «Internet otasi» I 
nomiga sazovor bo'lgan. Til dasturlash tili emas. faqat Web-sahifa 
yaratish uchun moijallangan. Web-sahifada biror ma’lumotlarni qayta 
ishlash algoritmlarini o'rnatish uchun Java tilida tuzilgan dasturlardan 
foydalaniladi.

Ushbu ma’lumotlardan foydalanib, ko‘zda tutilgan asosiy maqsad 
-HTM L haqida asosiy tushunchalarni misollar yordamida tushuntirib 
berish, HTMLning bir-oz qiyin boigan elementlari hisoblanmish jadval 
tuzish, freymlardan foydalanish va sahifaga tasvirlarni joylashtirish, ] 
sahifalarni bir-biriga faol havolalar orqali bogTash usullarini ko‘rsatib 
berishdan iborat.

Teg tushunchasi

HTML sahifa -  bu oddiy matn fayl bo'lib. HTML kengavtmasiga 1 
ega. HTML sahifani yaratish uchun maxsus dastur shart emas. H a r l  
qanday matn muharriri yordamida HTML sahifa yaratish mumkin. 1 
Ana shunday matn tahrirlovchi oddiy dasturlardan biri boigan Notepad 1 
(Блокнот) standart holatda Windows mo‘hitida mavjud. H TM L* 
sahifaning asosiy elementlaridan biri boigan teglar haqida dastlabki I  
tushunchalar bilan tanishib chiqamiz.

HTML teg

HTML teg bu HTML hujjatdagi turli elementlarni (matn, tasvir 1 
va boshqalar) web sahifada qanday ko'rinishda aks etishi lozimligini 
brauzerda ko‘rsatuvchi buyruqlar hisoblanadi. Teglar ma’lum olcham 
va vazifani bajaruvchi buvruqlardir.

1.2. HTML tili haqida
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leg quyidagi ko'rinishda bo'ladi: <TEG> hujjat elementi </TEG> 
Ko'rib turganingizdek teglar < > uch burchaksimon qo‘shtironoq 

t linii liak qavs) ichiga olib yoziladi. Uch burchaksimon qo‘shtironoq 
l< hn a teg nomi va uning atributlari yoziladi.

(Juyida teg va uning atribut yozilishiga misol keltirilgan:
H> <FONT COLOR=«red»> Hello World! </FONT> </B>

Vlisolda keltirilgan teglar HTML hujjatga kiritilgan Hello World! 
iMinIa qizil rangda, ajratilib yoziladi. Teglar orasida kiritilgan matn, teg 
Hinlnilida qanday vazifalar berilgan bo'lsa, shu vazifaga bo‘ysungan 
liulda ekranda hosil bo'ladi. Bu misolda Hello World! jumlasiga 
hi halan ikkita teg ishlatilgan. 1 -  teg <B> va 2 -  teg <FONT> Hello 
World! jumlasidan keyin yana ikki teg </B> va </FONT> yozilgan. 
Hnlaming farqi shundaki, birinchi ikkita teg ochuvchi va jumladan
о it).' yozilgan ikkita teg esa jum la oldida yozilgan teglarni davomi 

ч к ni yopuvchi tegdir. Yopuvchi teglarning vazifasi ochilgan teg ta’sir 
iiuiydoni tugaganligini belgilashdan iborat. HTML hujjatda deyarli 
km ha teglarni yopish lozim. '/’ belgisini qo‘yish orqali yopuvchi teg 
Siisaladi.

I slatma: har doim eng oxirgi ochilgan tegni birinchi navbatda 
\ iipishni unutmang. Teglarning ochilishi va yopilish tartibini almashtirib 
iihormang. Aks holda xatoliklar kelib chiqishi mumkin.

I ndi e’tiborimizni <FONT COLOR = «red»> ga qaratamiz. FONT 
i.In ill) teg nomi. COLOR (rang) -  esa tegning tarkibidagi qo‘shimcha 
iiiiiluit, red (qizil) -  rangning belgisi. Bu teg matnni qizil harflar bilan 
s o/ilishini anglatadi. Ayni misolda ranglarni o‘zgartirish uchun red so‘zi 
ii'miga boshqa rang nomini kiritish kifoya. Matn shu zahoti siz kiritgan 
mug bilan ifodalanadi. Ushbu teg va uning qo‘shimcha atributlari 
i|iinday yozilishini eslab qoling. Bu sizga keyinchalik ham as qotadi. 
le a rn in g  atributi bir nechta bo'lishi mumkin va ularni kiritganda har 

biri orasida bo‘sh katakcha ya’ni probel qoldirishni esdan chiqarmang.

HTMLda teglarni ishlatish shartlari

Siz yuqorida teg tushunchasi haqida qisqacha tushunchaga ega 
In * Igansiz. HTML teglarni ishlatganda ularni to‘g‘ri yozish muhim 
nhamiyatga ega. Quyida teglarni to‘g‘ri yozish va ishlatish shartlari 
hm|ida so‘z yuritamiz. Bu borada quyidagi qoidalar mavjud:
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• Barcha teglar uch burchakli qo‘shtirnoq ichida yoziladi
‘<TEG>’.

Ochuvchi teg  -  uch burchakli qo‘shtirnoq, teg nomi va uning 
qo‘shimcha atributlari (zarur bo‘lgan taqdirda). Yopuvchi teg -  
uchburchakli qo‘sh tirnoq ,'/' slesh belgisi va teg nomi.

• Probel orqali yoziluvchi teglar atributlari.
Teg nom idan so‘ng uning qo‘shimcha o‘lchamlari boiishi mumkin. 

Barcha atributlar probel orqali ajratib yoziladi. Bitta harf hajmidagi 
bo‘sh joy qoldirilish HTMLda probelni anglatadi.

<TEG 1 -  atribut=yuklatilgan vazifa 2 -  atribut=yuklatilgan va- 
zifa...>

• Qo‘shtirnoq ichida yoziluvchi yuklatilgan vazifalar ma’nosi.
Ma’lum vazifani bajaruvchi buyruqlar tenglik belgisidan 

so'ng qo'shtirnoq «...» ichida yoziladi. Agar probel ishlatilmagan 
taqdirda qo‘shtirnoqni tushirib qoldirish mumkin. <FONT SIZE = 2 
FACE=«Times Roman»> Har hil hatoliklar kelib chiqishini oldini olish 
uchun qo‘shtirnoqlarni ishlatish maqsadga muvofiq.

• Aksariyat teglar yakunlash buyrug‘ini talab qiladi.
Agar siz tegni yopmagan taqdiringizda aksariyat hollarda hatolik 

kelib chiqmaydi. Ammo ochilgan teg atributlari butun hujjatga ta’sir 
qiladi. Jadval ichida yopilmagan taqdirda bu hatolikni keltirib chiqarishi 
mumkin. Bu haqda jadvallar tuzish bo‘limida so‘z yuritamiz.

• Teglarni yopish qoidasi
Har doim teglarni qat’iy tartibga rioya qilgan holda yoping. Birinchi 

navbatda eng oxiri ochilgan teg yopiladi va shu tariqa navbati bo‘yicha 
barchasi yopiladi. <TEG1> <TEG2> <TEG3> ... </TEG3> </TEG2> 
</TEGl>

• Teg harflar yozish shartlari.
HTM L hujjatda teglarni katta yoki kichik harflar bilan yozilishi 

hech qanday ahamiyatga ega emas. Hamma teglarni katta yoki 
kichik h a rf la r  bilan yozishingiz mumkin. Hattoki mana bunday 
<teg></Teg> Sizga maslahatimiz: barcha teglarni bir hil shaklda 
yozgan m a’qul.

• Teg atributlarini yozish tartibi qanday bo‘lishi ahamiyatsiz.
Teg tarkibidagi atributlar qanday tartibda yozishingiz hech qanday 

o‘zgarishlarga sabab bo‘lmaydi. Quyidagi ikki variant ham to‘g‘ri:



11 с i 1 -  atribut=yuklatilgan vazifa. 2 -  atribut=yuklatilgan va- 
#11(1 ' atribut=yuklatilgan vazifa. >

I EG 3 -  atribut=yuklatilgan vazifa. 1 -  atribut = yuklatilgan va- 
4tl<i atribut=yuklatilgan vazifa>

HTML web-sahifa yaratish

■ I/ bilan birgalikda eng sodda HTML sahifa yaratishga harakat 
tyllih Ko'ramiz. Buning uchun bizga Notepad (Блокнот) matn muharriri 
lit il holadi. Dasturni ishga tushirish uchun asosiy menyu Start 
(Пик) > Programs (Программы) > Accessories (Стандартные) > 
Suit pad (Блокнот) buyrug‘ini tanlang.

nuyida keltirilgan HTML teglarni Notepad (Б л о к н о т а  qanday 
I*»' I .a .hundayligicha yozing:

II I ML>
III AD>
111 LE> Eng sodda ko‘rinishdagi HTML sahifa!</TITLE>
i ii;a d >

BODY BGCOLOR=«white»>
M <FONT COLOR=«red»>Salom!</FONT></B><BR>

I In mening ilk HTML sahifam.
I1()DY>
I П ML>

Nnvbatdagi amalga oshiradigan ishimiz, uni kompyuter xotirasiga 
«•«•il.i-.h Buning uchun Notepad (Блокнот) dasturi File (Файл) menyusi 
Idlkibnlagi Save As... (Сохранить как...) buyrug‘ini tanlang va fayl 

>|l.niishi lozim bo'lgan papkani tanlang hamda faylni nomi.html 
тми imasi bilan saqlang.

I slHlma: har qanday HTML sahifa html yoki htm  kengaytmasiga 
.1 lui'ladi. Faylni kompyuter xotirasiga saqlagach, uni brauzer 
niи11.in yordamida ochishingiz mumkin. Brauzer dasturlari internet
• i ■ liini ta’minlovchi maxsus dasturlar hisoblanib, gipermatnni 
i|hli web-resurslarda navigatsiyalash va ko‘rib chiqish dasturidir. 
i'li Inauzeri gipermatnlarni o’qishdan tashqari, tovushni va video 

Itnnotlarni qaytadan chiqarish, ya’ni, gipermediani qayta chiqarish, 
ни u|iiing boshqa kompyuterlari bilan ulanishni o‘rnatish va ularda 

|Й|1и\п|цап serverlarga web-hujjatlarga so‘rovlarni yuborish, tarmoqning
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boshqa foydalanuvchilari bilan muloqot tashkil qilish va uni quvvatlash 
kabi qo‘shimcha imkoniyatlarga ega bolishi mumkin. Eng ommaviy 
tarqalgan web-brauzerlarga misol qilib Internet Explorer, Opera, Avant 
Brauzer, Mozilla kabi dasturlarni aytishimiz mumkin. 1.2-jadval 
brauzer dasturlarning ro‘yxati va imkoniyatlari keltirilgan.

1.2-jadval
Brauzer dasturlari ro‘yxati

№ Brauzer nomi: Imkoniyatlari

I. Opera 10.63 Opera Software kompaniyasi dasturidir. Bu dastur 
43 tildagi foydalanuvchilar uchun moijallangan 
bo'lib, Windows, Linux va Mac operatsion 
tizimlarida ishlaydi.

2. Mozilla Firefox Mozilla Firefox — tezkor, ko'p funksiyali brauzer 
dasturi. Firefox dasturida bir oynada bir nechta 
sahifani ochish mumkin. Shuningdek, siz 
giper havolalarni shu sahifani (siz ayni paytda 
ko‘rib turgan sahifani) tark etmasdan turib 
ochish imkoniyatiga ega bo‘lasiz. Brauzer web 
standartlarni juda yaxshi qollab, unda juda qulay 
interfeys mavjud va o‘zida qidiruv paneli (Google 
va boshqalar) joylashgan.

3. Google Chrome Google Chrome -  bu brauzer, murakkab tex- 
nologiyalarni va sodda dizaynni birlashtirgan 
va bu esa Internetda ishlashni tezlashtiradi va 
xavfsizligini oshiradi.

4. Apple Safari Apple Inc. kompaniyasining brauzer dasturi 
hisoblanadi. Dastlab dastur Mac OS operatsion 
tizimi uchun ishlab chiqilgan edi. Dasturda ko‘p 
oynalik interfeys mavjud boiib, unda xavfsizlik 
uskunalari bilan boyitilgan.

5. Maxthon Internet-brauzer dasturi. Maxthon web-sahifalarni 
ko‘p oynali rejimda ko‘rish imkonini beradi. 
Dasturning asosiy xususiyatlaridan biri ko‘p sonli 
boglanishlar imkoniyati mavjud.
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Avant Browser Bu brauzer ham ko‘p oynali rejimda ishlaydi. 
Ya’ni asosiy oyna ichida ko'plab oynalarni ochish 
imkoniyati mavjud. Avant Browser dasturida 
sichqoncha tugmasini bir bosish bilan grafiklar, 
video, tovushlar va Flash animatsiyalarni yuk- 
lashni taqiqlash yoki aksincha ruxsat berish 
imkoniyati mavjud.

Netscape Navigator Dastur o‘zining oddiy va yengil sozlanadigan 
foydalanuvchi interfeysi bilan va tezkorligi, ish- 
lashga qulayligi hamda web-sahifalarni ko‘rishni 
boshqarish imkoniyatlari kengaytirilgan.

Bizga ma’lumki yaratilgan vveb-sahifalarni ishlatib ko‘rishda 
и /1111 iz bilgan yoki bilmagan holda brauzer dasturiga murojaat qilaraiz. 
\ iui  shu paytda yaratilgan web sahifani ochish uchun uning favli 
n.tida sichqonchaning chap tugmasini ikki marta ketma-ket bosish 
M larli. Bundan tashqari avval brauzer dasturini (Internet Explorer) 
i>.hga tushirib olib. key in esa File > Open buyrug‘ini berish orqali 
liiini faylni ishga tushirish mumkin. Hammamizga ma’lumki, web 
•.nhilani yaratish vaqtida uning qanday dizaynda chiqayotganini ko‘rish 
iii him biz brauzer dasturlariga qayta -  qayta murojaat qilamiz. Ayrim 
(nolcssional dasturlarda (Dreamweaver va boshqalar) natijani ko‘rish 
м. him to'g‘ridan-to‘g‘ri maxsus tugma bosiladi. Bunda to‘g‘ridan- 
Iny ri belgilangan brauzerda sahifa yuklanadi. Bu haqida Dreamweaver 
ilnsiurida batafsil ma’lumot beramiz.

HTML hujjatning asosiy strukturasi

Siz varatgan ilk HTML sahifa asosida HTML hujjat asosiy 
imklurasini tahlil qilamiz. Kompyuter xotirasiga saqlangan HTML 

htij iatni Notepad dasturi yordamida oching. Har qanday HTML hujjat 
i< lik i qismi quyidagilardan tashkil topgan bo‘ladi:

<HTML>
bu teg HTML hujjatni ochish (boshlash) uchun xizmat qiladi va u

III ML hujjatning birinchi ochuvchi va oxirgi yopuvchi teg hisoblanadi. 
linshqacha aytganda web sahifaning boshlanish va tugash chegarasini 
lliulalaydi. Uning yagona vazifasi, mazkur hujjatni ochayotgan dasturga 
Imi I ay I HTML hujjatligi haqida axborot berishdan iborat.
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<HEAD>
HEAD tegidan so'ng HTML hujjatning tizimli axborotlari haqida 

ma’lumot beradi. Bizning misolimizdagi yagona tizimli axborot -  
TITLE tegi hisoblanadi.

<TITLE>
Bu teg ochuvchi teg <HEAD> va yopuvchi teg </HEAD> orasida 

yoziladi. Ochuvchi va yopuvchi TITLE orasida kiritilgan axborot siz 
yaratayotgan hujjat nomini anglatadi. Siz kiritgan nom brauzer dasturi 
tomonidan va internetdagi qidiruv tizimlari tomonidan ishlatiladi. Biz 
keltirilgan misolda «Eng sodda ko‘rinishdagi HTML sahifa!» matni 
brauzer dasturi yuqori qismida ya’ni sarlavha satrida namoyish etiladi.

<BODY>
BODY ochuvchi va yopuvchi teglari orasida yozilganlarning 

barchasi sizning HTML hujjatingizning tanasi hisoblanadi. Agar siz 
ushbu teg orasiga matn yozsangiz yoki tasvir kiritsangiz -  bularning 
barchasini brauzer ekranda namoyish etadi.

Har qanday HTML hujjat quyida keltirilgan tartibda yozilishi shart:
<HTML> HTML hujjat boshi <HEAD> Hujjat nomlanishining 

boshlanishi <TITLE> ... </TITLE> HTML sahifa nomi (sarlavhasi) 
<HEAD> Hujjat nomlanishining yakunlanishi <BODY BGCO- 
LOR=«white»> Hujjat tanasining boshlanishi ... </BODY> Hujjat 
tanasining yakunlanishi </HTML> HTML hujjat yakuni.

HTML sahifaga tasvir joylashtirish

Internet bilan ishlovchi dasturlar tasvirlarni (grafik elementlarni) 
ochish imkoniga ega bolishi bilan internetda mavjud sahifalarning 
deyarli barchasi tasvirli axborotlarni nashr eta boshladi. Siz yaratgan 
web-sahifa qiziqarli va chiroyli dizayn asosiga qurilgan bo'lsa uning 
o‘quvchilari soni shubhasiz ortadi. Tasvirlar yordamida harakatlanuvchi 
tugmalar va G if animatsiyalarni kiritish mumkin. Biroq tasvirlar bilan 
ishlashda ularni hajmi va formatiga e’tibor berish kerak. Hozirgi paytda 
internetga joylashtirilayotgan deyarli barcha sahifalarda ishlatilayotgan 
tasvirlar formati *.JPEG yoki *.GIF ni tashkil etadi. Bunga asosiy 
sabab, bu formatdagi tasvirlar hajmi juda kichik. Bu formatdagi 
tasvirlar ishlatilganda web-sahifa hajmi ortib ketmaydi va sizning web
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ahifangizdan foydalanuvchi sahifani internetda ochilishini uzoq vaqt 
kulmaydi.

Agar siz boshqa formatdagi tasvirlardan web-sahifani bezashda 
lovdalansangiz uning hajmi ortib ketadi va undan foydalanuvchilarga 

ihifani ochishda muammolar keltirib chiqaradi. Web-sahifani 
kvatishda uning dizayniga *.GIF formatdagi tasvirlardan foydalaning. 
Mnshqa maqsadlarda *.JPEG dan foydalanishingiz mumkin.

<img> tegini qo‘llash qoidalari

IMG> tegi bilan bogliq bo‘lgan, quyida keltirilgan asosiy qoidalar 
bilan tanishib chiqing va o‘z sahifangizni yaratishda ushbu qoidalarga 
iloim rioya qilishga harakat qiling.

• Tasvir nomi va joylashgan o‘rnini yozganda harflarning bir 
liilila bo‘lishini ta’minlash katta ahamiyatga ega. Tasvir joylashgan 
|>»pka nomi va tasvirning nomini kiritganda harflarni bir hilda yozilishi
hart. Biror bir harfni tushirib qoldirish yoki hato yozilishi tasvirni 

m liishda hatoliklarni keltirib chiqaradi.
• Tasvir yoki papka nomini kiritganda probel ishlatmang. Web- 

inhilani yaratayotganingizda fayllar yoki papkalar nomini kiritganda 
|n ubel (bo'sh joy) ishlatmang. Agar siz kiritgan nom ikki yoki undan

hk| so‘zlardan iborat bo‘lsa. probel o‘rnida (pastgi chiziqcha) 
c.lilatishingiz mumkin. Masalan: .../Chet_elga_sayohat/Ispaniya/Ma- 
lui'a Ol.jpeg

• Internetda ishlatiluvchi tasvir formatlari. Hozirgi paytda 
mi rnetda ikki hil formatdagi tasvirlar keng qo‘llanilib kelinmoqda. Bu 
loimatlar: GIF (bu formatdagi tasvirlar *.gif qisqartmasiga ega) hamda 
Il'I Xi (bu formatdagi tasvirlar esa *. jpg yoki *.jpeg qisqartmasiga ega). 
Si/ ham ushbu formatdagi tasvirlardan foydalaning. Boshqa formatdagi 
iHsvirlarni aksariyat brauzerlar ocha olmaydi.

• Har doim WIDTH va HEIGHT atributlarini kiritishga 
hurakat qiling. Bu sizning web-sahifangizni ochilishini tezlashtiradi 
mi tasvirlarni asl o‘lchamda bolishini ta’minlaydi.

• Tasvir hajmini sun’iy kichraytirish. WIDTH va HEIGHT orqali 
lif.virning real atribut o‘lchamlarini kichraytirish mumkin. Ammo 
bn usuldan iloji boricha kamroq foydalanish kerak. Eng yaxshi usul
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tasvirni real o‘lchamini grafik muharrirlar yordamida kichraytirishdir. 
Bu usul tasvirning ochilish vaqtini kamaytiradi.

• Tasvir hajmini sun’iy kattalashtirish. Tasvir o‘lchami kat- 
talashtirilganda yoki kichraytirilganda uning sifatida o'zgarish 
sodir bo‘ladi. Agar siz o’lchamiarni o‘zgartirganda bo‘yi va enini 
proportsionalligiga e’tibor bermasangiz, tasvir sifatini buzilishiga 
olib keladi. WIDTH va HEIGHT atributlari orqali tasvir hajmini 
kattalashtirganda, real o‘lchamni 2 marta, 3 marta va shu tariqa 
oshishiga erishish kerak. Masalan, tasvirning real o'lchami W IDTH = 
= «100», HEIGTH=«200» ga teng bo‘lsa. uni ikki marta kattalashtir­
ganda WIDTH=«200», HEIGTH = «400» ga teng bo‘lishi shart. Bu usul 
tasvir sifatidagi salbiy o‘zgarishlarni bir oz yumshatadi. Shuningdek, 
ayni holatni tasvir o‘lchamini kichraytirishda ham qo‘llash maqsadga 
muvofiq.

• Har doim ALT atributini qo‘llang.
Har doim ALTdan so‘ng tasvirga aloqador qo‘shimcha axborotni 

kiritishga harakat qiling. Buning asosiy sababi, siz joylashtirgan tasvir 
ochilmagan taqdirda, Internetdan foydalanuvchi siz kiritgan tasvir 
izohini o'qiydi va minimum axborotga ega bo‘ladi.

Giperhavolalar -  web-hujjatlarni bir-biriga bog‘lash

Web-sahifaga tasvir joylashtirishni o‘zlashtirib olganingizdan so‘ng, 
endigi navbatda havolalar haqida tushuncha olishning ayni mavrudi. 
Havolalar tufayli internet hozirgi mavqeiga erishdi. Havolalar yordamida 
ikki va undan ortiq (cheksiz) web-sahifalarni bir-biriga bog‘lashingiz 
mumkin. Havola rus tilida «ссылка» deb ataladi. Havolaga bosish 
orqali siz ikkinchi sahifani ochishingiz mumkin. Havolalar yordamida 
web-sahifangiz uchun menyu tuzishingiz mumkin. Havolalar sizning 
web-sahifangizdan foydalanuvchini sahifa bo‘ylab tom ma’noda sayohat 
qilishi imkonini beradi va unga to‘g'ri yo‘lni ko‘rsatib turadi.

Havolalar

Havola -  bu HTML hujjatning boshqa HTML hujjat bilan bog'lovclii 
qismi. Unga kursorni bosishingiz bilan ikkinchi HTML hujjat ekranda 
namoyon bo‘ladi. Shuningdek, havoladan (agar siz yaratgan bir sahifada
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iiula ham ko'p matn kiritilgan bo‘lsa) bitta sahifa ichida boshqa HTML 
lull jatni ochmasdan turib ham foydalanish mumkin. Sizga maslahatimiz, 
n .u bitta sahifaga joylashtirmoqchi bo‘lgan matn juda ham ko‘p bo‘lsa, 
uni iloji boricha turli bo‘laklarga bo‘lgan holda, bir nechta HTML 
liivlga joylashtiring. Shundav qilsangiz, web-sahifadan foydalanish oson 
Kcchadi.

Navbatdagi sahifalar bilan tanishib chiqqach siz havolalarni ishlatish 
iiMillarini va havola tuzish uchun qanday HTML teglardan foydalanish 
/atnrligini bilib olasiz.

Havolalar tuzish usullari

I lavolalarni ta’sir doirasi va ularni qaysi sahifa bilan bog‘lash 
\ a/ifasini <A> ochuvchi hamda </A> yopuvchi teglari orasida bel­
l i  lanadi. Ushbu teglar orasida uning atributlari va kalit so‘z 
|os lashtiriladi.

lishbu teg orasida nimalarni joylashtirish mumkin? Deyarli 
liamina narsani. Bu matn, tasvir, jadval va hatto harakatlanuvchi 
lasvir ham bolish i mumkin. LHardan qaysi birini joylashtirish 
o’/ingizga havola.

Bu bo‘limda oldimizga qo‘ygan maqsadimiz havolalar tuzish. 
Maqsadga erishishning eng oson usuli barchasini oddiy misollardan 
bosh lash. Shunga amal qilgan holda sizga havola tuzishning eng oddiy 
misolini keltiramiz:

<A HREF = «pictures.htmI”>Bu sahifada mening hayotim bilan 
luigliq tasvirlar joylashgan.</A>

Natija mana bunday ko‘rinishda bo‘ladi:
tin sahifada m enins hayotim bilan bos‘lia tasvirlar iovlashean.

so /ini bosishingiz bilan pictures.htm l sahifasi ekranda namoyon 
lurladi. <A> tegining qo'shimcha atribut bo‘lgan HREF sizni pictures, 
html sahifasiga olib boradi.

Tasvirlarni havola sifatida namoyon etish uchun <A> va </A> teglari 
orasida <IMG> tegi yordamida tasvirda qaysi faylni nimani qo‘yish va 
и joylashgan papkaga yo‘lni ko‘rsating.

<A HREF = «pictures.HTML»> <1MG SRC = «img/photo.jpg» 
\\ IDTH = «100» HEIGHT = «100» ALT=«Mening foto galereyam»> 
</A>



Havolalar — <A> tegining qo‘shimcha atributlari tasnifi

Boshqa HTML teglari kabi <A> tegining ham qo‘shimcha atributi 
mavjud. Quyida ushbu buyruqlarning tasnifi keltirilgan.

HREF

Bu atribut yordamida havola qilinishi lozim bo'lgan HTML hujjat 
nomi va uning joylashgan joyi belgilanadi. Bu atribut <IMG> tegining 
SRC atributi kabi bir hil vazifani bajaradi. <IMG> tegining SRC 
atributi yordamida tasvir nomi va u joylashgan papkaga yo‘l ko‘rsatilsa, 
HREF yordamida HTML hujjat nomi va u joylashgan papkaga yo‘l 
tasvirlanadi.

TARGET

Bu atribut HTML hujjatni aynan o'sha oynada yoki alohida oynada 
yoki qaysi freymda ochilishini belgilaydi. TARGET atributining 
qo‘shimcha o‘lchamlari: Jblank -  brauzerda siz ishlab turgan oynadan 
tashqari yangi oynada ko‘rsatilgan hujjatni ochish.

_top -  web sahifada freymlar ishlatilgan bolsa, havolada 
koTsatilgan hujjatni faol oynada freymlar strukturasini buzgan holda 
ochadi. Ochilgan oynada freym alomatlari mavjud bo‘lmaydi.

_parent -  havolada ko‘rsatilgan hujjatni avval ochilgan oynada 
ochiladi.

_self -  havola qaysi freym yoki freymdan holi sahifada ishlatilgan 
bo’lsa aynan o‘sha sahifada ochadi.

<A HREF = «pictures.html» TARGET=«_blank»>Bu sahifada</A> 
mening hayotim bilan bog‘liq tasvirlar joylashgan. <BR> Bu sahifada 
siz <A HREF = «about.html» TARGET = «_top»> men haqimda </A> 
qiziqarli ma’lumotlarni o‘qishingiz mumkin.

Natija mana bunday ko'rinishda boMadi:
Bu sahifada mening hayotim bilan bog'liq tasvirlar joylashgan. 

Sahifada siz men haqimda qiziqarli ma’lumotlarni o4qishingiz mumkin. 
Ushbu havolalardan biriga bosib, siz havolada belgilangan HTML 
hujjatdagi ma’lumotlarni o‘qishingiz mumkin.
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E-MAIL havola

1 v-mail (Elektron pochta) manzillarni faollashtirish uchun havola 
m/ish mumkin. E-mail manzil ko‘rsatilgan havolani bosish bilan 
kompyuterga o‘rnatilgan elektron pochtalar bilan ishlovchi dastur 
laollashadi va unda havolada ko'rsatilgan elektron pochta manzili 
l 1' rsatilgan yangi oyna hosil boladi va siz ko‘rsatilgan manzilga xat 
и ■' ilatishingiz mumkin.

I -mail manzilni havola sifatida belgilash uchun HREF atributi 
" rnida mailto: elektron pochta manzili yoziladi. Misol uchun:

Mening <A HREF = «mailto: tsamar@mail.ru»> elektron poch- 
|,||цца</А> ushbu o'quv qo‘llanma haqidagi fikr -  mulohazalaringizni 
vo/ing!

Natija mana bunday ko'rinishda bo'ladi:
Mening elektron poshtamga ushbu o‘quv qo'llanma haqidagi fikr- 

niiilohazalaringizni yozing!

Havolalar yozishning asosiy qoidalari

Quyida havola tuzishda bilishingiz lozim bo‘lgan oddiy qoidalar 
\n/ilgan. Ularni diqqat bilan o‘qib chiqing va eslab qolishga harakat 
i|iling. Havola tuzishda bu qoidalarga amal qilsangiz, siz tuzgan 
hiivolalar hatoliklarsiz ishlaydi.

• Harflarning bir hilda yozish va fayl yoki papka nomini to‘g‘ri 
Ko'rsating. Havola tuzilganda eng katta e’tiborni siz murojaat qilmoqchi 
Inrlgan faylga olib boruvchi yo‘l aniq va to‘g'ri ko‘rsatilishi lozim. 
Hunda papka va fayl nomiga katta e’tibor qarating. Ularning nomida 
iir/imagan hatolikka yo‘l qo‘ysangiz havola ishlamaydi. Aytaylik biror 
I'll harfni tushib qolishi yoki bosh harf o‘rniga kichik harf bilan yozilsa 
Imlolik yuz berishi muqarrar. Shu bois, havola tuzishda aniqlik katta 
iilminiyatga ega.

• Fayl va papka nomini kiritganda probel ishlatmang. Web- 
Mihifa yaratish jarayonida fayl va papkalarni nomi ikki va undan ortiq
и /clan iborat bo‘lsa so'zlar orasida va oxirida probel ishlatmang. 

I'rnbel ishlatilgan fayl yoki papkaga havola murojat qilganda hatolik 
■odir bo‘ladi.

• Kalit so‘zlarga havola tuzish. Biror hujjat ichidagi kalit so‘zga 
luivola tuzganda, eng avvalo kalit so‘zni <A> tegining NAME buyrug‘i
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yordamida belgilab olish lozim. So‘ngra shu tegning HREF atributi 
orqali u joylashgan fayl nomi (agar kalit so'z boshqa faylda joylashgan 
bo‘lsa) va kalit so‘z manzilini ko‘rsating HREF = «fayl nomi.HTML# 
kalit so‘z».

• FTP server va E-M A IL uchun maxsus havola. FTP serverda
joylashgan faylga havola tuzganda FTP://’ bilan boshlanuvchi manzilni 
yozing. E-MAIL havola tuzganda esa «mailto: e-mail manzil»ni 
yozing.

Matnlarni tahrirlash

Matn tahrirlashni o‘zlashtirib olishingizni osonlashtirish uchun 
uni ikkiga bo‘lib tushuntirishni lozim topdik. Ularning har biri matn 
tahrirlashda ishlatiladigan HTML teglarni batafsil tahlili misollar 
yordamida aks ettirilgan.

• Matnning alohida bo'laklarini tahrirlovchi teglar;
• Matnning yirik bo‘laklarini tahrirlovchi teglar.

Matnning alohida bo‘laklarini tahrirlovchi teglar

Quyida tasnifi keltirilgan barcha matn tahrirlash uchun ishlatiluvchi 
teglar ochilgandan so'ng ularni yopish shart. Ochilgan tegning ta’sil' 
doirasi u yopilgunga qadar davom etadi. Agar siz tegni yopishnl 
unutsangiz, uning ta’sir doirasi hujjat oxirigacha davom etadi. Barcha 
teglash quyidagi tartibda yoziladi: <TEG1><TEG2> Kerakli matn </ 
TEG2></TEG1>. Har doim eng oxiri ochilgan tegni birinchi bo‘lib 
yopishni unutmang.

<B> Kerakli matn </B>
Bu teg orasida yozilgan matn qalin harflar bilan belgilanadi.
<1 >Kerakli matn</l>
Matn o‘ng tomonga egiltirib yoziladi.
<BIG>Kerakli matn</BIG>
Matnni kattalashtirish. Yozilgan matn boshqalariga nisbatan 

kattalashtirilgan harflar bilan belgilanadi.
<SMALL>Kerakli matn</SMALL>
Matnni kichraytirish. Yozilgan matn boshqalariga nisbatan ki- 

chiklashtirilgan holda belgilanadi.
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kg  orasida yozilgan main ustidan chiziq tortiladi.
S'I RO NO K erakli matn</STRONG>

Main ichidagi ayrim so‘zlarni kuchli ajratib ko'rsatish uchun 
Ithliitiladi.

Kerakli <SUB> </SUB>
m a tn

Ko'rinib turganidek bu teg orasida kiritilgan matn, matn chizig‘idan 
|in ula kichik harflar bilan yoziladi (indeks).

Kerakli <SUP> ‘ </SUP>
Yuqorida keltirilgan tegning teskari shakldagisi bo‘lib, u matnni 

\ iit|orida kichik harflar bilan yozilishini ta’minlaydi (daraja).
• U>Kerakli matn</U>
Yozilgan matn ostida chiziq tortiladi. Bu teg yordamida ayrim 

и ,'larni belgilab ko‘rsatish mumkin.
• CENTER>Kerakli matn</CENTER>
Hu teg kiritilgan matnni sahifa o‘rtasida bo‘lishini ta'minlaydi. Agar 

Imi leg jadval ichida qo‘llansa, u holda bu jadval katakchasi ichidagi 
malnga ta'sir etadi. Bu tegni jadval ichida qollash usullari haqida 
i:111vallar bilan ishlash bo‘limida tushuntirib o‘tamiz.

<BR>
Mu teg matn qatorlarini surish uchun xizmat qiladi. Ma’lum 

imnladan so‘ng ikkinchi jumlani yangi qatordan boshlamoqchi 
i"' Isangiz, jumla so‘ngida ushbu tegni yozing.

I ndi hech bolmaganda bitta qo'shimcha buyruqqa ega bo‘lgan 
leglar bilan tanishib chiqamiz.

<FONT>Kerakli matn</FONT>
Bu teg harfning qo‘shimcha atributlarini belgilash uchun ishlatiladi. 

«>uy ida ushbu tegning eng ko‘p qo‘llaniladigan qo‘shimcha atributlari 
hilau tanishib chiqamiz:

SIZE

Harf o'lchamini belgilashda qo‘llaniladi. Matndagi harflar o'lchamini 
I dan boshlab xohlagan son bilan belgilash mumkin.

Masalan: <FONT SIZE = «5»>Salom!</FONT> Bu mening web 
..iliifam. <FONT SIZE = «2»>(Izoh)</FONT>
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Bundan tashqari siz SIZE o‘lchamlarini plyus + va minus - bilan 
ham belgilashingiz mumkin. Bu usul qo‘llanganda harf o‘lchanii 
ishlatilayotgan harfga nisbatan katta yoki kichik belgilanadi. Misol 
uchun siz 3 ga teng kattalikdagi harfdan foydalanayotgan bo‘lsangiA | 
SIZE = «+2» harf olchami SIZE=«5» ga. SIZE = « -1 »  o‘lchami esil j 
SIZE=«2» ga teng bo‘ladi.

COLOR

Bu atributdan so‘ng rang nomi yoki rangni belgilovchi olti xonall 
lotin harflari hamda raqamli kod kiritiladi va shu tariqa harf rang! 
belgilanadi. Turli brauzerlar turli rang nomlarini belgilay oladi. Rann 
nomlari ingliz tilida kiritiladi. Rang nomi va ko‘rinishini yodlah 
olishingiz uchun ularning har birini nomi o‘sha rangda belgilangan, 
Bu ranglarni Netscape Navigator va Internet Explorer brauzerlarl 
muammosiz taniydi va o‘qiy oladi.

Rangni belgilovchi lotin alifbosi va raqamli kod simvol bilan 
boshlanadi. Raqamlardan 1 dan 9 gacha yoki A dan E gacha bo‘lgan 
lotin harflarini ishlatish mumkin. Rang kodi qanday bo’lishidan qat’iy 
nazar u RGB (RED -  qizil, GREEN -  yashil, BLUE -  ko'k) ranglsn 
tizimida aks ettiriladi. Rangni belgilash uchun uchta rangni bir- 
biriga qo‘shish lozim. Har bir rang ulushini 0 dan 255 gacha bo'lgiin 
miqdorda belgilanadi. Misol uchun toza qizil rangni belgilash! 
uchun qizil rang miqdorini 255 ga, yashil va ko‘k ranglar miqdorini 
esa 0 ga tenglashtirish lozim va bu mana bunday yoziladi <FONTl 
COLOR=#FFOOOO>. Olti xonali alifboli -  raqamli kodini qo‘llash juda 
ham qiyin. Shu bois ranglar kodini belgilab beruvchi jadvalimizdan 
foydalanishingiz mumkin.

FACE

Matnni qanday shriftda yozilishini belgilash uchun shrift nomi 
keltiriladi. SHrift nomi kompyuterda o‘rnatilgan bo'lishi kerak yoki 
umumiy ishlatiladigan shriftlardan foydalanish mumkin. Agar siz 
qo‘llagan shrift foydalanuvchining kompyuterida topilmagan taqdirda 
brauzer standart shriftni tanlaydi.

Masalan:
<FONT FACE = «Ariab»Salom!</FONT>
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I < )NT FACE= «Times New Roman, Arial, Courier New»>Bu 
ни mug web sahifam.</FONT>

'■I/ har doim <FONT> tegining FACE atributini tanlaganingizda, 
i mhIiiiI shrift turlaridan foydalaning. Misol uchun Windows muhitida 

jllilnvchi barcha kompyuterda o‘rnatiladigan standart shriftlar quyida- 
glliiiilun iborat:

Windows: Arial Arial Black, Arial Narrow, Courier, Courier New, 
Itiinuiiond, Helvetica Times, Times New Roman.

Aytaylik siz Times va Times New Roman shriftining boshqacha 
Iih ни tanlagan bo‘lsangiz, u holda foydalanuvchi kompyuterida bu 
•III ill o'rnatilmagan bolsa, brauzer siz tanlagan shriftni standart Times 
N> " Roman shriftiga almashtiradi.

Matnning yirik bo‘laklarini tahrirlovchi teglar

I ndi siz bilan matndagi yirik bloklar va abzatslarni tahrirlovchi 
tei'I'U va ularning qo'shimcha buyruqlarining ishlash tartibini o‘rganib 
ihiipim iz.

I’LAINTEXT>
I shbu tegdan so‘ng kiritilgan barcha HTML teglarning ta'sirini 

'■Hiunlay kesadi va ular huddi ekranda ko‘rsatilishi lozim boigan 
liniln kabi aks etadi. Bu teg boshqa teglardan tubdan farq qiladi va 
inn \opish shart emas. Agar matnda ayrim HTML teglarni ekranda 
i" ni/cr aks ettirishini xohlasangiz bu tegdan foydalanishingiz mumkin. 
Mn>h| yuqorida aytganimizdek bu tegdan so'ng matnni HTML teglar 
\ i >i darnida tahrirlash mumkin emas. Chunki ularni brauzer huddi 
Hi И is matn kabi tushunadi. Agar siz </PLAINTEXT> tegini kiritgan 
i i.|'lit ingizda ham bu <PLAINTEXT> ta’sir doirasini cheklay olmaydi. 
\M> sahifangizda HTML teglarni matn shaklida aks ettirmoqchi 
bn'Kangiz, u holda uch burchakli qo'shtirnoq ‘<’ o'rnida &LT; simvolini 
t|<* llang.

<ADDRESS>
Kerakli matn
• /ADDRESS>
leg o‘z nomi bilan adres ya’ni manzillarni belgilash uchun 

Hhlatiladi. Bu teglar orasida yozilgan manzilni har qaysi brauzer o'zi
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xohlagan tarzda namoyish etadi. Teg yopilganidan so'ng kiritilgan matn 
yangi satrdan boshlanadi.

<BLOCKQUOTE>
Kerakli matn 
</BLOCKQUOTE>
Bu teg matndagi paragraf va satrlarni belgilash uchun qollanadi. 
<H1>, <H2>, <H3>, <H4>. <H5> va <H6>
yuqoridagi oltita teg sarlavhalarni belgilash uchun qo'llaniladi. 

Sarlavhalar qalin harflarda yoziladi. Bu teglarning bir-biridan farqi 
ularning o‘lchamlarida. 1 dan 6 gacha bo'lgan sonlar sarlavha 
o‘lchamlarini katta-kichikligini quyida keltirilgan tartibda belgilaydi: 

Sarlavha HI 
Sarlavha H2

Sarlavha H6 
<P>
Kerakli matn 
</P>
Bu teg paragraflarni belgilaydi. Paragraf boshi va ohirida bo‘sh 

qator qoldiradi.

ALIGN

<P> tegining qo'shimcha atributi boiib u papagraf ichida yozilgan 
matnni tekislash uchun ishlatiladi. Bu atributning qo‘shimcha 
olchamlari ALIGN -  LEFT (matnni chap burchakdan tekislaydi), 
RIGFIT (o‘ng tomonga tekislaydi), CENTER (sahifa markaziga 
tekislaydi) va JUSTIFY (matnni sahifa eni bo'ylab tekislaydi). JUSTIFY 
ishlatilganda brauzer matnni chap va o‘ng tomon bo‘ylab bir xilda 
tekislab chiqishga harakat qiladi. Bu jarayonda so'zlar orasi cho'zilib 
ketishi ham mumkin.

<PRE>
Kerakli matn 
</PRE>
Bu teg yordamida siz matnni qanday kiritgan bolsangiz shunday 

ko‘rinishda bo‘lishi ta’minlanadi. Quyida keltirilgan ikki misolda buni 
yaqqol kovrish mumkin. <PRE> tegidan tashqarida yozilgan matnda
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probel necha marta ishlatilishidan qat’iy nazar u bittaga hisoblanadi.
I‘RE> tegi tarkibida kiritilgan matn qanday bo‘lsa shundayligicha 

fkranda ko‘rinadi.

Hujjat asosiy qismini tahrirlash

Bu bo‘limda hujjat tanasini belgilab beruvchi <BODY> tegi va 
uning qo‘shimcha buyruqlari haqida so‘z boradi. <BODY> tegini 
ulilingi bo‘limlarda qisqacha tanishtirib o‘tgan edik. Bu teg bevosita 
HTML hujjatni ekranda ko‘rinishi lozim boigan matn, tasvir va boshqa 
dcmentlarni o‘z ichiga qamrab oladi. <BODY> ochuvchi hamda </
I I I  >I)Y> yopuvchi teglari orasida barcha muhim elementlar joylashadi. 
Hu tegning qanday qo‘shimcha buyruqlarini quyida birgalikda ko‘rib 
i hiqamiz.

BGCOLOR

Sahifaning orqa foni rangini belgilash uchun ishlatiladi. Bunda 
uingning ingliz tilidagi nomi yoki harf va sonlardan iborat kod 
4<)' I laniladi.

BACKGROUND

Sahifaning orqa foni uchun qo‘llaniluvchi tasvir nomi va u 
|и\ lashgan papkaga yo‘lni ko‘rsatishda qo‘llaniladi. Tasvir joylashgan 
papkaga yo‘lni ko‘rsatish haqidagi ma’lumotlarni «HTML safifaga tasvir 
loy lashtirish» bo‘limida o‘qishingiz mumkin.

TEXT

Hujjatda yozilgan matn harflarini qanday rangda bo'lishini rang 
kodlarini kiritish orqali belgilab beradi. Agar siz ushbu atribut 
r.hlatmagan taqdiringizda matn rangi qora rangda bo’ladi.

LINK

Bu atribut qo’llanilgan sahifadagi havola rangi teg o’lchamlarida 
iiaysi rang kodi yoki nomi berilgan boisa, o‘sha rangda ekranda 
namoyon bo‘ladi.
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VLINK

Bu atribut yordamida ishlatilgan havolalarni belgilab ko‘rsatish 
uchun qo‘llaniladi. Siz foydalanuvchilar adashib ketmasligi va havolada 
ko‘rsatilgan sahifaga qayta kirmasligi hamda hali qo'llanilmagan 
havolalarni qoilanilgan havolalardan ajratib ko‘rsatish uchun ish- 
latishingiz mumkin.

ALINK
Bu atribut kursor yordamida tanlangan va sichqoncha chap tugmasi 

bosilgan paytda havola rangini o‘zgartirish uchun ishlatiladi.
Siz hozir o‘qigan sahifada <BODY> tegining barcha qo'shimcha 

atributlari quyidagi tartibda qo‘llaniladi.
<BODY BGCOLOR=#003399 TEXT = black LIN К = blue ALINK= 

=red VL1NK=#006666>

Ro‘yxatlar tuzish

Sahifada matndagi ayrim elementlarni ro‘yxatlangan tartibda yozish 
qiyin emas va bundan tashqari o'quvchi matn bilan tanishib chiqishida 
qulayliklar yaratib beradi. Siz huddi Microsoft Word matn muharririda 
ro‘yxatlarni qanday tuzsangiz huddi shu ko’rinishda HTML hujjatda 
ham maxsus teglar yordamida belgilash imkoniga egasiz.

Bu bo‘limda ro‘yxatlangan tartibda matnni kiritish usullari bilan 
tanishib chiqamiz:

<RO YXATNI OCHUVCHI TEG>
< Ro‘yxat elementining tegi > Matn
</ RO'YXATNl YOPUVCHI TEG >
Tartiblangan ro‘vxat: Tartiblanmagan ro‘yxat:
1. Ro'yxat elementi 1 • Ro‘уxat elementi 1
2. Ro‘yxat elementi 2 • Ro'yxat elementi 2
3. Ro‘yxat elementi 3 • Ro'yxat elementi 3
Matn ro‘yxatini belgilovchi teglar tarkibida siz HTMLning boshqa 

matn tahrirlash uchun qo‘llaniluvchi teglarini ishlatishingiz mumkin.

Ro‘yxatlar tuzish -  ro‘yxatni tartiblash

Matn bo‘laklarini tartiblashda sonlar yoki harflar bilan belgilash 
mumkin. Shuningdek ayni jarayonda simvollardan ham foydalanish 
imkoni mavjud.
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Matn bo'laklarini tartiblashda <OL> ochuvchi va </OL> yopuvchi 
ь I’laridan foydalaniladi. Ushbu teglar ichida tartiblanuvchi matn oldiga 

I l> atributi yoziladi. <OL> tegining yagona qo‘shimcha o‘lchami 
I VPE bo'lib, u tartiblovchi belgi ko‘rinishini aniqlab beradi.

Arab raqamlari bilan belgilash:

HTML kodi 
<OL TYPE= 1> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</OL>

Natija

3.

Matn 1 
Matn 2 
Matn 3

Rim raqamlari bilan belgilash:

HTML kodi 
<OL TYPE=I> 
<Ll> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</OL>

Natija 
I. Matn 1 

П; Matn 2 
III Matn 3

Rim harflari bilan belgilash:

HTML kodi 
<OL TYPE = i> 
<Ll> Matn 1 
<Ll> Matn 2 
<LI> Matn 3 
</OL>

Natija
i. Matn 1

ii. Matn 2
iii. Matn 3

Bosh harfalari bilan belgilash:

HTML kodi 
<OL TYPE=A> 
<Ll> Matn 1 
<LI> Matn 2 
<L1> Matn 3 
</OL>

Natija
A. Matn 1
B. Matn 2
C. Matn 3
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K ic h ik  h a rf la r  b ila n  b e lg ila sh :

HTML kodi 
<OL TYPE = a> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</0L>

Natija
a. Matn 1
b. Matn 2
c. Matn 3

Ro‘yxat tuzish -  tartiblanmagan ro‘yxat

Tartiblanmagan ro‘yxat tuzishda <UL> va </UL> yopuvchi 
teglaridan foydalaniladi. Ro‘yxat ichidagi tartib <LI> atributi bilan 
belgilanadi. <UL> tegi uchun ham TYPE o‘lchami ishlatiladi. TYPlJj 
o'lchami 3 xil turdagi ro‘yxat kirita oladi:

Doirasimon belgi yordamida tartiblash:

NatijaHTML kodi 
<UL TYPE = circle> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</UL>

Matn 1 
Matn 2 
Matn 3

HTML kodi 
<UL TYPE = disc> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</UL>

Nuqtasimon belgi yordamida tartiblash:

Natija
Matn 1 
Matn 2 
Matn 3

To‘g‘ri to'rtburchaksimon belgi yordamida tartiblash:
HTML kodi 

<UL TYPE = square> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</UL>

Matn 
Matn 2 
Matn 3

Natija



Ro‘yxat tuzish -  aniqlashtiruvchi ro‘yxatlar

\niqlashtiruvchi ro'yxat va uning izohidan iborat matnni tartibli 
In i li uchun bir-necha teglar ishlatiladi.

Aniqlashtiruvchi ro'yxatni <DL> ochuvchi va </DL> yopuvchi tegi 
Ifnuhimida amalga oshiriladi. Aniqlashtiruvchi ro‘yxat nomi <DT> 
i 1'iilan so‘ng yoziladi va uni izohlovchi matn esa <DD> tegidan so'ng 
kli itiladi. <DL> tegi qo'shimcha oichamlarga ega emas.

Aniqlashtiruvchi ro‘yxat:
<DL>

l)T> Aniqlashtiruvchi asosiy so'z yoki jumla
■ I )D> Izoh beruvchi matn
• / D L >

Jadval tuzish

hidval tuzish -  HTML bo‘yicha o‘zlashtirish qiyin bo'lgan bo'lim- 
Im I.in biri. Shu bois bu bo‘limni jadval tuzishni eng sodda usullaridan 
Itir.hlaymiz. Web-sahifani mukammal darajada yaratishni xohlasangiz, 
iinl.i jadval tuzishni chuqur o'rganib olishingiz kerak. Qisqa qilib 
■ 1 i -inda jadvallar yordamida sahifani o'zingiz xohlagan tarzda 
Itf.liqara olishingiz mumkin. Jadval ichiga nafaqat matn. balki tasvir va 
hi'.hqa elementlarni tartibli joylashtirish mumkin.

Jadval tuzish -  umumiy qoidalar

ludval tuzishda ishlatiladigan teglarni tasniflashdan avval, oddiy 
!' il tuzish sxemasi bilan tanishib chiqsak. Har qanday jadval 

>|h\ nl;igi sxema bo'yicha tuziladi:
JADVALNI OCHUVCHI TEG>

• JADVAL QATORIN1 OCHUVCHI TEG>
JADVAL BO'LAGINI OCHUVCHI TEG>

Matn, tasvir yoki jadval 
'/JADVAL BO'LAGIXI YOPUVCHI TEG>

JADVAL QATORINI YOPUVCHI TEG>
■ /JADVALNI YOPUVCHI TEG> S
I lar qanday jadvalda qatorlar va ustunlar mavjud bo‘ladi. Jadvalning

h" lakchalarida esa axborot kiritilishi mumkin. Yuqorida keltirilgan



misoldan ko‘rinib turibdiki, bitta ustun, bitta qator va bitta katakchadan 
iborat jadvalni tuzish uchun jadval ochiladi va yopiladi. Bitta ustundan 
iborat va bir nechta qatorni o‘z ichiga olgan jadvalni tuzish uchun. 
jadval qatorini ochuvchi va yopuvchi teglar orasiga bir nechta jadval 
katakchalarini ochuvchi va yopuvchi teglarini kiritish lozim.

Oddiy jadvallar tuzish

Jadval tuzish usullarini tushunib olish uchun dastavval eng oddiy 
jadvalni tuzishni o‘rganamiz. Biz tuzmoqchi boigan jadval uchta 
ustundan iborat bo'ladi va har bir ustunda 3 dona katakchalar o’rin 
oladi. Jadvalning birinchi ustunini «Mahsulot», ikkinchisini esa -  
«Rangi», uchinchisini «Narhi» deb nomlaymiz. Biz tuzgan jadval mana 
bunday ko'rinishda boladi:

1.3-jadval

Mahsulot Rangi Narhi (so‘m)
Qalam Qora 100

Qalam ochgich Qora 500

Endi ushbu jadvalni tuzishda qanday HTML teglardan foyda- 
lanilganligini ko‘rib chiqamiz:

<TABLE>
<TR>
<TD>Mahsulot</TD>
<TD>Rang i</TD>
<TD>Narhi(co‘m.)</TD>
</TR>
<TR>
<TD>Qalam</TD>
<TD>Qora</TD>
<TD>100</TD>
</TR>
<TR>
<TD>Qalam ochgichi</TD>
<TD>Qora</TD>
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<TD>500</TD>
</TR>
</TABLE>
Jadvalni ochuvchi teg
I -  qatorni ochuvchi teg
1 -  Jadval bolagini ochuvchi va yopuvchi teg
2 -  Jadval bo‘lagini ochuvchi va yopuvchi teg
3 -  Jadval bolagini ochuvchi va yopuvchi teg
1 -  qatorni yopuvchi teg
Jadvalni yopuvchi teg
Misolda ko'rinib turibdiki, jadvalni <TABLE> va </TABLE> teg- 

l.ui yordamida ochiladi va yopiladi. Qatorlar uchun <TR> va </TR> 
Kflari qoMlaniladi, <TD> va </TD> teglari esa jadval ustunlarini 
(kiitakchalarini) belgilash uchun ishlatiladi.

Jadval chizish -  HTML teg o‘lchamlari

Murakkab jadvallar tuzishni boshlashdan avval <TABLE>, <TR> 
\;i <TD> teglariga qisqacha tasnif berib o‘tamiz. Mazkur uchta teg 
bilan qo‘llaniladigan bir xildagi o‘lchamlar mavjud bo'lib, faqatgina 
illuming farqli tomoni, ularning ta’sir doiralarining chegaralanishidadir.

BGCOLOR

Atribut yordamida jadvalning orqa fonida qanday rang qoilanilishi
belgilanadi.

BACKGROUND

Jadvaldagi bolakcha foni sifatida berilayotgan tasvirni joylashgan 
joy va uning nomini belgilash uchun ishlatiladi. Agar siz bu atributni 

IABLE> tegidan so‘ng qollasangiz, u holda siz tanlagan tasvir 
i.idvaldagi har bir kataklar foni sifatida qo‘llaniladi. <TR> tegidan so'ng 
i|o‘llani1ganda, mazkur qatorda joylashgan hamma katakchalar uchun, 

I D> tegidan so'ng qollanilganda esa aniq biror katakchagacha fon 
o'rnatiladi.

WIDTH

Jadval eni (kengligi)ning o‘lchami (umumiy jadval uchun xos). 
Mu 0‘lcham bilan jadvaldagi ma’luni bir ustuncha yoki bo‘lakning
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kengligini piksel yohud foiz o‘lchamida belgilash mumkin. Bu 
o‘lcham <TABLE> yoki <TR> tegi bilan qollanilgan taqdirda ham 
bir xil ko'rinishdagi, ya'ni siz bergan olchamlarni hisobga olgan 
holda jadval enining kengligini belgilaydi. Shuni doim yodda tutish 
lozimki, siz bu olchamdan foydalangan holda jadval enining kengligini 
belgilaganingizda bir xildagi oichov turidan foydalanishingiz maqsadga 
muvofiq. Agar siz jadval kengligini piksellarda belgilasangiz (misol 
uchun WIDTH=«100»), boshqa o‘lchovlar ham pikselda belgilanishi 
lozim. Agar jadval kengligi foizlar hisobida berilsa (misol uchun 
WIDTH = «50%»), boshqa o‘lchovlar ham foiz hisobida berilishi lozim. 
Ayni hollarda brauzer siz yaratgan jadvalni ekranning teng yarmi, ya’ni 
50% ga joylashtiradi.

HEIGHT

Jadvalning, qator yoki katakchalarning balandligi o'lchovlarini 
piksellar yoki foiz hisobida belgilash uchun qoilaniladi.

BORDER

jadval ustuni va qatorlari kesishmalarini belgilovchi chiziqlarni 
qalinligini piksellar hisobida belgilash uchun qollaniladi. Agar jadval 
chiziqlarini nolga teng qilib belgilansa BORDER (BORDER=0) chiziq 
(border) brauzerda ko‘rinmaydigan boiib qoladi.

ALIGN

Jadvalning ekranga nisbatan joylashish o in in i belgilaydi. Agar 
jadval ichida qo‘shimcha jadval tuzilgan boisa, u holda ichki jadvalga 
bu atribut kiritilganda, ichki jadval joylashishi o’rni tashqi jadvalga 
nisbatan belgilanadi. ALIGNning quyidagi qo‘shimcha oichamlari 
mavjud: ALIGN -  center (Jadvalni markaz bo‘ylab joylashtirish), left 
(chap burchak bo‘ylab joylashtirish) va right (o‘ng burchak bo'ylab 
joylashtirish).

CELLPADDING

Katakcha enining kengligini piksellar yordamida kengaytirish yoki 
toraytirish.
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CELLSPACING

Jadvaldagi katakchalar chegara enining piksellar yordamida ken- 
г.ivtirishi yoki toraytirishi.

Misol:
<TABLE BORDER=0 W IDTH= 100% CELLSPACING=5 
CELLPADD1NG = 5 BGCOLOR=blue>
<TR BGCOLOR=yellow>
<TD>Mahsulot</TD>
<TD>Narhi</TD>
</TR>
<TR BGCOLOR=white>
<TD>Qalam</TD>
<TD>100 so‘m</TD>
</TR>
</TABLE>

ALIGN

Jadvaldagi har bir katakchaning ichidagi elementlarni gorizontal 
I.u/da tartiblash uchun qo‘llaniladi. Uning mavjud o'lchamlari quyida- 
I'ilardan iborat: -  left (chap tomonga tekislash), right (o‘ng tomonga 
Irkislash) va center (markaz bo‘ylab tekislash).

VALIGN

Jadvaldagi har bir katakchaning ichidagi elementlarni vertikal tarzda 
lulliblash uchun qollaniladi. Uning mavjud o'lchamlari quyidagilardan 
iliorat: -  top (katakning yuqori qismiga nisbatan), middle (yuqori va 
i|iiyi qismiga nisbatan markazga tekislash).

Jadval tuzish qoidalari

I Hi sahifada jadval tuzish jarayonida siz amal qilishingiz lozim 
bo’lgan eng asosiy qoida va maslahatlar keltirilgan.

• <TABLE>, <TR> va <TD> teglarini tartibiga rioya qiling 
I lar doim jadval tuzish sxemasini buzmaslikka harakat qiling. Avval 

ovtib o'tilgandek eng avvalo jadvalni oching so'ngra jadval qatorlari va 
u s tunlarini tuzing va eng oxirida jadvalni yoping. Ushbu tartib buzilgan 
liiqdirda turli hatoliklar kelib chiqishi mumkin.
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• <TABLE> tegini jadval so‘ngida yoping
Agar <TABLE> tegini yopmasangiz kutilmagan hatoiiklar vujudga 

keladi. Masalan, Netscape Navigator siz tuzgan jadvalni ekranda 
umuman ko‘rsatmaydi.

• Ustunda joylashgan qatorlar soni
Har bir qatorda kataklarning soni bir xilda boiishiga e'tibor bering. 

Bu tartibga, agar siz ayrim kataklarga hech qanday axborot kiritmagan 
taqdiringizda ham ularni yaratish lozim. Bunday holatlarda bo'sh 
katakchalarni mana bunday ko‘rinishda yozish lozim: <TD>&nbsp;</TD>, 
'&nbsp;' simvoli brauzerga mazkur katakda hech qanday axborot mavjud 
emasligi haqida xabar beradi. Agar ushbu simvol yozilmagan taqdirda 
brauzer bu katakni aks ettirmaydi va <TD> tegida BGCOLOR atribut 
ishlatilgan taqdirda fon rangi ifoda etilmaydi va hatolik yuz beradi.

• Har bir jadval tegini yangi qatorda yozing
Jadval tuzishda adashib ketmaslik uchun har bir jadval qatori, ustuni 

va katakchalar belgilanganda ularni bir-biridan ajratib yozishga harakat 
qiling. Quyida ana shu holatga misol keltirilgan.

<TABLE>
<TR>
<TD> ... </TD>
<TD> ... </TD>
<TD> ... </TD>
</TR>
<TR>
<TD> ... </TD>
<TD> ... </TD>
<TD> ... </TD>
</TR>
</TABLE>
Ushbu qoidalarga rioya qilsangiz jadval tuzishda turli qiyinchi- 

liklarga duch kelmaysiz hamda siz tuzgan jadvallarda hatolik lai 
bo‘lmaydi.

Murakkab jadvallar tuzish

Oddiy jadval tuzish usullarini o‘rganib oldingiz. <TD> tegining hall 
siz bilmagan ba’zi qiziq o‘lchamlari mavjud bo‘lib ularni qo‘shish orqali
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Mioyib natijalarga erishish mumkin. Aytaylik siz quyida keltirilgan 
i ul\ alga o'xshash jadval tuzmoqchisiz (1.4-jadval).

1.4-jadval

Л# Mahsulot nomi Narhi (so‘m)
■ 1 Qalam .100
I 2 Ruchka 150
* 3 Daftar 400
l.iiiii: 650 so‘ni

I ’tibor bergan bo'lsangiz jadvalning so‘ngidagi qator boshqalaridan 
Miqli oiaroq bitta katakchadan iborat. Biz avval aytib o‘tganimizdek 
imlvaldagi barcha kataklar soni bir xil emas. Bu misolda oxirgi 
t|nlordagi uchta kataklar bir-biri bilan birlashtirilgan xolos. Buni <TD> 
It'i'ining COLSPAN yordamida amalga oshirish mumkin.

COLSPAN

Jadvaldagi bir qator yoki ustundagi bir nechta kataklarni bir- 
Insliliradi. Bu atribut oichamiga siz nechta katakchani birlashirmoqchi 
I»** lsangiz, ularning sonini kiritishingiz lozim. Quyida, yuqoridagi 
|m ha Ida bu usui qanday amalga oshirilganini ko‘rsatib beruvchi misol 
In'll и amiz. Bu misolda jadvalning aynan COLSPAN atributi qoilanilgan 
<11 niigina yozilgan:

<TR>
ГО COLSPAN = 3 BGCOLOR = red>
FONT COLOR=white>Jami: 650 so'm</FONT>

• /TD>
• /TR>

HTML kodlarga izoh

HTML kodlarni tahrirlashni oson kechishini ta’minlash uchun turli 
l/iililarni kiritish maqsadga muvofiq. Izohlar yordamida siz HTML

• Ilai ni qayerda boshlanib, qayerda yakunlanganini muntazam kuzatib 
limnsiz va adashib ketmaysiz.
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Murakkab web-sahifalar tuzganda ishlatiladigan HTML kodlar 
soni cheksiz ko'payib ketishi mumkin. Bunday paytda HTML kodlarni 
qayerdan boshlanib qayerda yakun topganini adashtirib yuborishingiz 
aniq. Shu sababli teg ochilganda va u yopilganda izoh bilan belgilab 
borish lozim. Quyidagi misolda izohli HTML kodlar tizimi keltirilgan: 

<BODY BACKGROUND=img/back.gif>
<!—HTML hujjat boshlanishi-->
<TABLE BORDER =0 CELLPADDING=0 CELLSPACING = 0 

WIDTH =100%>
<!-Tashqi jadval boshlanishi—>
<TR>
<TD WIDTH=«1%» VAL1GN = «top»>
<IMG SRC = «img/p.gif» WIDTH=«160» HEIGHT=«1» ALT= 

= « »><BR>
<!—Sahifaning chap ustuni—>
<FONT COLOR=white>Sayt menyusi:</FONT>
<!—CHap ustun yakuni—>
</TD>
<TD WIDTH = «2%»></TD>
<TD WIDTH = «94%» VALIGN = «top»>
<!—Sahifaning markaziy ustuni—> 
web sahifaning asosiy matni.
<BR><BR><BR><BR><BR><BR><BR><BR><BR><BR><BR> 
<!—Markaziy ustun yakuni—>
</TD>
<TD WIDTH = «2%»> </TD>
<TD WIDTH = «1%» VALIGN = «top»>
<IMG SRC=«img/p.gif» WIDTH=«100» HEIGHT = «1» A LT- 

= « »><BR>
<!—Sahifaning o‘ng ustuni—>
<TABLE BORDER=«0» CELLPADDING = «1» CELLSPACING- 

= «0» WIDTH=«100» BGCOLOR=«#336699»>
<!—0 ‘ng ustundagi reklamali jadval—>
<TR>
<!—Reklama sarlavhasi—>
<TD><FONT COLOR = «#eOeOff»>Reklama:</FONT></TD>
</TR>
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<TR>
<TD>
<TABLE BORDER = «0» CELLPADDING = «0» CELLSPACING=

■ «0» W IDTH=«100%» BGCOLOR=«#f0f0f0»>
<TR>
<TD BGCOLOR =«#cccc33»>
<!—Reklama matni—>
<FONT SIZE=«2»>Reklama matni va tasvirni shu yerga joylash- 

lii ishingiz mumkin 
</FONT>
</TD>
</TR>
</TA BLE>
</TD>
</TR>
</TABLE>
< !--0 ‘ng ustun yakuni—>
</TD>
</TR>
</TABLE>
<!—’Tashqi jadval yakuni—>
</BODY>
<!—HTML hujjat yakuni—>
Bu ifodalar sizga jadvalli sahifani oson tahlil qilish imkonini 

beradi hamda turli o‘zgarishlar kiritgan taqdiringizda, uni qaysi joyda 
bo'lishini aniq belgilay olasiz.

Ba’zida o'zingiz ham mana shunday sxemalarni tuzishingiz mumkin 
m i  sahifa tayyor bo‘lgach, kiritilgan izohlarni o‘chirib tashlang. Bunda 
kiritilgan izoh quyidagi tartibda yozilishi lozim: ’<!— izoh —

Freymlar bilan ishlash imkoniyatlari

Freym -  brauzer oynasidagi mustaqil to‘g‘ri to‘rtburchak shaklidagi 
nmydon boiib, u o‘z ichiga boshqa alohida mustaqil HTML hujjatlarni 
liulashtira oladi.

Endi siz har bir oynasida alohida mustaqil HTML hujjatlarni ochish 
imkonini beruvchi freymlarni tuzish usullari bilan tanishib chiqasiz. 
I'rcymlar brauzerdagi yangi oyna emas, balki bu alohida oyna yoki
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ramka boiib, u brauzerning ochilib turgan oynasi ichida aks ettiriladi. 
Bu boiim da, bir freymdan ikkinchi frevmlarni bir-biriga havolalar 
yordamida bogiash usullarini tahlil qilib chiqamiz.

Freymlar tuzish

Siz internetdan foydalanish jarayonida freymlar ishlatilgan web 
sahifani koigansiz. Aytaylik bu sahifada uchta freymdan foydalanilgan.

Ko;rib turganingizdek bu sahifa uchta freymdan iborat ustunlarga 
bolingan. CHap ustunda joylashgan freymda navigatsion menyu, 
yuqoridan o‘ngdagisida reklama va o'ngdan pastdagi freymda esa web 
sahifa asosiy matni o‘rin oladi. Chap ustunda joylashgan havolalarga 
bosish bilan, havolalari hujjatning o‘ngdan pastida joylashgan freymda 
ochiladi.

Ushbu freymlar qollanilgan sahifaning umumiy tuzilishini ко'rib 
chiqsak:

<FRAMESET> -  freymlar tuzilishini belgilovchi ochuvchi teg 
(freymset)

<FRAME> -  birinchi freym
<FRAME> -  ikkinchi freym
</FRAMESET> -  freymsetni yopuvchi teg
Sxemada ko'rinib turganidek, har gal <FRAMESET> tegi yor­

damida freymlar tuzilishini belgilash lozim. Shundan so‘ng bevosita 
freymlar <FRAME> tegiga navbat keladi. Oxirgi navbatda </ 
FRAMESET> freymset yopuvchi teg yoziladi.

Hozircha bu oddiy sxemani eslab qoling. Murakkab freymlai 
qollanilgan sahifalar haqida ushbu boiim da keyinroq ma’lumot 
beramiz.

Freymlar -  oddiy misol

Xullas. freymlar bilan ko'rsatilgan oddiy misolni ko iib  chiqami/ 
Ishni boshlashdan oldin, oddiy F1TML formatida ikkita hujjat varating, 
Birinchi hujjatga «Freym-1» ikkinchisiga esa «Freym-2» deb yozing va 
ularni freml.HTM L va frem2.HTML deb nomlang. Bu ikkita fayllat 
bizning misolimizda ikki freymlar uchun asosiy manba boiib  xizmal 
qiladi. Endi esa HTML formatida keyingi hujjatni varating.
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<HTML>
<HEAD>
<TITLE>freymlar</TITLE>
</HEAD>
<FRAMESET COLS= «200»,*>
<FRAME NA M E= left SRC = «framel.HTML>»
<FRAME NAM E= right SRC = «frame2.HTML»>
</FRAMESET>
<NOFRAMES>
Sizning brauzeringiz freymlarni tushunmaydi.
</NOFRAMES>
</HTML>
Demak siz ham o'zingizning birinchi sahifangizni freymlar 

yordamida yaratdingiz. Endi shu yaratgan sahifangizni frameset.html 
deb nomlab oldin yaratilgan framel.html va frame2.html fayllar turgan 
IMpkada saqlang va frameset.html faylini o‘z brauzeringizda oching.

Birinchi navbatda, e’tibor bergan boisangiz HTML formatidagi 
lieymlardan iborat sahifada <BODY> tegi mavjud emas. Bu esa juda 
muhimdir. Agar siz <BODY> tegini ishlatsangiz u holda, hamma 

I RAMESET> va <FRAME> teglari brauzeringiz tomonidan 
o'chiriladi. Undan tashqari <NOFRAMES> tegi shunday holatga 
iMo'ljallangan-ki, bu holatda sizning brauzeringiz freymlarni qo'llab- 
i|uvvatlamaydi.

Freymlar -  oddiy freym

Bizning misolimizda <FRAMESET> va <FRAME> teglarini oddiy 
и .ham lard a ishlatgan edik. Endigi navbatda biz freymlar yordamida 
и / sahifamizda nimalarni o'zgartira olishimizni ko iib  chiqaylik. 
Iriimeset.html sahifasini brauzerda yoki HTML teglarni tahrirlovchi 
tlnsturda oching. Foydalanuvchi sizning freymlaringizni o‘lchamlarini 
nVgartira olmaydigan qilishingiz mumkin. Siz hozir freym 
vlicgaralariga sichqoncha ko'rsatkichini belgilab uning o‘lchamlarini 
Kohlagan tarzda o'zgartirishingiz mumkin.

NORESIZE
FRAME> tegining parametr ushbu freymni o‘zgartirib bo‘l- 

Hmsligini anglatadi.
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Misol:
<FRAME NAME = left SRC = «framel.html» NORESIZE>
<FRAME NAME = right SRC = «frame2.html» NORESIZE>
Keyingi holatlarda, agar siz freymlar orasidagi chegaralarni 

belgilash uchun siz <FRAMESET> tegining quyidagi atributini isli- 
latishingiz zarur.

BORDER
<FRAMESET> tegi freymlar chegaralari orasidagi masofani 

piksellarda ifodalaydi. Freym orasidagi chegarani umuman bo'hnasligi 
uchun shu oicham ni nolga tenglashtiramiz.

Misol:
<FRAMESET COLS = «200»* BORDER=«0»>
<FRAME> tegining yana bir muhim atributi
SCROLLING
<FRAME> tegi mavjud freymda sahifalash chizig'ini mavjudligi 

yoki mavjud emasligini belgilaydi. Bu parametrning yes, no va au(o 
belgilari bu freymda sahifalash chizig’ini borligini, yo'qligini va agar 
kerak bo‘lsa ishlatilishini ko‘rsatadi.

Misol:
<FRAME NAM E= «left» SRC = «framel.html» NORESIZE SCROl 

LING=«auto»>
<FRAMENAME=«right» SRC = «frame2.html»NORESIZE SCROl 

LING = «yes»>
<FRAMESET> tegining quyidagi atributlarini siz bilishingiz /a

rur:
COLS
<FRAMESET> tegining bu parametri gorizontal freymlarning 

chapdan o’ngga tuzilishini ko‘rsatadi. Freymlarning kengligi piksellardu 
yoki foizlarda beriladi va bir-biridan tinish belgisi bilan ajratilaili,

simvol shuni ko'rsatadiki, qolgan umumiy mavdon shu freymgi 
ajratilishini anglatadi.

Misol:
<FRAMESET COLS = «200», * 100>
Bu misolda uchta freym mavjud bo‘lib. birinchisi-200 piksvl 

oxirgisi —100 piksel, ikkinchisi (o’rtadagi freym) -  qolgan maydonninj 
hammasi shu freym uchun ajratilgan.
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<FRAMESET COLS = 20%, 100, 50, *>
Bu misolda esa toTtta freym bo‘lib, birinchisi maydonning 20%ni, 

ikkinchisi -  100 pikselli, uchinchisi -  50 pikselli, to‘rtinchisi esa qolgan 
maydonni tashkil etadi.

ROWS
<FRAMESET> tegining bu parametri freym larning vertikal 

u padan pastga bo'lgan tuzilishini ko'rsatadi. 0 ‘lchami raqamlar bilan 
Ih riladi. Bu freymlarning balandligi piksellarda yoki foizlarda beriladi 
v I bir- biridan tinish belgisi bilan ajratiladi. simvol shuni ko‘rsatadiki 
и umumiy qolgan maydonni shu freymga ajratilishini anglatadi.

Misol:
<FRAMESET ROWS = 50%, 50%>
Ralandligi ekranning 50% tashkil qiluvchi ikkita freym. Anglash 

qiyin emaski, bu ifodani ROWS parametrida, simvol orqali quyidagicha 
ы /ish mumkin 50%, *.

Freymlar -  murakkab freymlar tuzish

Ushbu bo‘limning boshida siz tanishib chiqqan, freymlarga 
Im> Iingan sahifaga yana bir bor murojaat qilsak (1.3-rasm). Berilgan
i.ihifada uchta freym bo‘lib. bu freymlar tarkibida gorizontal hamda 
UMlikal holatdagi freymlar mavjud. Bu sahifani yaratish uchun biz 
nima qilishimiz kerak? Demak hammasini bir boshdan boshlaymiz.

Murakkab tarkibli freymlarni yaratishimiz uchun, biz jadvallarni
• iinday yo'l bilan yaratgan boMsak shu yo‘l bilan yaratishimiz 
i|iilayroqdir. Oq qogo‘zga freymlar tuzilishi 
Wliilozasini chizib oling va shu freymlarni 
inqamlab chiqing. Bizning misolimizda 
licymlar tuzilishi quyidagicha boiadi:

Freymlarni quyidagicha raqamlaymiz: 
clmpdan o‘ngga, tepadan pastga qarab. Endigi 
liuvbatni yangi sahifani yaratishga bersak.
Ml/ning misolimizda yolg‘iz <FRAMESET> 
i'!'I orqali freymlar strukturasini bel-
yil.iy olmaysiz, nega deganda birgina 1.3-rasm. Freymlarga

I l<AMESET> tegida freymlarni birgalikda bo'lingan sahifa.
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gorizontal (COLS) va vertikal (ROWS) joylashtirishning iloji yo‘q. Gap 
shundaki bir nechta <FRAMESET> teglarni quyidagicha ishlatiladi 

<HTML>
<HEAD>
<T I TLE>frey m lar</'TITLE>
</HEAD>
<FRAMESET COLS= 150* BORDER=0>
<FRAME SRC = left.html SCROLLING= yes NORESIZE> 
<FRAMESET ROWS = 70* BORDER =0>
<FRAME SRC = top.html SCROLLING = auto NAM E= top 

NORESIZE>
<FRAME SRC = content.html SCROLLING=yes NAME=content 

NORESIZE>
</FRAMESET>
</FRAMESET>
<NOFRAMES>
Sizning brauzeringiz bu freymlarni qoilab quvvatlamavdi. 
</NOFRAMES>
</HTML>
Birinchi <FRAMESET> tegi ekranni ikkita freymga. ya’ni o’ng va 

chap freymlarga ajratadi. Ikkinchi <FRAMESET> tegi esa o‘ng qism 
(o‘ng freym)ni yana ikkita tepa va past freymga ajratadi. Ketma-ketlik 
tartibi HTML formatida oldin ko‘rsatib o‘tilganidek bo‘lishi shart. 
Birinchi navbatda birinchi <FRAMESET> tegi. Birinchi freym (o‘ng 
freym). Undan keyin ikkinchi freym kelishi kerak edi. Ammo bi/ 
ikkinchi <FRAMESET> tegi yordamida uni yana ikkiga boTdik, ya’ni 
biz ikkinchi freym (chap freym)ga yana ikkita freymni vertikal holda 
(ROWS = 70,*) joylashtirgan bo'lamiz. Keyin ikkita freym keladi va 
ikkala <FRAMESET> teglari yopiladi. Mana endi natija quyidagicha 
bo‘ladi, ya’ni chap freymda left.html o‘ng tomondagi freymning yuqori 
qismida top.html va undan yuqori qismida content.html freymlar 
yuklanadi.

Freymlar -  havolalar tuzish

Belgilangan maxsus freymda HTML hujjatni ochilishi uchun 
havolani qanday tuzish lozim? Bu juda ham oson. Buning uchun, freym 
ishlatiladigan sahifa yaratilganda, freym nomini berib o‘tish lozim.
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N A M E
I RAME> tegining bu atributi mazkur freym nomini belgilaydi.

I trym nomlari ushbu freymga boshqa freymdan havola tuzish uchun 
40‘llaniladi.

Bizning misolimizda quyidagi kodlar qollanilgan:
FRAMESET COLS= 150,* BORDER=0>

• FRAME SRC = left.html NAME = left SCROLLING= yes NORE- 
M/,E>

<FRAMESET ROWS = 70,* BORDER=0>
• FRAME SRC= top.html NA M E= top SCROLLING = auto NORE- 

SI/,E>
FRAME SRC = content.html NAM E=content SCROLLING=yes> 

</FRAMESET>
</FRAMESET>
Natijada quyidagi nomlardagi freymlar vujudga keladi: left, top 

у м  content. Endi chap freymdagi havoladan asosiy freymda hujjatni 
iidulishi uchun <A> tegining TARGET parametrini content teng qilib 
belgilash lozim, ya’ni:

A HREF= l.html TARGET=content>l-Punkt </A>
Shakllar hosil qilish (Фор1ма)
Siz internetda ko‘p marta shakllarga duch kelgan bo'lsangiz kerak. 

I 'ii qog'ozdagi anketaning elektron varianti, o‘zida matn kiritish
iii.ivdonlarini, savollarga javob variantlari va boshqa shakl elementlarini 
miijassam qiladi. Shakllar sayt egasi va foydalanuvchilar orasida aloqa 
и 1 uatish uchun kerak.

Shakllar yordamida saytingiz orqali, misol uchun, ovoz berish, 
lnvdalanuvchilarning ayrim savollar bo‘yicha fikrini bilish va shunga
II xshash masalalarni hal qilishingiz mumkin.

ShakHarning umumiy sxemasi

Quyida har qanday shaklni yaratish umumiy sxemasi berilgan. 
<FORM>
shakl maydonidagi teglar 
</FORM>
Ko‘rib turganingizdek, ochuvchi <FORM> va yopuvchi</FORM> 

ii‘rlari orasiga shakl maydonlari teglarini qo‘yish yetarlidir. Keyingi 
..iliil'ada turli shakl maydonlari bilan tanishamiz.
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Turli shakl maydonlari

Shakl maydonlari qanday boTadi va ular nima ish bajaradi?
Matn qatori (TYPE = TEXT)
Bu qator ko'p bo'lmagan simvollardan iborat erkin ko‘rinishdagi 

ma’lumotni (matnni) kiritish uchun foydalaniladi.
Misol:
<INPUT TYPE= TEXT NAME = Tekst SIZE = 20 VALUE= «Siz­

ning matn»>
Shunday qilib matn qatori <INPUT> tegi va TYPE = TEXT para- 

metrlari yordamida yaratiladi. Shu tegning boshqa parametrlari nimani 
bildiradi?

NAME
Serverga jo ‘natiladigan o‘zgaruvchining nomi. Foydalanuvchi ki- 

ritgan matn natijada shu nomli o‘zgaruvchiga beriladi. HTMLda 
shakllar yaratish serverda dasturlash bilan uzluksiz bog‘liq. Serverda 
foydalanuvchilaringizdan ma'Iumotlarni shu dastur orqali qabul qi- 
lishingiz mumkin.

SIZE

Matn qatorining simvol koTinishdagi kengligi. Bizning misolda 
bu parametrning ifodasi 20 ga teng. Buning ma’nosi kiritilayotgan 
matnning kengligi 20 simvoldan iborat. Foydalanuvchi undan ko'p 
simvollardan iborat bo;lgan matnni kiritishi mumkin, lekin 20 tadan 
ortiq simvol ko‘rinmaydi. Klaviaturadagi yo'naltiruvchi tugmachalar 
yordamida matnni boshi yoki oxiriga o‘tish mumkin.

VALUE

Bu parametr ifodasi oldindan matn maydoniga kiritilgan boiadi, 
Uni o‘zgartirish yoki o‘chirish mumkin.

Javob varianti (TYPE=RADIO)
Foydalanuvchi bir qancha javob variantlari orasidan faqat bitta 

variantni tanlashi mumkin.
Misol:
Jinsi:
<INPUT TYPE = RADIO NAME = Jins VALUE=«Erkak»>Er.
<INPUT TYPE = RADIO NAME= Jins VALUE = «Ayol»>Ay.
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Natija:
Jinsi: Er. Ay.
Ko‘rib turganingizdek javob variantlari <INPUT> tegi TYPE= 

RADIO atributi orqali yaratiladi. Diqqat qiling, javob variantlaridagi 
NAME atributining ifodalari bir xil bo‘lishi kerak, aks holda brauzer 
I mi larni har xil savol deb qabul qiladi.

VALUE
Bu ifoda o'zgaruvchining ifodasi ko’rinishida jo ‘natiladi (bizning 

misolda, agar Er. tanlansa Jins o‘zgaruvchining ifodasi 'Erkak' ga teng 
bo'ladi).

Tasdiqlash (TYPE = CHECKBOX)
Ayrim ifodalarni yoki javob variantlarini belgilash uchun ishlatiladi. 
Misol:
Jinsi:
<INPUT TYPE = CHECKBOX NAME = AddMe VALUE = «Obuna 

lu)'lish»>
I la, men sizning saytingizdan yangiliklar olishni istayman 
Natija:
Ha. men sizning saytingizdan yangiliklar olishni istayman 
Tasdiqlash <INPUT> tegi TYPE = CHECKBOX atributi yordamida 

\aratiladi. Bizning misolda, agar foydalanuvchi kvadratga belgi 
qo'ysa (tasdiqlasa) AddMe o'zgaruvchining ifodasi «Obuna bo‘lish»ga 
Icng boiadi. Aks holda AddMe o‘zgaruvchisiga hech qanday ifoda 
borilmaydi.

Harakatlanuvchi menyu (SELECT)
Bir qancha javob variantlaridan birini tanlash uchun harakatlanuvchi 

mcnyu ko‘rinishida ifodalanadi.
Misol:
Yoshi:
<SELECT NAME = Age>
<OPTION VALUE = 10>10 dan kam 
O P T IO N  VALUE= ll-20>ll-20 
<OPTION>21 dan ko'p 
</SELECT>
Natija:
Yoshi:
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Harakatlanuvchi menyu <SELECT> tegi, menyuning javob va- 
riantlari esa <OPTION> tegi yordamida yaratiladi.

NAME
<SELECT> tegining atributi, o‘zgaruvchining nomini ifodalaydi 

Bu o‘zgaruvchiga tanlangan javob variantining ifodasi beriladi. Bizning 
holatda o‘zgaruvchining nomi Age.

VALUE
<OPTION> tegining atributi, shu variant tanlanganda parametr 

ifodasi o‘zgaruvchiga beriladi. Agar bu atribut belgilangan bo'I 
masa (uchinchi <OPTION> tegiga o‘xshab), o‘zgaruvchining ifodasi 
<OPTION> tegidan keyin kelgan matn bo‘ladi. Agar bizning miso­
limizda uchinchi variantni tanlasak Age o‘zgaruvchining ifodasi 21 dan 
ko'p, agar birinchi variantni tanlasak ifoda TO’ boTadi.

<OPTION>tegidan so‘ng berilgan matn ekranda harakatlanuvchi 
menyu varianti sifatida ko‘rinadi. Keyin <OPTION> tegini vopish shait 
emas.

Matn maydoni (TEXTAREA)

Matn maydoni foydalanuvchi tomonidan ko‘p sonli simvollardan 
iborat matnni kiritish uchun foydalaniladi.

Misol:
Sizning mulohazalaringiz:
<TEXTAREA NAM E=Comments COLS = 20 ROWS = 5>
0 ‘z mulohazalaringizni kiriting
</TEXTAREA>
Natija:
Sizning mulohazalaringiz:
Matn maydoni <TEXTAREA> tegi orqali yaratiladi. Ochuvchi va 

yopuvchi teglar orasidagi hamma matnlar shu matn maydoni ichiga 
yoziladi.

COLS

Matn maydonining simvol ko‘rinishidagi kengligi.

ROWS

Matn maydonining qator koTinishidagi balandligi.
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Shaklni tozalash va jo ‘natish tugmachasi

foydalanuvchi to‘ldirilgan shaklni jo‘natish uchun tasdiqlovchi 
in ’ macha yaratish kerak. hamda shakl maydonini tozalash tugmasini 

и il ishi mumkin. Shu bo'lim boshida jo'natish va tozalash tugmasini 
I unlay ko‘rinishga ega ekanligini ko‘rdingiz.

Jo'natish tugmachasi (TYPE = SUBMIT)
loydalanuvchining shaklda belgilangan ma’lumotlarini tasdiqlab, 

ihu ma’lumotlarni serverga jo ‘natish uchun qo‘llaniladi.
Vlisol:

INPUT TYPE = SUBMIT VALUE = «Shaklni jo ‘natish»>
Natija:
Shaklni jo'natish" nomli tugmacha

Jo'natish tugmachasi <INPUT> tegi yordamida TYPE=SUBMIT 
niiihiitini ishlatgan holda yaratiladi. Natijada VALUE parametrida 
Muilangan yozuv bilan tugmacha yaratiladi. Tugmacha bosilganda 
h.ikldagi ma'lumotlar serverga jo ‘natiladi.

lozalash tugmachasi (TYPE = RESET)
Shakl maydonidagi ma’lumotlarni tozalash uchun qo‘llaniladi.
Misol:

INPUT TYPE = RESET VALUE = «Shaklni tozalash)»
Natija:
' Shaklni tozalash’ nomli tugmacha
Shakl maydonini tozalash tugmachasi <INPUT> tegi yordamida 

I YIT, = RESET atributini ishlatgan holda belgilanadi. Natijada VALUE 
■H i ibutida belgilangan yozuv bilan tugmacha yaratiladi. Tugmacha 
bosilganda shakldagi ma’lumotlar to ia  o‘chiriladi.

Ko'rinmas shakl maydoni

Yana bir turdagi shakl maydoni bor -  bu ko‘rinmas shakl maydoni. 
Mu maydon ma’lumotlar almashinuvi uchun ishlatiladi. Ko‘rinmas 
maydonni foydalanuvchi ko'ra va o‘zgartira olmaydi.

Ko‘rinmas maydon (INPUT TYPE = HIDDEN)
Shakl maydoni ekranda ko‘rinmaydi, uning ifodasi sahifa yara- 

nlishida beriladi va foydalanuvchi shaklni to'ldirish jarayonida 
o'zgartirib bo'lmavdi.
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Misol:
<INPUT TYPE = HIDDEN NA M E= Page VALUE = «1 sahifa»> 
Ko‘rinmas shakl maydoni <INPUT> tegi yordamida va TYPE=

- HIDDEN atributini ishlatgan holda yaratiladi. Berilgan misolda 
shaklni jo ‘natish vaqtida Page o‘zgaruvchisiga ‘1 sahifa’ ifodasi 
beriladi. Buning natijasida, agar to‘ldiriladigan sahifalaringiz ko‘p 
bo'lsa, qaysi sahifadagi shakldan ma’lumot jo'natilganini aniqlashingiz 
mumkin.

FORM tegining atributlari va shaklni jo ‘natish

Shu bo‘lim boshida eslatib o‘tganimizdek, shakl yaratish dastur- I 
lash bilan uzluksiz bogiiq . Boshqacha qilib aytganda shakldagi 
ma’lumotlarni qayta ishlash dasturlashsiz iloji yo'q. Ma’lumotlarni j 
qayta ishlash natijasi siz ko'rsatgan email manzili bo‘yicha jo ‘na- 
tiladi.

Keling, sizning saytingizdagi shakl ma’lumotlari dastur orqali qayta 
ishlanishi uchun nima qilishni ko‘rib chiqaylik. Natija siz ko'rsatgan 
email manzili bo‘yicha shu formatda jo'natiladi.

0 ‘zgaruvchi: Kiritilgan ma’lumot
Buning uchun saytingizda xohlagan shaklni shu ko'rinishda yara- j 

tishingiz zarur:
<FORM METHOD= POST ACTION=http://.....com/mail.php3> 
<INPUT TYPE = HIDDEN NA M E= recipient VALUE = EMAIL> 
<INPUT TYPE= HIDDEN NAM E=subject VALUE=MAVZU> 
<INPUT TYPE = HIDDEN NAME = type VALUE=TUR>
<INPUT TYPE = HIDDEN N A M E=return VALUE= MANZIL> 
<INPUT TYPE = HIDDEN NAME = alpha VALUE = a>
Sizning shaklingiz Я
</FORM>
Endi shu HTML kodni o‘z sahifangizga ko‘chiring va keyingi 

so‘zlarni o'zgartiring:
EMAIL -  natija jo'natiladigan email manzil;
MAVZU -  Xat mavzusi (Subject);
TUR -  Sizning pochtangiz turi, HTML deb yozing, agar aniq i 

bilmasangiz TEXT deb yozing;
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MANZIL -  foydalanuvchi shaklni to'ldirgandan keyin ko'rishi kerak 
bo’lgan sahifa manzili;

Keyin. ’Sizning shaklingiz’ so’zini o'rniga o‘z shaklingizni qo‘ying. 
Dastur qanday ishlashini ko‘rish uchun o‘zingizni email manzilingizni 
Kiriting va ‘Tekshiruv’ tugmasini bosing.

HTMLda simvollar jadvali

Ayrim simvollarni to‘g‘ridan-to‘g‘ri yozib bo‘lmaydi. Chunki ularni 
brauzer aks ettirib bera olmaydi. Undan tashqari ko‘plab simvollar 
I laviaturada mavjud emas. Bu ikki turdagi simvollarni brauzerda 
.ilvs ettirish uchun son va shriftlar kombinatsiyasidan foydalaniladi. 
ASCII simvollar deb ataluvchi simvollarning son va shriftlardan iborat 
Unnbinatsiyasi mavjud.

Savol va topshiriqlar:

1. Web-dizayn nima?
2. Dizaynning qanday turlari bor?
3. Web-dizaynda qanday dasturing vositalar ishlatiladi?
4. NTML nima? Uning asosiy strukturasi nimalardan iborat?
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U-bob. DREAMWEAVER DASTURINING IMKONIYATLARI

Dreamweaverning MX versiyasi bu nafaqat interfeysning tashqi 
koiinishi yangilangani, balki radikal texnologik yangilangan, gi­
permatnli belgilash tili imkoniyatlari kengaygan. Unda Web-sahifa 
maketlarini yaratish uchun yangi ashyolar paydo boidi. Jumladan, 
tizimga Flash obyektlarni qo‘yish buyruqlari qo‘shilgan va WEB uzellar 
bilan boshqarish va turli jamoaviy ishlarni loyihalashda rivojlanishga 
imkon beradi. Endi Dreamweaver MX bilan batafsil tanishib chiqamiz.

Belgili kodlar bilan ishlash vositalari sezilarli darajada rivojlandi. 
MX-versiyasi bu ixtiyoriy murakkablikdagi dastlabki matn bilan ishlash 
uchun kuchli bazaga ega boigan gipermatnli dasturlashning toiaqonli 
qobig‘idir. Asosiy imkoniyatlarini sanab chiqamiz:

1) Hujjatning oynasi endi har xil rejimlarda ishlashi mumkin. 
Design View (Режим планировки) rejimida, foydalanuvchi HTML 
sahifa maketini taxminan shunday ko‘rinishda ko'rish mumkin. 
Code View (Режим разметки) rejimida esa hujjatning oynasida 
belgili matn sahifasining barcha deskriptorlari, senariylari va 
kommentariyalari tasvirlanadi. Dasturning bu rejimlari orasida kichik 
koordinatsiya mavjud. Kodlarni o'zgartirish maket modifikatsiyasiga, 
vizual rejimda rejalashtirish yoki formatlashga o‘zgartirish kiritish 
imkonini beradi;

2) Dreamweaver tizimi qobigiga barcha zaruriy qurilmalarga ega 
boigan toiaqonli kodlar tahrirlagichidan iborat dastur integratsiya 
qilingan. Unda HTML hujjatlarining dastlabki matnlari bilan ishlashni 
yengillashtiruvchi vositalar: kiritilgan teglarning sarlavhalari. turli 
kodlarni rangli belgilash, tez qidirib topish vositalari aks etgan. 
Sintaktik noto’g'ri loyihalarni aniqlash, uzun qatorlarni avtomatik 
ko‘chirish, avtokorreksiya rejimi yoiga qo‘yilgan. Dastur vositalari 
yordamida nafaqat gipermatnli sahifalarni, balki matnli koiinishga ega
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liar qanday hujjatlarni, dasturlar, senariylar, oddiy matnlar, XML belgili 
hujjatlar va boshqalarni tahlil qilish mumkin.

3) Gipermatnlarni belgilash kodlari bilan ishlashni ma’lumot 
paneli ancha soddalashtiradi. Bu dastur ichiga qurilgan interfaol ma’lu- 
motnoma gipermatnli belgilash tilining barcha standart loyihalarini va 
u bilan bogiangan vositalarni: diskreptorlar, atributlar, ierarxik stildagi
0 /.iga xosliklarning deklaratsiyalari (Cascading Style Sheet), Java Script 
tilining sintaktik loyihalarini qisqa va lo‘nda shaklda tavsiflaydi.

Tajribadan ma’lumki xatto eng tajribali, HTML tilini chuqur 
liiladigan Web-ustasi ham bu til standartiga kiruvchi yuzlab kodlar va 
niributlarni eslab qolishga qodir emas. Ma’lumotlar paneli deskriptorni 
imiq va ravshan tavsiflab beradi, uning atributlari hamda ko‘rib chiqish 
ilasturining turli versiyalari bilan mos tushishi haqida ma’lumot beradi.

4) Java Script senariylar
Java Script dasturlash tilida yozilgan senariylardagi yashirin xa- 

tolarni aniqlash imkoni beriladi. Bu vosita nafaqat hozirgi vaqtda 
\VI B-dasturlash sohasida qoilaniladigan ko‘p sonli analizatorlar uchun 
»|iyin bo‘lmagan, sintaksis xatolarni aniqlashga qodir. Kodlarni tuzatish 
vnqtida dastur ichiga qurilgan nazorat nuqtalari va qadamba-qadam 
bajariladigan dastur ko‘rsatmalari hamda o‘zgaruvchilarning holatini 
na/orat mexanizmlariga ham ega.

Doimo sezilarli potentsialga ega bo‘lgan vizual loyihalash tah-
1 и lagichining uskunalari yana bir vosita bilan boyitildi. Bu gipermatnli 
. iliifalarni rejalashtirish va yaratish uchun moijallangan maxsus dastur 
Islichi rejimidir. U sahifani aks ettirishning maxsus rejimi (Layout Viev) 
m i  ikkita uskuna ko'rinishida amalga oshirilgan boiib, ular yordamida 
niaket elementlarini chizish mumkin.

Tahrirlagichning oldingi versiyalari vektorli animatsiyalashgan 
liisvirlar sohasida birinchilar qatorida boigan Flash dasturi bilan juda 
\n\shi o‘zaro aloqada boiishi bilan ajralib turgan. Dasturning joriy 
U'lsiyasiga animatsiyalashgan obyektlarni generatsiya qilishning 
ikkita asosiy buyrugi integratsiya qilingan. Endi bevosita dastur 
ovnasida interfaol tugma yoki «jonli matn» yaratish mumkin. Bunga 
n'xshash obyektlarni kiritishning texnik tomoni o‘ta soddalashtirilgan 
m i  loyihalashtirishdan ko‘ra ko‘proq anketalashtirishga o‘xshab 
kctudi. Foydalanuvchidan Flash -  texnologiya sohasida chuqur
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bilimlar talab qilinmaydi. U faqat muloqot oynasi sohasini to'ldirishi 
kerak. Zamonaviy dasturlarning ko'pchiligi animatsiyalashgan Flash
-  grafikani aniq aks ettiradi. Bu tipdagi obyektlar аЧо darajada 
masshtablanishi bilan ajralib turadi va tarmoq bo‘ylab uzatishda ham, 
diskda saqlashda ham juda kam resurs talab qiladi. Dasturga kiritilgan 
yangiliklarni qisqacha sanab o‘tamiz:

-  ierarxik stildagi o‘ziga xosliklar (CSS) bilan ishlash vositalari 
sezilarli darajada takomillashtirilgan.

-  Macromedia firmasi tomonidan ishlab chiqilgan Fire woks 
grafik muharriri bilan Dreamweaver dasturining integratsiyasi yanada 
rivojlantirildi.

-  yangi Assets (resurslar) palitrasi yaratildi. U dasturda bitta WEB
-  tugunning bir necha sahifasi tomonidan birgalikda ishlatiladigan 
turli xildagi ma’lumotlarning omborxonasi vazifasini bajaradi. Bular 
tasvirlar, animatsiva roliklari, ranglar, senariylar, kutubxonalar va 
boshqalar boiishi mumkin. Saqlanayotgan resurslarni turli sahifalarning 
talab qilinadigan sohalarida joyini o‘zgartirish (yoki surish) yo'li bilan 
joylashtirish mumkin.

Site Report (Отчет о сайте) buyrugl loyiha holati haqidagi batafsil 
hisobotni hosil qiladi. Hisobot o‘ziga ko‘p sonli giperbog'lanishli 
hujjatlarni biriktiradi:

-  tahrirlagichga versiyalarni va dasturiy ta’minotni yangilashni 
boshqarishni nazorat qilishning yetakchi dasturiy vositasi bo‘lgan 
Microsoft Source Safe paketli integratsiya vositalari qo'shilgan. Bu 
narsa Dreamweaver tizimini Internet uchun murakkab loyihalarni 
ishlab chiquvchi jamoalar uchun asosiy uskuna sifatida qoilanilishiga 
asos boladi.

-  dasturning bu versiyasi WEBDav bayonnomasini to‘laqonli 
qoilab-quvvatlaydi. Bu versiyalarni boshqarish va taqsimlangan ishni 
tashkil qilish bo‘yicha kengaytirilgan imkoniyatlarga ega bo'lgan klassik 
bayonnomasidir.

-  interfeysni standartlashtirish va sayqal berish bo'yicha kat­
ta ish qilindi. Macromedia firmasi ko'pgina dasturlarning tashqi 
ko‘rinishi noturg‘un palitralarning yagona konsepsiyasiga asoslanadi. 
Muharrirning oxirgi versiyasida palitralarning ko‘rinishi standart- 
lashtirilgan. Ulaining deyarli hammasi tarkibiy majmuaviy palitralarga



biilashish imkoniyatiga ega boldilar. Oldingi versiyalarning ro‘yxatga 
nlishdagi ba’zi kamchiliklar bartaraf etildi.

klaviatura kombinatsiyalari bir shaklga keltirildi. Ular web- 
ili/ayn uchun Macromedia firmasi tomonidan ishlab chiqilgan, bar- 
. lu dasturlash vositalari uchun umumiy boigan ichki standartga 
moslashtirilgan. Ichiga qurilgan boshqaruv tizimi yordamida tugma- 
I uning har qanday tuzilishini o‘zgartirish mumkin.

Savol va topshiriqlar:

1. Dreamweaver MX dasturi nima maqsadda qollaniladi?
2. Dasturning qanday yangi imkoniyatlari mavjud?
3. Dastur avvalgi web-muharrirlaridan nimasi bilan farq qiladi?

2.1. Dasturni o‘rnatish va ishga tushirish

Tajribali foydalanuvchi dasturni oinatish  jarayonida o'zi uchun 
licch qanday yangilik ko‘rmaydi. Distributiv diskda Dreamweaver MX 
lnsialler.exe (инсталятор) faylini qidirib topish va ishga tushirish lozim 
luvto yuklanish bolmagan holatda). Windowsning ko‘pchilik ilovalari 
kabi bu dastur ham bir necha bosqichda oinatiladi. Ularning har biri 
ulohida muloqot oynasidan iborat.

Dasturni o‘rnatishning asosiy bosqichlarini ketma-ket sanab o'tamiz 
Ml. [4]:

-  Extracting Files. Bu bosqichda DREAMWEAVER tizimdagi 
qurilmalar va dasturning instalyatori ishlashi uchun zarur boigan 
l.i\ liar arxivdan ochiladi. Bosqich foydalanuvchining aralashuvini talab 
qilmaydi.

-  Welcome (Xush kelibsiz). 0 ‘rnatishning birinchi bosqichi boiib, 
unda foydalanuvchi tanlangan dastur va uni installyatsiya qilish 
i|oidalari haqida asosiy ma’lumotlarni oladi.

-  License Agreement (Litsenziya shartnomasi). Ikkinchi bosqichda 
litsenziya shartnomasi va muallifning dasturiy mahsulotiga huquqlari 
biIan tanishish taklif etiladi. Foydalanuvchi taklif qilinayotgan 
majburiyatlarni qabul qilishi yoki rad etishi kerak.

-  Macromedia Dreamweaver Serialization (dasturni ro‘yxatdan 
o'tkazish). Uchinchi bosqichda muloqot oynasi hosil boiadi, uning
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yordamida foydalanuvchining rekvizitlari va dasturning serial nomerini 
kiritish zarur bo‘ladi.

-  Choose Destination Location (joylashuv). Bu bosqichda dasturni 
oinatish uchun disk va papkani olish zarur boladi. Taklif qilinganidan 
farq qiluvchi manzilni ko'rsatish Windows tizimi uchun standart boigan 
faol disk va katalogni tanlash yoii bilan berish mumkin. Buning uchun 
Browse tugmasini bosish kerak.

-  Default Editor o’rnatishning bu bosqichida Dreamweaver dasturi 
keyin ishlatiladigan asosiy tahrirlash fayllarini tanlashni taklif qiladi.

-  Select Program Folder (Dastur papkasini tanlash). Bunda foy­
dalanuvchi dasturni ishga tushiruvchi yorliq joylashgan papkani 
ko‘rsatish kerak boladi. O'rnatishning keyingi barcha operatsiyalari 
foydalanuvchining aralashuvini talab etmaydi. Instalyator arxivlarni 
ochadi, kataloglar va kichik kataloglar tizimini yaratadi, unga ish uchun 
zarur boigan barcha fayllardan nusxa ko‘chiradi va ekranga gipermatnli 
faylni dastur imkoniyatlarining tavsifi, foydali ma’lumotlar manbalan 
haqida qisqacha m aiumotlar bilan chiqarib beradi.

Dasturni ishga tushirish

Paket o‘rnatilgandan keyin Windows bosh menyusiga Dream- 
weaverni yuklash va unga tegishli fayllar maxsus boiim i qo'shiladi. Hai 
qanday holatda ham dasturni yuklash buyrugi: Пуск > Программы > 
Macromedia > Dreamweaver MX ko'rinishida boladi.

Dasturni yuklashni bir nechta universal usullari mavjud. Bu bizga 
oddiy Microsoft Office paketi dasturlaridan ham ma’lum.

Savol va topshiriqlar:

1. Dreamweaver MX dasturini oinatish ketma-ketligini aytib bering?
2. Dasturni o‘zingiz mustaqil ravishda olnating?
3. Dasturni ishga tushirish ketma-ketligini aytib bering?
4. Dasturni ishga tushirishning yana qanday usullari bor?

2.2. Interfeys. Dastur oynasi qismlari

Interfeys deganda informatikada dasturdagi turli komponentlai 
va foydalanuvchi oltasidagi o‘zaro aloqani ta’minlovchi vositalar va
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qoidalar yig'indisi tushuniladi. Dreamweaver paketi taklif etadigan 
muomala usuli zamonaviy foydalanuvchi uchun odatiy boiib  qolgan 
1'iafik oynali interfeys prinsiplariga asoslanadi. Dreamweaver paketi 
irsha sinfdagi boshqa dasturlar bilan taqqoslaganda ancha aniq. 
moslashuvchan va shu bilan bir paytda kuchli interfeys hisoblanadi. 
I’alitralar, ko'p sonli klaviatura kombinatsiyalari va menyu qatori uning 
asosiy vositalari hisoblanadi. Barcha operatsiyalar to'xtatilgach ekranda 
qoladigan oynalarni palitralari (Palette) yoki panellar (panel) deb atash 
(|ahul qilingan. Ekranning maxsus ajratilgan pozitsiyalarida emas, balki 
isliyoriy joyida joylasha oladigan oynalar ko'chib yuruvchi palitralar 
(lloating plette) deb ataladi. Dreamweaver dasturi muloqot oynalarining 
ko'pchiligi ko'chib yuruvchi palitralar ko‘rinishida ishlaydi. Palitralar 
\.i panellar orasidagi kichik farqlar dasturni tavsiflash uchun sezilarli 
ahamiyatga ega emas. Shuning uchun kelgusida bu atamalarni 
unonimlar sifatida qoilaymiz.

Deyarli barcha palitralar birlashish xususiyatiga ega. Bu har xil 
palitralarni bitta muloqot oynasida joylashtirish mumkinligini bildiradi. 
I liiiashtirish amali turli mavzu yoki buyruqlarga tegishli boshqaruv 
vositalariga ega boigan ko‘p funksiyali terma palitralarni olish 
imkoniyatini beradi. Birlashish xususiyatiga ega boigan palitralarni 
iular dasturda ko'pchilikni tashkil etadi) modulli (dockable) palitralar 
ili'li ataymiz. Bir nechta alohida modullardan iborat murakkab palitralar 
lei ilia (tabbed) palitralar deb ataladi.

2.!-rasmda to'rtta ochiq muloqot oynali dasturning tashqi ko‘rinishi 
kursatilgan. Boshqaruvning eng talab qilinuvchi vositasi so‘zsiz, 
I’mperties inspector (xossalar nazoratchisi) palitrasi hisoblanadi. Uning 
yordamida HTML sahifalarida obyektlarni formatlash va HTML 
.aliifasidagi obyektlarni tahrirlash bo‘yicha ko‘plab amallar bajariladi. 
Ikliavieros (rejimlar) palitrasi -  bu modul ko‘chib yuruvchi palitraga 
ui isol boiadi. Dreamweaver dasturi turli loyiha masalalarini hal qilishga 
mn'ljallangan obyektlarga ega.

Kasmda ikkita oddiy modulli Layers va History palitralardan 
llmrat boigan terma palitraga misol keltirilgan. Objekts palitrasi 
lii'.liqi obyektlar: rasmlar, jadvallar, qatlamlar, freymlar va boshqa 
obyektlarni qo‘yish uchun moijallangan. Rasmda ko‘rsatilgan boshqa 
liui elm boshqaruv elementlari hujjat oynasining ajralmas tashkil etuvchi
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2.1-rasm. Dastur oynasin ing ko‘rinishi.

qismi hisoblanadi. Texnik tizimlarning ishonchli ishlashi, dasturiy 
mahsulotlarni interfevslarining qulayligi asosida to‘g‘ri tashkil qilingan. 
Dreamweaver paketi formatlash va tahrirlashning deyarli barcha 
asosiy buyruqlari uchun amalga oshirishning bir necha xil usullarini 
taklif etadi. Keng formatli ekranlarning egalari barcha buyruqlami 
palitralar va panellar yordamida bajarishlari mumkin. Bundan mahrum 
foydalanuvchilarga esa dastur menyu qatori buyruqlarini va klaviatura 
tugmalari kombinatsiyalaridan foydalanishadi.

70



H ujjat oynasi

Hujjat oynasi -  bu gipermatnli hujjatlar yaratiladigan ish may­
doni hisoblanadi (2.2-rasm), U HTML sahifasi o‘z ichiga olgan 
matnlar, rasmlar, jadvallar, shakllar va boshqa obyektlarni saqlaydi. 
I >reamweaver, WYSIWYG sinfiga kiruvchi tahrirlagich dastur 
hisoblanadi. Bu uzun atama inglizcha W hat you see is what you 
net (siz nimani ko‘rayotgan boisangiz shuni olasiz) iborasining bosh 
harflaridan tuzilgan. Bu narsa HTML sahifasining hujjat oynasida 
aks ettirilishi uning yanada ommaviyroq ko‘rib chiqish dasturlari 

Microsoft Internet Explorer va Netscape Navigator brauzerlarida 
il'odalanishidan uncha farq qilmasligini bildiradi. HTML kodlari 
bilan to‘g‘ridan-to‘g‘ri ishlash yuqori professionallik hisoblanishiga 
qaramay, hatto eng tajribali WEB-dizayner ham grafik interfeys va 
WYSIWYG rejimida hujjat yaratishda beradigan qulayliklardan voz 
kecha olmaydi.

Ko‘pchilik Windows ilovalaridan farqli ularoq Dreamweaver dasturi 
bitta dastur oynasida bir necha hujjatlar bilan ishlay olmaydi. Tanlab 
nlingan parametrlarni o‘rnatishdan kelib chiqib yangi hujjat dasturning 
alohida oynasiga joylashtiriladi yoki joriy oynada avval ochilgan hujjat 
" mini egallaydi. Bunday ish rejimida dastur oynasi va hujjat oynasi 
orasida deyarli farq yo‘q. Shuning uchun ham biz kelgusida bu nomlarni 
Miionimlar sifatida ishlatamiz.

ж а а ж ш в ш ж а * м »  а ш а
File Edit V iew Insert Modify Text Commands Site W indow Help

*| , 1 -  I Title: Untitled D ocum ent
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2.2-rasm. Hujjat oynasi.
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Ish rejimlari

WYSIWYG rejimida gipermatnli hujjat yaratish oddiy matn mu- 
harriri bilan ishlashdan ko‘p farq qilmaydi.

Matnni kiritish va formatlashning bazaviy amallari, obyektlarni 
joylashtirish buyruqlari, navigatsiya va tanlash texnikasining barcha 
amallari Dreamweaver dasturida so‘nggi bir necha yil davomida 
vizual muhitda ustunlik qilish usulida amalga oshirib kelinmoqda. 
Foydalanuvchi loyihalash yechimlarini HTML tili vositalari tomonidan 
qanday yoiga qo'yilishi haqida o‘ylab o'tirmasdan tahrirlash va 
formatlashning odatdagi vositalaridan foydalanib ishlashi mumkin. 
Dreamweaver paketi dastlabki matnni avtomatik ravishda yaratadi, 
unda hujjatning ma’lumot bilan to‘ldirilishi va ro’yxatga olinishi bilan 
gipermatnni belgilash tilining kodlari yoziladi.

Yaratuvchanlik ishining katta qismi WYSIWYG rejimida baja- 
rilishi mumkinligiga qaramay ba’zan to‘g‘ridan-to‘g‘ri kodlashga 
murojaat qilishga to 'g 'ri keladi. Buning bir nechta sababi bor. Asosan. 
bu belgilash kodlarini juda ehtiyotkorlik bilan sozlash zarurligidir. 
Bundan tashqari HTML tili standartida yuzdan ortiq deskriptorlar 
haqida eslatib o‘tiladi. Ularning har biri bir nechta atributlar va 
modifikatorlarga ega boiishi mumkin. Gipermatnli belgilashning 
eng ko‘p talab qilinadigan vositalari Dreamweaver tizimi interfeysi 
doirasida joylashtirilgan.

Dreamweaver dasturining hamma versiyalari, birinchisidan boshlab. 
foydalanuvchiga belgilash kodlarini to‘g‘ridan-to‘g‘ri tahrirlash imkonini 
beradi. Bu ish uchun qanday vositalar qoilaniladi?

Birinchidan, bu maxsus ichiga qurilgan Code Inspector (kodlar 
inspektori) tahrirlagich boiib, u Dreamweaver dasturini eng bi­
rinchi versiyalarida ham mavjud edi va bu oxirgi versiyalarda vaqt 
davomida faqatgina dizayniga o‘zgartirishlar kiritildi. Ikkinchidan, 
foydalanuvchi HTML tiliga tashqi tahrirlagichlarni ulash imkoniyatiga 
ega. Turli dasturlar: universal vazifali (masalan, Bloknot) oddiy matn 
tahrirlagichlaridan boshlab. to murakkab gipermatnli hujjatlar bilan 
ishlashga moijallangan (Allaire Home Stile) yuqori darajali dastur 
vositalarigacha bu rolni bajarishi mumkin. Dasturning MX versivasida 
juda qulay yangilik -  hujjat oynasining ish rejimi paydo boiadi. Hujjat 
oynasi uchta rejim yoki ko‘rinishlardan birida boiishi mumkin.
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2.3-rasm. Belgilash rejimidagi hujjat oynasi Code and View 
(belgilash va rejalashtirish rejimi). Bu aralash rejim bo‘lib, unda hujjat 
oynasi ikkita qismga bo'linadi. Bir qismda gipermatnli belgilash kodlari 
aks etadi. boshqasida dastur sahifani barcha obyektlar va formatlash 
atributlari bilan rejalashtirishni ko'rsatadi. 2.4-rasmda bo'sh sahifali 
ajratilgan hujjat oynasi ko'rsatilgan.

Ish rejimini o‘zgartirishning bir necha usuli bor. Birinchidan, bu 
menyu qatori buyruqlari: View > Code, View -  Design, View -  Code 
and Design. Ikkinchidan, uskunalar panelida bir rejimidan boshqasiga 
tez o'tish imkonini beruvchi tugmalar bor. Va nihoyat, Ctrl + Tab 
tugmalar kombinatsiyasi yordamida rejalashtirish rejimidan belgilash 
rejimiga va aksincha, yoki ajratilgan oynaning bir qismidan boshqasiga 
o'tish mumkin.

Ajratilgan hujjat oynasi qismlarining o'lchamlarini o‘zgartirish 
mumkin. Buning uchun ko'rsatkich yordamida ajratuvchi chiziqni 
ko‘chirish kerak bo‘ladi. Oxirgi paytlarda dasturchilar orasida «dastlabki 
matn» atamasi paydo bo‘ldi. Yuqori saviyali dasturlash tilida yozilgan 
dastur ishlab chiqishning dastlabki bosqichlarida shunday deb ataladi. 
Bu atama gipermatnli hujjatning kodli qismi va ko‘rinadigan obrazi

2.3-rasm. Hujjatning belg ili rejimida ko'rinishi.
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2.4-rasm. B o ;sh sahifali hujjatning aralash rejimda ko'rinishi.

o‘rtasida mavjud boigan munosabatlardan tashkil topadi. Hujjatning 
HTML tilida yozilishini dastlabki matn deb ataymiz.

Menyu qatori

Menyu qatori -  bu Windowsning ixtiyoriy ilovasining zaruriy 
atributidir. U buyruqlar yordamida, muloqot oynalariga, tugmalarga 
yo‘l ochadi, ular yordamida hujjat yaratish, dasturni sozlash. 
vizuallashtirish jarayonini boshqarish kabi dasturning barcha 
funksional imkoniyatlarini o'z ichiga olgan samarali ishlar bajariladi. 
Menyu qatorining har bir bandi vazifasi jihatidan bir-biriga yaqin 
kiritilgan menyu va kichik menyular ierarxiyasini hosil qiluvchi 
buyruqlar guruhini birlashtiradi. Bu bandlarning qisqacha tavsifini 
keltiramiz.

• File menyusi (Файл) fayllar bilan bogiiq buyruqlarni, gipermatnli 
hujjatlar shablonlari bilan ishlash, eksport qilish, import qilish va 
brauzer dasturlarida ko‘rish buyruqlarini o‘z ichiga oladi.

• Edit (Правка) menyusiga tahrirlash va qidirish bilan bog‘liq 
buyruqlar kiradi.
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• View (Вид) menyusi interfeysning yordamchi elementlarini 
va gipermatnli hujjat obyektlarining ko‘rinishlari ustida ishlovchi 
buyruqlarni o‘z ichiga oladi.

• Insert (Вставка) menyusiga har-xil obyektlarni import qilish 
huyruqlari kiradi: rasmlar, jadvallar, shakllar, qatlamlar, maxsus belgilar 
va boshqalar.

• Modify (Изменить) menyusi o‘z ichiga gipermatnli hujjat 
obyektlari atributlarini o‘zgartirish buyruqlarini oladi.

• Text (Текст) menyusi matnli fragmentlarni hosil qilish va ularni 
lormatlash bilan bog‘liq buvruqlarni o‘z ichiga oladi.

• Commands (Команды) menyusi gipermatnli hujjatlarni avtomatik 
4.iyta ishlash buyruqlarini o‘z ichiga oladi.

• Menyu qatorining Site (Сайт) boiim i sayt bilan ishlash vositalari 
va gipermatnli hujjatlar bilan bogiiq  murakkab tizimlar vositalarini o‘z 
ichiga olgan.

• Window (Окно) menyusi dasturga tegishli palitralar, panellar va 
muloqot oynalarini o‘rnatish va aksincha olib tashlash bilan bogiiq 
buyruqlarni o‘z ichiga oladi.

• Help (Справка) menyusida dasturdan foydalanish haqidagi 
interfaol m aiumotlarni chaqirish, elektron qoilanm ani chaqirish kabi 
buyruqlar joylashgan.

Uskunalar paneli

Uskunalar paneli dasturning asosiy dispetcherlik pulti vazifasini 
bajaradi (2.5-rasm). U eng ko‘p ishlatiladigan buyruqlar va tahrirlash 
icsurslarini chaqirish tugmalarini birlashtiradi. Bu ixchamgina panel 
kiritilgan menyu va kichik menyular tizimi navigatsiyasi bilan bogiiq 
sarf-harajatlarni anchagina qisqartiradi.

Unda joylashgan barcha boshqaruv elementlarini sanab o'tamiz 
ichapdan o'ngga):

• Code View (Режим разметки) -  gipermatnli hujjatning faqat 
belgili kodlari tasvirlanadi (dizayni tasviiianmaydi).

I 'i'P a l |  ИЦЦ I Title: U ntitled  D ocum en t < 0 tf, | О  { } „  50 „

2.5-rasm. Uskunalar paneli.
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• Code and Design View (Режим разметки и планировки) 
Tugmasi bosilganda hujjat oynasi ikki qismga ajraladi: birinchi oynada 
belgili kodlar beriladi, ikkinchi oynada esa gipermatnli sahifaning 
dizayni, ya'ni tashqi ko'rinishi beriladi.

• Design View (Режим планировки). Dasturda ishlashning vizual
-  WYSIWYG rejimiga o‘tish tugmasi.

• Title (Заголовок) -  bu matnli maydon hujjatning sarlavhasini 
kiritishga moijallangan.

• File Management (Управление файлами) -  tarmoqda maiumol 
almashish uchun xizmat qiladigan fayllar bilan ishlash buyruqlaridan 
tarkib topgan menyuni ochish tugmasi.

• Preview/Debug in Browser (Просмотр/отладка в браузе­
ре) -  tugmasi gipermatnli hujjatni ko'rish va undagi Java Script 
kodlarini tanlangan brauzerda ishlash yoki ishlamasligini tekshiruvchi 
buyruqlaridan iborat menyuni ochadi.

• Refresh Design View (Обновить страницу) -  bu buyruq beril- 
gandan so‘ng, hujjatning belgili matnlarida boigan barcha o‘zgarishl;u 
loyihalash rejimiga uzatiladi. Ana shu vaqtda kodlarni interpritatsiyasi 
va sintaksik tekshiruv boshlanadi. Xato fragmentlari sariq rangda 
ko‘rsatiladi. To*g‘rilari esa sahifada tasvirlanadi.

• Reference (Справка) -  tugmasi elektron maiumotli qoilanmani 
ekranga chiqarib beradi. Bu qoilanmada gipermatnli belgilash tili 
deskriptorlari ifodalangan.

• Code Navigation (Навигация по кодам) -  tugmasi Java Script 
tilida yozilgan belgili kodlarni tuzatishni boshqaruv buyruqlaridan 
tarkib topgan menyuni ochadi.

• View Options (Параметры отображения) -  tugmasi hujjat 
oynasining qo‘shimcha elementlari vizualizatsiyasini boshqaruvchi buy­
ruqlar menyusini ochadi. Bu menyuga asosiy menyu qatoridagi View 
menyusining bir necha buyruqlari kiradi.

Sahifalar oicham larini belgilash

Virtual to;plam hech qanday tartib-qoidalarga va standartlarga 
bo‘ysunmasdan, tarqoq holda rivojlanadi. Bu esa ishlab chiquvchilar 
va dasturchilar uchun ko'p sonli qiyinchiliklar manbai boiishi
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Internet almashuvi»ning juda tez 0‘sishi sabablaridan biridir. Aslida 
iiliil'aga yoki saytni ishlayotganda muallif o‘z asarini turli kompyuter 

ii/milarida aks etishi mumkinligini yodda tutishi kerak. Agar u tashrif 
hivuruvchilarini (foydalanuvchilarini) yo‘qotishni istamasa, u holda har 
\il oichamli va har xil texnologiyalarni qoilovchi (elektron-nur trubka 
Iw/asida boiishi shart emas) monitorlarda hujjatning aniq va qisqa 
iliulalanishi haqida o‘ylab ko‘rish kerak.

Onlaynli hujjatlarni ko'rib chiqishda brauzer oynasi oichamlarini 
и /gartirishga majbur qiluvchi boshqa sabablar ham bor. Har bir savodli
■ и >on o'qish tezligi boshqa sabablardan tashqari qator uzunligiga ham 
hoc liqligini tushunadi. Agar qatorlar biror me’yordan sezilarli farq qilsa 
ni|ilganning qabul qilinishi murakkablashadi. Psixologik tadqiqotlar 
korsatishicha, matn qatorining optimal uzunligi alfavit simvollari 
Mini bilan uzviy bog‘liq. Qulay o'qish zonasini aniqlash uchun alfavit
0 Ichamini 1,5 dan 2 gacha qiymatni qabul qiladigan koeffitsiyentga 
lui'paytirish kerak. Bu narsa rus tilida matn qatorlari 70 simvoldan 
п/un boimasligini bildiradi. Ko‘p foydalanuvchilar bunday formulaning 
mavjudligi haqida o‘ylab ko‘rmaydilar va xaddan tashqari uzun qatorlar 
piiydo boiishining oldini olish uchun brauzer oynasining oichamlarini
1 lick lab qo‘yadilar.

Dreamweaver paketini yaratuvchilari dasturni turli oichamdagi 
monitorlarda hujjat qanday koiinishga ega boiishini tasavvur qilish 
imkonini beruvchi maxsus vosita bilan ta'minlab qo'yganlar.

Holat qatorining o‘rta qismida (2 .2-rasm) hujjat oynasining joriy
о Ichamlari piksellarda chiqariladigan maydon joylashgan. Birinchi 
■on-kenglik qiymatini, ikkinchi son balandlikni oicham ini ifodalaydi. 
At’ar maydonning ixtiyoriy nuqtasida sichqoncha tugmasini bosilsa, u 
holda Windows va Macintosh platformalarida hisoblash tizimlarining 
nig ommaviy konfiguratsiyalari uchun vettita standart oichamga 
nia boigan yetti muloqot oynasi chiqadi. O icham ni belgilash uchun 
oynaning tegishli qatorini tanlash yetarli.

Menyuning birinchi bandi hujjat sohasining 592 pikselga teng 
boigan kengligini belgilaydi va sohaning joriy balandligini o‘zgarishsiz 
c|oldiradi. Edite Sizees (Oicham larni to‘g‘rilash)ning oxirgi bandi 
hujjat oynasining oicham larini tanlash va ularni standartlar ro‘yxatiga 
klritish imkonini beradi. Ekranda Preferences (Sozlashlar) muloqot
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oynasi paydo boiadi, unda Width (kenglik, eni) maydonida kenglik, 
HEIGHT (balandlik) maydonda esa soha balandligi belgilanadi. 
Yangi standartning matnli tavsifi Description (tavsiya) maydonida 
ko‘rsatiladi.

Barcha oicham lar dastur oynasining xizmat elementlarini: o‘lchov 
chiziqlari va menyu qatorini inobatga olmasdan hisoblab chiqiladi. 
Faqatgina hujjat va uning obyektlari uchun ajratilgan ishchi soha 
hisobga olinadi.

Palitra va tez yuklanish paneli

Tez ishga tushirish palitrasi (Launcher) -  bu asosiy muloqot 
oynalari va dasturlar panellarini ekranga chiqarish uchun moijallangan 
yordamchi, xizmatchi palitra. Palitrani aks ettirish uchun Windows > 
Launcher buyrugini bajarish kerak. Bu buyruqning takroran bajarilishi 
palitrani ekrandan olib tashlaydi.

Palitraning Launcher (tez ishga tushirish) tugmasini bosish natija­
sida ekranga shu nomdagi muloqot oynasi chiqadi. Agar ochilgan 
palitra ekranning oldingi qavatida joylashgan boisa, buyruq tugmasini 
takroran bosish uni yopilishiga olib keladi. Agar faol palitra hech 
boimaganda qisman boshqa obyektlar bilan to‘silgan bo‘lsa, u oldingi 
qavatga o‘tadi.

Palitra yettita eng ko‘p talab qilinadigan dastur komponentlarining 
tez ishga tushirish tugmalarini birlashtiradi:

Site (Сайт) -  katta saytlarni boshqarish uchun muloqot oynasi, 
murakkab kesishuvli bog‘lanishlarga ega gipermatnli hujjatlar tizimi 
uchun moijallangan.

• Assets (Библиотека) -  bu nom harfma-harf tarjimada faollar 
yoki fondlar ma’nolarini beradi. Bu panel dasturda kutubxona rolini 
o‘ynaydi. U gipermatnli hujjatlar dizayniga tegishli elementlarni o'zida 
saqlaydi. Bu elementlarga: tasvirlar, ranglar, tashqi bogianishlar, Flash
-  roliklari, shablonlar va boshqalar kiradi.

• HTM L Styles (Стили HTML) -  bu palitra matnli qator va 
abzatslar uchun HTML belgili stillar bilan ishlashga moijallangan.

• CSS Styles (Каскадные листы стилей) -  bu palitra stillarni 
kaskadli sahifalar bilan boshqarish uchun xizmat qiladi. Keyinchalik 
bu jumlani «ierarxik stillar spetsifikatsiyasi» ko^rinishida ham 
qoilaymiz.
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• Behaviors (Режимы) -  palitrasi gipermatnli sahifalarni inter- 
laolligini boshqarish vositalarini o‘zida birlashtirgan. Senariy sahifani 
ko'rish jarayonida ro‘y beradigan hodisalar asosida quriladi. Bu 
jtirayonning chizmasida ko‘plab interfaol effektlar yig'iladi: oddiy 
animatsiyalashgan tugmalardan tortib ma’lumotlar bazasini qayta 
ishlashning murakkab protseduralarigacha.

• H istory (Предыстория) — palitrasi foydalanuvchining HTML 
hujjatni tahrirlashdagi xatti-harakatlarini yozib boradi va saqlaydi. 
lahrirlash  jarayonidagi operatsivalarni bekor qilish imkonini beradi va 
ayrim zanjirli ketma-ketliklarni buyruq ko'rinishida saqlaydi.

• Code Inspector (Инспектор кода). Dasturning eng muhim 
palitralaridan biri. HTML kodining ichki tahrirlagichi bo‘lib Dream- 
ueaverning grafikli rejimiga o'zaro bogiangan.

Tez ishga tushirish palitrasining o‘ng tomondagi pastki burchagida 
10‘g‘ri burchakli tugma joylashgan. Bu vosita palitraning yo‘nalishini 
n’/gartirishga moijallangan. Tez ishga tushirish palitrasini o‘zgartirish 
mumkin. Buning uchun Edit > Preferences buyrugini berish kerak. 
Dasturning asosiy sozlashlariga ega boigan muloqot oynasi ochiladi.
1 nda Panels (panellar) kategoriyasini tanlab oling va palitra ichidagi 
Show in Launche (tez ishga tushirish palitrasida ko‘rsating) boiim ida 
beriladigan vositalar yordamida o‘zgartiring. Holat qatorining o’ng 
.(isinida (2 .2-rasm) joylashgan.

Kontekstli menyu

Kontekstli menyu Windows operatsion tizimining boshlovchi 
loydalanuvchilari uchun ham yaxshi tanish. Boshqaruvning bu 
standart usuli ushbu operatsion tizimi boshqaruvida ishlovchi 
ko'pchilik ilovalar (dasturlar) tomonidan ko'p qoilaniladi. Uning 
mohiyati sodda. Sichqonchaning o‘ng tugmasini hujjat oynasining 
ohyekti ustida bosilsa, ekranga obyekt turiga bogiiq  boigan 
mazmundagi menyu chiqadi. Bu menyuda shu obyektga tegishli yoki 
ushbu holatda talab qilinishi ko'proq ehtimolligi bor boigan buyniqlar 
to'plangan.

Dreamweaver dasturining barcha versiyalarida kontekstli menyu 
mavjud. Kontekstli menyuning oicham i ya’ni buyruqlari safi kengaydi, 
qo‘shimcha darajalarga ega boidi va endi har qanday holatda

79



Paragraph Format
List
Align
Font
Style
CSS Styles 
Size

Templates ►

Element View ►

Edit Tag < b o d y > ... 
QuickTag Editor... 
M ate Link

Shift+F5

Target Frame ►

Create New  Snippet
...-.........—

Paste
Paste Special,..

Ctrl+V

Design Notes for P ag e .,. 
Page Properties...

2.6-rasm. K ontekstli menyu.

chaqirilisbi mumkin. 2 .6-rasmda oyn;i 
ixtiyoriy bo;sh nuqtasida sichqonchaning 
o‘ng tugmasi bosilsa dastur chiqarih 
beradigan kontekstli menyuga misol 
keltirilgan.

Property Inspector palitrasi

Property Inspector (Инспектор 
свойств) palitrasi -  bu dasturning aso­
siy uskunasidir. HTML sahifasiihi 
joylashgan obyektlar atributlarini o"/- 
gartirish ishlarining asosiy qismini 
uning yordamida bajariladi. (2.7-rasm).

Property Inspector palitrasi ko'chih 
yuruvchi palitradan iborat boiib. uning 
tarkibi bajarilayotgan operatsiyaga, tan- 
langan obyekt turiga va kursorniii}.’ 
holatiga qarab, mos ravishda o‘zgarib 
turadi. Palitrani ekranga chiqarish uchun 
quyidagi Window > Properties (Окно
> Свойства) buyruqni berish yoki 
CTRL+F3 tugmalar kombinatsiyasim 
bosish kerak. Bu buyruqni qaytadnn 
berish palitrani ekrandan olib tashlaydi.
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Palitraning asosiy maydonlari va tugmalarini sanab o‘tamiz. 
I’.ilitraning shu boshqaruv elementlari matnni formatlash va gipermatnli 
bogianishlarni hosil qilishga tegishli vazifalarni o‘z ichiga oladi:

• Format (Формат) ro‘yxati matnning standart strukturali tiplaridan 
Imi ini tanlash imkonini beradi (1).

• Link (Ссылка) ushbu hujjatga tegishli giperbog‘lanishlar 
10'yxatini o‘zida saqlaydi. Flar bir bog‘lanishni bir necha marta qoilash 
mumkin. Ya’ni bir marta tuzilgan bog‘lanishni, boshqa faol hududlarga 
h.im takror qoilash mumkin (2).

• Matn fragmenti shriftini belgilash imkonini beradi. Bu ro‘y- 
lining punktlari shriftlar to'plamidan iborat boiib, qoilanilishiga

11 и rab joylashgan (3).
• Size (Размер) ro‘yxati shrift oichamini tanlash uchun m oi- 

inllangan (4).
• Standart ranglar palitrasini chaqirish tugmasi. Bu palitra tan-

l.mgan matnli fragment rangini tanlash imkonini beradi (5).
• Tanlangan rangning kodi tasvirlangan yoki kiritiladigan maydon

(6).
• Shriftni holatini tanlash tugmasi. Ko‘rinishi va funksiyasi standart 

boshqa dasturlardagidek (7).
• Matnni tekislash tipini tanlash tugmalari (8).
• Interfaol yordamni chaqirish tugmasi (9).
• Marker-ko'rsatkich. Uni tegishli fayl yoki simvolga surish bilan 

gipermatnli bogianish hosil qilinadi (10).
• Select File (Выбрать файл) muloqot oynasini ochish tugmasi.

I nyliar tizimida harakatlanish va gipermatnli bogianishlarni asosi 
boiib xizmat qiladigan hujjatni tanlash (11).

• Target (Назначение) ro‘yxati gipermatnli bogianishda ko'r- 
.ililgan hujjatni ekranda yuklanish usulini tanlash imkonini beradi. Shu

boiimda havolali hujjat chiqish oynasi yoki freymni belgilanadi (12).
• Ko‘pchilik tahrirlagich dasturlarda standart ko‘rinishda, matnli va 

IП ML, ro‘yxatlarni belgilash va nomerlash tugmasi (13).
• List Item (Раздел списка) tugmasi List Properties (Свойства спи- 

ка) muloqot oynasini ochish uchun ishlatiladi. Bu oyna barcha tipdagi
ro'yxatlarni tahrirlashga moijallangan (14).

• Ikkita tugma, matnli fragmentlarni gorizontal surilishini bosh- 
i|aradi (15).
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• Kodlarni ekspress-tahrirlash oynasini chaqirish tugmasi (16).
• Expander arrow (Расширение) palitra oicham larini o'zgartirish 

uchun xizmat qiladi. Uning yordamida Property Inspector (Инспектор 
свойств) palitrasini ochish va yopish mumkin (17).

Property Inspector paneli yordamida bajariladigan buyruqlarning 
ko‘pchiligi qayta ishlanayotgan obyektlar: rasm, matn yoki jadvallarga 
tegishlilari paydo boiadi. Xossalar panelida harakatlanish uchun TAB 
tugmasini bosish yoki kerakli qismga sichqonchani chap tugmasini 
bosish kerak. Tanlangan boiim da kerakli ko‘rsatkichni kiritib, ENTER 
tugmasini bosish uni oinatilishi uchun yetarli.

Property Inspector panelining ko‘plab boshqaruv elementlari 
o‘zida matnli yoki raqamli maydonlar kombinatsiyasi va bekiladigan 
ro‘yxatlaridan iborat. So‘ralgan qiymatni klaviaturadan terish yoki 
menyudan tanlash yo ii bilan tegishli parametrlarni o'rnatish uchun eng 
qulay usul hisoblanadi.

Dreamweaver o‘zining bir qancha qo'shimcha funksiyalari bilan 
foydalanuvchilarga manzur boidi: birinchidan, Dreamweaver barcha 
palitralari erkin holatda turadi. Ularni qayerga surib qo‘ysangiz 
o‘sha joyda joylasha oladi. Bu esa monitorning ish maydoni xududini 
boshqaruvning xizmatchi elementlari va hujjatning oynasiga eng 
optimal boiish imkonini beradi. Ikki monitorli tizimda ishlaydigan 
foydalanuvchilar barcha yordamchi oyna va palitralarni bitta monitorga 
joylab, ikkinchisida esa hujjatlar bilan ishlashi mumkin. Ikkinchidan, 
dastur palitralari birlashish xususiyatiga ega. Uchinchidan, barcha 
ochiq palitralarni dastur ish stolidan olib tashlovchi buyruq mavjud. 
Bu operatsiyalarni F4 tugmasini bosish bilan ham bajarish mumkin. Bu 
tugmani takror bosish esa yana tiklash imkonini beradi.

Obyektlar palitrasi

Faqatgina eng oddiy gipermatnli hujjatlar o'zida havola bo‘yicha 
boshqa hujjatlarga o‘tuvchi buyruqlar biriktirilgan gipermatnli 
fragmentlarni birlashtiradi. Ammo ko‘pchilik zamonaviy HTML 
sahifalari multimedialashib bormoqda. Ya'ni ularning tarkibiga quyidagi 
tashqi obyektlar kiradi: multimediali fayllar, ijro etish vositalari, 
kartinkalar, animatsiya fayllari va boshqalar. Objects (Палитра объек-
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2.8-rasm. Obyektlar palitrasi.

i o b )  palitrasi ana shunday tashqi obyektlarni yaratish va qo‘yish uchun 
x i/mat qiladi. Bu palitrani ekranga chiqarish uchun Window > Objects 
(Окно > Объекты) buyrug‘ini bajarish kerak. Xuddi shu buyruqni 
klaviaturadan CTRL +F2 tugmalar kombinatsiyasini bosish bilan ham 
berish mumkin. Bu buyruqni takror berish palitrani ekrandan olib 
lashlaydi.

Palitra yettita nomdagi qismlardan iborat. Bular: Characters, Com­
mon, Forms, Frames, Head, Invisibles, Special.

• Characters (Специальные символы). Klaviaturada uchramay- 
digan maxsus simvollarni qo'yish (savdo markasi, kopirayt va bosh- 
qalar).

• Common (Общие) -  bolim i eng ko‘p qoilaniladigan obyektlarni 
birlashtiradi. Bu jadvallar, rasmlar, gorizontal chizg‘ich. joriy ka- 
lendardagi sanalar va boshqalar.

• Forms (Формы). Formalar va elementlar, ularning tashkil qiluv- 
chilari: yoqib-o'chiruvchilar, ro‘yxatlar, matn maydonlari va boshqalar.

• Frames (Фреймы). Freymlar tizimini yaratish. Har xil 
ko'rinishdagi freymlar qismlaridan tarkib topgan freymlar tizmini hosil 
qilish. Ya’ni yaratilayotgan saytni sahifasini freymlarga bo'lib olish.

• Head (Заголовок) -  gipermatnli hujjatning sarlavha qismiga tav- 
sif berish.

• Invisibles (Скрытые объекты). HTML sahifani brauzer dastur- 
larida namoyish qilishda, ko‘rinmaydigan yashirin obyektlarni joylash.
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Bu palitraning eng kichik qismi boiib, u faqat uchta tipdagi obyektlarni 
qo‘shib beradi: simvollari, izohlar va senariylar.

• Special (Специальные объекты) -  bu boiim  o‘zida maxsus 
obyektlarni qo‘yish tugmalarini birlashtiradi. Bularga appletlar, ActiveX 
obyektlari va boshqa tashqi toidiruvchilarni (plagins) kiritish mumkin.

Palitraning pastki qismida ikki guruhga boiingan to‘rtta tugma 
joylashgan: Layout (Компоновка) va View (Вид). Ular maketlash 
rejimiga o'tish va sahifannig strukturasini tezda yaratishga imkon 
beradi. Bu elementlar bilan qisqacha tanishib o'tamiz:

• Draw' Layout Cell (Создание макетной ячейки) -  maketli ka- 
takcha yaratish uskunasini faollashtiradi.

• Draw Layout Table (Создание макетной таблицы). Maketli 
jadval yaratish uskunasini faollashtiradi.

• Standard View (Стандартный режим). Hujjat bilan ishlashning 
standart rejimiga o‘tish.

• Layout View (Режим макетирования) -  Hujjatni maketlash reji­
miga o'tish.

Ushbu boiim ni nomi palitra sarlavhasi qatori ostida tasvirlanadi. 
Boiim ni ochish uchun shu nomni sichqoncha chap tugmasi bilan 
bosing. Ochilgan menyudan foydalanuvchi kerakli qismni tanlashi 
mumkin. Palitraning ayrim boiim larida hamma tugmalar ham 
tasvirlanmaydi. Masalan, Common (Общие) boiim i yigirmaga yaqin 
tugmani o‘z ichiga oladi, ularning hammasi ham palitra oynasiga 
siginaydi. Boshqa tugmalarni ko iish  uchun prokrutkadan foydalanish 
(prokrutkani vazifasini palitraning chetida joylashgan strelkali tugmalai 
bajaradi) yoki muloqot oynasining oicham ini kattalashtirish kerak.

Aksariyat hollarda obyektlarni qo‘yish uchun qo‘shimcha para- 
metrlarni kiritishga to'g'ri keladi. Bunday holatlarda ekranda foy­
dalanuvchi tanlashi yoki m aium ot kiritishi mumkin boigan muloqot 
oynasi paydo boiadi. Bu oynaga foydalanuvchi obyektning kerakli 
obyektlarini tanlashi yoki kiritishi kerak.

Kodlar nazoratchisi bilan ishlash

Ko’p sonli HTML tahrirlagichlari sinfi orasida Dreamweaver dasturi 
gipermatnli hujjatlar kodlari bilan ishlash imkoniyatlari jihatidan keskin
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In rq  qiladi. Foydalanuvchining HTML kodlarni qo‘lda tahrirlashdan 
i|utilishi eng katta yutuq va tezkorlikni ta’minlab berdi.

Kodlar bilan to‘g‘ridan-to‘g‘ri ishlash, yashirin xatolarni iden- 
I ili katsiya qilish, ortiqcha kodni bartaraf etish, gipermatnning 
lanlangan fragmentiga tezkor o‘zgartirish kiritish, hujjatning struk- 
turasini yoki uning formatlanishini optimallashtirish imkoniyatlari 
mavjud.

Dreamweaver paketi tarkibida gipermatnli hujjatlarni belgilash 
kodlarini ko‘rish va tahrirlashga moijallangan maxsus vositasi mavjud. 
I)u vosita Code Inspector (Инспектор кода) deb nomlanadi. Uni 
<|iiyidagi usullar bilan o‘rnatish mumkin: birinchidan, Window > Code 
Inspector (Окно > Инспектор кода) buyrugini berish yoii bilan, 
ikkinchidan, bu F10 tugmasini bosish yo ii bilan. Bu buyruqlar takror 
hosilganda Code Inspector yana ish stolidan yo‘qoladi.

2.9-rasmda Kodlarni nazorat qilish oynasi koisatilgan. Palitrada 
kodlarning belgilanishini tanishtirishni View Options (Параметры ото­
бражения) tugmasi yordamida ochiladigan buyruqlar boshqaradi. Bu 
huyruqlarni ko‘rib chiqamiz:

[ l.h tm  • Code Inspector r  i

[ fO -C o d e  Inspector)

| С  4 ? »  { } J 1 ,
■ <  1 11 L t> d < >  1 11 L t >  ............... 1

1</HEAD >
< b о dy  b a  ckg  г о u n d =.. /  FO N J PG >
<ul>
<!i)j<b><font face="T im es  N ew  R om an  CYR" size=3><a href="#1 ">2. C 

о зд а н  не w e b -y  з  лa < /a >  </font></b>
</li>
<ul>
< lix fo n t  fa c e -T im e s  N ew  R om an  C YR" $ iz e = 3 x a  href="#2" >2.1. 

П р о е кт и р о в а н и е  </s x / f  ont>
<ul>

_  <!ix fo n t  fa c e ="T im e s  N ew  R om an CYR" s iz e = 3 x a  htgf="#3">C
J  _________________________________________

2.9-rasm. Kodlar nazoratchisi.
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• Word Wrap (Перенос по словам). Kod qatorini ko'chirish rejimi. 
Agar u yoqilgan boisa, HTML tili bayonnomasi tahrirlagich oynasining 
oichamiga yetganda avtomatik ravishda yangi qatorga o‘tadi.

• Line Numbers (Номера строк) -  nomerlashni o‘rnatish buy- 
rug‘i. Agar bu rejim o‘rnatilgan bo‘lsa, har bir qator tartib bilan 
nomerlanadi.

• Highlight Invalid HTML (Пометка некорректных кодов). Bu 
buyruq sintaktik xatoga ega konstruktsiyalarni Property Inspector 
panelida va hujjatning oynasida sariq rangda ajratish rejimini faol­
lashtiradi. Shundan so‘ng Property Inspector xato haqida xabar beradi 
va ayrim hollarda uni tuzatish uchun ko‘rsatmalar beradi.

• Syntax Coloring (Раскраска синтаксических конструкция). Bu 
rejimda belgili kodlar turli xil ranglarga ajratiladi. Bu esa hujjatning 
kiritiladigan matni va belgili kodlarini tez ajratib olishga imkon 
beradi. Bundan tashqari Dreamweaver dasturi HTML tilining har bir 
deskriptori uchun alohida rang belgilash imkoniyatiga ega. Ranglarni 
belgilashning dastur asosiy ko'rsatkichlarini Code Colors (Цвета кода) 
bo‘limida amalga oshiriladi.

• Auto Indent (Автоматический отступ) buyrugi kodlar na- 
zoratchisi oynasiga kiritilgan belgilash diskreptorlari uchun avtomatik 
joy qoldirish rejimini faollashtiradi.

Kodlar nazoratchisi oynasining o‘ng qismida uchburchak formada 
tugma joylashgan. U hujjatning mavjud matnlariga xizmat qiladigan 
buyruqlardan iborat menyuni chaqiradi. Bu buyruqlarni sanab o'tamiz:

• Find and Replace (Найти и заменить). Qidirish va almashtirish 
vazifasini bajaradi.

• Find Next (Найти далее). Avval qidirilgan namunani mavjud 
parametr asosida qidirish. Bunda qidirish va almashtirish muloqot 
oynasi chiqmasdan to'gTidan-to‘g i i  amalga oshiriladi.

• Reference (Справочное руководство). HTML. JavaScript va CSS 
manbalari asosidagi ma’lumotli qoilanmani chaqiradi.

• Set Breakpoint (Вставить контрольную точку). Matn kursori 
pozitsiyasida nazorat nuqtasini belgilaydi.

• Remove All Breakpoint (Удалить все контрольные точки). 
Hujjatning mavjud matnidan barcha nazorat nuqtalarini olib tashlaydi.

• Cut (Вырезать). Tanlangan kodli fragmentni buferga qirqib olish.
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• Сору (Копировать). Tanlangan kodli fragmentni nusxasini bu- 
terga olish.

• Paste (Вставить). Buferga olingan fragmentni qo‘yish.
Kodlar nazoratchisini matn muharriri uchun biroz g‘ayri oddiy 

holda muvaffaqiyatli qoilash mumkin. Dreamweaver dasturi ASCII 
simvollarini qoilash bilan yozilgan fayllarni, masalan oddiy matnli 
I'ayllarni yoki dasturning dastlabki matnini muvaffaqiyatli o‘qiydi. 
Bunday hujjatlar Open (Открыть) buyrugi yordamida ochiladi va kodli 
rejimda ishlaydigan oyna hujjatiga yuklanadi. Bunda dasturning ba’zi 
resurslariga kirish mumkin boim ay qoladi.

Dasturning kutubxonasi

Kutubxonalar -  bu gipermatnli sahifaning dizayniga tegishli ko‘p 
marta qoilaniladigan elementlarni saqlash vositasidir. Bu elementlarga: 
tasvirlar, bogianishlar, matn boiaklari va boshqalar kiradi. Dream­
weaver dasturida esa kutubxonaning ishlash prinsipi biroz boshqacha. 
Dastlab kutubxonaga saqlashning bitta elementi hisoblangan, 
obyekt yoki obyektlarga tegishli gipermatnli belgilash fragmentlari 
saqlanadi. Dreamweaver dasturida kutubxona elementlari maxsus
I ibrary papkasida saqlanadi. Bu papka saytning asosiy papkasi ichida 
joylashadi. Har bir Web-uzel o‘zining standart elementlari va ularni 
saqlash papkasini tashkil qiluvchi shaxsiy kutubxonasiga ega. Ular bilan 
ishlash uchun palitraning Assets (Ресурсы) boiim idan foydalaniladi 
(2.10-rasm). Kutubxonalar bilan boshqarish ishlarining asosiy qismini 
palitraning Assets (Ресурсы) boiim i buyruqlari yordamida amalga 
oshiriladi.

Dreamweaverda kutubxonalarning asosiy imkoniyatlarini sanab 
o'tamiz:

• Kutubxona elementi deb <body> deskriptori orasida yotgan har 
qanday fragmentni aytish mumkin:

• Kutubxona elementlari qoilanilishida cheksiz imkoniyatlarga 
ega. Ularni gipermatnli sahifalarga hech qanday tahrirlashsiz qo'yish 
mumkin;

• Kutubxona elementlariga o‘zgartirish kiritilsa, ularni boshqa 
gipermatnli sahifalar va hujjatlarda qoilashda saqlanib qoladi.
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2.3. Fayllar bilan ishlash

Dasturning fayllarni ochish texnikasi Windows tizimida ishlaydigan 
boshqa dasturlardan farqi yo‘q. Buning uchun File > Open (Файл
> Открыть) buyrugini berish kerak. Bu buyruqni klaviaturadan 
CTRL+0 tugmalar kombinatsiyasini bosish bilan ham bajarish mumkin 
Bundan tashqari dasturda fayllarni ochishning surib kelish usuli ham 
mavjud. HTML fayl belgisini sichqoncha yordamida surib kelib, hujjat 
oynasining ixtiyoriy yeriga tashlansa fayl ochiladi. Dasturda bir vaqtdii 
bir nechta oyna bilan ishlash imkoniyati faqatgina kompyuterning bo‘sh 
xotirasi bilan mos ravishda cheklanadi. Agar dasturda bo‘sh sahifa bilan 
ish boshlangan boisa, u holda yangi fayl har qanday holatda uni o‘rnini 
egallaydi.

Dreamweaver dasturi ochiladigan HTML sahifalarida sintaktik 
xatolarni tekshiradi. Dastur standart HTML gipermatnli belgilash 
tili asosida yozilgan barcha kengaytmali fayllarni ocha oladi. Ularga 
quyidagilar kiradi: .HTM, .HTML, .ASP, .CFM, .CFML, .TXT, .SHTM. 
.SHTML, .STM, .LASSO, .XML, .CSS, .PHP.

Fayllarni saqlash

Dreamweaverda fayllarni saqlash ham Windows tizimining boshqa 
standart dasturlaridagi singari amalga oshiriladi. Buning uchun: File
> Save (Файл > Сохранить) yoki File > Save as (Файл > Сохранить 
как) buyruqlarini berish kerak. Birinchi buyruqni CTRL+S tugmalar 
kombinatsiyasini bosish bilan ham bajarish mumkin. Bu buyruq 
shu nomdagi muloqot oynasini hosil qiladi. Oynada foydalanuvchi 
tomonidan faylning nomi, tipi va saqlash joyi belgilanadi.

Gipermatnli hujjatlar fayllari Windows operatsion tizimida .htm 
kengaytma oladi, Macintosh platformasida esa .html kengaytma oladi. 
Ammo bu kengaytmadagi fayllarni dasturlarda ochish va saqlash 
buyruqlari bajarilishi teng kuchli. Dasturda ochilishi mumkin boigan 
barcha tipdagi fayllar, xuddi shu dasturda saqlanadi ham.

Tabiiy sharoitda yoki ilmiy laboratoriyalarda oiadigan ko‘pgina fizik 
jarayonlar qaytmas hisoblanadi. Bu tabiatshunoslikda olamning butun 
ilmiy manzarasini shakllantiruvchi fundamental qoidalaridan biridir. 
Zamonaviy hisoblash mashinalari insonni bu falsafiy kategoriyadan
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11 .man qutqarishga qodir. Ko'pchilik zamonaviy dasturlar qoniqarsiz 
lulijani bekor qilishga imkon beradi. Ya’ni hujjatning avvalgi holatiga 
i|iivtish, qabul qilingan qarorlarni qadamba-qadam orqaga qaytarish 
imkonini beradi.

Dreamweaver dasturida buning uchun Edit > Undo (Е1равка > От­
мена) buyrug‘ini bajarish yoki CTRL+Z tugmalar kombinatsiyasini 
bosish yetarli.

Dastur bekor qilishni bir nechta o‘zaro bogiangan ketma-ket 
iiilamda amalga oshiradi. Bu ketma-ketlik qadamlarining soni 

<Listurning tegishli ko‘rsatkichida ifodalangan songa teng; odatda bu 
•.on 100 ga teng.

Bu sonni quyidagicha o‘zgartirish mumkin;
1. Edit>Preferences (Правка>Настройки) — buyrugini bering;
2. General (Общие) kategoriyasini oching;
3. Maximum Number of History Steps (Максимальное число 

миисей журнала) maydoniga o‘zingiz saqlamoqchi boigan ketma- 
Uiliklar maksimal sonini kiriting.

Tahrirlash ishlari va buyruqlarini yozish va saqlash foydalanuv- 
l hidan qo‘shimcha hisoblash manbalarini talab qiladi.

Undo (Отмена) buyrugi «eng muhim izlarni» bekor qilish 
imkoniyatini beradi. Ammo bu usul bilan jarayonni bir necha bor 
bajarib «bekor qilish» buyrugidan yaxshi natija olib boimaydi. Chunki 
lining yordamida faqatgina eng muhim izlarni bekor qilish mumkin 
\olos. Bundan tashqari, ayrim buyruqlarni bu usul bilan bekor qilib 
boimaydi. Bekor qilib boimaydigan buyruqlarni orqaga qaytarish 
yoki ancha oldin bajarilgan operatsiyalarni qaytarish uchun File > 
Revert (Файл > Вернуться к сохраненному) buyrugidan foydalanish 
mumkin. Bu buyruq hujjatni oxirgi saqlangan holatini tiklab beradi.

Buyruqni ishlatish yoii oddiy. Qaytarib boimaydigan buyruqlar 
mavjud ketma-ketlikni tiklashga berishdan oldin hujjatni diskka saqlab 
olish kerak. Agar ish yaxshi natija bermasa, u holda Revert (Файл > Вер­
нуться к сохраненному) buyrugi hujjatni o‘sha holatida tiklab beradi.

Dasturda bajarilgan operatsiyalarni takrorlash ham mumkin.
I dit > Redo (Правка > Повторить) buyrugi oxirgi buyruqni yoki 
tahrirlash ishlarini takroran bajaradi. Bu buyruqni CTRL+Y tugmalar 
kombinatsiyasi yordamida ham berish mumkin.
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Shuni esda tutish kerakki, dasturning ish bayonnomasiga faqatgina 
natijaviy operatsiyalar yoziladi, masalan: simvollarni kiritish va 
o‘chirish, obyektlarni qo‘yish, formatlash buyruqlari va boshqalar. 
Faqat shunday holatlarni bekor qilish yoki takrorlash mumkin. Ko‘plab 
yordamchi tipdagi buyruqlarni bekor qilib yoki takrorlab boimaydi. 
Kursorni surish, obyektlarni belgilash, hujjatni saqlash va boshqalar 
shular jumlasidan.

Savol va topishiriqlur:

1. Dasturda fayllarni ochish yobllarini sanab bering?
2. Dastur yordamida qanday kengaytmali fayllarni ochish mumkin?
3. Dasturning fayllarni saqlash usullarini aytib bering?
4. Dasturning bekor qilish va takrorlash imkoniyatlarini sanab bering?

2.4. Web-uzel yaratish

Jahon o‘rgimchak uyasining (World Wide Web) barcha informatsion 
manbalarini ikkita katta sinfga boiish qabul qilingan: sahifalar va 
uzellar yoki saytlar. Biz yuqorida web -  sahifalar ta'rifi bilan tanishdik.

Web-uzellar ya'ni saytlar -  deganda o’ziga sahifalarni birlashtirgan 
tizim tushuniladi. Boshqacha aytganda uzel deganda minglab hujjatlarni 
o‘zida birlashtirgan, ko'psonli bogianishga ega, multimediali murakkab 
tizim tushuniladi.

Dreamweaver paketi -  bu ko'p qirrali dastur. Uni alohida sahifalar 
yaratish uchun oddiy gipermatnli hujjatlar tahrirlagichi sifatida ham 
ishlatish mumkin. Bundan tashqari dastur har qanday murakkablikdagi 
Web-uzellarni ham yarata oladi.

Chiziqli struktura

Kompyuter paydo boigunga qadar barcha chop etiladigan: badiiy 
kitoblar, qoilanmalar, ma’lumotnomalar, texnik koisatmalar chiziqli 
strukturaga misol boia olar edi. Bugungi kunga kelib bularni multimediali 
qoilanmalar va elektron koisatmalar koiinishida qoilanmoqda. 
Chiziqli zanjir elektron magazinda buyurtma berishni rasmiylashtirish 
qadamlari, ayrim tarmoq manbalariga kirish uchun ro‘yxatdan oiish yoki 
rasmiylashtirish ketma-ketliklarini tushunish mumkin.
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2.12-rasm. Chiziqli struktura.

Chiziqli strukturaga kirish nuqtasi bo'lib birinchi sahifa xizmat 
qiladi. Bu bosh sahifa odatda index.htm yoki main.htm deb nomlanadi. 
Hu esa kitob yoki jurnallardagi muqova rolini bajaradi. Bu sahifa bir 
vaqtning o‘zida ham namoyish bob, ham tanishtiruv sahifasi, ham 
miflumotli sahifa bo‘lmog‘i lozim. Qidiruv mashinalari har bir sahifani 
alohida indekslaydi. Shuning uchun barcha ichki sahifalarni bosh 
ahifaga o'tkazadigan harakatlanish tugmalari bilan to‘ldirish kerak.

lyerarxik struktura

Saytlar yaratishning zanjirli prinsipi sahifalar joylashuviga va ular 
orasidagi bir-biriga o‘tishlarga qat’iy cheklashlar qo‘yishga asoslanadi.

%  

U U l - U

2.13-rasm. lyerarxik struktura.
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lyerarxik bo'ysunish prinsipi bo'yicha qurilgan tugunlar ancha katta 
moslashuvchanlikka ega. Ko‘plab korxonalar, tashkilotlar lyerarxik 
struktura chizmasi asosida qurilgan. Bu esa lyerarxik strukturaning 
karnchiliklari va yutuqlari yaxshi o‘rganilganidan darak beradi. Bu 
strukturani ba’zan daraxtsimon struktura ham deyilib, bitta bosh o'zak 
(butun saytga kirish nuqtasi hisoblangan) sahifaga ega bo'ladi.

Har qanday ichki sahifa informatsion manba hisoblanib bosh sahifa 
bilan mantiqiy bog'langan bo‘ladi.

Ko‘p bogianishli strukturada hech qanday cheklanishlar bo‘lmaydi. 
Ya’ni har bir sahifa boshqa barcha sahifalar bilan bogiangan bo'lishi 
kerak. Katta saytlarda tashrif buyuruvchilarning m oljal olishi uchun 
maxsus indeksatsiya tizimlari yoki saytning aylanish kartasi ifodalanishi 
kerak.

Materialning Web-uzelda bo'limlar bo‘yicha taqsimoti mantiqiy 
ravishda amalga oshirilishi kerak. Har bir sahifaga faqat belgilangan 
predmet yoki mavzudagi material joylanishi kerak. Tanlangan

Ko‘p bog‘lanishli struktura

2.14-rasm. K o:p bog'lanishli struktura.

Materialning taqsimoti
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gipermatn ostida aynan shu mavzudagi hujjat borligi foydalanuvchining 
ishonchini yanada orttiradi. Ayrim hollarda buning aksini, ya’ni 
tanlangan gipermatnga xos boim agan hujjatning ochilishini ham ko'rish 
mumkin.

Saytni qismlarga bo‘lishda ham ma’lumotning katta-kichikligiga, 
ma'lum mavzu yoki predmetga xosligiga qarab boMish ham maqsadga 
muvofiqdir. Yuqorida aytilgandek biror sahifada bir predmet yoki 
mavzuga xos bo'lgan matnlar bilan birga, rasmlar, jadvallar, ani- 
matsiyalar va boshqa ko'rinishdagi materiallarning ham shu bo'limga 
\osligi katta ahamiyatga ega. Ma’lumotlarning mos kelmasligi foyda- 
lanuvchilarning ishonchini yo'qotib, ularning sonini keskin kamaytirib 
\ uboradi. Bunday holatga tushib qolmaslik uchun Web-dizaynerdan 
qunt bilan ishlashni talab qiladi. Agarda tayyorlanayotgan saytdagi 
materiallar Web-dizaynerga notanish mavzuda bo'lsa, u holda o‘sha 
sohadagi biror yetuk mutaxassis bilan hamkorlikda ishlashga to'g'ri 
keladi.

Web-saytlarni internetga joylash uchun manzil berish

Saytlarga internetda manzil berish uchun URL (Uniform Resource
l ocator) deb nomlanadigan ibora qo'llaniladi. URL-internetga mu­
rojaat qilishning eng oddiy usuli bo'lib, u manzilni ifodalaydi. URL 
inanzilidan ixtiyoriy sondagi foydalanuvchi bir vaqtning o'zida 
I'oydalanishi mumkin. URL manzili qat’iy format asosida yoziladi (2.15- 
rasm).

Протокол: // хост :порт / путь / файл #фрагмент

2.15-rasm. U R L  m anzili strukturasi.

Manzilni to'liqroq tushunish uchun quyidagi misolni ko‘rib chi- 
qamiz:

http://www.pedagog.uz/index.php

bu URL manzili tarkibiy qismlari quyidagicha:
http -  resursdan fovdalanishda gipermatn bayonnomasi ishlati- 

layotganini bildiradi.
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www.pedagog.uz -  ma'lumotlar joylashgan Internet sayt nomim 
bildiradi.

Index.php -  faylning kompyuterdagi to‘la nomini bildiradi.
Manzilning asosiy tashkil qiluvchilarini ko'rib chiqamiz:
• П ротокол -  bayonnoma. Internet -  mijozlari va serverlariniiic 

bogianishi usulini tavsiflovchi qism. Odatda http (HyperText TransK i 
Protocol) gipermatnli uzatish maxsus bayonnomasidan foydalanilad i 
Manzil kichik lotin harflari bilan yoziladi (http://).

• Имя сервера. Bunda joylanadigan ma’lumotlarni saqlaydigau 
hisoblash tizimining (bu hisoblash tizimini server deb nomlash qabul 
qilingan) nomi ko'rsatiladi. Serverga berilgan ta’rifda ham -  tarmoq 
ishini nazorat qiluvchi kompyuter deb aytilganligi bejiz emas. Servci 
nomi domen nomi kabi www bilan yoki usiz yozilishi mumkin. 
Masalan, www.macromedia.com. Boshqacha usulda nomni IP -  ad res 
ko'rinishida ifodalash mumkin. Masalan, 199.227.52.143.

• Порт. Port raqamini ko'rsatish bitta server ichidagi jarayonni 
adresatsiya qilish uchun talab etiladi. Biroz vaqtdan keyin port 
ishlatiladi va uning raqamini tushirib qoldirish mumkin.

• Путь поиска. Kataloglar va ostki kataloglar zanjiri, faylning 
joylashgan o'rnini belgilaydi. Bu zanjirning elementlari «/» simvoli 
bilan ajratiladi.

• Файл. Faylning nomi uning kengaytmasi bilan birga yoziladi 
(faqat kengaytma so‘ralgan platformada). Agarda faylning nomi tushirib 
qoidirilgan bo‘lsa, u holda Web-brauzer ko‘rsatiladigan faylni qidiradi. 
Brauzer reaksiyasi va uning keyingi harakatlari faylning nomim 
kengaytirishga bogiiq bo‘ladi. Masalan, grafik fayllari GIF yoki JP(i 
ko'rish dasturiga tasvirlarning yuklanishini boshlab beradi. Arxiv 
fayllar (ZIP, RAR va boshqalar) bilan uyg‘unlashgan kengaytmalar -  
mijoz kompyuterida faylning saqlanishini boshlab beradi.

• Фрагмент. URL adresining fakultativ qismi. U # (panjara) 
maxsus simvoli bilan boshlanadi. Bu belgi gipermatnli hujjatning 
lavhasini ajratib ko'rsatuvchi maxsus belgidir. Tarkibga qo‘shib qo'yish 
simvoli nomining kiritilishi butun sahifaga emas, balki uning ma’lum 
bir qismiga murojaat qilish imkonini beradi.

http bayonnomasi bo'yicha bog'lanish Internet tarmog'ida eng ko'p 
tarqalgan usul. Internetdagi obyektlarning manzil lari, aloqaning boshqa
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и-lnblarini va bayonnomalarini o‘z ichiga olishi mumkin. Ulardan bir 
ncchtasini sanab o‘tamiz.

2.1-jadval

Uayonnoma
nomi

Yozish
qoidasi Qo'llanish sohasi

FTP ftp:// Fayllarni uzatish bayonnomasi. FTR-serveri bilan 
bog‘lanish uchun qo'llaniladi

File file:// Kompyuter yoki lokal tarmoqda berilgan fayl- 
larga bog‘lanish bayonnomasi

Gopher gopher:// Gopher serveriga bog‘lanish bayonnomasi

JavaScript javascript: JavaScript tilida yozilgan dasturni chaqirish

Mailto mailto: Elektron pochta manzili

Newt news: Telekonferensiyalarga bogianish bayonnomasi

Telnet telnet: kompyuterga bog'lanish ba)ronnomasi

Internetning bugungi ommaviyligini tushuntiruvchi sabablardan 
biri HTTP bayonnomasi imkoniyatlarining kengligidir. O'zidan avvalgi 
avlodlarining ba’zi bayonnomalarini u butunlay yutib yuboradi. 
Ha'zilarini esa shunchaki siqib chiqaradi va ko‘rgazmali grafik inter- 
Icys yordamida qo’llab-quvvatlash yo'li bilan vaxshiroq imkoniyat 
yaratadi.

Lokal uzel yaratish. Uzel kartasi

Dreamweaver dasturida saytlar va sahifalar yaratishning har 
xil yo‘llari bor. Bulardan saytlarni yaratish bo‘yicha eng mashhur 
tcxnologivani ko‘rib chiqamiz. Buning uchun quyidagi ketma-ketlikni 
bajaramiz:

• saytning lokal versiyasini yaratish;
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• lokal versiyani Internet tarmog'iga joylash.
Lokal uzel -  bu foydalanuvchi yoki foydalanuvchilarning kompyu- 

terida joylashgan haqiqiy virtual Web-uzelning versiyasidir. Lokal uzel 
tarmoqdan ko‘rinmaydi. unga faqat mualliflarigina bog‘lana olishlari 
mumkin.

Lokal uzelning ma'lumotlari diskdagi belgilangan katalog ichida 
saqlanadi. Bu katalog vazifasini diskdagi har qanday katalog bajarishi 
mumkin. Yangi lokal uzel hosil qilish uchun quyidagi ketma-ketliklarni 
bajaring:

1. Site > New Site (Сайт > Создать) buyrug'ini bering. Ekranda 
2.16-rasmda ko'rsatilgan Site Definition (Определение сайта) muloqot 
oynasi hosil boladi.

2. Oynaning chap qismidan Local info (Информация о локальном 
узле) boiim ini tanlang. Maydonning qiymatini kiriting.

3. Remote Info (Сведения об удаленном сервере) kategoriyasiga 
sayt saqlanayotgan server haqidagi ma'lumotlarni kiriting.

Site Definition for Unnamed Site 1

Category
яяяшя_____
Remote Info 
Design Notes 
Site Map Layout 
File View Columns

Local Info

Site Name: Unnamed Site 1

Local Root Folder: JC:\Program Files\Macromedia\Dreamweav 

W Refresh Local File List Automatically

HTTP Address: j http:/7

This address enables the Link Checker to 
detect HTTP links that refer to your own 
site.

Cache: P  Enable Cache
The cache maintains file and asset 
information in the site. This speeds up the 
Asset panel, link management, and Site Map 
features.

OK Cancel Help
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4. Muloqot oynasining yuqorida sanalgan maydonlar to‘ldirilishi 
sliart. Site Map Layout (Планировка карты узла), Design Notes 
(Комментарии разработчика) va File View Columns (Колонки ото­
бражения файловых атрибутов) maydonlari toidirilishi shart emas 
(foydalanuvchi o‘z xohishiga qarab to‘ldirishi mumkin).

5. Barcha kerakli ma’lumotlar kiritilgach OK tugmasini sichqoncha 
yordamida bosing yoki ENTER tugmasini bosing.

Uzel kartasi

Uzel kartasi -  lokal uzel yaratishning qulay interfaol vositasi 
hisoblanib, unda ko‘plab texnik qiyinchiliklarga ega boigan topshiriqlar 
grafikli ko‘rinishda yengillik bilan amalga oshiriladi. Bu rejimda 
saytning kartasi tasvirlanadi. Uzel dispetcheri oynasi ikki qismga 
bolingan. Chap tomonda uzelning kartasi kiritiladi (Kartada -  sahifa 
belgilari HTML fayllarni ifodalaydi). Hujjatlar orasidagi gipermatnli 
bogianishlarni strelkalar ifodalaydi.

O'ng tomonda esa uzelning fayllar va kataloglar ro'yxati beriladi. 
Kartaning koiinishi organizatsion diagrammani eslatib yuboradi. Kartada 
ikki darajani ko'rish mumkin. Yuqori darajani uzelning asosiy sahifasi 
egallaydi. Quyi darajada esa unga tegishli va o'zaro giperbogianishga ega 
sahifalar tushuniladi. Uzelning gipermatnli hujjatlaridagi boglanishlar 
ko‘k rangda tasvirlanadi. Agar bogianishda ko‘rsatilgan fayl kengaytmasi 
11TM, .HTML va boshqa shu formatdagilardan farq qilsa u holda yashil 

rangda tasvirlanadi. Agar bogianishda qo‘pol xatoliklar bolsa, u holda 
bogianish qizil rangda ifodalanadi. Tashqi fayllar, boshqa fayllarda 
joylashgan fayllar va maxsus boglanishlar (masalan, mailto: yoki 
javascript:) globus ko‘rinishidagi maxsus belgi oladi. Bulardan tashqari 
agar ko‘k rangli belgi qo‘yilgan bolsa -  bu fayl foydalanuvchining o‘zi 
lomonidan taqiqlanganini bildiradi. Qulf belgisi ostidagi belgi faqat 
o'qish uchun moijallangan fayllarni bildiradi.

Savol va topshiriqlar:

1. Lokal uzel nima?
2. Lokal uzel hosil qilish ketma-ketligini aytib bering?
3. Uzel kartasi nima?
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2.5. H ujjatlarga havolalar o‘rnatish va olib tashlash

Tegishli hujjatga havola o‘rnatish unchalik murakkab emas. Bun­
da foydalanuvchini chalkashtiradigan eng asosiy muammo -  bu ope- 
ratsiyani bajarish usul va uslublarining ko‘pligidir. Qachonki biror 
hujjatga yoki sahifaga havola o'rnatmoqchi bo'lsangiz, buning uchun 
quyidagi uch holatdan birini belgilash kerak. Ular bir-biridan faylning 
holati va yuklanish texnikasi bilan farq qiladi.

• Havola uchun ko'rsatilgan hujjat uzelning hisobidagi obyekt 
sanaladi. Ya’ni faylning nomi fayllar va papkalar ro'yxatidan iborat 
uzelning kartasi va panelida ifodalanadi. Bunday faylga havola o‘rnatish 
uchun asosiy hujjatni tanlash, sichqoncha yordamida marker ko'rsat- 
kich bog'lab olib, uni tegishli hujjatga olib o'tish lozim. Marker- 
ko‘rsatkich -  bu havola oi'natish uchun maxsus interfaol vosita hi­
soblanadi. Markerni uzel dispetcherining har qanday paneliga (kartaga 
yoki fayllar ro'yxatiga) surib kelish mumkin.

• Butun hujjat saytning tarkibiga kiradi, ammo uning ro'y- 
xatidan o‘tmagan. Ya’ni uning nomi o'ng paneldagi fayllar ro‘yxatida 
mavjud, ammo u uzel kartasida yo‘q. Bunday holatlarda marker ko'r- 
satkichni o'ng panel ustiga surish va uni fayl nomi ustiga tashlash 
kerak.

• Butun hujjat saytga kirmagan. Bunday holatda marker-ko'rsat- 
kichini surishni teskari yo‘nalishini qo‘llash kerak.

Havolani o‘zgartirish

Havolalarni o'zgartirish uchun eski bog'lanishga tegishli ko'rsal- 
kichlarni o'chirib tashlab, yangi faylga tegishli ko‘rsatkichlarni kiritish 
mumkin. Ammo Dreamweaverda buni o'zgartirish uchun maxsus 
vositalar mavjud:

1. Uzel kartasidan hujjat belgisini tanlang;
2. Uzel dispetcheri oynasidan Site > Change Link (Сайт > Из­

менить ссылку) buyrug'ini bering. Xuddi shu buyruqni -  C T I ^  I 
tugmalar kombinatsiyasi yordamida ham berish mumkin;

3. Select HTML Files (Выбор гипертекстовых файлов) muloqot 
oynasi ochiladi. Unda yangi faylning nomi va joylashgan katalogiiu 
ko‘rsatish kerak:
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Change Link Sitewide (Site - Unnamed Site 3 copy)

Change All Links To: OK

Cancel
into Links T o:

Help

2.17-rasm. B o g ’lanishni yangilash.

4. Fayl tanlangandan keyin, Dreamweaver dasturi Update Files 
(Обновление файлов) muloqot oynasi ochiladi. Barcha o'zgarishlarni 
qu'shish uchun Update (Обновить) tugmasini bosing.

Agar bir nechta hujjatlar bilan bitta hujjat o'rtasida bog'lanish 
n'rnatm oqchi bo'lsangiz buning uchun maxsus buyruq mavjud. Bu 
luiyruq yordamida barcha obyektlardagi havolalarni global tarzda
0 /gartirish mumkin. U barcha gipermatnli havolalardagi ko'rsatilgan 
liiylni nomini o'zgartirib chiqadi.

1. Uzel dispetcheri oynasini oching;
2. O'zgartirilishi kerak bo'lgan hujjatni oling;
3. Site > Change Link Sitewide (Сайт > Изменить связи по всему 

| питу) buy rug'ini bering. Shu nomdagi muloqot oynasi ochiladi (2.18-
1 asm).

Change Link Sitewide (Site - Unnamed Site 3 copy)

Change All Links T o: OK

Cancel
Into Links To:

Help

2.18-rasm. Havolani global o'zgartirish.
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1. Tanlangan faylning nomi Change All Links To (Изменить всс 
ссылки на) maydonida ifodalanadi. Yangi faylning nomini Into Links 
To (На ссылки на) maydoniga kiritish yoki standart protseduralni 
yordamida tanlash mumkin.

2. OK tugmasini (кнопка) bosing yoki ENTER (клавиша) tug­
masini bosing.

3. Update Files (Обновление файлов) muloqot oynasi ochiladi, 
bunda bogianishga ega va ayni vaqtda yangilanishni talab etadigan. 
fayllar nomi aks etadi. Fayllarni tanlang va ularga tegishli havolam 
o‘rnating.

Change Link Sitewide (Изменить связи по всему сайту) buyrugi 
ham havolalarni ommaviy almashtirish uchun juda qulay. Masalan. 
bunday almashtirishlarni ko'pincha saytning barcha sahifalaridagi 
elektron pochta adresini almashtirish uchun qoilash mumkin.

1. Change All Links To (Изменить все ссылки на) maydoniga 
o'zgartirilishi kerak boigan havolani to iiq  kiriting.

2. Into Links To (На ссылки) maydoniga to iiq  yangi havolani 
kiriting.

3. OK tugmasini bosing.

Havolani olib tashlash

Havolani olib tashlashni bir nechta usullari mavjud. Masalan, 
havolaga tegishli, ya’ni manba hisoblangan hujjat faylini ochish va 
uni oddiy yo‘1 bilan o'chirib tashlash mumkin. Bu usul balki noqulay 
tuyulishi mumkin, ammo maksimal aniqlikda boladi. Uzel dispetcheri 
orqali amalga oshiriladigan boglanishni olib tashlash usulini ko‘rib 
chiqamiz:

1. Uzel dispetcheri oynasini oching;
2. Uzel kartasidan boglanishni koisatuvchi hujjat belgisini oling;
3. Site > Remove Link (Сайт > Удалить ссылку) buyrugini bering. 

Bu buyruqning klaviaturada ikkita ekvivalenti bor: CTRL+SH1FT+L 
tugmalar kombinatsiyasi yordamida ham berish mumkin.

Sarlavhani o ‘zgartirish

Dreamweaver dasturi HTML hujjatining sarlavhasini uzel dis­
petcheri oynasida almashtirish (o'zgartirish) imkonini beradi. Shuni esa 
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I ill ish kerakki gipermatnli hujjatning sarlavhasini <title> deskriptori 
belgilaydi. Bu matn qatori hujjatning nomi hisoblanadi va qidiruv 
ii/imlarida hujjatni indeksatsiyalashda muhim rol o‘ynaydi. Eng 
mashhur Internet Explorer va Netscape Navigator brauzerlar sarlavhani 
ilastur oynasining sarlavha qatoriga chiqarib beradi.

Sarlavhani o'zgartirish uchun quyidagilarni amalga oshirish kerak:
1. Uzel dispetcherini oching (ALT+F8).
2. View > Show Page Titles (Вид > Показать заголовки стра­

ниц) buyrug'ini bering. Bu buyruqni CTRL+SHIFT+T tugmalar 
kombinatsiyasi yordamida ham berish mumkin. Natijada uzel kartasida 
gipermatnli fayllar nomi o'rnida ularning sarlavhasi beriladi.

3. Hujjatni tanlang va File > Rename (Файл > Переименовать) 
Iniyrug'ini bering yoki klaviaturadan F2 tugmasini bosing.

4. Yangi sarlavhani kiriting va ENTER tugmasini bosing.

Savol va topshiriqlar:

1. Giperhavola nima?
2. Gipermatn nima?
3. Ixtiyoriy hujjatga havola o‘rnatish tartibini aytib bering?
4. Havolani o'zgartirish ketma-ketligini aytib bering?

2.6. Dasturning HTML bilan ishlash imkoniyatlari

Dreamweaver dasturining foydalanuvchilari gipermatnli hujjatlar- 
ning ko'plab tahrirlash operatsiyalarini to 'g 'ridan-to 'g 'ri HTML 
ilcskriptorlari yordamida bajarishi mumkin. HTML tili haqida 
biz yuqorida batafsil ma’lumot oldik. Bu tilning elementlarini 
deskriptorlar yoki teglar deb nomlash qabul qilingan. Ingliz tilidan 
lag (yorliq, belgi va boshqa ma’nolarni beradi). Deskriptorlarni 
saqlash uchun ASCII belgilari qo'llaniladi. Shuning uchun har 
qanday gipermatnli hujjatni belgilashni har qanday oddiy matn 
muharrirlarida bajarish mumkin. Buning uchun xatto Блок­
нот dasturi ham yetarli. HTML tilining kodlari hujjatning matnli 
massivlari qismi hisoblanadi.

Endi deskriptorlar bilan tanishib chiqamiz. Deskriptorlar ikki xil 
bo'ladi. Yakka va juft deskriptorlar. Juft deskriptorlar ayrim xollarda
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konteynerlar deyiladi. Hujjatga tegishli matnlar va uning belgili 
kodlarini ajratish uchun, HTML tili kodlari burchakli qavslarda 
yoziladi. Masalan, <br> yoki <p>. Juft deskriptorlar (konteynerlar) 
o‘z ichiga deskriptorlar juftligini, ochiladigan (boshlang‘ich) va 
yopiladigan (oxirgi) deskriptorlarni oladi. Bu juftliklar <tag> </tag> 
ko'rinishida yozilib, o‘z qiymatini juftlik orasidagi hujjat fragmentiga 
o'tkazadi. Boshqacha aytganda konteyner juftliklari orasiga hujjat 
fragmenti yoziladi. Deskriptorlar ana shu fragment uchun ishlaydi 
xolos. Yakka deskriptorlarda yopiladigan teg bo'lmaydi. Masalan, 
<hr> deskriptori gorizontal chiziq hosil qiladi, <br> -  esa matnli 
qatorni ifodalaydi, eng muhim yakka deskriptorlardan biri <img> 
maxsus kodi hisobalanadi. U rasmlarni qo‘yiladigan holatini va 
joylashuvini belgilaydi.

Endi Dreamweaver dasturida shablon asosida yangi hujjat hosil 
qilamiz. Yangi hujjatning bo'sh (toTdirilmagan) bo‘lishi hammamizga 
maTum. Quyida bunday sahifaning Dreamweaver dasturidagi 
gipermatnli belgilari keltirilgan:

<html>
<head>
<title>Untitled Document</title>
<tneta http-equiv-»Content-Type>> content-»text/html; charset=iso- 

8859-1»>
</head>
<body bgc olor= « # FFFFFF»>
</body> </html>
Bundagi deskriptorlarning vazifalari bilan HTMLda tanishib 

chiqdik. Undan tashqari <meta> deskriptorining charset atributi 
internetda tanlangan simvollarni namoyishini ta’minlovchi kodirovkani 
ifodalaydi. Odatda yangi shablondagi (iso-8859-1) kodli to'plam kiril 
simvollarini ifodalay olmaydi.

Deskriptorlarni kiritish qoidalari

Belgilash kodlarini to‘giidan-to‘g‘ri kiritish hujjatning faqat max­
sus rejimida amalga oshiriladi. Bu rejimga o‘tishning bir nechta 
imkoniyatlari bor. Ulardan ayrimlarini ko‘rib chiqamiz:
104



• Window > Code Inspector buyrugini bering. Xuddi shu buyruqni 
110 tugmachasini bosish yordamida ham berish mumkin;

• Uskunalar panelining chap qismida joylashgan Code View (Ре­
жим разметки) tugmasini bosib kodlarni tasvirlash rejimiga o‘tish 
mumkin;

• Uskunalar panelidagi chapdan ikkinchi Code and Design View 
(Режим разметки и планировки) tugmani bosish bilan hujjat oynasini 
ikki qismga boiish mumkin.

Kodlar nazoratchisida joriy hujjatning kodlari tasvirlanadi. Bel­
gi lashda qollaniladigan ko‘pchiIik deskriptorlar alohida rangda 
(asvirlanadi. Deskriptorlarning ranglari dasturning asosiy ko‘rsat- 
kichlariga kiradi. Ranglarni foydalanuvchining xohishiga qarab 
o'zgartirish mumkin. Agar foydalanuvchi hujjat ustida biror tahrirlash 
ishlarini olib bormoqchi bo isa  u holda F5 tugmasini bosish yoki View 

Design View (Вид > Обновить) buyrugini berish kerak. Bu buyruq 
hujjatning kodlarni belgilash rejimidan tahrirlash rejimiga olkazadi. 
Tahrirlash rejimidagi obyektlarni qo‘yish, formatlash buyruqlari va 
liar qanday o'zgarishlar darhol kodlar inspektoriga ko‘chadi. Agar 
tahrirlash rejimida biror obyekt yoki fragmentni belgilasangiz, 
kodlarni belgilash rejimida ham shu obyekt yoki fragmentga tegishli 
kodlar belgilanadi. Bu esa dasturda ikki yoqlama ishlash imkoniyatini 
ta’minlab beradi.

Kodlardan nusxa olish

Dreamweaverda boshqa HTML tahrirlagichlari bilan gipermatnli 
belgilashdagi kodlarni almashish imkoniyati mavjud. Buning uchun 
Windows operatsion tizimining ko‘pchilik dasturlarida mavjud b o i­
gan, belgilangan fragmentdan nusxa olish va qo‘yishning standart 
buyruqlaridan foydalaniladi. Aytaylik HomeSite dasturida ochilgan 
gipermatnli hujjatning belgilash kodlaridan nusxa olishimiz kerak:

Nusxa olish uchun Edit > Copy (Правка > Копировать) yoki 
(i'R L +C  tugmalar kombinatsiyasidan foydalanamiz;

Buferga olingan nusxani qo‘yish uchun Edit > Paste (Правка > 
Вставить) yoki CTRL+V tugmalar kombinatsiyasidan foydalanamiz.

Matn muharrirlarida tanlangan fragmentni sichqon yordamida surish 
yoii bilan ko‘paytirish imkoniyati mavjud. Bu imkoniyat Dreamweaver
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dasturida ham ishlaydi. Buning uchun CTRL tugmasini bosgan holda 
belgilangan fragmentni sichqon ko‘rsatkichi bilan kerakli joyga surib 
ko'paytirish mumkin.

Savol va topshiriqlar:

1. HTML so‘zining lug'aviy ma’nosi qanday?
2. Deskriptorlar nima?
3. Deskriptorlarning qanday ko'rinishlari mavjud?
4. Deskriptorlarni kiritishni tushuntirib bering?

2.7. Hujjatning o‘lchamlarini belgilash

Dasturda yaratilgan har qanday yangi hujjat bo‘m-bo‘sh oq 
rangdagi fonli sahifadan iborat boladi. Hujjatda ish boshlashdan oldin 
uning bir qancha muhim parametrlarini kiritib olish kerak. Bular ish 
maydonining olchami, fon rangi, hujjat sarlavhasi, havola ranglaridir. 
Bu parametrlarni ish jarayonining ixtiyoriy vaqtida ham o'zgartirish 
mumkin. Sanalgan barcha parametrlarni yagona Page Properties (Свой­
ства страницы) muloqot oynasi yordamida kiritiladi (2.19-rasm). Bu 
muloqot oynasini bir necha yollar bilan ochish mumkin:

• Dastur menyu qatoridan Modify > Page Properties (Изменить > 
Свойства страницы) buyrugini berish bilan;

• CTRL+J tugmalar kombinatsiyasini bosish bilan;
• Kontekstli menyudan Page Properties (Изменить > Свойства 

страницы) buyrugini berish bilan.
Endi Page Properties (Свойства страницы) muloqot oynasining 

boshqaruv elementlari bilan tanishib chiqamiz:
• Title (Заголовок). Sahifaning sarlavhasini kiritish uchun xizmat 

qiladi.
• Background Image (Фоновый рисунок). Hujjatga fon sifatida 

qo‘yiladigan rasm koisatiladi.
• Background (Фоновый цвет). Sahifaning fon rangini tanlash 

imkoniyatini beradi.
• Text (Текст). Shriftning rangini tanlash imkoniyatini beradi.
• Links (Ссылки). Bu boiim da giperhavolalar rangi va grafikli 

havolalar ramkasi rangi belgilanadi.
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Page Properties m

l i t le  |Q

Background Image: ( file :///C l/B o o k  VFON.JPC 

Background: : Г ^ [ |

Text: [ ' , ] }

tjrow sft..

Visited Links: Г j f "

Links: Q f  

Left M arg in :}

T 0£> Margin: j

f ic tiv e  Links: 

Margin W idth: j 

Margin Height: j

document Encoding: j Cyrillic (V/indows-1251) 3  Reload

Tracing Image: I

Image Transparency: ----------------------------------------------------- ) iqq%

Browse...

Transparent Opaque

Document Folder: C :\V/INDOW S\Pa6o4Hft сто я \

Site Folder: C :\V /IN D 0W S \P a6o4nft с то я \

OK

Apply

Cancel

Help

2.19-rasm. Page Properties m uloqot oynasi.

• Visited Links (Просмотренные ссылки). Brauzerda ko‘rilgan 
havolalar rangini tanlash.

• Active Links (Активные ссылки). Faol havola rangini belgilash.
• Left M argin (Левое поле). Sahifaning chap tomonidan qol- 

diriladigan maydonni pikselda belgilaydi.
• Top M argin (Верхнее поле). Sahifaning yuqori qismidan qol- 

diriladigan maydonni pikselda belgilaydi.
• M argin W idth (Ширина полей). Sahifa maydoni enini bel­

gilaydi.
• M argin Height (Высота полей). Sahifa maydoni bo‘yini bel­

gilaydi.
• Document Encoding (Кодировка документа). Kiril simvol- 

laridan iborat sahifalar tuzish uchun juda muhim ko‘rsatkich. Chunki 
uning yordamida qanday simvollarni brauzer dasturlarida tasvirlab
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berish ko‘rsatiladi. Rus alifbosini faqat quyidagi to‘rtta kodirovka 
tasvirlab bera oladi xolos ISO-8859-5, MacCyrillic, KOI8-R va 
Windows-1251.

• Reload (Повторная загрузка). Tugmasi yordamida hujjatning 
grafik tahrirlash ishlari bilan bog‘liq oxirgi saqlangan ko‘rinishni tiklash 
imkonini beradi.

• Tracing Im age (Трафаретное изображение). Sahifaning dizayni 
bilan ishlashda namuna sifatida ishlatiladigan tasvirlarni ifodalaydi. Bu 
tasvirlar sahifani ko‘rish rejimida ko‘rinmaydi.

• Image Transparency (Прозрачность изображения). Iz qoldirish 
uchun tanlab olingan rasmning shaffoflik darajasi belgilanadi.

• Document Folder (Папка документа). Hujjatning qaysi katalogda 
joylashganini ko‘rsatib turadi.

• Site Folder (Корневая папка узла). Tegishli Web-uzelning o'zak 
katalogiga toiiq  yo‘l ko‘rsatadi.

Yuqoridagi ko‘rsatkichlar tanlangandan so‘ng, barcha o'zgarishlarni 
saqlab, ularni ko iish  uchun File > Preview in Browser (Файл > Про­
смотр в браузере) buyrug‘i beriladi.

Gorizontal va vertikal chizg‘ich

Gorizontal va vertical chizgich hujjat bilan ishlashda o'lchash va 
etalon vazifalarini bajaradi. ChizgMchga qarab obyektlarning o'lchamini 
boshqa obyektlarga nisbatan joylashuvini ko‘rish mumkin. Boshqaruvda 
chizg‘ichlar maxsus buyruq yordamida o‘rnatiladi. Buning uchun View
> Rulers (Вид > Линейки) buyrug‘ini berish kerak. Bu menyuning 
punktlarini sanab o‘tamiz.

• Show (Показать) buyrug'i chizg‘ichni o‘rnatib beradi. Bu 
buyruqni -  CTRL+ALT+R tugmalar kombinatsiyasi yordamida ham 
bajarish mumkin. Buyruqni takror berish chizg‘ichni ekrandan olib 
tashlaydi.

• Pixels (Пикселы), Inches (Дюймы), Centimeters (Сантиметры)
-  buyruqlari olcham  birligini tanlash imkonini beradi.

• Reset O rigin (Восстановить начало координат). Koordinatalar 
boshini sahifaning ixtiyoriy nuqtasi bilan bog‘lash mumkin. Buning 
uchun chiziqlar kesishuvida joylashgan krest shaklidagi markerni
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hujjatning ixtiyoriy joyiga olib o'tish yetarli. Ushbu buyruqning ba- 
jarilishi sanoq nuqtasini dastlabki vaziyatga qaytaradi.

Montaj to‘ri

Montaj to‘ri -  hujjat elementlarini tekislash va joylashtirish uchun 
1110‘ljal olish vositasidir. Hujjat elementlariga: matn, rasmlar, jadvallar 
va boshqalar kiradi. Montaj to‘ri sahifani rejalashtirishning eng asosiy 
vositasidir. Loyihaning dizayn bilan bog'liq ishlari tugagach to‘rni olib 
lashlash mumkin. To‘rni yana ekranga chiqarish uchun View > Grid
• Show' Grid (Вид > Разметочная сетка > Показать сетку) buyrug‘i 

beriladi yoki CTRL+ALT-G tugmalar kombinatsiyasi bosiladi. Olib 
lashlash uchun shu buyruq takror beriladi.

View > Grid > Edit Grid (Вид > Разметочная сетка > Настроить 
сетку) buyrugi 2.20-rasmda ko‘rsatilgan muloqot oynasini ekranga 
chiqaradi. Uning tarkibiy qismi bilan tanishib chiqamiz: 

о Color (Цвет) -  to‘r rangini tanlash imkonini beradi. 
о Show Grid (Показать сетку) -  to’rni 0‘rnatish yoki olib tashlash.
0 Spacing (Расстояния) -  olchash birligi va chiziqlar orasidagi 

bolinish qadamini belgilaydi.
о Display (Отображение) -  to‘r chiziqlari ko‘rinishini belgilaydi.

Grid Settings

Color: □ Н И И Г

Г  Show Grid 

Г~ Snap to Grid

Spacing: J50 j Pixels

Display: Lines 
C" Dots

OK

Apply

Cancel

Help

2.20-rasm. Montaj to ‘rini o‘rnatish.
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Savol va topshiriqlar:

1. Hujjat oichamlarini belgilash uchun qaysi buyruqdan foydalaniladi?
Bu buyruqning mos kombinatsion tugmalarini ayting?

2. Page Properties muloqot oynasi qismlari vazifalarini aytib bering?
3. Chizg‘ich va uning vazifalari nimalardan iborat?
4. Montaj to'ri nima va uning vazifalari nimalardan iborat?

2.8. Dreamweaverning ro‘yxatlar bilan ishlash imkoniyatlari

Ro‘yxatlarni nomerlash deb -  bo‘lim yoki qismlar ketma-ketligini 
tartibga soluvchi va ularning har biri navbatdagi yangi son bilan 
tartiblanishini tushunish mumkin. HTML tilida ro‘yxatlarni hosil 
qilish bilan biz yuqorida batafsil tanishib chiqdik. Bundan tashqari 
tartiblangan ro‘yxatlar asosida murakkab iyerarxik ro‘yxatni tuzish 
mumkin. Bunda murakkab ro‘yxatning qismlari bo'lib quyi (oddiy) 
ro'yxatlar olinadi.

Nomerlangan ro'yxatlar quyidagi уоЧ bilan hosil qilinadi.
1. Hujjatning bir nechta tizimli bo‘lagini oling. Bunday bo‘laklarga 

abzatslar, har qanday standart sarlavhalar yoki boshqa ro‘yxatlarning 
bo‘limlarini kiritish mumkin.

2. Dreamweaver
3. Homesite
4. Hotmetal Pro
Text > List > Ordered List (Текст > Список > Нумерованный спи­

сок) buyrug‘ini bering. Bu buyruqni CTRL+F3 tugmalar kombinatsiyasi 
yordamida ham berish mumkin.

Belgili ro‘yxatlarni yaratish

Belgili ro‘yxatlar deb -  ma’lum belgi ostida ketma-ket boiimlarni 
sanash tushuniladi. Bunday ro‘yxatlarni HTMLda hosil qilish bilan biz 
yuqorida tanishib chiqdik.

Brauzerlarning oxirgi versiyalarida ro‘yxatlarni belgilash uchun 
type atributi bor. Bu atributni quyidagi qiymatlarini qoilash mum- 
kin: circle (aylana), disk (disk), square (kvadrat). Ya’ni ro'yxatning 
har bir bolim i shu belgilar bilan belgilanadi. Bundan tashqari kichik
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\ajmdagi rasmlarni ham ro'yxatning maxsus belgisi sifatida qo‘llash 
mumkin.

Betartib ro'yxatlarni yaratish tartibi quyidagicha:
1. Hujjatning bir nechta bir-biriga qo'shni strukturali bloklarini 

l.mlang. Text > List > Unordered List buyrugini bering. Bu buyruqni
i I RL+F3 tugmalar kombinatsiyasi yordamida ham bajarish mumkin.

• Toshkent
• Samarqand
• Buxoro
• Xorazm

Savol va topshiriqlar:

1. Ro'yxatlami belgilash deganda nimani tushunasiz?
2. HTML tilida ro'yxatlar qaysi deskriptor yordamida hosil qilinadi?
3. Belgili ro'yxatlar qanday hosil qilinadi?

2.9. Matnlarni formatlash. Shriftlar

Bizga boshqa dasturlardan belgilangan matnni yoki butun hujjatdagi 
matnni shriftini o'zgartirish ma'lum. Endi ana shu jarayonni HTML 
lilida qanday bajarilishini ko'rib chiqamiz. Bu vazifani HTMLda 
maxsus deskriptor <font> yordamida bajariladi. Uning qiymatlari 
boiib bir nechta shriftlar nomi ishlatilishi mumkin, masalan: <font 
lace = «Courier, Helvetica, sans-serif !>Shriftni belgilash </font>.

Shriftlarni belgilashni texnik tomoni esa matn muharrirlaridan hech 
ham farq qilmaydi:

1. Matnni belgilang yoki matn kursorini hujjatning shrifti o'zgarishi 
kerak boigan joyiga qo'ying;

2. Text > Font (Текст > Шрифт) buyrugini bering va kerakli 
shriftni tanlang. Xuddi shu ishni Property Inspector (Инспектор 
свойств) palitrasi yordamida ham bajarish mumkin.

Tanlangan shriftning nomi shriftlar ro'yxatining nomi hisoblanadi.

Shriftlar ro‘yxatini tahrirlash

Shriftlar to'plami ro'yxatiga foydalanuvchi o'z xohishiga qarab 
yangi shriftlar qo'shishi yoki qoilanilmaydigan shriftlarni olib tashlashi 
ham mumkin:

111



Edit Font List

+ b i Font List:
Courier New, Courier, mono 
Georgia, Times New  Roman, Times, serif 
Verdana, Arial, Helvetica, sans-serif 
Times 11гЬ Roman 
Geneva, Arial, Helvetica, sans-serif
Add fonts in list below

Chosen Fonts: Available Fonts: 
Arial
Arial B lack 
Arial Narrow 
Arial Unicode MS 
Batang

S53

OK

Cancel

Help

2.21-rasm. Shriftlar to'plam ini tahrirlash m uloqot oynasi.

1. Text > Font > Edit Font List (Текст > Шрифт > Редактирован, 
список шрифтов) buyrug‘ini bering. Bu buyruqni CTRL+F3 tugmalar 
kombinatsiyasini bosish bilan ham bajarish mumkin. Buyruqni berish 
natijasida Edit Font List muloqot oynasi hosil bo‘ladi.

2. Bu oyna yordamida foydalanuvchi o‘ziga kerakli shriftlar ro‘y- 
xatini qaytadan tuzib olishi mumkin.

3. Ishni tugallashdan oldin muloqot oynasida OK tugmasi bosiladi.
• Muloqot oynasining tugma va maydonlari bilan tanishib chi­

qamiz:
• Font List (Список шрифтов). Muloqot oynasining bu bo'limida 

ayni vaqtdagi ro'yxatga tegishli shriftlar berilgan. Endi qo‘shiladigan 
shriftlar esa ro‘yxatning eng oxiriga joylashadi.

• Chosen Font (Выбранные шрифты). Tanlangan shriftlar nomi.
• Available Fonts (Наличные шрифты). Ushbu hisoblash tizimida 

o‘rnatilgan shriftlar ro‘yxati. Bu shriftlardan birortasini tanlangan 
shriftlar to‘plamiga qo‘shish uchun, oynadagi chapni ko‘rsatish yo‘nalish 
tugmasini bosish kerak.

• To'plamdagi tanlangan shriftni o'chirish uchun «-» belgili 
tugmani, to‘plamga yangi shrift qo‘shish uchun «+» belgili tugmani 
bosish kerak.
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• Yuqoriga va pastga qaragan strelkalar esa tanlangan shriftni 
lo'yxatdagi holatini o'zgartirish, ya’ni yuqoriga va pastga yurish im- 
konini beradi.

Matn oicham ini belgilash

HTMLda matn oicham ini qanday belgilash bilan tanishib chi- 
qainiz. Buning uchun <font> deskriptorida size atributi qollaniladi. 
Masalan, <font size = «4»> 0 ‘lchamni belgilashning absolyut tizim i </ 
lont>. Bundan tashqari <body> deskriptori yordamida ham <basefont 
.i/e = «qiymat»> shriftni belgilash mumkin. Bunda sizening qiy- 
matiga birdan to yettigacha bo’lgan har qanday qiymatni qo‘yish 
imnnkin.

Kattalashadigan oichamlarda esa size atributi qiymati oldiga + 
(kattalashtirish) yoki -  (kichiklashtirish) belgisi qo‘yiladi. Nisbiy ti- 
/imda shriftni o‘lcbamini o‘zgartirishga misol keltiramiz:

<font size = «+l»>Nisbiy tizimda o1cham</font>
Shrift oicham ini quyidagi yo‘l bilan o‘zgartirish mumkin:
1. Matnni belgilang yoki kiritiladigan joyga kursorni qo‘ying.
2. Absolyut oicham ni belgilash uchun Text > Size (Текст > Раз­

мер) buy rug'ini bering yoki nisbiy tizimida oichamni berish uchun Text
Size Change (Текст > Изменить размер) buyrug‘ini bering. Ikkala 

buyruqni ham Property Inspector (Инспектор свойств) palitrasidan 
berish mumkin. Palitraning Size (Размер) ro‘yxatida shrift oichamini 
n'/gartirishning barcha imkoniyatlari ko'rsatilgan.

3. Absolyut yoki o"sish oicham ini tanlang.

Matnlarga rang berish

Agar matnga biror rang berilmagan bolsa, u holda Windows 
operatsion tizimidagi yoki brauzerda tanlangan rang tasvirlanadi. 
ko'pincha bu rang qora rang boladi. Butun massivning simvollariga 
lang hujjatning asosiy koisatkichiarida belgilanadi. Ko‘pincha hujjat 
yaratib olingach, bu kabi ko'rsatkichlar kiritilib olinadi. Buning uchun 
\ uqorida ko‘rganimizdek Modify > Page Properties (Изменить > 
( 'мойства страницы) buyrugini berish kerak (CTRL+J). Har qanday
■ imvollar to'plamiga alohida rang berish mumkin. Ranglarni saqlash
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uchun <font> deskriptorida color atributi ishlatiladi. Masalan, yashil- 
koLk rangini belgilovchi kod quyidagicha yoziladi:

<font color=«#66FFFF»>bu moviy rangning kodi</font>
Shuni esda tutish kerakki HTML tilida rang o‘n oltilik sanoq tizim i 

kodlari yordamida belgilanadi. Palitraning ayrim elementlari o‘zining 
nomiga ega, masalan green (ko‘k). red (qizil) va boshqalar.

Dasturda ranglarni tanlashni Property Inspector (Инспектор 
свойств) palitrasidan foydalanib ham uskunaviy yo‘l bilan belgilash 
mumkin. Bu jarayon xuddi boshqa matn muharrirlarida bajarilgandek 
boradi.

Matn maydoni -  sahifaning asosiy qismi hisoblanadi. Chunki har 
qanday Web-sahifaning asosiy belgilovchi qismi matnlar hisoblanadi.

Matnli maydonlar uch xil ko‘rinishda boladi (2.22-rasm):
• Single line (Однострочное). Qisqa xabar yoki javoblarni kiritish 

uchun xizmat qiladi.
• Multi line (Многострочное). Ixtiyoriy uzunlikdagi xabarni 

kiritish uchun moijallangan.

|Текстовое поле

Matnli maydonlar

М н о г о с т р о ч н о е  
т е к с т о в о е  п о л е

Subm it j }7  (? [n ОИСК Обзор...

2.22-rasm. M atn m aydonlarining tiplari.
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• Password (Пароль). Parolni kiritish uchun moijallangan.
Matnning uchala ko‘rinishi ham bitta buyruq yordamida qo‘yiladi.

Ularni tiplarga ajratish esa Property Inspector (Инспектор свойств) 
palitrasi yordamida amalga oshiriladi. Buning uchun shu nomlardagi 
uchta qayta ulagich xizmat qiladi.

Single line matn maydoni

Bitta qatordan tarkib topgan oddiy matn maydoni. U <input> 
deskriptori yordamida belgilanadi. Quyidagi misolda shunday obyektni 
ifbdalovchi belgili kod qatori keltirilgan:

<input type = «text» name = «maydon_nomi»>

bu yerda type atributi maydonning tipini bildiradi, name atributi esa 
obyektning nomini bildiradi.

Oddiy matn maydoni bilan bog‘liq ko‘rsatkichlar bilan tanishib 
chiqamiz:

• Text Field (Текстовое поле). Palitraning bu bo‘limi matn may­
donining nomini belgilaydi. Bu yerda maxsus belgilardan foydalanish, 
bir nomni takrorlash va maydonni bo‘sh qoldirish ham mumkin emas.

• Char Width (Ширина в символах). Matn maydonining enini 
simvollar soni bo‘yicha belgilash. Odatda bu o‘lcham 20 ta simvolni 
tashkil qiladi.

• Max Chars (Максимальный объем). Matn maydoniga kiriti- 
ladigan simvollarning maksimal soni.

• Init Val (Начальное значение). Bu maydonga qarab ko'rish 
dasturi sahifani birinchi yuklashdan keyin olib chiqadigan matn 
qatorini kiritish mumkin.

Password matn maydoni

Kiritilgan simvollarning oynada aks etmasligini ta’minlash maq­
sadga muvofiq bo'lgan holatlar ham mavjud. Ko:pincha bunday zarurat 
maxfiy axborotlarni, masalan, parollar yoki kalit so;zlarni kiritishda 
yuzaga keladi.

Password (Пароль) matn maydoniga kiritilgan ma’lumot faqat 
vulduzchalar ko‘rinishida tasvirlanadi. Matn maydoni bunday xususiyati 
bilan boshqa tipdagi matn maydonlaridan keskin farq qilib turadi.
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M ulti Line m a tn  m a y d o n i

Katta hajmdagi matnli ma’lumotlarni kiritish uchun Multi Line 
(Многострочное) tipidagi maydonlar ishlatiladi. Bunday tipdagi 
obyektlarni yaratish uchun, sahifaga matn maydoni qo'yish kerak, 
masalan Insert > Form Objects > Text Field (Вставка > Объекты форм
> Текстовое поле) buyrug‘i yordamida. Xossalar paneli ochish va bu 
palitradan Multi Line (Многострочное) qayta ulagichni oling. Natijada, 
bir qatorli matn maydoni ko‘p qatorli matn maydoniga aylanadi. Uning 
uzunligi 18 simvoldan, balandligi esa 3 qatordan iborat.

Bu tipdagi obyektlar ishlash uchun yana Property Inspector (Ин­
спектор свойств) palitrasiga murojat qilamiz:

• Text Field (Текстовое поле) -  ko'pqatorli maydonning nomi.
• Char Width (Ширина в символах) -  matn maydonining simvol- 

larda belgilanadigan kengligi.
• Num Lines (Число строк) -  matn maydonining qatorlar soni.
• Int Val (Начальное значение) -  maydonining boshlanglch qiy- 

mati.
• Wrap (Перенос по словом) -  ko'p qatorli matn maydonida 

matnni yangi qatorga ko‘chirish imkoniyatlarini belgilaydi.

Savol va topshiriqlar:

1. Matnlarni formatlash jarayonida shriftni belgilash uchun qaysi 
deskriptordan foydalaniladi?

2. Shriftlar ro‘yxatini tahrirlash ketma-keligini aytib bering?
3. Matn oichamini belgilash uchun qaysi deskriptordan foydalaniladi?
4. Matnlarga rang berish ketma-ketligini aytib bering?

2.10. Grafikli formatdagi fayllar bilan ishlash

Grafik tasvirlar ishtirokisiz tuziladigan hujjatlar juda kamchilikni 
tashkil qiladi. Ayniqsa Web -  sahifalarini rasmlar, logotiplarsiz tasavvur 
ham qilib boimaydi. Bu kabi grafikli ma’lumotlarning turlari juda ham 
ko‘p. Ularni faqat formati bo‘yicha ajratish mumkin. Masalan, birgina 
rasm degan ma’lumot ostida har xil formatdagi fayllar yotadi. Faylning 
formati deganda ma’lumotni yozish va saqlash uchun belgilangan
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slandart qoidalar to'plami tushuniladi. Hozirda o'nlab grafikli formatlar 
inavjudki, ular turli tizim larda har xil m aqsadda qo‘llaniladi, Grafikli 
lormatlar uchta sinfga boMinadi. Bular: rastrli, vektorli, metafaylli. Bu 
lormatlar haqida keyingi boblarda batafsil m a’lumot berilgan.

Dasturning rasmlarni qo‘yish imkoniyatlari

Rasmlar W eb-sahifalarga jilo beruvchi vositalar hisoblanadi. 
Kasmlarni qo‘yish -  bu oddiy texnik operatsiya hisoblanadi. Dasturda 
rasmlarni qo‘yishning bir nechta y o ila ri bor. Avval rasmni qo‘yish 
buyruqlaridan birini tanlaymiz:

• Objects (Объекты) palitrasini oching, Common (Общие) boMi- 
miga o'ting, palitraning yuqori -  chap qismida joylashgan Insert Image 
(Вставка изображения) tugm asini bosing.

• Insert > Image (Вставка > Изображение) buyrug‘ini bering.
• CTRL+ALT+I tugm alar kombinatsiyasidan foydalaning.
• Tasvirni Assets (Фонды) palitrasidan hujjat oynasining kerakli 

qismiga ko‘chiring.
• Saytning dispetcheri oynasidan rasm ning belgisini olib hujjatning 

oynasiga tashlang.
• Rasmni ish stolidan hujjat oynasining kerakli joyiga tashlang.
HTML tilida esa bu vazifalarni <img> deskriptori bajaradi. Bu

deskriptor rasm ning barcha ko‘rsatkichlarini belgilaydigan bir nechta 
atributlarni o‘z ichiga oladi. Quyidagi misolda deskriptor o‘ziga to'q- 
qizta atributni bog'lagan:

<img src = «Temp/anim l.gif» width=«170» heigh t= «180» alt= 
«Tushuncha» border = « l»  nam e=«ins» align = «right» vspace = «50» 

hspace = «60»>
Shuningdek qo‘yilgan rasmga ram ka ham qo‘yish mumkin:
<img src = « 10.jpg» border = «l»>
Bu misolda border atributi ram kaning qalinligini bildiradi.

Rasmni fon sifatida qo‘yish

Biz yuqorida giperm atnli hujjatning param etrlarida fonga rang 
lanlash, fonga rasm qo‘yish bilan tanishib chiqdik. Endi rasmlarni fon 
sifatida qo‘yish bilan batafsil tanishib chiqamiz:
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1. M odify  > Page Properties (Изменить > Свойства страницы) 
buyrugLini bering.

2. Background Image (Фоновый рисунок) maydonida rasm faylini 
ko‘rsating.

Xuddi shu vazifani HTM L tilida <body> deskriptori yordamida 
bajariladi. M asalan, <body background = «image.jpg»> bunda rasm huj­
jat saqlangan katalogda joylashgan.

<body b ackground= «www.images.com/source/back.gif»> fragment i 
esa in ternetning ko'rsatilgan m anzilidagi rasm ni fon sifatida qo’yib 
beradi.

Interfaol rasmlar

Hozirgi kunga kelib rasmlar va anim atsiyalarsiz sahifalarni 
uchratish ju d a  qiyin. Aksariyat W eb-sahifalar animatsiyalar. animatsion 
tugm alar yoki harakatlanish tugm alari, rasmlar, interfaol rasm lar bilan 
boyitilgan.

In terfao l rasm lar so‘zi «rollover im age» iborasidan olingan b o iib  
so‘zm a-so‘z  tarjim ada « tasv irn i ko‘chirib  o‘tkazish»  m a’nosini bil­
diradi. A g ar W eb-sahifada biror rasm  ustiga sichqon ko 'rsatk ichini 
olib b o rgan ing izda  boshqa rasm  paydo b o lsa  b ilingki u rasm 
interfaol rasm dir. In terfaol rasm larn i qo‘yish quyidagi y o l  bilan 
bajariladi:

1. M atn kursorini rasm qo‘yiladigan joyga qo‘ying.
2. Insert > Interactive Image > Rollover Image (Вставка > Дина­

мические изображения > И нтерактивное изображение) buyrug in i 
bering. 2.23-rasm da ko’rsatilgan muloqot oynasi hosil bo lad i.

3. Bu m uloqot oynasining tegishli m aydonlarini to ld iring :
о Im age Name (Имя изображения) maydonda rasm ning nomi 

ko‘rsatiladi.
о O riginal Image (Исходное изображение). Joriy holatda ko‘- 

rinadigan rasm ning nomi ko‘rsatiladi.
о Rollover Image (И нтерактивное изображение). Sichqon ko'rsat- 

kichi kelishi bilan almashinadigan rasm ni nomini ifodalaydi.
° Preload Rollover Im age (П редварительная загрузка) -  bu 

bayroqcha rasm ni ko‘rish dasturlarida yuklash rejim ini ishga tu- 
shiradi.
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Insert Rollover linage

Image Name: Imaqe15

Original Image: I Browse,..

Rollover Image: | Browse... |

^  Preload Rollover Image

When Clicked Go To URL. Browse,..

2.23-rasm. Interfaol rasm ni qo'vish oynasi.

о When Clicked Go To U RL (переход по адресу) -  bu yerda 
I'ipermatnli o‘tish buyrug i saqlanadi.

4. Tegishli ko‘rsatkichlar kiritilgandan so'ng OK tugmachasini 
hosing yoki klaviaturadan ENTER tugm asini bosing.

Dreamweaver dasturi rasm larning dinam ik alm ashinuvini ko isat- 
nuiydi. Bu jarayonni faqat brauzer dasturlarida k o iish  mumkin. Brauzer 
<lasturlarini chaqirishning eng qisqa y o ii  F12 tugm asini bosishdir.

Savol va topshiriqlar:

1. Rastrli formatlar nima?
2. Vektorli formatlar nima?
3. Metafayllar nima?
4. Sahifaga rasm qo‘yish ketma-ketligini aytib bering?

2.11. Jadvallar qo‘yish va ular bilan ishlash

Jadvallar -  matnli va grafikli ma’lumotlarni saqlash uchun tayyor 
l**inia hisoblanadi. Bundan tashqari sahifalarda rasmlarni birlashtirish 
uchun, matn ostiga rasm qo‘yish uchun ham jadval kataklaridan 
luydalanish mumkin. Qatordagi ikkita yonma-yon joylashgan katak- 
t lialardan kolonka sifatida foydalansa boladi. Bir katakli jadvaldan
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tortib to m urakkab jadvalgacha -  bularning barchasi qator. ustun, 
katakchalarning oddiy kombinatsiyasidan tuzilgan.

HTM L tilida jadvalga tegishli barcha am allar yoki m a’lumotlar 
<table> </table> deskriptorlar juftligi orqali ifodalanadi. Bu deskrip- 
torning ko'plab atributlari mavjud. Bu atributlar yordam ida jadvalning 
eni, foni rangi, chegarasi, tekislash, maydon, kataklar orasidagi masofa 
va boshqa ko‘rsatkichlarni belgilash mumkin. Biz yuqorida HTM Lda 
jadvallarni qo'yishning barcha im koniyatlari bilan tanishib chiqdik. 
Endi esa Dreamweaverda jadval qo‘yish bilan tanishib chiqamiz.

Jadval qo‘yish

Jadval qo‘yish -  bu uncha qiyin bo'lm agan texnik jarayondir. 
Dreamweaverda jadval qo‘yish uchun quyidagi ketm a-ketlik bajariladi:

1. Jadval quyilishi kerak bo'lgan joyga kursorni qo‘ying.
2. Insert > Table (Вставка > Таблица) buyrug‘ini bering. Bu 

buyruqni bajarishning alternativ variantlari ham bor:
° CTRL+ALT+T tugm alar kombinatsiyasi;
° Object (Объекты) palitrasidagi Common (Общие) bo lim in ing  

Insert Table (Вставить таблицу) tugm asini bosish bilan;
3. Insert Table (Вставка таблицы) muloqot oynasi maydonlarini 

to‘ldiring (2.24-rasm). Bu oynaning boshqaruv elem entlarini ko‘rib 
chiqamiz:

L*i

Rom:

Columns: p!

Width: |75

Border: fT"

Cell Padding: f 

Cell Spacing: f  

P e rce n t ^1

OK

Cancel

Help

Insert Table

2.24-rasm. Insert Table muloqot oynasi.



о Rows (Строки). Jadvalning qatorlari soni.
о Colums (Столбцы). Jadvalning ustunlari soni.
° Width (Ширина). Jadvalning eni.
о Border (Рамка). Har bir katakchaning va butun jadvalning 

chegara ram kalari eni. Piksellarda beriladi.
о Cell Padding (Поля ячейки). Katakcha chegarasi va ichidagi 

ina’lumot orasidagi maydon kattaligi.
° Cell Spacing (Расстояние между ячейками). K ataklar orasidagi 

inasofa.
4. OK tugm asini bosing.
Ixtiyoriy ko‘rsatkichli jadval qo‘yilgandan keyin, uni to‘ldirish 

vaqtida yoki undan keyin ham  o‘zgartirish mumkin.

Jadvalli ma’lumotlarni import qilish

Dreamweaver dasturida tashqi m atnli fayllarni o‘qish va undagi 
jadvallarni o 'girib olish uchun maxsus buyruqlar mavjud. Jadvalli 
ma’lumotlarni im port qilish quyidagicha amalga oshiriladi:

1. File > Im port > Im port Tabular Data (Файл > Импорт > Импорт 
табличных данных) buyrug‘ini bering.

2. Import Table Data (И мпорт табличных данных) muloqot oynasi 
hosil b o lad i (2.26-rasm). Bu muloqot oynasining asosiy boshqaruv 
elementlari bilan tanishib chiqamiz:

° Data File (Файл данных). Bu maydonga jadvalli m a’lumot 
joylashgan faylni qidirish uchun to 'liq yo‘l ko‘rsatiladi.

° Delim iter (Разделитель). Bu ro‘yxatda m atnli fayldagi jadvalni 
boLluvchisi kiritiladi. Ro‘yxat o‘z ichiga quyidagi bandlarni oladi: Tab 
(Символ табуляции), Com ma (Запятая), Semicolon (Точка с запя­
той), Colon (Двоеточие), Other (Другой).

о Fit to Data (Подбирается по данным). Agar bu qayta ulagich 
o'rnatilgan bo‘lsa, jadval kengiligi har bir ustunda eng uzun qator 
o'lchami bo‘yicha tanlab olinadi.

° Set (Равна). Agar bu qayta ulagich o‘rnatilgan bo isa, u holda 
jadvalning enini oldindan belgilash m um kin boiadi.

о Cell Padding (Поля ячейки). Katakcha tashkil etuvchilari va 
chegarasi orasidagi m asofani belgilaydi.
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Format Non# 

Link

v  Default Font

Cell Ногг Default v  V  

Q 3 Vert Default v H

v  Size None v I f~̂ j
• v . t o  T«9«

Wo Wrap Bg 

Header! j B q !~L|

В I

Brdr Д Г

2.25-rasm. P ro p e rty  Inspector palitrasi.

Inset! Tabulae Data

Data File: ;:Jfile:///Q/Book/Chapler"2/ 1.htm Browse... |

Delimiter T ab

T able W idth: ** Fit to D a ta

z l

r Set:

Cell Padding: 

Cell Spacing:

j Percent j[ ]

: Format Top R o w :: | [No Formatting] ▼  I

Border. II

2.26-rasm. Jadvalli m a'lum otlarni im port qilish.

0 Cell Spacing (Расстояние между ячейками). Jadvalning yonma- 
yon turgan kataklari orasidagi masofani belgilaydi.

о Format Top Row (Ф орм атирование верхней строки). Jad­
valning birinchi qatorini fo rm atlash  uchun to’rtta  variantni tak lif  qi­
ladi.

о Border (Рамка). Bu yerda jadvalning chegaraviy ram kasining 
qalinligi belgilanadi. Agar ram ka zarur bo‘lm asa u holda bu maydonda 
nol ko'rsatish kerak.

3. OK tugmasini bosing.
Agar muloqot oynasida ko‘rsatilgan jadval tashkil qiluvchilari matnli 

fayldagi jadval tashkil qiluvchilariga to-g ‘ri kelmasa, u holda jadvalni 
import qilish n o to ^ r i  bajariladi. Aniqroq aytganda jadval buzilgan 
holda ko‘chadi.

122

file:///Q/Book/Chapler"2/1.htm


Savol va topshiriqlar:

1. Jadvallar bilan ishlashda qaysi deskriptorlardan foydalaniladi?
2. Jadval qo’yish ketma-ketligini aytib bering?
3. Jadvalli ma’lumotlarni import qilish qanday amalga oshiriladi?
4. Jadvalga qator yoki ustun qo’shish va ularni o‘chirish qanday amalga 

oshiriladi?

2.12. Sahifalarni brauzerlarda ko‘rish

Dreamweaver HTM L -  sahifalarni vizual tahrirlash dasturlari sin- 
liga kiradi. Dreamweaver dasturi HTM L sahifalarni m axsus dasturlar 
yordamida tabiiy tasvirlarga yaqin ko‘rinishda ko'rsata oladi. Bunday 
dasturlar brauzer dasturlari deb yuritiladi. Biz bu dasturlar haqida 
\ uqorida batafsil ma’lumot bergan edik. Brauzerlarda ko'rish ketma- 
ketligi bilan tanishib chiqamiz:

1. Sahifani brauzerda ko’rish uchun File > Preview in Browser 
(Файл > Просмотр в браузере) buyrug‘ini bering;

2. Ochilgan oynadan brauzerni tanlang;
Bu buyruq hujjat oynasida ham, uzel dispetcheri oynasida ham  

mavjud. Asosiy brauzerni yuklash uchun F I2 tugm asi xizm at qiladi. 
Asosiy va yordamchi brauzerlarni tanlash quyidagicha:

1. File > Preview in Browser > Edit Browsers List (Файл > про­
смотр в браузере > Изменить список браузеров) yoki Edit > 
Preferences (Правка > Настройки) buyrug’ini bering. Qaysi buyruqni 
hcrishdan qat’iy nazar, ekranda Preferences (Настройки) muloqot oynasi 
hosil bo‘ladi;

2. Bu muloqot oynasida barcha tegishli ko'rsatkichlarni kiriting va 
ularni o in a tilish i uchun OK tugm asini bosing.

• + belgisi ostidagi tugm a, hisobga olingan ko’rish dasturlari 
lo’yxatiga yangi brauzerni qo’shadi;

• -  belgisi ostidagi tugm a tanlangan brauzerni ro‘yxatdan o‘chi- 
rudi;

• Edit (Изменить) tugm asi ro‘yxatga olingan brauzer param etrlarini 
o'zgartirishga imkon beradi;

• Prim ary Browser (Первичный браузер) bavroqchasi ro 'yxatda 
tanlangan dasturni birinchi darajali brauzerga aylantiradi (birinchi 
darajali brauzerni chaqirish uchun F12 tugm asini bosish kerak);
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• Secondary Browser (Вторичный браузер) bayroqchasi ikkin­
chi darajali brauzerni tanlaydi. Bu vazifa CTRL+F12 tugm alar 
kombinatsiyasi yordamida bajariladi;

• Preview Using Local Server (Просмотр нелокальном серве­
ре) bayroqcha yordam ida lokal server yordamida sahifalarni k o iish  
rejimini o in a tish  yoki olib tashlash mumkin. Barcha serverga tegishli 
dasturiy ta’m inot lokal kompyuterga oldindan o‘rnatilgan bo iish i lozim.

D asturning bunday imkoniyatlari web-sahifani tayyorlash ja- 
rayonining o‘zida ko‘rish uchun qulaylik yaratib beradi. Bunda 
foydalanuvchi nafaqat bitta, balki bir nechta brauzerdan bittasini tanlash 
imkoniyatiga ega bo lad i. Brauzerlar sahifani bir xil ko‘rsatsada, ammo 
ulardan foydalanish, boshqarish va interfeys har xil bo lad i. Shuning 
uchun ham foydalanuvchi o'zi xohlagan brauzerni tanlash imkoniyatiga 
ega boladi.

Savol va topshiriqlar:

1. Sahifani brauzer dasturida ko‘rish uchun qanday buyruq beriladi?
2. Asosiy va yordamchi brauzerlarni tanlash ketma-ketligini aytib be­

ring?
3. Preferences (Настройки) muloqot oynasi tuzilishini tushuntirib 

bering?
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Ш -bob. KOMPYUTER GRAFIKASI VA DIZAYN

3.1. Kompyuter grafikasi va dizayn

Bizga m a'lum ki web dizaynning ajralmas qismi bu kom pyuter 
grafikasi hisoblanadi. Boshqacha aytganda kom pyuter grafikasi 
yordamida saytlarni dizayni m ukam allashtiriladi. Saytlarni be- 
/ash  uchun turli xil illustratsiyalar (rasmlar, grafiklar, roliklar, 
animatsiyalar, bannerlar va boshqalar) yaratishda va tayyor grafik 
formatdagi m a’lumotlarni o‘zgartirishda kom pyuter grafikasidan 
keng foydalaniladi. Kom pyuter grafikasi va uning tarkibiy qismi 
bo'lgan grafik va turli tasvirlar axborot texnologiyasida m uhim  o‘rinni 
i-gallaydi. Pedagogika oliy ta ’lim muassasalarida ta ’lim olayotgan 
tulabalarga kompyuter grafika va dizayn fanlarini o ‘rganish, 
ularga grafik axborot texnologiyalari haqidagi bilimlarni beradi va 
professional faoliyatida ulardan samarali foyda/anisliga tayyorlaydi. 
Boshqacha aytganda har qanday bo'lajak o'qituvchi, kelajakda 
o'zining fan i bo‘yicha elektron o‘quv resurslarini yarata olishi 
kerak. Bu bilan esa ta ’lim samaradorligiga erishiladi. 0 ‘qituvclii 
dasturlash texnologiyasidan yaxshi xabardor bo‘lishi lozim. Ammo 
и yaratgan resurslari talabalarni o ‘ziga tortadigan dizayn bilan 
hoyitilmagan bo‘lsa, и holda har qanday dasturiy mahsulotning 
o'qitish jarayonidagi samaradorligi past bo‘ladi. Shuning uchun 
liam dasturlash bilan birga kompyuter grafikasini ham mukammal 
o'rganish talab qilinadi.

Kompyuter grafikasi va dizayn fanidagi m aterallarni o‘rganish 
niilijasida quyidagilarni bajara olish mumkin:

-  rasm lar bilan ishlash;
-  ko‘p bo‘g‘inli statik rasm lar bilan ishlash;
-  grafik m uharrirlar im koniyatlaridan foydalanish;
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-  turli maqsadlardagi grafikli paketlarni qo‘llagan holda rang- 
barang grafik obyektlarni yaratish;

-  nashrga tasvirlarni tayyorlash.
Kompyuter grafikasi fani asosan elektron rasm va tasvirlar bilan 

ishlashni o‘rgatadi. Hozirgi kunda grafik dasturlar soni ju d a  ko‘p 
bo‘lib ular ishlash prinsipiga k o la  har xil grafikada ishlashi mumkin. 
Masalan: Rastrli grafika bilan ishlovchi dasturlar Paint, Adobe 
Photoshop, CorelPhotoPaint va boshqalar (grafik m uharrirlarning 
umumiy ro‘yxati 3.1-jadval).

3.1-jadval

Grafik m uharrirlar ro‘yxati

№ Grafik muharrir Izoh

1. Adobe Photoshop Rastrli grafikani qayta ishlash uchun 
moijallangan

2. TwistedBrush Pro Studio 
15.74

Tasvirlarni chizish va tahrirlashga 
moijallangan grafik muharrir

3. CorelDraw Graphics Suite X4 Vektorli grafika bilan ishlashga m oi­
jallangan grafik muharrir

4. CorelDraw Graphics Suite X4 3D-modellashtirish, animatsiya va vi- 
zualizatsiya uchun moijallangan

5. Adobe Flash CS3 Professional Professional animatsiyali Flash-fayl- 
larni yaratish uchun moijallangan 
dastur.

6. Paint.NET Grafik muharrir (standart Paint das- 
turini o'rnini bosuvchi)

7. AutoCAD 2010 Eng murakkab loyihalarni chizishga 
moijallangan dastur

8. Adobe Illustrator С S3 Har qanday murakkablikdagi vektorli 
tasvirlarni yaratishga moijallangan

9. Adobe Creative Suite 5 
Master Collection

Loyihalarni chizish va qayta ishlashga 
moijallangan dastur
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10. ZBrush 3.0 Ikki va uch olchamli loyihalashga 
moijallangan grafik muharrir

11. The GIMP Rastrli grafik muharrir

12. Adobe InDesign CS3 Har qanday dizayndagi chop etiladigan 
va Internet nashrlarini loyihalashga 
moijallangan professional dastur

13. Xara Xtreme Pro rastrli va vektorli grafikani qo'llagan 
holda professional web-grafikani 
yaratish uchun moijallangan grafik 
muharrir

14. Adobe Fireworks CSS Web-saytlar uchun grafikani tayyor- 
lashga va moijallangan grafik mu­
harrir

15. Corel Painter 11 Illyustratsiyalar chizish va tayyor- 
lashga moijallangan dastur

Rastrli grafik m uharrirlarida har bir tasvir nuqta ya’ni piksel asosida 
4iiriladi. Bu dasturlar yordamida yaratilgan fayllar *.bmp. *.jpg, *.psd„ 
Mif va boshqa form atlarda saqlanishi mumkin. Bu turdagi fayllar 
iimglari yorqinligining juda sifatliligi bilan ajralib turadi, ularning
l amchiligi sifatida esa tasvirni kattalashtirish bilan uning sifati yo'qolib 
borishini va xotiradan ko‘p joy egallashligini aytib o‘tish lozim. Shuning 
uchun ko‘pincha ulardan tayyor rasm larni qayta ishlashda foydalanish 
i.ivsiya qilinadi.

3.2. Axborot va uni taqdim etishning turli ko‘rinishlari

Hozirgi kunda inson faoliyatining turli sohalari ichida o‘zining 
niuhimligi bilan ajralib turuvchi soha -  bu tashkiliy, ya’ni ishlab 
iliiqarish va xo'jalik hamda ijtimoiy jarayonlarni boshqaruv sohasidir. 
Itusiz barcha sohalarda faoliyat yuritib boim aydi. Boshqaruv axboroti
I a rayon hisoblanib, tizim lar holatini qanday o‘zgarishiga qarab qo‘yilgan 
maqsadga erishish uchun yetakchi yo‘nalishdir. Har qanday tizim  to‘g‘ri 
\ I teskari aloqa tam oyilidan iborat.
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M a’lumki, insonlar bir-biriga axborotlarni uzatish jarayonida matn, 
jadval, tovush va tasvir ko'rinishdagi signallardan foydalanadi.

Axborotlarni uzatish turli xil usullarda, ya’ni xabarchi yordamida, 
pochta orqali, transport vositalari yordamida, aloqa tarm og'idan uzoq 
masofaga uzatish yordamida amalga oshiriladi. A loqa tarm og 'i bo'yicha 
uzoq masofaga uzatish usulida m a'lum otlarni uzatish vaqtini sezilarli 
darajada kamaytiradi. Buning uchun m axsus texnika vositalari mavjud. 
Axborotlarni yig‘ish va hisobga olishni texnik vositalari ish joyida 
o‘rnatilgan datchiklar yordamida axborotlarni avtom atik ravishda 
yig‘adi, ham da kompyuterga uzatadi.

Matn ko‘rinishda berilgan axborotlarni qayta ishlash texnologiyalari

M a’lumki, eng ko‘p tarqalgan kom pyuter texnologiyalari quyi- 
dagilardan iborat:

-  matnli ma’lumotlarni tahrir qilish;
-  jadval va grafik ko‘rinishdagi m a’lumotlarga ishlov berish. 
M atnlar bilan ishlash uchun matn m uharrirlaridan foydalaniladi.

Hozirgi paytda ko’plab matn m uharrirlari ishlab chiqilgan. Umuman 
ularning vazifasi bitta ammo, beradigan imkoniyatlari va ularni 
amalga oshirish vositalari turlicha. Bu grafik m uharrirlari va elektron 
jadvallarga ham tegishlidir.

Formatlash vositasining yordam idan foydalanib hujjatni tashqi 
ko'rinishini yaratish, stilini o'zgartirish. tagiga chizish, kursiv harflarini 
ajratish, simvollar oicham larini o 'zgartirish, satr boshini ajratishi, 
ularni o'ng, chap tomonlari va m arkazga nisbatan tekislash va ramka 
(hoshiya) ichiga olish mumkin.

Jadval ko‘rinishda berilgan axborotlarni qayta ishlash texnologiyalari

Jadval ko'rinishidagi hujjatlar har qanday korxonada hujjat 
aylanishining katta qismini tashkil qiladi. Elektron jadval kompyuter 
xotirasida joylashgan ikki o‘lchamli m assivning satrlari va ustunlarini 
o'zida ifodalaydi.

Jadval m uharrirlari ko‘plab moliyaviy va ma’m uriy masalalarni 
yechish imkonini beradi. M asalan, oylik maoshni hisoblash va boshqa 
hisobga olish masalalari: sotuv hajm ini, bozor o'sishini, daromadlarni
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lahlil qilish; foiz stavkalari va soliqlarini tahlil qilish; moliyaviy 
ilcklaratsiyalar va balans jadvalarini tayyorlash; sotish hajmini va 
slrukturasini hisobga olish uchun hisobchi daftarini yuritish; smeta 
kalkulyatsiyasi; pul cheklarini hisobga olish; budjetga va statistikaga
о id hisoblashlar.

I'asvir ko‘rinisbda berilgan axborotlarni qayta ishlash texnologiyalari

Ixtiyoriy matn yoki hujjatda grafiklar, diagrammalar, chizmalar. 
lasmlar, yorliqlarini kiritish ehtiyoji grafik m uharrirlarini yaratish 
/aruriyatini hosil qiladi. Grafik m uharrirlar qurol vositalardan iborat 
boiib, ular o‘ziga mos axborot texnologiyalardan foydalanib grafik 
nbrazlarini yaratish va o 'zgartirish im koniyatlarini beradi.

Axborot texnologiyalarida grafik m uharrirlar quyidagi turlardan 
loydalanadi:

-  tijorat grafikasi;
-  tasviriy grafika;
-  ilmiy grafika.
Tijorat grafikasining axborot texnologiyasi aylanma diagrammalar, 

nstunli gistogrammalar, chiziqli grafiklar hamda boshqa tipdagi ikki 
va uch olcham li grafik ko'rinishda elektron jadvalli m uharrirlarida, 
ma'lumotlar bazalarida va alohida lokal fayllarda saqlanayotgan axbo­
rotlarni ekranga akslantiradi.

Tasviriy grafikaning texnologiyasi turli xil matnli hujjatlar uchun 
regulyar va noregulyar struktura ko'rinishdagi foydalanuvchining 
lasinlari (piksel grafikasi) tasvirini yaratish imkoniyatlarini beradi. 
lasviriy grafika texnologiyasini amalga oshiruvchi muharrirlar 
loydalanuvchiga chiziq qalinligi va rangi, palitra quymasi, matnni yozish 
uchun shrift, oldin yaratilgan grafik obrazlarini tanlash uchun vosita 
beradi. Bundan tashqari, foydalanuvchi rasmni o‘chirish, qirqish va 
lining qismini bir joydan boshqasiga surishi mumkin. Ammo, tasvirlarni 
laydda, maxsus effektlar va ularni jonlantirish rejimida ko‘rish 

imkoniyatlarini beruvchi (CorelDraw, Stonyboard, 3DStudioM AX va 
boshqalar) informatsion grafik texnologiyalar ham bor.

Ilmiy graiikaning texnologiyasi kartografiya masalalari, kimyo- 
s iy. m atematik va boshqa form ulalarni o‘z ichiga oluvchi ilmiy 
liisoblashlarni bezab joylashtirish uchun xizm at qiladi.
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Kom pyuter grafikasi qo'llaniladigan asosiy sohalarni ko‘rsatib 
o‘tamiz:

1) G rafiklarni chizish;
2) Kartografik-geografik, tabiiy yoki iqtisodiy hodisalarni o’zam 

chegaradosh mamlakatlar, viloyatlar, o ik a la r va shu kabiiarni aniq 
tasviri;

3) Chizm a va konstruktorlik ishlarini avtomatlashtirish;
4) M odellashtirish va multiplikatsiya;
5) Turli texnologik jarayonlarni boshqarish -  real dunyo massh- 

tabida interfaol rejimda ishlash. Texnologik jarayonni eng kerakli 
nuqtalariga o‘rnatilgan dastlabki axborot manbai b o igan  datchiklardan 
kelayotgan axborotlar qiymatini vizual idrok qilish;

6) N ashr ishlarini avtomatlashtirish va chop etishni elektron usuli. 
Reklama va san’at -  qandaydir fikrni ifodalash va estetik yoqimli 
tasvirlar orqali jam oani diqqatini tortish.

Tasvir ко 'rinishda berilgan axborotlarni qayta ishlashning 
umumiy masalalari

Tasvir ko‘rinishida berilgan axborotlarni kompyuterda qayta ishlash 
texnologiyasi xilma-xil bo iib , juda ko‘p amaliy masalalarni ha! qilishga 
tatbiq etiladi. Axborotlarni qayta ishlashning bu sohasini quyidagi uch 
yo‘nalishga ajratiladi:

1. Kompyuter grafikasi (COM PUTER GRAPHICS);
2. Tasvirlarni qayta ishlash (IMAGE PROCESSING);
3. Tasvirlarni tanib olish (COM PUTER VISION).
Tasvir ko‘rinishga ega boim agan  axborotlarni vizuallashtirish (va'ni 

tasvirni yaratish) masalalari bilan kompyuter grafikasi (COMPUTER 
GRAPHICS) shug‘ullanadi.

V izuallashtirish tasvirlanishi zarur bo igan  obyektning tasnifi 
(modeli) asosida bajariladi. Hozirgi paytda vizuallashtirish usullari va 
algoritmlari juda ko‘p boiib , ular nim ani va qanday qilib aks ettirish 
bilan bir-biridan farq qiladi.

V izuallashtirishga misollar (murakkablashib borish tartibida) sifatida 
quyidagilarni ko‘rsatish mumkin:

-  funksiyalar grafigi;
-  diagrammalari;
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-  geografik xaritalar;
-  animatsiyalar.
Shuni takidlab o‘tish kerakki, grafiklar vaqtga nisbatan o‘zgarmas 

(statik) bo'ladi.
Tasvirlarni qayta ishlash (IM AGE PROCESSING) -  bu tasvir­

larni alm ashtirish bilan bog'liq masalalar. Tasvirlarni qayta ishlash 
iilgoritmlari uchun boshlang'ich m a’lumotlar ham tasvirlar, natija ham 
tasvirlar husoblanadi.

Grafik ma’lumotlarni tasvirlash

1. Kompyuter grafikasi turlari
Kompyuter grafikasi tasvirlarni shakllantirish usullariga bog'liq 

lwlda 3 turga boMinadi:
1. Rastrli grafika;
2. Vektorli grafika;
3. Fraktal grafika.
Ular bir-birlaridan tasvir ko‘rinishdagi axborotlarni hosil qilish va 

qayta ishlash texnologiyalari bilan farq qiladi.
Rastrli grafika vositasida shakllangan tasvir asosan elektron va 

poligrafiya nashriyotlarida qo'llaniladi. Rastrli tasvir ikki oTchovli 
inassiv (matritsa) ko‘rinishdagi nuqtalar to‘plam idan iborat bo‘lib, ular 
piksellar deb ataladi. Rastrli tasvirning eng kichik elementi peksildan 
iborat (3.1-rasm).

Uning atributlari boshqa piksellarning 
atributlari bilan bog‘liq emas. Komp­
yuterda qo'llaniladigan operatsion tizim- 
larning imkonitiyaga ko‘ra, 480x640,
800x600, 1024x768 va undan ko'proq 
pikselga ega bo'lgan tasvirlar joylashishi 
mumkin. Tasvirning oTchamiga ko‘ra 
uning imkoniyati ham oshib boradi.
Ekranning imkoniyati param etrik boTib, 
bir dyuym dagi nuqtalar soni bilan bel­
gilanadi. Rastrli grafik vositalari bilan 
bajarilgan (tayyorlangan) tasvirlar juda

3. l-rasm. Rastrli grafikada 
piksellarning ko'rinishi.
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kam  hollardagina kom pyuter dasturlaridan fovdalanib ishlab chiqiladi. 
Bu m aqsadda professional rassom chizgan rasm yoki fotografiya texnik 
vositalar yordamida kompyuterga kiritiladi.

Oxirgi paytda rastrli tasvirlarni kompyuterga kiritish uchun 
raqamli foto va videokam eralardan foydalanilmoqda. Shu sababli rastr 
grafikasini asosiy maqsadi tasvirni yaratish emas, balki mavjud tasvirni 
qayta ishlashdir.

Rastrli grafikning ijobiy tom onlari sifatida quyidagilarni ko isatish  
mumkin:

□ universalligi (bu formada har qanday tasvirni taqdim  etish 
mumkin);

□ shakllantirishning soddaligi;
□ rang jilolarini berish aniqligining yuqoriligi.
Ushbu usulning salbiy tom onlari sifatida quyidagilarni ko isa tish  

mumkin:
□ rastrli grafik bloklar hajm ining juda kattaligi;
□ ularning masshtabi o'zgarganda tasvir sifatining pasayishi.
Rastrli grafikada har bir tasvirni kodlash va saqlash uchun katta

hajmdagi xotira talab etiladi. Tasvirdagi juda kichik obyektlarni k o iish  
uchun uning m asshtabini kattalashtirib bo'lmaydi. Bu rastrli tasvirlarni 
qayta ishlash jarayonida ba’zi bir m uam m olarni paydo boiish iga olib 
keladi.

Rastrli tasvirlar quyidagi tiplarga bo‘linadi: binar. kulrang, palitrali, 
to iiq  kulrang. Bunda tasvirning elementlari faqat ikki qiymatni (0-yoki 
1) qabul qilish m um kin. Bu tasvirlar turlicha paydo boiish i mumkin. 
Am m o ko'p hollarda kulrang, palitrali va turli rangli tasvirlarni 
o 'zgarm as yoki adektiv chegaraviy son bilan binar tasvirga alm ashtirish 
natijasida paydo boladi. Binar tasvirlarni saqlash uchun juda ham 
katta joy talab qilinadi. U larning har bir elementi uchun 1 bit joy kerak 
bolad i. Kulrang tasvirning elementlari m aium  bir rang intensivligining 
turli xil qiym atlarini qabul qiladi. Odatda bu tasvirlarning har bir 
elementini saqlash uchun 8 bit ishlatiladi. Kulrang tasvirlar turli xil 
amaliy m asalalarni hal qilishda eng ko'p qollaniladigan tasvirlardan 
biri hisoblanadi.

Palitrali tasvirlarning har bir elementiga ranglar xaritasining bir 
katakchasidagi rang mos qo'yiladi. Palitra -  bu ikki olchovli massiv
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boiib, uning qatorlariga turli ranglar, har bir ustunlariga esa ma’lum bir
rangning intensivligi joylashtiriladi.

To‘liq rangli tasvirlar elementlari rangni tashkil etuvchi yorqinliklari 
haqidagi axborotni o‘zini saqlaydi. Shu bilan u palitiali tasvirlaidan 
farq qiladi. Amaliy masalalar yechishda qaysi tipdagi tasvirni tanlash 
masalasining o‘ziga xos xususiyatlaridan bog lab, tasviidagi zaiur 
axborotni qanchalik to iiq  ifodalanishi bilan xaiakterlanadi.

V ektorli grafika vositasida shakllangan tasvii sodda grafik 
obyektlar to‘plamidan tuzilgan boiib , uning tipik elementiga mos 
keladi. Vektorli tasvirning asosiy elementi chiziq bo lib hisoblanadi.

Kom pyuter xotirasida bu chiziq juda katta jov  egallam a\d i, 
chunki xotirada chiziqni faqat param etrlari ко rsatiladi. Unda 
sodda obyektlar m urakkab obyektlarga birlashtii iladi, shu sababli 
vektor grafikasini obyektga y o ‘n a l t i r i l g a n  grafika deb ham aytiladi. 
Kompyuter xotirasida vektor grafikasi chiziqlar sifatida saqlanib 
turishiga qaram asdan, tasv ir ekranga nuqtalar sifatida chiqariladi. 
Tasvirni ekranga chiqarishdan oldin hai bii param etrni hisoblab 
chiqadi. Shu sababli vektor g r a f i k a s i n i  hisoblanuvchi grafika deb 
aytiladi. Vektor grafikasi yordam ida sodda tu idag i bezash ishlaiini
olib borish m um kin.

Vektorli grafik tizim ning muhim tavsifi bo iib . uning sodda grafik 
elementlarining tarkibi xizm at qiladi. Sodda grafik elementlariga bir
nechta misol keltiramiz:

-  Koordinatasi ko lsatilgan  n u q ta la r  boshlanuvchi ma’lum bir 
burchak ostida yo‘nalgan va berilgan uzunlikka ega bo lgan chiziq,

-  M arkaziy koordinatalari ko'rsatilgan nuqtada joylashuvchi, yarim  
o'qlarining uzunligi, chiziqning rang va qalinligi, hamda uni bo yash
rangi berilgan ellips;

-  Chap tomondagi yuqori b u rch a g ig a  joylashgan nuqtaning koor­
dinatalari, tomonlar uzunligi, chiziq qalinligi va rangi ko isatilgan
to’g‘ri to’rtburchak.

Vektorli tasvirni k o is a ta y o tg a n d a  sodda elementlarning chiziqli 
geometrik atributlari, uning boshlang ich va zaiui о lchamlari 
o’rtasidagi munosabatni, ham da chiqarish quiilm alarida (monitoilar, 
chop etish qurilmasi) ru x sa t berilgan xatolikni hisobga olgan holda 
hisoblab chiqadi. Bunday usul masshtablashtirish imkoniyatini sezilarli
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darajada oshiradi. Tasvir o icham ini qancha ko'paytirsa ham, uning 
sifati o'zgarmaydi. Tasvirning o icham larin i juda kichiklashtirib 
yuborganda, sodda elem enlarning chiziqlari ustm a-ust tushib qolishi va 
xatolarni ixchamlash hisobiga u o‘zgarishi (buzilishi) m um kin.

F ra k ta l  g ra fik a  vositasida shakllangan tasvirlar ham xuddi vektorli 
grafika kabi m atem atik hisoblarga asoslangan. Am m o kompyuter 
xotirasida hech qanday obyektni saqlamasligi bilan undan farq qiladi. 
Tasvir tenglam a (yoki tenglam alar tizim i) bo‘yicha quriladi. Shuning 
uchun formulalardan boshqa hech narsani saqlash kerak emas.

«Fraktal» atam asi lotincha F rac tu s  so‘zidan olingan va u «qis- 
m lardan tuzilgan» m a’nosini anglatadi. Frantsuz matem atigi Benua 
M andelbrot 1975-yilda «The fractal geometry of Nature» kitobini nashr 
qildi va fraktal so‘zi eng ko‘p tarqalgan atamalardan biriga aylandi.

Eng sodda frak ta l obyekt sifatida qor uchqunlarini yoki 
paporotnik  bargini keltirish m um kin. Shuning uchun ham  fraktal 
obyekt chizish yoki bezash asosida em as, balki program m alashtirish  
asosida hosil b o lad i. K om pyuterda tashkil qilingan turli 
o‘y in larda ham  frak tal grafikasidan foydalaniladi. F raktal grafikasi 
kom pyuter xotirasida saqlanib turm avdi. H ar bir tasv ir tenglam a 
yoki tenglam alar sistem asi asosida quriladi. F raktal grafikadagi 
tenglam aning biror koeffitsiyentini o 'zgartirish  orqali butunlay 
boshqa tasv irn i hosil qilish m um kin.

Sanab o'tilgan kompyuter grafikasi turlarini tashkil qilish va ularni 
boshqarish uchun bir qator dasturiy vositalar ishlab chiqilgan.

Rastrli tasvirlar va ularning asosiy xarakteristikalari

Rastr -  bu juda kichik yuzaga ega bo igan  geom etrik figuralar 
(piksellardan), masalan kvadratchalardan tuzilgan matritsa. Har bir 
piksel o‘z I'angiga ega bo iish i m um kin. Turli ranglarga ega bo igan  
rastrlar to‘plami tasvirni tashkil etadi. Tasvir ko'rsatilayotgan sirtda 
piksellarni joylashishiga nisbatan rastrlar turli tiplarga bolinadi: 
kvadrat, to 'rt burchak, doira va shu kabilar. Piksellar joylashishini 
tasvirlash uchun turli xil koordinata tizim laridan foydalaniladi. Bu 
tizim larni ham m asi uchun umumiy b o igan  xossa, ularda piksel 
koordinatalarining diskret qiym atlar qatoridan (butun son bolm aslig i 
m umkin) tashkil topgandir. Ko‘p hollarda butun sonlar koordinatasidan
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loydalaniladi. Bunda piksellarning boshlang'ich koordinatasi chap 
lomondagi yuqori burchakdan boshlanadi.

Rastning geometrik xarakteristikalari quy idagilardan iborat:
□ Ruxsat berilgan xatolik;
□ 0 ‘lcham;
□ Piksel shakli.
Rastrda ruxsat berilgan xatolik o‘zaro qo‘shni (yonma-yon) joy- 

hishgan piksellar orasidagi masofa bilan xarakterlanadi. Ruxsat berilgan 
\;ilolik bir birlik uzunlikdagi piksellar soni bilan o‘lchanadi. Eng ko‘p 
i.irqalgan oichov  birligi bo‘lib, dp i (dots per inch) xizm at qiladi. U bir 
dyuym (25,4 mm) uzunlikdagi piksellar soni.

Rastrning o'lchami odatda gorizontal va vertikal o'qlar bo‘yicha 
loylashgan piksellar soni bilan aniqlanadi. Shuni ta'kidlab aytish 
mumkinki, har ikki o'qlar uchun bir xil qadamli (ya’ni, dpiX =dpiY) 
mstr kompyuter grafikasi uchun juda qulay. Bu ayniqsa grafik 
obyektlarni chiqarish algoritmlari uchun qulay. Aks holda muammo 
paydo bo'ladi.

Rastr piksellarining shakli tasvirni chiqarish qurilm asining xu- 
stisiyatlari bilan aniqlanadi. M asalan, piksellar quyidagi shakllarda 
lurlishi mumkin:

1. Kvadrat (yoki to 'g 'ri to 'rtburchak shaklidagi piksellar). Ular 
o'lchami bo'yicha rastr qadamiga teng (suyuq kristalli displeyda);

2. Doira shaklidagi piksellar. U lar o'lcham i bo'yicha rastr qadamiga 
long bo'lmasligi m um kin (printerlar).

Ranglar soni (rang chuqurligi) ham rastrning eng muhim xa-
i ikteristikalaridan biri. Ranglar soni faqat rastrli tasvir uchun emas. 
Ihilki har qanday tasvir uchun ham muhim xarakteristika hisoblanadi.

Savol va topshiriqlar:

1. Kompyuter grafikasi nima?
2. Qanday grafik muharrirlar bor?
3. Grafikaning qanday turlari bor?
4. Kompyuter grafikasi qanday turlari bor?
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IV-bob. ADOBE PHOTOSHOP DASTURI

4.1. Adobe Photoshop dasturi haqida

Adobe Photoshop Windows m uhitida ishlovchi elektron ko‘ri- 
nishdagi foto tasvirlarni tahrir qiluvchi dasturdir. Adobe Photoshop 
dasturi Adobe System, Inc kompaniyasi tom onidan ishlab chiqarilgan 
boiib , ishlatishdagi alohida qulayliklari bilan m ashhur hisoblanadi.

Adobe Photoshop grafik m uharriri yordamida fotosuratlarga qo‘- 
shimchalar kiritish, fotosuratdagi d o g larn i o'chirish va eski rasmlarni 
qayta ishlash va tiklash, rasm larga m atn kiritish, qo‘shim cha maxsus 
effektlar bilan boyitish, bir fotosuratdagi elementlarni ikkinchi 
fotosuratga olib o'tish. ranglarni o 'zgartirish, alm ashtirish mumkin. 
Adobe Photoshop im koniyatlari keng qamrovli bo iib , u gazeta va 
jurnallarn i turli tum an rasm lar bilan boyitishda juda katta qulayliklar 
yaratadi.

Adobe Photoshop ayniqsa dizaynerlar, rassom larning ijodiy im­
koniyatlarini to la  amalga oshirishlarida yordam beradi. Jurnalistika va 
bevosita matbuot yoki nashriyot sohasiga aloqador b o igan  shaxslarning 
m azkur dastur bilan ishlashni bilishi ular uchun qo'shimcha 
imkoniyatlarni yaratib beradi. Adobe Photoshop juda murakkab 
dasturdir. Foydalanuvchilar uning asosiy imkoniyatlaridangina foy- 
dalanadilar xolos.

D asturni ishga tushirish ketm a-ketligi quyidagicha: Windows 
95, 98, M E, 2000, X R  yoki NT operatsion tizim larida Start (Пуск) 
tugm asi ustida sichqoncha chap tugm asini bosing Programs (Програм­
мы) bolim iga kiring so'ngra Adobe Photoshop elementi ustiga yana 
sichqoncha chap tugm asini bilan bosing. Bundan tashqari ish stolida 
mavjud Adobe Photoshop uchun maxsus belgida «sichqoncha»ning
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chap tugm asi ikki m arta bosish y o ii  bilan ham  dasturni ishga tushirish 
mumkin.

Adobe Photoshop dasturidan chiqish uchun quyidagi usullarning 
biridan foydalanish mumkin:

Alt + F4 tugm alarini bosish.
Файл m enyusining Выход b u y ru g in i tanlash.
Ekranning yuqori qismi o‘ng burchagida joylashgan x belgili 

lugmachani bosish yoki Файл > Закрыть b u y ru g in i berish;
D asturning har bir versiyasi o‘zida yangi elementlarni mu- 

jassamlantirgan. Bu o'zgarishlar Photoshop 7.0 versiyasida ham ku- 
zatiladi.

4.2. Adobe Photoshop dasturi oynasi qismlari

Adobe Photoshop dasturi ishga tushirilgandan so‘ng ekranda Adobe 
Photoshop tasvir tahrir qiluvchi oynasi hosil bo lad i.

Adobe Photoshop oynasining yuqori qism ida sarlavha satri 
va W indowsga xos elem entlar joylashadi. Sarlavha satridan so‘ng 
menyu satri joylashadi. M enyudagi kerakli buyruqlarni tan lash ingiz 
mumkin.

Adobe Photoshop dasturi menyusi 9 banddan iborat. H ar bir menyu 
tarkibida ochiladigan m enyu bandlari mavjud. U larni ko‘rish kursor 
yordamida amalga oshiriladi. D asturning barcha buyruqlari uchun 
Asosiy m enyu (Главное меню) mavjuddir:

Файл (File) menyusi quydagi holatlarda ishlatiladi: yaratish (соз­
дать), ochish (открыть), joylashtirish (разместить), yopish (за­
крыть), saqlash (сохранить), skanerlash (отсканеровать), import 
va eksport, qog'ozga chiqarish (напечатать изображение), faylni 
tarmoq orqali uzatish (передать файл по сети), bir nechta Opsiyalarni 
avtomatlashtirish uchun va albatta Photoshop dasturidan chiqish uchun.

Правка (Edit) menyusida, tasvirni tahrirlash ya'ni sozlash uchun 
buyruqlar: nusxalash (копирования), o 'zgartirish (трансформации), 
joylashtirish va tasvir ranglarini tusini va muyqalam qalinligi va turini 
tanlash mumkin.

Режим (Mode) menyusi orqali Image (Изображение) menyusi, 
tasvir sakkiz turdagi tasvir urinishlarini tanlash m um kin.
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Слой (Layer) menyusida joylashgan buyruqlar, bir necha qal- 
lamlarda joylashgan tasvir ustidagi am allar ya'ni: qatlamlararo 
boglanishni qatlamlar ketma-ketligini va qatlam larni um um iy qatlamga 
birlashtirish imkoniyatini beradi.

Выделить (Select) m enyusida joylashgan buyruqlar — kerakli 
qatlamlarni tanlashda (belgilashda) ishlatiladi.

Филтр (Filter) menyusi o 'zida tasvirlarni birlashtirish va umumiy 
holga keltirish uchun kerakli bo igan  filtrlari mavjuddir.

Вид (View) menyusidagi buyruqlar, ekrandagi tasvirni ko'ri- 
nishlarini va dastur oynasi qismlarini nazorat qiladi.

Окно (Window) menyusi buyruqlari, ekrandagi boshqa tasvirlarni 
aks ettiradi va ulardan kerakli bo igan  paytda foydalanish imkonini 
beradi.

Помощь (Help) menyusidagi buyruqlar foydalanuvchi uchun kerakli 
bo igan maslahatlar orqali ko‘m ak va hozirda bajarish m um kin bo igan  
imkoniyatlar bilan tanishtiradi hamda Photoshop yaratuvchilari rasmiy 
saytiga murojat qilish imkoniyatini beradi.

4.1-jadval

Dastur menyulari va ulardagi buyruqlar

Файл (File) menyusi buyruqlari

Новый (Ctr+N) Yangi fayl yaratish

Открыть (Ctrl+O) Bu buyruq yordamida diskda mavjud fayllar 
ochiladi

Открыть как (Alt+Ctrh-O) Faylni qanday ko‘rinishda ochishni tanlash

Сохранить (Ctrl+S) Faylni xotiraga mavjud formatda yozish

Сохранить как Shift+Ctrl+S Faylni xotiraga boshqa nom bilan yoz­
ish. Ushbu buyruq fayl nomi, format 
va joylashgan papkasi kabi atributlarini 
o'zgartirishda foydalaniladi

Сохранить Копию 
(Alt+Ctrl+S)

Tasvir nusxasini xotiraga yozish
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Пернуть Tasvirning dastlabki holatiga qaytish

1Уместить Boshqa mustaqil fayl bilan birlashtirish

Импорт Boshqa papkada joylashgan faylni Adobe 
Photoshop dasturiga olib kirish

•кспорт Tasvirni boshqa papkaga jo'natish

'1».1Йл информация Fayl haqidagi ma’lumotlarni kiritish

V\ гановка страницы 
lMiift+Ctrl+P)

Tasvirni printer yordamida chop etishga 
tayyorlash, qog‘oz shaklini tanlash

1К чать (Ctrl+P) Tasvirni printerga jo'natish

11редпочтения Adobe Photoshop dasturini kerakli tartibda 
sozlash

11иетройка цвета Tasvir ranglarini sozlash

Vlobe online Internet bilan bog‘lanish

Им ход (Ctrl+Q) Adobe Photoshop dasturidan chiqish

ПРАВКА (Edit) menyusi

l.cpn (Ctrl+Z) Tasvir ustida bajarilgan oxirgi amalni bekor 
qilish

i V ta гь (Ctrl+X) Tasvirning ajratilgan qismini buferga (xo­
tiraga) olish

Копировать (Ctrl+C) Nusxa olish

Мпавить (Ctrl+V) Buferdan (muvaqqat xotiradan) kursor ko‘r- 
satgan joyga qo‘yish

1 ti i авить (Shift+Ctrl+V) Buferdan (muvaqqat xotiradan) belgilangan 
joyga qo'yish

i (чистить Tasvirda belgilangan maydonni tozalash, 
o‘chirish. Bunda o'chirilgan maydon fon 
rangiga bo'yaladi.
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davom I

Залить Штрих Tasvir yuzini asosiy rang bilan bo'yash

Трансформация (Ctrl+T) Tasvirda belgilangan maydonni shtrixlab 
ko‘rsatish

Трансформ Tasvir shaklini o‘zgartirish. Tasvir shaklini 
turli ko'rinishlarda o'zgartirish

Очистка «История» darchasida tasvir olib borilgan 
o’zgartirish amallarini butunlay o‘chirish. Bu 
amal bajarilgandan so'ng o‘zgartirishlarni 
ortga qaytarish mumkin emas

ИЗОБРАЖЕНИЕ (Image) menyusi

Режим Rang modellarni o'zgartirish

Настройка Tasvir ranglarini sozlash

Дубликат Tasvirdan nusxa olish

Наложить изображение Tasvirni qo‘shimcha ranglar bilan bovitish

Вычисление Tasvirdagi ranglar kanallarini o‘chirish

Размер изображения Tasvir shaklini va oichamlarini o‘zgartirish

Размер холста Tasvir ramkasi oichamlarini o‘zgartirish

Обрезание Belgilangan maydondagi tasvirni kesib olish

Перевернуть Холст Soat strelkasi bo‘ylab yoki soat strelkasiga 
qarshi 180°, 90° burish

Гистограмма Tasvirdagi ranglar miqdori haqidagi ma’­
lumotlar darchasi
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СЛОЙ (Layer) menyusi

11овый yangi qatlamni hosil qilish

Лубликать слоя qatlam nusxasini hosil qilish

Учалить слой mavjud qatlamni muvaqqat xotiradan 
o'chirish

! )ффекты qatlamga turli effektlarni qo‘shish

I руппа с предыдущим 
(( ui+G)

qatlamlarni bir-biriga birlashtirish

Газгру пировать 
(Sliift+Ctrl+G)

qatlamlarni bir-biridan ajratish

( клеть все слои mavjud barcha qatlamlarni birlashtirish

ВЫБОР (Select) menyusi

Ike (Ctrl+A) tasvirni belgilash

Убрать выделение (Ctrl+D) tasvirning belgilangan qismini muvaqqat 
xotiradan o‘chirish

Выделить заново qaytadan belgilash

Обратно Sift+Ctrl+I) so‘nggi bajarilgan amalni qaytarish

1 {ветовой ряд (Shift+Ctrl+D) tasvirdagi ranglar asosida belgilash 
maydonini aniqlash

Модифицировать belgilash chizig‘ini piksellarda kengaytirish

Увеличить belgilash maydonini kengaytirish

11реобразовать выделение belgilangan maydon shaklini o'zgartirish

Сохранить выделение belgilangan maydon shaklini xotiraga 
joylashtirish
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ФИЛЬТР

Последний фильтр Foydalanuvchi tomonidan ohirgi ishlatilgan filtrni 
qo'llash.

Заточка >

0 ‘rnatiladigan filtrlar ro‘yxati

Пиксели >

Пятно >

Стили >

Шум >

Другое > Boshqa filtrlar

ВИД (View) menyusi

Новый вид Asosiy tasvirni yangi darchada ochish

Увеличить (Crtl++) Tasvirning ekrandagi ko‘rinishini kattalashtirish

ОКНО (Window)

Документы > Очилган жужжат л ар (расмлар) руйхати

Рабочее пространство, Инструменты, Опции, 
Браузер файла, Навигатор, Информация, 
Цвет, Образчики, Стили, История, Действия, 
Предустановки инструмента, Слои, Каналы, 
Пути, Кисти, Символ. Параграф, Строка со­
стояния

Dastur oynasi qismlari

ПОМОЩЬ (Help)

Помощь Photoshop 
FI

Photoshop dasturi bo‘yicha yordam ma’lumot olish

О программе 
Photoshop

Photoshop dasturi haqida maTumot olish. Unda 
dasturning nomi versiyasi ishlab chiquvchilar ha­
qida maTumot beriladi.
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System info ... Foydalanuvchining kompyuteri haqidagi ma’lu­
motlarni ko'rsatadi.

Updates ... Internetga ulanish orqali Photoshop dasturini yan- 
gilash (обновления) imkonini beradi.

Registration ... Registratsiya (Adobe Photoshop dasturini ro‘y- 
xatdan o‘tkazish)

Adobe Online ... Adobe kompaniyasining Web-saytini ochib beradi. 
Unda dastur bilan ishlash bo‘yicha maslahatlarni 
o'z ichiga olgan punktlar beriladi.

Adobe Photoshop dasturida jam i 46 ta uskunalar mavjud bo‘lib, 
ulardan 20 tasi bevosita dastur ishga tushirilganda darchada ko‘zga 
tashlanib turadi. Qolganlarini qo‘shimcha buyruqlarni bajarish orqali 
ishga tushirish m um kin. Agar uskunalar panelida joylashgan tugm aning 
ostki qism o‘ng burchagida kichik uchburchak shakli tasvirlangan 
bo‘lsa, bu tasvir ushbu tugm a tarkibida o'xshash buyruqni bajaruvchi 
uskunalar vashiringanligidan darak beradi.

Yashiringan uskunani faollashtirish uchun kursorni maxsus belgili 
tugma ustidan sichqonchaning chap tugm asini bosgan holda uskunalar 
panelidan tashqariga olib chiqiladi va kerakli tugm a ustida kursorni 
keltirilib sichqonchaning chap tugm asi qo‘yib yuboriladi.

Har bir tugm aga kursor yaqinlashtirilsa, kursor belgisi ostidagi 
uskunaning qanday vazifani bajarishi haqidagi axborot paydo bo‘- 
ladi. Quyida Adobe Photoshop dasturida ishlash jarayonida keng 
qo‘llaniladigan uskunalarning qisqacha tavsifi keltiriladi.

Прямоугольная область: Tasvirda to‘g‘ri to 'rtburchak shaklidagi 
maydonni belgilab olish uchun qo‘llaniladi. Bu uskuna yordam ida 
tasvirdagi alohida maydonni belgilab olingandan keyin tasvirga 
kiritilgan barcha o‘zgarishlar faqat belgilangan maydon ichiga ta’sir 
etadi. Ushbu tugm aga qo'shim cha tarzda Shift klavishi ishlatilsa, 
belgilangan maydon hududi ortadi. Shift klavish o‘rnida Alt klavishi 
qo llanilgan taqdirda belgilangan maydon hududi qisqaradi. Ushbu 
amal Лассо va Волшебная палочка uskunalari bilan ishlashda 
qollaniladi.
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Эллиптическая область: Tasvirda doira shaklidagi maydonni 
belgilab olish uchun qollaniladi. Bu uskuna yordamida tasvirdagi 
alohida maydonni belgilab olingandan keyin tasvirga kiritilgan barcha 
o‘zgarishlar faqat belgilangan maydon ichiga ta’sir etadi.

Строка пикселей: Tasvirda gorizontal shakldagi chiziqni 
belgilaydi. Am alda bu uskuna juda kam  qo‘llaniladi.

Столбец пикселей: Tasvir yuzida vertikal chiziqni belgilaydi. 
Amalda bu uskuna ham juda kam  qollaniladi.

Кадрирование: Ushbu uskuna, asosan, tasvir chetlarini va 
keraksiz qismlarini kesib tashlash uchun qollaniladi. Bu buyruq 
faollashtirilganda tasvir yuzida to‘g‘ri to‘rtburchak shaklidagi ramka 
hosil bo‘ladi. R am kaning chetlari kichik kvadratchalardan iborat bo‘lib, 
bu kvadratchalar yordam ida ram ka hajmi o‘zgartiriladi. Tasvir ramka 
ostiga olingandan so‘ng Enter klavishi bosilsa, ram ka tashqarisida 
qolgan ortiqcha bo iak lar kesib tashlanadi. Ushbu buyruqni Esc 
klavishini bosib rad etish mumkin.

Перемещение: Ushbu uskuna tasvirdagi belgilangan maydonni 
yoki qatlamni siljitish va kesib olish uchun xizm at qiladi. Ba'zan Пере­
мещение buyru g in i bajaradigan ayni jarayonni boshqa ayrim uskunalar 
(masalan, Волшебная палочка uskunasi) yordamida ham amalga 
oshirish mumkin.

JIacco: tasvirdagi turli shakldagi obyektlarni belgilash uchun isli- 
latiladi.

М ногоугольное лассо: Asosan tasvirdagi to‘g ‘ri chiziqlardan 
iborat obyektlarni belgilashda ishlatiladi. Alt klavishi bilan 
qollanilganda oddiy Лассо uskunasi vazifasini bajaradi.

М агнитное лассо: Bu uskuna ishlatilganda Adobe Photoshop 
dasturi tasvirdagi obyekt chegaralarini o‘zi belgilaydi. Ammo bu 
uskuna piksellardagi ranglarni o‘zgarishiga bog iiq  tarzda chegaralarni 
aniqlashi bois kam qollaniladi.

Волшебная палочка: Bir-biriga yaqin bo igan  rangdagi piksellar 
joylashgan maydonni belgilaydi. Shift bilan birgalikda qoilansa, 
belgilangan maydon hajmi ortadi. Alt bilan ishlatilganda esa belgilangan 
maydon hajmi kamayadi.

Аэрограф: Tasvirni bo‘yashda ishlatiladi. Aerografni bir joyda 
ushlab turish siyohni tasvir bo‘ylab yoyilib ketish effektini beradi.
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Huyoqning tasvir bo'ylab oqishi kursorni qo‘yib yuborm aguncha davom 
I'ladi. Odatda bu uskuna bilan yum shoq chutkalar ishlatiladi. Aerograf 
kursorni ushbu uskuna ustida bosish yoki klaviaturadagi J klavishni 
bosish orqali faollashtiriladi.

Кисть: A erograf uskunasi kabi tasvirni buyashda ishlatiladi. 
Ammo Kist yordam ida tasvirni sifatli bo‘yash mumkin. Bu uskuna 
iicrografga nisbatan ko‘p qollaniladi. Kist uskunasini V klavishini 
bosish orqali faollashtirish mumkin. Brushes darchasi yordamida buyoq 
mo'yqalamlarining shaklini o‘zgartirish mumkin.

Штамп: Tasvirdagi kichik bir bo‘lak nusxasini ko‘chirish uchun 
ishlatiladi. Bu uskuna tasvirdagi ayrim  nuqsonlarni, d o g la rn i yo‘qotish 
\ a eski rasm larni tiklashda keng qollaniladi.

Кисть предыдущ их состояний: Bu uskuna tasvir haqidagi 
ilastlabki m a’lumotlar asosida ishlaydi. Uning yordam ida tasvirga
I и itilgan so‘nggi o‘zgartirishlarni bekor qilish mumkin.

Ластик: Tasvirni o‘chirish uchun ishlatiladi. U qoilanganda 
lasvirda fon qaysi rangda bo lsa , o'sha rangdagi chiziqlar hosil boladi. 
Alt klavishini qo ilash  yordam ida kompyuter xotirasiga olinmagan 
.o'nggi o’zgartishlarni bekor qilish mumkin. Lastik uskunasi E 
klavishini bosish orqali faollashtiriladi.

Карандаш: Turli chiziqlarni chizish uchun foydalaniladi. Alt
I lavishi bosilganda kursorning ekrandagi tasviri o‘zgaradi va bevosita 
lasvirdan kerakli rangni tanlash m um kin. Bu amal bajarilgandan so‘ng 
К арандаш o‘sha rangda chiziq tortadi.

Линия: To‘g‘ri chiziqlarni chizishda qollaniladi.
Размывка: Ushbu uskuna ishlatilganda, tasvirdagi yorqinlik pa- 

.ayadi. Alt klavishi bilan qollanganda yorqinlik ortadi.
Резкость: Ushbu uskuna ishlatilganda tasvirdagi yorqinlik ortadi. 

All klavishi bilan qo ilanganda esa tasvir xiralashadi.
Палец: Tasvirdagi ranglar chayqaltirib. tasvirdagi obyektlar o‘r- 

lasidagi chegaralarni bir-biriga qo‘shishga xizm at qiladi.
Осветитель: Piksellardagi ranglar yorqinlashadi. Alt klavishi bilan 

i|o llanganda esa piksellardagi ranglar xiralashadi.
Заменитель: Tasvir ustida harakatlantirilganda piksellardagi rang­

lar qoramtir tus oladi.
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Губка: Tasvir ustida harakatlantirilganda, tasvirdagi ranglar 
miqdori pasayadi. Gubka bir joyda ko‘p harakatlantirilsa, tasvirning 
o'sha joyi kul rang tus oladi.

Перо: Peroni tasvir ustida harakatlantirilganda, nuqtalar hosil 
bo lad i. Ushbu nuqtalar yordamida chizilgan tasvirni o'zgartirish 
mumkin.

М агнитное перо: Bu uskuna xuddi М агнитное Jlacco kabi 
harakatlanadi. Biror-bir tasvirdagi obyekt atrofida harakatlantirilganda, 
Adobe Photoshop dasturining o‘zi obyekt chetlarini belgilab chiqadi.

Произвольное перо: Juda qulay uskuna bo'lib, xohlagan shakldagi 
tasvirni u yordamida ifodalash mumkin.

Вставить точку: Bu uskuna Pero yordamida chizilgan chiziq 
ustiga qo‘shim cha nuqtalarni qo‘shadi.

Удалить точку: Pero yordamida chizilgan chiziq ustidagi ortiqcha 
bo'lgan nuqtalarni o'chiradi.

Непосредственное выделение: U yoki bu pero bilan chizilgan 
chiziqlarni tahrir qilish uchun xizm at qiladi. Uning yordamida 
chiziqdagi nuqtalarni yakka tartibda harakatlantirish va kerakli joyga 
siljitish mumkin.

П реобразовать точку: Tasvir ustida chizilgan chiziqchalarda 
o'rnatilgan har bir nuqta. burchak yoki yoy vazifasini bajaradi. Ushbu 
uskuna yordamida nuqtalarning vazifalarini o'zgartirish, ya’ni yoyni 
burchakka va burchakni yoyga alm ashtirish m um kin. Buning uchun 
kursorni nuqta ustiga olib borib sichqonchaning chap tugm asi bir marta 
bosiladi.

Текст: Ushbu uskuna yordamida tasvirga turli m atnlarni kiritish 
mumkin. Текст uskunasi faollashtirib, kursor tasvir ustida bosilsa, matn 
kiritish uchun alohida darcha hosil bo iad i. Bu darchada h a rf oicham i, 
turi, rangi va boshqa koisatk ich lari kiritiladi. Bu uskuna yordamida 
kiritilgan m atnni qayta tahrir qilish im koni mavjud emas.

Текст-маска: «Текст» uskunasi kabi bu uskuna faollashtirilib, 
m atn ustida bir m arta bosilganda, «Текстовый инструмент» darchasi 
hosil bo lad i. Lekin bu matn oddiy m atndan tubdan farq qiladi. 
Harflarning cheti xuddi Jlacco uskunasida belgilash kabi ko‘rinishga ega 
bo lad i. Harflarni turli ranglarga bo‘yash va «Перемещение» uskunasi 
yordamida o‘rnidan siljitish yoki boshqa rasmga olib o 'tish mumkin.
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Вертикальный текст: Agar tasvirga pastdan yuqoriga shaklda 
(vertikal shaklda) matn kiritmoqchi boMsangiz ushbu uskunadan 
loydalanishingiz mumkin.

Вертикальная текст-маска: Xuddi Текст-маска uskunasi kabi 
bir xil vazifani bajaradi. Ammo bu uskuna qo‘llanganida harflar ustma- 
nst ustun kabi joylashtiriladi.

Измеритель: Tasvirda turli o‘lchovlarni bajarish uchun ishlatiladi. 
Ии uskuna bilan bir nuqtadan ikkinchi nuqtaga kursor olib borilishi 
kifoya. Shundan so‘ng dastur avtom atik tarzda ikki nuqta orasidagi 
masofani olchaydi.

Градиент: Bu uskuna ishlatilganda, tasvirdagi belgilangan may- 
ilonda ranglar kombinatsiyasi hosil boiadi. Asosiy rangning tasvir 
Ibniga sizib o‘tish effekti hosil bo'ladi.

Ковш: Ushbu uskunadan asosan, tasvirni yoki tasvirdagi ajratib 
olingan hududni bo'yashda foydalaniladi. Ranglarni qo'shimcha 
buyruqlarni bajarish orqali tanlanadi. Bu uskunani faollashtirish uchun 
К klavishi bosiladi.

Пипетка: Tasvirdagi asosiy yoki tasvir foni rangini o‘zgartiradi. 
Пипетка tasvir ustidagi biror nuqtada bosish bilan o‘sha nuqtadagi, 
ya’ni pikseldagi rang asosiy (faol) rang sifatida tanlanadi. Agar 
ayni jarayonga Alt klavishasi qo'shilsa, tanlangan rang tasvir fonini 
o'zgartirishiga olib keladi.

Выборка цветов: Ushbu uskuna tasvirdagi ranglar haqida axborot 
olishga xizm at qiladi. Info darchasida belgi qo'yilgan nuqtada necha 
loiz qizil, ko'k va qora ranglar mavjudligi haqidagi axborot hosil 
bo'ladi.

Рука: Tasvirning ko'zga tashlanm ay turgan qism larini ko‘rsatadi. 
Huning uchun ushbu uskuna faollashtirilib tasvir ustida sichqonchaning 
chap tugm asini bosgan holda kerakli tomonga harakatlantiriladi. Ayni 
larayonni Adobe Photoshop dasturi darchasidagi Navigator yordamida 
ham amalga oshirish mumkin.

Масштаб: Tasvirni kattalashtirish yoki kichraytirib  ko‘rsatish 
uchun xizm at qiladi. Agar ushbu uskuna bilan birgalikda Alt klavishi 
ishlatilsa, tasvir kichrayadi. Kursor ushbu uskuna faollashtirilgandan 
so'ng o‘z shaklini o‘zgartiradi va lupa ko‘rin ishin i oladi. Kursor 
lasvirning qaysi nuqtasida bosilsa, Adobe Photoshop dasturi
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avtom atik tarzda o‘sha nuqtani ekranga yaqinlashtiradi. M asshtab 
uskunasini faollashtirib, Enter klavishi bosilsa, О пция масш таби­
рования darchasi ochiladi. Bu darchada maxsus to ‘rtburchak ichig;i 
belgi qo‘yilsa, tasv ir o‘lchamlari o‘zgartirilganda tasv ir darchasi ham 
mos tarzda o‘zgaradi. Har safar tasv ir o icham larin i kattalashtirish 
yoki kichraytirish uchun М асш таб uskunasini faollashtirish zarur 
emas. Boshqa uskuna bilan ishlash paytida Ctrl+Probel bosilsa, 
ishlatilayotgan uskuna vaqtinchalik М асш таб uskunasi vazifasini 
bajaradi va tasv ir kattalashadi. Ctrl + Probel o in id a  Alt+Probel 
qo llan ilsa , tasvir o lch am i kichrayadi. Shuningdek, tasv ir o icham ini 
Ctrl + «+» (plyus) klavishlari yordam ida kattalashtirish yoki Ctrl) 
« —» (minus) yordam ida kichraytirish m um kin. Adobe Photoshop 
dasturi darchasi ostida «Строка состояния» satrida tasvir o lcham lari 
haqida axborot beruvchi m axsus darcha mavjud. Bu darchada tasvir 
o lcham lari sonlarda ifodalangan. Ushbu sonlarni o 'zgartirish  orqali 
tasvirning aniq o lcham lari kiritiladi.

Основной цвет: Ushbu uskuna ustida kursor ikki m arta ketma-ket 
bosilganda Adobe Photoshop dasturining yangi darchasi (Выбор цвета) 
hosil bo'ladi. Bu darchada kerakli rang tanlanib, OK yoki Enter tugmasi 
bosiladi va tanlangan rangni Карандаш, Кисть, Аэрограф, Гради­
ент kabi uskunalari yordamida qoilash  mumkin. Ц вет фона: Ushbu 
tugm a ustida kursor (sichqoncha chap tugm asi) ikki m arta ketma-ket 
bosilganda Adobe Photoshop dasturining yangi darchasi (Color Picker) 
hosil bo lad i. Bu darchada tasvir fonining rangi aniqlanadi. Tasvir 
fonidagi rang Ласточка va Градиент uskunalari uchun qollaniladi.

П ереключение цветов: Ushbu belgi ustida kursorni bosish bilan 
asosiy rang bilan tasvir foni ranglari o‘rni almashtiriladi.

Цвета но умолчанию: Bu belgi ustida kursorni bir m arta bosish 
bilan asosiy rang qoraga va tasvir foni ranglari oqqa aylanadi.

М арширующие муравьи: Bu tugm a yordamida Adobe Photoshop 
dasturida tez niqoblash holati bekor qilinadi. Ekranda belgilash 
chegaralari chumolilar harakatini eslatuvchi punktir chiziq yordamida 
aks ettiriladi. Bu Adobe Photoshop dasturida odatda standart holat deb 
ataladi.

Быстрая маска: Ushbu tugm a ustida kursor bir m arta bosilishi 
bilan Adobe Photoshop dasturi tez niqoblash holatiga o la d i va
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natijada tasv irdagi niqoblanm agan xudud qizil rang bilan bo‘yaladi.
I shbu uskuna tasvirdagi tu rli obyektlarni aniq niqoblashda 
ishlatiladi. К ист uskunasi yordam ida niqobga ishlov berish m um kin. 
Hunda qora rang bilan tasvir niqoblanadi, oq rang bilan tasvirdagi 
niqob o 'chiriladi.

Стандартное окно: Uskuna faollashtirilganda tasvir standart 
holatda bo'ladi.

Полный экран с меню: Bu holat tasvir kompyuter ekraniga sig‘- 
magan holda ishlatiladi. Ushbu uskuna faollashtirilganda ekranda 
faqatgina menyu satri hamda uskunalar paneli qoladi.

Полный экран: Ekranda faqat tasvir va uskunalar paneli hamda 
menyu satri qora fonda qoladi.

Tasvir o‘lchami

Adobe Photoshop dasturida ekranda tasvirning barcha qismini yoki 
tasvirdagi kichik detallarni ko‘rish uchun xohlagancha kattalashtirish 
yoki kichraytirish mumkin. M asalan, 100% -  bu tasvirdagi piksellar 
soniga ekrandagi piksellar soni tengligini anglatadi. Ya'ni 1:1. 200% 
ga tasvir kattalashtirilganda ekrandagi bir pikselga katta miqdordaga 
piksellar miqdorini to‘g‘ri kelayotganligidan dalolat beradi.

Tasvirning haqiqiy o'lchami

Adobe Photoshop dasturida 100% li o'lcham tasvirning real o'lchami 
deyiladi. 100% li o ichainda tasvir aniq va ravshan ko'rinadi.

Tasvirning real o icham i quyidagi amallarni bajarish orqali o in a -  
tiladi:

□ M enyular satrida Вид m enyusida Реальный размер buyrug‘ini 
tanlang:

□ Ctrl+ Alt+ 0 (nol) tugm alar ini birgalikda bosish orqali;
□ Uskunalar panelidagi М асштаб tugm a ustida sichqoncha tug­

masini ikki m arta ketma-ket bosish orqali.

To‘liq ekranli rejim

Adobe Photoshop dasturi tasvirni birinchi m arta ochganda uni 
maksimal o'lchamda ochadi. Tasvir bilan ishlash jarayonida uning 
o'lchamini bir necha m arta kattalashtirish yoki kichraytirishga to‘g‘ri
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keladi. Ana shunday holatlarda tasvirni xohlagan paytda dastlabki 
Полноэкранный режим holatiga qaytarish mumkin. Buning uchun 
quyidagi am allarni bajarish lozim:

□ M enyular satrida Вид menyusidagi По размерам экрана 
bu yrug in i tanlash;

□ Ctrl+ 0 (nol) tugm alarini birgalikda bosing;
□ Uskunalar panelidagi Рука tugm asi ustida sichqoncha chap 

tugmasini ikki m arta ketma-ket bosing.

Tasvirning bosma shakldagi o‘lchami (Размер печати)

Adobe Photoshop dasturi tasvirning printerda chop qilingandagi 
ko‘rinishini chop qilmasdan avval ekranda ko‘rish imkonini beradi 
Buning uchun M enyular satrida Изображение menyusi tarkibidagi 
Размер изображения buyrug‘ini tanlanadi. Ammo, ham m a vaqt ham 
tasvirning ekrandagi ko‘rinishi bilan chop etilgandagi o‘lcham lari 
aynan mos tushavermaydi. Tasvir kattaliklari 0,2% dan 16000% miqdoi 
o itasid ag i sonlar bilan belgilanadi.

Navigator darchasi bilan ishlash

Adobe Photoshop dasturida tasvirdagi mayda detallar bilan 
ishlash jarayonida tasv irn i bir necha m arta kattalashtirishga to ‘g ‘ri 
keladi. Tasvirga k iritilgan  o‘zgartirish lar sifatli chiqishi uchtui 
N avigator darchasida am al bajariladi. N avigator darchasi asosan 
tasv ir o ich am larin i o‘zgartirish  va tasv irn i boshqarish uchun xizm ai 
qiladi. Agar N avigator darchasi Adobe Photoshop dasturi ishga 
tushirilganda ekranda m avjud b o im asa , uni faollashtirish uchun 
m enyular satrida Окно m enyusidagi Показать Навигатор b u y ru g in i 
bering.

Action darchasi bilan ishlash

Action darchasi Adobe Photoshop dasturida ishlashni yanada 
tezlashtiradi va bir nechta tasvir ustida amalga oshiriladigan hit 
xil am allarni har safar takrorlashga zaruriyat qoldinnaydi. Adobe 
Photoshop dasturidagi Action darchasi bilan ishlashni bilsangiz, qisqn 
fursat ichida ko‘p miqdordagi tasvirni tahrir qilishingiz m um kin
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Huning uchun Action darchasida yangi Action ochiladi. Uni kerakli 
н от bilan nom lagandan so‘ng Record tugm asi bosiladi. Shu daqiqadan 
boshlab Adobe Photoshop dasturi sizning tasvir ustida bajargan barcha 
iimallaringizni kom pyuter xotirasiga ketm a-ket joylashtiradi. Tasvir 
ustida barcha am allar yakunlangandan so'ng Action darchasidagi 
Stop tugm asi bosiladi. Adobe PhotoShop dasturi sizning barcha 
iimallaringizni tartibli ravishda Action darchasida joylashtiradi. Boshqa 
lasvirlarga ushbu am allarni qo‘llash uchun yangi tasvir ochilgandan 
No'ng Action darchasidagi Выполнение buyrug‘ini ishga tushirish 
lozim. Adobe PhotoShop dasturi avtom atik tarzda yangi ochilgan
i isvirda ham siz amalga oshirgan vazifalarni hech bir o‘zgarishlarsiz 
bnjaradi.

Yangi tasvir yaratish, dublikat olish va tasvirni 
doimiy xotiraga joylashtirish

Adobe PhotoShop dasturida ishlashdan avval yangi fayl tuziladi 
voki kompyuter xotirasida mavjud boigan  tasvir ochiladi. Yangi fayl 
m/ish va avvaldan mavjud bo‘lgan fayllarni ochishning quyidagi 
yo'llari mavjud:

□ Файл > Новый. M enyu satrida Файл menyusini ochib Новый 
l>uy rug'ini tanlang yoki Ctri+N tugm alari kombinatsiyasidan foydalanib, 
wmgi fayl yarating. Yuqoridagi amal bajarilganidan so‘ng Adobe 
I’liotoShop dasturi yangi faylni tashkil etish uchun uning olcham lari 
!uu|idagi ma’lumotlar bitilgan yangi darchani hosil qiladi. Bunda 
wmgi tuzilayotgan fayl nomi, uning olcham lari kiritilishi talab etiladi. 
kerakli o'lcham lar kiritilganidan so‘ng OK tugm asini bosish lozim. 
Adobe PhotoShop dasturi oq rangdagi (bo‘sh) yangi tasvirni tuzadi. 
Ilu lasvirga xohlagan o‘zgartirish kiritish yoki boshqa tasvirlardan 
.141 ini detallarni ko‘chirib o 'tkazib, umuman yangi tasvirni ijod qilish 
imimkin.

□ Ф айл > О ткрыть: M enyu satrida Ф айл m enyusini ochib О тк­
рыть b u y ru g in i tan lang  yoki C trl+O  tugm alari kom binatsiyasidan 
loydalanib kom pyuter xotirasida mavjud b o ig an  faylni oching. 
Juda kam hollarda Ф айл -  О ткры ть Как (Ctrl+Alt+O) b u y ru g i 
iimlanadi.
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Tasvir form atlari

Adobe PhotoShop dasturi 20 dan ortiq formatdagi fayllar bilan 
ishlash imkoniga ega. Eng ko‘p qo‘llaniladigan formatlar:

BM P (W indows Bitmap) -  Windows m uhitida ishlovchi kompyu- 
terlarda ekran osti tasvirlarini qoMlovchi dastur Microsoft Paintda keng 
qoMlaniladi.

JPEG (Joint Phonographic Experts Group) -  hozirgi kunda eng ko'p 
qoMlaniladigan formatlardan biri bo‘lib, uning asosiy afzalliklaridan 
biri maxsus dastur yordamida fayl hajmini yetarlicha siqish imkonining 
mavjudligidir. Ammo faylni siqib hajmini kichraytirish jarayonida 
tasvir sifatida o‘zgarish boladi. Fayl kuchli siqilganda tasvir sifati 
yomonlashishi mumkin. Ushbu formatdagi fayllar kompyuter xotirasida 
ko‘p joy egallamaydi. Hajm jihatidan kichikligi sababli mazkur 
formatdagi tasvirlar bilan ishlashni ancha osonlashtiradi. Aksariyat 
raqam li fotokameralar, videokameralar va skanerlar yordamida olingan 
rasm lar JPEG formatida saqlanadi.

TIFF (Tagged Image File Format) -  bu form atdagi fayllar ham  keng 
qo’llaniladi. Lekin TIFF formatidagi fayllar kompyuter xotirasida ko'p 
joyni egallavdi. Adobe PhotoShop dasturida ushbu formatdagi tasvirlar 
bilan ishlashda dasturning ishlash tezligi sezilarli ravishda pasayishi 
mumkin.

GIF (Graphics Interchage Format) -  ushbu formatdagi tasvirlar 256 
turdagi rang bilan tasvirlanadi. Bu formatdagi tasvirlar asosan Internet 
tizim ida keng qo’llaniladi.

Ranglar bilan ishlash

Adobe PhotoShop dasturida uskunalar panelida ranglar bilan ishlash 
uchun to‘rtta uskuna ajratilgan:

□ Основной цвет. Ushbu uskunada qanday rang ko’rsatilgan 
bo isa. Ковш, Линия, Карандаш . Кисть. Аэрограф va shuningdek Alt 
klavishi bilan birgalikda qo’llanganda Палец uskunalari uchun o‘sha 
rang asosiy hisoblanadi. Основной цвет uskunasidagi rang Пипетка 
yoki ushbu uskuna ustida sichqoncha chap tugm asini ikki m arta ketma- 
ket bosish orqali o‘zgartiriladi.
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□ Ц вет фона. Ko'rsatilgan rang Ластик uskunasi bilan ishlaganda 
qo’llaniladi. Ц вет фона uskunasidagi rang Основной цвет uskunasida 
rangni o 'zgartirish uchun qanday amal bajarilgan b o lsa , bunda ham 
xuddi o‘sha amalga rioya qilish lozim yoki Пипетка uskunasi bilan Alt 
klavishini birgalikda bosish orqali rangni almashtirish m um kin.

□ Переключение цветов. K ursorni ushbu tugm a ustida bir m arta 
bosish orqali asosiy rang va fon rangi o 'rin  almashadi.

□ С тандартный цвет. K ursorni ushbu tugm a ustida bir m arta 
bosish asosiy rang va fon rangini standart ranglar -  qora va oq rangga 
almashtiradi.

Ranglarni tanlashda Adobe PhotoShop dasturida Color yoki 
Swatches darchalaridan ham foydalanish mumkin.

RGB (Red, Green, Blue-qizil, ko'k, yashil) moduli tasvirni ekranda 
tahrir qilish nuqtai nazaridan kelib chiqqan holda juda qulay va u 24 
razryadli ranglar platasi yordamida deyarli barcha 16 million ranglarni 
monitorda aks ettiradi. RGB ranglar majmuasi bilan ishlangan barcha 
tasvirlarni xohlagan form atda diskka yozish m um kin. RGB ranglar 
inajmuasidagi ayrim  ranglar um um an tabiatda uchramaydi.

CM YB-tabiatda mavjud bo igan  ranglar majmuasi, quyosh 
nurlari inson ko‘zlari ajrata oladigan barcha ranglarni o‘zida mu- 
jassam lashtirgan. Quyosh nurlari biror bir jismga tushganda uning ta’siri 
ostida inson ko‘zlari jism  shakli va rangini idrok etadi. Misol uchun 
binolarning o‘t o‘chirish burchaklariga osib qo‘yilgan o‘t o‘chirgichlar 
to‘q ko‘k va zangori ranglar bilan boLyalgan bolishiga qaramay, bizning 
ko‘zimizga to‘q qizil rangda ko‘rinadi. Ranglarni bir-biriga qo‘shilishi 
natijasi boshqa ranglar hosil qilinadi:

S -  havo rang', M -  binafsha rang; Y  -  sariq rang', В -  qora rang.
Bosma m ashinalari va bosm axonalarda tasvirlar yuqorida keltirilgan 

ranglarning kombinatsiyasidan foydalangan holda to‘la tasvirni 
ifodalaydi.

RGB ranglar majmuasida oq rang uchala ranglarning maksimal 
aralashm asidan hosil qilinadi. Qora rang esa buning aksi ularoq olinadi.

CM YB ranglar majmuasi bilan ishlaganda qora va oq ranglarni 
hosil qilish uchun buning aksini bajarish lozim. Ya’ni to‘rt rangning 
m inim al qo‘shi!ishida oq rang hosil boladi. Q ora rang esa alohida 
kanalda mavjud.
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RGB ranglar m ajm ui keng ko‘lamdagi ranglarni tak lif  etadi 
Lekin ularning ko‘p qismi (ayniqsa, yorqinlari) tasv irn i chop 
etganda m onitordagi bilan keskin farq qiladi, Shu bois ham  ko'plab 
m utaxassislar tasv irn i chop etishdan avval uni C M Y B  tizimiga 
o‘tkazadilar. Ayrim m utaxassislar esa tasvir bilan C M Y B  tizimida 
ishlashni maslahat beradilar. Ammo bu tasvir bilan ishlash turli 
qiyinchiliklarni tug ‘dirad i. A na shunday qiyinchiliklardan biri 
kompyuter juda sekin ishlaydi. Bunga asosiy sabab Adobe PhotoShop 
dasturi RGB tizim iga sozlangan bo‘lib, har bir buyruqni bajarib, uni 
RGB tizim idan C M Y B  tizim iga alm ashtirgunga qadar kompyutci 
qo‘shimcha vaqt talab qiladi. Bundan tashqari, skaner va monitor 
RGB tizim ida ishlashga mo'ljallangan. Ranglar bilan ishlovchi barcha 
uskunalar (rangli p rin terdan  tashqari) RGB tizim ida ishlaydi. Shuning 
uchun yaxshisi tasv irn i chop etishdan avval CM YB tizim iga o‘tkazib 
olish maqsadga muvofiq. Tasvir ustida barcha am allarni poyoniga 
yetkazib, m enyular sa trida  Изображение -  Н астройка tarkibidagi 
CM YB buyrug‘ini tanlang.

H istory darchasi bilan ishlash

Adobe PhotoShop dastu ri ishga tushirilganda ekranda History 
darchasi mavjud bo‘lm asa, Окно m enyusida П оказать History 
buyrug‘ini tanlang. H istory  darchasida tasvirga kiritilgan so'nggi 
o‘zgartirishlar haqidagi m a’lum otlar joylashadi. Tasvir ustida bajarilgan 
har bir muhim am allar H istory darchasida ro‘yxatga olinadi. Xohlagan 
paytda yoqm agan am allarni H istory darchasi orqali rad etish mumkin. 
Buning uchun kursor bajarilgan so'nggi am aldan oldingi buyrug'i 
ustida bosiladi yoki Ctrl+Alt-r7 klavishlari bosiladi. Adobe PhotoShop 
dasturi bajarilgan so 'nggi 20 am alni ro‘yxatga oladi, yigirm a birinchi 
amal bajarilganda Adobe PhotoShop dasturi avvalgi am allarni 
o'chiradi.

Qatlamlar bilan ishlash

Adobe PhotoShop dasturi tasvirdagi biror obyekt Прямоуголь­
ная область, Э ллиптическая область, Лассо, Волш ебная палоч­
ка, Быстрая маска yordam ida tasvirdagi detallar belgilanib ularning
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nusxalari olinganda Adobe PhotoShop dasturi yangi qatlam  hosil 
i|iladi. Bu qatlam alohida obyekt bo‘lib, uni tah rir qilish ham alohida 
larzda bo lad i. Bir nechta tasvirlardagi ayrim  detallarni yagona 
tasvirga jam langanda Adobe PhotoShop dasturi ko‘chirib o‘tilgan 
lasvir bo‘laklarni qatlam larga ajratadi. Ayni jarayon tasvir detallarini 
joylashtirish uchun ju d a  qulay. Bir necha qatlam lar bilan ishlaganda 
ularni boshqarish qiyinlashadi. Adobe PhotoShop dasturi bajarilganda 
yangi darcha hosil bo lad i. Bu darchada tasvirdagi yangi qatlamlar 
haqidagi axborotlar joylashadi. Yangi qatlam hosil qilinganda Adobe 
PhotoShop dasturi uni Слой darchasida ro‘yxatga oladi. Bu darchada 
qatlamlar tartibli tarzda joylashtiriladi. Shuningdek, qatlam larning 
o’rnini alm ashtirish yoki vaqtincha o‘chirib qo‘yish mumkin. 
Qatlam larni o‘chirish uchun avval kerakli qatlam Слой darchasida 
belgilab olinadi va m enyular satrida Слой m enyusi tarkibidagi Уда­
лить Слой b u y ru g i tanlanadi. Qatlam larni bir-biriga birlashtirish 
imkoniyati ham  mavjud.

Filtrlar bilan ishlash

Adobe PhotoShop dasturida tasvirni qo‘shim cha effektlar bilan 
boy itish uchun filtrlardan foydalanish m um kin. Buning uchun menyular 
satrida Ф илтры b u y ru g i tarkibidagi filtrlardan foydalanishingiz 
mumkin.

Photoshop va ImageReady dasturlariga tasvirni tez ko‘rib chi­
qish m oduli kiritilgan. Oldingi vaqtlarda bu ishni amalga oshirish 
uchun tashqi dastur (utilit)lar ishlatilar edi. M asalan ACDSee yoki
I humbsPlus. Cho'ntak kom pyuterlari uchun rasm ni im porti va eksporti 
WBMP formatli filtrlari kiritilgan. Kom pyuterning ishlash chegarasi 
doirasida avtom atik tarzda rasm ning sifatini buzm agan holda moslashuv 
(optimizatsiya)ni bajaradi.

Photoshop 7.0 dasturiga guruh (групповой) b o iib  ishlash 
uchun qo'shim cha im koniyatlar kiritildi. Bu bir kompyuterda turli 
I'oydalanuvchilar tomonidan Adobe dasturida ishlash imkoniyatini 
beradigan A fterCast kengaytgich qo‘shildi. Agar bir foydalanuvchi 
tasvirga o‘zgartirish kiritsa bir vaqtning o‘zida ham m a foydalanuvchilar 
kuzata oladi. Am m o A fterC ast sozlashni faqat adm inistrator boshqara
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oladi, lekin bu shaxsiy kompyuterlarda Photoshop dasturida ishlovchi 
fbydalanuvchilar bu muammoga duch kelmaydilar. Biz yuqorida 
faqatgina Photoshopning 7-versiyasini asosiy im koniyatlarini sanab 
chiqdik.

Uskunalar paneli

Ekranda turgan dastur uskunalarini ishga tushirish uchun sichqoncha 
bilan uni ustiga bosing va ekranda ko‘rinayotgan piktogram m ani ustiga 
bosing. Bir xil piktogram m alar yonida kichik ko isatk ich  (strelkacha) 
lar mavjud. Agar uni ustiga bosilsa tasvirga to‘g‘ri keluvchi oynalai 
koi'satiladi. U  yerdan siz kerakli uskunalarni tanlashingiz mumkin, 
Har bir uskuna uchun o‘zining o icham lari ekran tepasida joylashgan 
Opsiyalar panelida mavjuddir (masalan, режим смешивания, значение 
непрозрачности).

Opsiyalar paneli

Opsiyalar paneli har bir uskunaning param etrlarini sozlash uchun 
ishlatiladi (masalan, shaffoflik darajasi yoki tasvirni aralashtirish 
rejimini) (4.1-rasm). Opsiyalar panelining o‘ng tom onida maxsus 
ranglarni saqlovchi bo‘lim mavjuddir. Param etrlarni ko’rsatilishi qaysi 
rasmni tanlanganiga bogiiq  (4.1-4.6-rasm). Foydalanuvchi tomonidan 
kiritilgan tasvir ko‘rinishi boshqa o‘zgartirishlar kiritilgunga qadar 
saqlanadi. Palitra va Opsiyalar panelini ham ekranning istalgan joyiga 
siljitish mumkin.

■ \ ...............  ' ........... : ... 'r

1 У * j Brush: *
45 4 \ Mode: jNorma Opacity: | l00%\> I Flow: |50% 1 4

4.1-rasm. Brush uskunasi uchun Opsiyalar paneli.

_ j lJj ip  P Feather; jo px Г  Style: jNormal

4.2-rasm. Rectangular Marquee uskunasi uchun Opsiyalar paneli.

л и и = з ы  Mode: (Normal” ' Opacity: llOOfrTl ► 1

4.3-rasm. G ra d ie n t  uskunasi uchun Opsiyalar paneli.



1
n p l  )  J  J  J  J  \  ’  17 Auto Add ''Delete J

4.4-rasm. Pen uskunasi uchun O psiyalar paneli.

1
_1 - i l i  s a  - j  Л I  j  j  j  j

4.5-rasm. Rectangle uskunasi uchun O psiyalar paneli.

1
T * j (Helvetica r  j ^Medium ^ | T  f* ̂  P* Vi jsh-arp :T:1 :

4.6-rasm. Ture uskunasi uchun O psiyaiar paneli.

Opsiyalar panelining o‘ng tom onida faol uskuna piktogram m asi 
koisatilgan. Agar piktogram m a yonidagi strelka ustiga bosilsa. 
ko‘rinmay turgan m enyu ochiladi, unda boshqa kerakli bo igan 
nskunani tanlash mumkin. Bu jadvalga o‘zgartirishlar kiritish mumkin. 
ya’ni kam ishlatilayotgan uskunalarni olib tashlab o‘rniga kerakli 
holgan uskunalarni joylash m um kin. Har bir Opsiyalar paneliga 
kiritilgan o‘zgartirishlar avtom atik tarzda saqlanib qolinadi. Tugmalarni 
qayta tiklash va joylashtirish ishlari paydo boiuvchi paneldan amalga 
oshiriladi.

Yordamchi maslahatlar

Istalgan piktogram m a ustida sichqonchani chap tugm asini bos- 
masdan olib boring shunda siz ishlatmoqchi b o igan  uskunaning nomi 
\a  uni klaviatura orqali ishga tushiradigan tugm achalar ko‘rsatiladi. 
Shu bilan bir qatorda ishlatilayotgan Opsiyalar oynasi va uning vazifasi 
haqida qisqacha m aium ot olish m um kin. Edit > Preferences > General 
(Правка > Установки > Общие) oynasidagi yordamchi maslahatlar 
oynasini ishlatish uchun Show Tool Tips oynasi ustiga bayroqchani 
o'rnating (Показывать всплывающие подсказки).

Istalgan tasvirni xohlagan paytda o'zgartirishlar kiritish imkonini va 
12 turdagi Photoshop kengaytm alarida saqlash im konini beradi. Ammo 
odatda ko'pincha quyidagi Photoshop formatlari ishlatiladi: TIFF, GIF, 
JPEG, EPS.
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Photoshop dasturida ko‘pgina operatsiyalar asosan palitralar orqali 
bajariladi. Ekranda ko'p joy egallamasligi uchun palitralar oV.am 
guruhlarga biriktirilgan: Navigator / Info (Boshqaruv /  M a’lumot). 
Color / Swatches /  Styles (Rang / Namuna / Uslublar), History / 
Actions / Tool Presets (Tarixi / harakatlar / Uskunalar tanlash), Layers 
/  Channels / Paths (Qatlamlar /  K anallar /  Konturlar) va Character / 
Paragraph (Shrift /  Abzats).

Palitralar

Photoshop dasturida ko‘p operatsiyalar palitralar orqali bajariladi 
U larni o‘zaro aralashtirish ham m um kin. Istalgan palitrani ochish uchun 
esa W indow (Окно) menyu buyruqlari yordamida amalga oshiriladi 
Belgilangan palitra boshqa shu guruhga kiruvchi palitralardan eng 
yuqorida avtom atik tarzda joylashadi.

Photoshop dasturidan chiqish: Windows operatsion tizim ida bu 
dastur oynasini yopish uchun File > Exit (Файл > Выход) buyrug'im  
bering yoki (Ctrl+Q) tugm alar kombinatsiyasini bosing.

Savol va topshiriqlar:

1. Adobe Photoshop dasturi qanday ishga tushiriladi?
2. Adobe Photoshop dasturining asosiy menyusi nimalardan tashkil 

topgan?
3. Opsiyalar paneli nima uchun ishlatiladi?
4. Palitra operatsiyalari orqali nima bajarish mumkin?

4.3. Adobe Photoshop dasturida tasvir va rasm bilan ishlash

Adobe Photoshop Windows m uhitida ishlovchi elektron ko‘ri- 
nishdagi foto tasvirlarini tahrirlovchi dasturdir. Adobe Photoshop 
dasturi Adobe System Inc kompaniyasi tomonidan ishlab chiqarilgan 
bo’lib, ishlatishdagi alohida qulayliklari bilan m ashhur hisoblanadi.

Adobe Photoshop grafik m uharriri yordamida fotosuratlarga 
qo‘shimchalar kiritish, fotosuratdagi dog'larni o'chirish, eski rasmlarni 
qayta ishlash va tiklash ishlarini am alga oshirish mumkin. Rasmlarga 
matn kiritish qo‘shimcha maxsus effektlar bilan boyitish, bir foto­
suratdagi elementlarni ikkinchi fotosuratga olib o‘tish, suratdagi 
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unglarni o‘zgartirish, almashtirish mumkin. Adobe Photoshop im­
koniyatlari keng qamrovli bo iib , u gazeta va jurnallarn i turli tum an 
lasmlar bilan boyitishda juda katta qulayliklar yaratadi.

Adobe Photoshop ayniqsa jurnalistlarning, rassom larning ijodiy 
imkoniyatlarini to la  amalga oshirishlarida yordam beradi, jurnalistika 
\ .i bevosita matbuot yoki nashriyot sohasiga aloqador b o igan  shaxs- 
laming m azkur dastur bilan ishlashni bilishi uchun qo'shimcha 
nnkoniyatlarni yaratib beradi.

Adobe Photoshop grafik m uharriri juda m urakkab dasturdir.
1 dydalanuvchilar uning asosiy im koniyatlaridangina foydalanadilar 
\olos. Opsiyalar panelida Brush muyqalamni tanlash uchun strelkasi 
ustiga bosing. Har bir piktogram m a ustidagi raqam lar muyqalamni 
<|.ilinligini piksellarda ko isatad i. Agar siz istalgan muyqalam ustiga 
olib borsangiz shu m uyqalamning qalinligi va turi haqida m aium ot 
iliiqadi. Boshqa turdagi muyqalam larni tanlash uchun muyqalamlar 
к ulubxonasini yuklash kerak. Muyqalam panelini yopish uchun 
paneldan tashqaridagi ekranning istalgan joyga bosing va avtomatik 
tarzida panel yopiladi. Mode (Режим смешивания) bo lim in i tanlang, 
hamda Opacity (Непрозрачность) bo lim in i foiz ko‘rsatkichida Brush 
(Кисть) uskunasi uchun tanlang (4.7-rasm). Agar ko‘rsatilgan qism 
parametri 100% ni tashkil qilsa muyqalam shtrixi pastki piksellarni 
mutloq qoplaydi.

Esiatma: Faqatgina shafof bo im agan  qatlam larning rangini o‘z- 
cartirish uchun Layers (Слои) palitrasidagi Lock transparent pixels 
( {афмксировать прозрачные точки) ustiga bayroqchani o'rnating.

Photoshop 7.0 dasturi yordamida siz bir qancha standart muy- 
qalamlar yoki o‘zingiz o lcham lari va k o iin ish in i kiritgan holda juda 
qi/iqarli rassom chilik ishlarini amalga oshirishingiz mumkin.

Rasmlar bilan ishlash uchun dasturning yangi versiyalari o‘ta 
qiziqarli b o ig an  rasm larni yaratish imkonini beradi. Photoshop 7.0 
dasturida standart va avvaldan foydalanuvchi kiritgan rasm larni

Mode: |Normal 3  O pacity:

4.7-rasm. O pacity param etrini belgilash.
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nusxalab unga sayqal berish shu bilan birga tasvirga nam va quruq 
muyqalam usullarida bezak berish mumkin. Muyqalam paketiga barg 
va o‘tlarni tasvirini yaratadigan maxsus effekt m uyqalamlari kiritildi. 
M axsus original tasvirlarni yaratish uchun skanerdan o‘tkazilgan 
rasm va m atnlarni orqa fon sifatida shaffof ko'rinishda tasvirga 
kiritish mumkin. Photoshop 7.0 dasturida faqat yangi tasvir yaratish 
imkoniyatlari bilan cheklanib qolmay balki, boshqaruvni soddalashtirish 
ham e’tiborga olingan.

Mavjud bo‘lgan muyqalamni o'zgartirish

Photoshop dasturiga qo'shim cha sifatida muyqalamlar bazasi ham 
beriladi va siz u yerdan istalgan muyqalamni tanlab uni xohishingizga 
ko'ra o‘zgartirishingiz mumkin.

1. Opsiyalar panelidan Brushes (Кисть) tugm asiga bosing undagi 
menyudan Brush Tip Shape bo‘limini tanlang.

2. Diameter (Диаметр) effektni kerakli joygacha cho'zing yoki 
muyqalam diam etirini kiriting (1 dan 999 pikselgacha).

3. Muyqalam izi shaffofsizligini belgilovchi Hardness (Жесткость) 
koeffitsentini tanlang yoki uni ham foiz miqdorda kiriting (0-100% 
gacha).

4. Muyqalam qoldirgan izlari oralig 'ini Spacing (Интервал) orqali 
belgilanadi (0-99% ). Foiz miqdorini oshirilgan sari shtrixlar orasidagi 
masofa kattalashib boradi. Shuningdek bu vazifani kursor yoki 
muyqalam ham bajarishi mumkin. Buning uchun Spacing (Интервал) 
tugm asidan bayroqni olib tashlashni o‘zi kifoya. Qanchalik kursorni tez 
harakatlantirsangiz shuncha oraliq kattalashadi va aksincha. Ko‘pgina 
standart o‘rnatilgan m uyqalam lar uchun asosan Spacing va Diameter 
bo iim larin i o‘zgartirish mumkin.

5. Muyqalam izini doira yoki boshqa ellips ko iin ish larin i belgilash 
uchun Angle (Угол) bo‘limidan (—180° dan +180° gacha) qiymatlarni 
ko'rsating yoki ekranning chap tarafidagi rasmdagi strelkani xohishga 
ko'ra joylashtiring.

6. M uyqalamni tiniqlashtirish uchun Roundness (Округлость) 
(0-100%) param etrlarini bering. Foiz miqdori ortgani sari nuqta izi 
tiniqlashadi.
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Yangi muyqalamni yaratish

Brush (muyqalam) menyusidan New Brush (Yangi muyqalam) 
buyrug'ini tanlang.

1. Mavjud muyqalamni o‘zgartirish (Изменение существующей 
кисти) bo lim idan  2 dan 8 gacha bo'lgan buyruqlarni tanlang. Create 
New Brush (Yangi muyqalamni yaratish) bo‘limiga bir m arta bosing 
va kerakli o‘lchamlarni bering. Agar siz ushbu tayyor muyqalamni 
saqlab qolmoqchi boisangiz, uni nomini kiriting va OK tugm asini 
bosing. Saqlangan muyqalam piktogram m asi tanlash panelining oxirida 
joylashadi.

Tasvirdan iborat bo‘lgan m uyqalamni yaratish uchun quyidagi 
ketma-ketlik bajariladi:

1. Rectangular Marquee (Прямоугольная область) uskunasini 
laollashtirish uchun klaviaturadan M  tugm asini yoki Shift+M  tug- 
malarini bosing.

2. Berilgan figuralar joylashgan oq fondagi tasvirni chegarasini 
belgilang (maksimum 1000x1000 pikselgacha).

3. Edit > Define Brush (Pravka > Определение киста) buyrug‘ini 
tanlang.

4. Yuqorida aytib o‘tilgandek ushbu yangi muyqalam nomini kiri- 
ting va OK tugmasini bosing. Bu muyqalamdan Brush (Кисть) menyusi 
bilan ishlayotganda foydalanish mumkin. Paydo bo‘luvchi muyqalam 
o'lchamlarini, Spacing (Интервал) tugm asidan shtrixlar orasidagi 
masofani aniqlashtiring (1-99%).

5. Belgilangan hududni qaytib o‘z holiga keltirish uchun Ctrl+D  
tugmalarini birgalikda bosing.

Muyqalamni o‘chirish

Muyqalam tanlash panelini oching:
Birinchi usul. Alt tugm asini bosib turib o‘chirmoqchi bo‘lgan 

muyqalamni belgilang. Bu harakatni orqaga qaytarish (отменить) 
mumkin emas.

Ikkinchi usul: Keraksiz bo igan  muyqalamni ko‘rsating va Delete 
Brush (M uyqalamni o‘chirish) b u y ru g in i tanlang.

Background Eraser va M agic Eraser uskunalarini ishlatilishi.
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M agic Eraser menyusi sichqoncha tugm asi bilan o‘chirish imkonini 
beradi. U siz ko‘rsatgan rangga yaqin bo‘lgan piksellarni o‘chiradi. В li m 
aksini esa Paint Bucket (Ведро с краской) uskunasi bajaradi. A gar si/ 
shaffofsizlikni 100%dan pastrog‘ini tanlagan bo‘lsangiz unda M agic 
Eraser uskunasi orqali kerakli joylarni shaffof ko‘rinishga keltirishingiz 
mumkin.

Background Eraser uskunasi bu fondagi keraksiz joylarni o‘chiradi 
yoki kerakli ranga bo‘yaydi. Bu uskunaning ustunligi shundaki u 
bilan aralash fonlarni yakdil holatga va o‘chirilayotgan m aydonni yoki 
chegaralarni ham ohangligini nazorat qiladi.

1. Xohlagan qatlamni tanlang. Eraser (o‘chirgich) uskunasi yor­
dam ida qatlam dagi keraksiz joylarni o‘chirmoqchi bo‘lsangiz undii 
Lock transparent pixels (Зафиксировать прозрачные точки) 
bo'lim iga bayroqchani o inating . Shunda o‘chirilayotgan qatlam  undan 
oldingi qatlam foniga ega bo‘ladi. Agar Lock transparent pixels (За­
фиксировать прозрачные точки) bo iim idag i bayroqcha olib tashlansa 
unda o‘chirilgan qism shaffof holatga o lad i.

2. Eraser (o‘chirgich) uskunasini E tugm asi yoki Shift+E  tugma- 
larini birga bosib uni ishga tushiring.

3. Opsiyalar panelidan Brush (Кисть) bo‘limiga kiring va kerakli 
bo'lgan m uyqalamni tanlang.

M ode (Режим) bo‘lim idan kerakli rejimni tanlang: u yerda Brush 
(кисть), Pencil (карандаш) yoki Block (Блок)п i tanlang. X o‘l bo‘yoqni 
akslantiruvchi Brush (Кисть) effektini tanlang. Opacity param etrlarini 
ko‘rsating.

Avtomatik tozalash rejimi

Auto Erase (Автоластик) o‘z-o‘zidan avtomatik tarzda ishlashga 
mo‘ljallangandir. Agar siz uni o‘z xohishingizga ko‘ra ishlatmoqchi 
bo‘lsangiz quydagilarni bajarishingiz shart:

1. Kerakli bo‘lgan fon rangini tanlang. Bunda Eyedropper (Пипет­
ка) uskunasidan rang tanlashda foydalanishingiz mumkin;

2. Kerakli bo‘lgan qatlamni belgilang;
3. Pencil (Карандаш) uskunasini faollashtiring, buning uchun V 

tugm asi yoki Shift+B tugm alarini birgalikda bosing;
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4. Opsiyalar panelidan Auto Erase (Автоластик) uskunasi ustiga 
bayroqni o‘rnating;

5. Tasvirga shtrixlarni chizing. Asosiy pikseldan boshlab kerakli 
hududgacha kursorni tortib boring.

Savol va topshiriqlar:

1. Brush uskunasi imkoniyatlarini sanab bering?
2. Background Eraser buyrugi nima uchun ishlatiladi?
3. Obyekt rangi qanday o‘zgartiriladi?

4.4. Matnlar bilan ishlash

Adobe PhotoShop dasturi tasv irlar ustiga m atnlarni kiritish 
uchun yana bir keng im koniyatni ochib beradi. Tasvir ustiga m atn 
kiritish uchun uskunalar panelida m axsus Текст uskunasi mavjud. Bu 
uskuna, asosan, tasvirga turli m atnlarni k iritish uchun xizm at qiladi. 
Гекст uskunasi tarkibida Текст-маска, В ертикальны й текст kabi 
uskunalar yashiringan. Bu uskunalar faollashtirilib, kursor tasvir 
ustida bir m arta  bosishi bilan yangi Текстовый инструмент darchasi 
hosil b o iad i. Bu uskunalar faqat m atnlarni tuzish  uchun xizm at 
qiladi. U ning yordam ida m avjud m atnlarni tah rir  qilishning imkoni 
yo'q.

Photoshop 7.0 dasturida matn vektor ko'rinishiga ega. Dasturda matn 
o'zining aniq chegara va konturlariga ega. Chunki dastur m atnlarni 
ishlatavotganda vektor konturini qollaydi. Shu bilan bir qatorda matn 
ham rasm sifatlarini o‘zida mujassamlashtirgan. Bu matn printerdan 
chiqarilishiga qaramay u PDF yoki EPS formatlarida saqlanishida o‘z 
tiniqligini saqlab qoladi.

Photoshop dasturi faqatgina m atnlarni kiritibgina qolmasdan, balki 
ularni yozilayotgan vaqtida va yozilgandan so'ng ham  ularni tusini, 
rangini, k o iin ish in i hamda yo‘nalishini o‘zgartirish mumkin.

Matnni kiritish

Photoshop dasturida matn yozish uchun Текст tugm asi tanlanadi 
va avtom atik tarzda kerakli joyda o‘z maxsus qatlamiga ega boigan
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fonda yozila boshlaydi. Istalgan paytda uning k o iin ish in i o'zgartirish 
m um kin masalan: shrift, uslub, kegl, rang, kerning, treking, oraliqdagi 
interval, to‘g‘irlash, chiziqlarni hajmi. Bundan tashqari bir tekstni o‘ziga 
bir qancha atributlarni kiritish mumkin.

Shu bilan bir qatorda m atnning m a'nosini m exanik tarzda 
o 'zgartirish unga har xil effektlar qo ilash  va u joylashgan qatlam 
ustida bir qancha im koniyatlarni qo ilash  m um kin. Matn qatlam i 
ustida qanday am allar qo ilash  mum kin? Unga filtrni qo ilash , matndan 
tozalash m um kin. Bu am allarni bajarish uchun eng avvalo matn 
qatlam ini Layer > R asterize > Ture (Слой > П реобразовать в рас­
тровый формат > Текст) uskunasi orqali belgilab undagi buyruqni 
tanlash kerak.

Eslatma. Bitmap. Indexed Color va M ultichannel rejim ida yaratilgan 
m atn o‘z qatlamiga ega boim aydi va to‘g iid an -to ‘g‘ri ekran foniga 
tushadi hamda uni tahrirlash imkoniyati yo'qoladi.

Turli xildagi m atnlar (tahrirlanadigan va tahrirlanmaydigan) ko*- 
rinishlari Ture (Текст), Layer (Слой), Character (Шрифт), Paragraph 
(Абзац) uskunalari va Opsiyalar paneli orqali yaratiladi.

Tahrirlanadigan matn qatlamini yaratish:

1. Eng avvalo Ture (Текст) uskunasini T tugm asini bosish bilan 
faollashtiring.

2. So‘ngra m atnni joylashtirish kerak bo igan  ekrandagi qismning 
o icham larin i sichqoncha orqali belgilang (so'zlar va m atnlar bir-birigii 
to‘qnashib ketmasligi kerak). Yaxshisi har bir so‘zni alohida qatlamga 
yozing shunda ularni bir-biridan mustaqil ravishda siljitish imkonini 
qo lga kiritasiz.

3. Opsiyalar panelida quyidagi am allarni bajaring:
° Ture tugm asiga bosing va m atnning yo'nalishini ko'rsating (go­

rizontal, vertikal);
о Shrift va uning o icham ini tanlang;
о Shuningdek Anti-aliased (Moslashtirish) menyusidan matn 

qatlam chegarasini ko'rsating: Sharp (Tiniq) Crisp (qattiq), Strong 
(kuchli) yoki Smooth (yumshoq). Bu m atnni soyasi k o lin  ishlarini 
tubdan o‘zgartiradi va tasvirga moslaydi. Alignm ent (Выключ­
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ка) tugm alaridan biriga bosing va kerakli bo‘lgan m atnni yozilish 
chegarasini ko'rsating (o'ngdam chapdan, o‘rtadan).

Opsiyalar panelidan matnni rangini ko‘rsating. Bundan tashqari 
matn rangini Swatches (Образцы) va Colors (Цвета) palitralaridan 
ham belgilash mumkin.

4. Ekrandagi oynada matnni kiriting.
5. Yangi matn qatlamini yaratish uchun Enter tugm asini bosing. 

Agar sizga boshqa qatlam kerak bo'lm asa Esc tugm asini bosing.
Eslatm a: A gar siz m atn lar b ilan  ishlayotganda kom pyuter 

to‘xtab qolaversa yoki tezlig i pasaysa unda ochilgan qolgan kerak 
bo 'lm agan oynalarn i yoping. Shunda dastur tezlig i o‘z holiga 
keladi.

Eslatm a: Har safar m atn yozishda yangi qatlam dan foydalan- 
jianingiz ma’qul va xatolikka ega bo'lgan qatlam larni o 'chirib tash­
lang.

M atnni tahrirlash. M atnni o‘zgartirishdan oldin uni faollashtiring 
va matndagi so‘z. jum la va harfni belgilab o'zgartirish kiriting. 
Shuningdek matnni belgilash uchun uning ram kasini ustiga bosish
kifoya.

Matnni masshtablash

Horizontal Scale (М асштаб по горизонтали) va Vertical Scale
(Масштаб по вертикали) buyruqlaridan matnni joylashish shaklini 
o'zgartirish uchun foydalaning. Bir xil to 'g 'ri ko'rinishdagi masshtablash 
uchun quydagi am allarga rioya qiling:

Matn uchun maxsus effektlar

Eng avvalo quyidagilarni eslab qoling. Agar siz m atnni ram ­
kasini m asshtabini, hajmini va tuzilishini o 'zgartirish uchun uni 
tahrirlanadigan ko'rinishda bajarishingiz kerak bo'lsa va so'ngra matnga 
maxsus effektlar qo'shish uchun uni rasm sifatiga keltirib undan keyin 
cffektlarni qo'llashingiz mumkin.

V tugmasi orqali ishga tushiriluvchi Move uskunasi orqali matnni 
trasformatsiya qilish mumkin.
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Show Bounding Box (П оказать габаритную  рамку) uskunasip,» 
bayroqchani o‘rnating Layers (Слои) uskunasi orqali kerakli qatlamni 
belgilang. Ekranda matn qatlam i aks etadi.

Yakka holda kiritilgan ju m la  va so'zlarni quyidagicha o'zgartirish 
mumkin:

• Layers (Слои) oynasiga jum lan i kiriting va Edit (Праи 
ка) m enyusidan Free Transform  (Произвольная трансформация) 
buyrug in i tanlang;

• Sichqoncha bilan m atn  oynasini kerakli shaklni olgunchn 
surib boring. Bu vazifani boshqa uskunalar yordam ida ham  bajarish 
mumkin.

Matnni rasmli qatlam  ustiga joylashtirish:

1. M atnli qatlamni yarating.
2. Shu m atn qatlamidan nusxa oling va uni saqlab qo'ying.
3. Matn nusxasini belgilang va Layer > Type > Convert to Shapr 

(Слой > Текст > Преобразовать в фигуру) buyru g in i bering. Matn 
qatlami avtomatik rasmga aylanadi va  uni tahrirlash endi m um kin emas.

4. Layer > Change Layer Content > Levels (Слои > Измени 11 
содержимое слоя > Уровни) b u y ru g in i bering. Yozilgan qatlam si/ 
boshqa qatlamni kiritm aguningizga qadar buferda qoladi va faol bo iib  
turadi.

5. Yozilgan matn boshqa tasv irlar bilan ham ohangligini jigarrang 
tusga ega b o igan  piktogram m a Input (Ввод) ustiga bosing va matn 
rangini ochartiring yoki to 'qlashtiring;

6. OK tugm asini bosing. E kran  fonining bir qismiga bosing.

Ko'rinmaydigan matnlar yaratish:

1. M atn kiriting va uni qatlam ini faol holatda qoldiring.
2. Layers oynasining pastk i qism idan Add a mask (Добавить 

маску) tugm asini bosing. B elgilangan joy yonida kichik belgi (маска) 
paydo boladi.

3. G klavishasini yoki Shift+G  tugm alar kombinatsiyasini bosgan 
holda Gradient (Градиент) uskunasin i ishga tushiring.

4. Gradient uskunasi yonidagi strelkani bosing va kerakli rangni 
tanlang. Linear gradient (Л инейны й градиент) tugm asiga bosing va
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Normal (Нормальный) rejimini tanlang shaffofsizlik qiym atini bering 
ll% dan 100% gacha).

5. M atnni ustiga kerakli b o igan  hududni ram ka sifatida sichqoncha 
bilan belgilang va shu qismlar ocharadi yoki to'qlashadi.

M atnni effekt bilan ko‘chirish uchun u joylashgan qatlamni 
laollashtiring va Move (Перемещение) uskunasini ishga tushiring.

Agar siz effektni o 'zgartirm oqchi bo'lsangiz matn joylashgan qatlam 
iKtiga bosing shunda Layer Style muloqot oynasi paydo bolad i. Undan 
boshqa effektlarni tanlashingiz mumkin.

Matn qatlamini chegaralarini o'rash:

1. Blending Options (Опции смешивания) oynasidan Layers 
(Слои) b u y ru g in i tanlang.

2. Style (Стиль слоя) oynasining chap tarafida joylashgan Stroke 
(Обводка) b u y ru g i ustiga bosing va Preview (Предварительный 
просмотр) uskunasiga bayroqcha o 'rnatilganligini tekshiring. U yerdan 
quyidagi b o lim larn i k o iib  chiqing va kerakli o lcham larn i bering: 
Structure (Структура) Size (Размер), Position (Joylashish holati) 
(ular tashqaridan va ichkaridan bo'lishi m um kin Outside (Снаружи), 
Inside (Внутри) yoki Center (markaz)). Blend Mode (Режим сме­
шивания), O pacity (Shaffofsizlik), F ill Type (bo'yash usuli) va Color 
(rang).

OK tugm asini bosing (yoki Enter tugm asini bosing).

Savol va topshiriqlar:

1. Dasturda matn konturini o'zgartirish uchun qaysi buyruqlardan foy­
dalaniladi?

2. Qaysi uskuna yordamida Photoshop dasturida matnlarni yaratish 
mumkin?

3. Gradient (Градиент) uskunasi qaysi tugmalar yordamida ishga tu- 
shiriladi?

4.5. Adobe Photoshop dasturida tasvirga ishlov berish. Qatlamlar

Qatlam lar xuddi oyna qatlamlariga o'xshagan boiib , faqat tasvir 
bo'lgan joylarigina ko'rinishga egadir. Har bir qatlam uchun o'zining
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shaffoflik darajasi b o iib  undan oldingi va keyingi turgan qatlamlai 
bilan hamohangligini moslash m um kin. Qatlam larni joylashish o in im  
almashtirish yoki ularni yagona qatlamga birlashtirish m um kin. Bii 
vaqtni o ‘zida har xil qatlamlarda turgan tasvirni birgalikda o 'zgartirish 
va bir qatlamda turgan rasmni faqat bir qismini o 'zgartirish  m um kin 
emas.

Layers (Слои) oynasida qatlamlar ustida turgan qatlam dan eng 
tagidagi qatlamgacha aks ettirilgan. Bunda fon qatlam i oxiritla 
joylashadi. Hozirda belgilangan qatlam faol bo'lib ko 'rinadi va faqat shu 
qatlam ustida am allar bajarish mumkin.

Istalgan qatlam ni faollashtirish uchun Layers oynasidan kerakli 
qatlam ustiga bosish kerak. Faol b o ig an  qatlam nomi dastur nomi 
yonida akslanib turadi.

Eslatma: Katta hajmdagi tasvirlar bilan ishlayotganda bajarilib 
bo'lgan qatlam larni birlashtirish yoki o'chirib tashlagan m a’qul. Shunda 
dastur ishlash tezlik unumdorligi oshadi va tasvir hajmi kamayadi.

Yangi qatlam hosil qilish

1. Eng avvalo 100% shaffof qatlam hosil qilish uchun Create New 
Layer tugm asi ustiga bosing.

2. Agar qatlam ni o icham larin i o 'zingiz bermoqchi bo'lsangiz unda 
Alt tugm asini bosib turgan holda Create New Layer tugm asini bosing;

3. Name (Имя) bo litn ida qatlam ni nomini kiriting Group W ith  
Previous Layer (Сгруппировать с предыдущ им слоем) bolim iga 
bayroqchani o'rnating;

4. Layers (Слои) palitrasidan ko'z va muyqalam ko'rinishidagi 
piktogram m alarga bayroqchani o'rnating;

Mode (Режим смешивания) va Opacity (Непрозрачность) 
param etrlaridan tasvir uchun yangi param etrlarini bering (keyinchalik 
bu param etrlar o 'zgartirilishi mumkin).

5. OK tugm asini bosing. Yangi qatlam ishlatilayotgan qatlam ustida 
paydo bo'ladi.

Eslatma: Tasvir hajmini kam aytirish uchun Layers (Слои) 
menyusidan Palette Options (Опции палитры) buyrug'ini tanlang va 
shu tasvirga to 'g 'ri keladigan eng kichik hajmni tanlang.
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Belgilangan qistnni qatlamga aylantirish

1. Belgilangan qismni hosil qiling;
2. Layer > New > Layer Via Soru (Слой > Новый > Посред­

ством копирования) menyusidan buyruqni bering (Ctrl+J tugmalari).
3. Tasvirni belgilangan qismini qirqib olib tashlash uchun Layer 

> New > Layer Via Cut (Слой > Новый > Посредством вырезания) 
buyrug in i bering (Ctrl+ Shift+J tugmalari).

Qatlamni siljitish

1. Layers (Слои) oynasida o 'zgartirish kiritmoqchi bo'lgan qatlamni 
belgilang;

2. Move (Перемещение) uskunasini faollashtiring (V klavishasi);
3. Qatlam ni kursorni ushlab turgan holatda siljiting.
Eslatma: Auto Select Layer (Автовыделение слоя) bolim ida 

bayroqcha turgan bolsa Move (Перемещение) uskunasi yordamida 
lezda qatlamni siljitish mumkin, ammo bu siljitish shaffofligi 50% dan 
kam b o igan  qatlamlar uchun ishlamaydi.

Qatlamlar bilan ishlash uchun uskunalar

Barcha uskunalar qatlamlar bilan ishlaydi. Lekin bu bilan qat- 
lamning shaffofsizligiga katta tasir o lkazad i. Shuning uchun qatlam 
shaffofsizligini doimo nazorat qilib turing.

Qatlamni o ‘chirish

Qatlam ni uchirishdan oldin uni nomini faolligini tekshiring va uni 
belgilab o‘chirib tashlang.

Qatlamga effektlar qo ilash

Qatlamga quyidagi maxsus effektlarni qo ilash  mumkin: Drop 
Shadow (Отбросить тень), Inner Shadow (Внутренняя тень), Outer 
Glow (Внешнее свечение). Inner Glow (Внутреннее свечение). Bevel 
and Emboss (Скос и рельеф), Satin (Атлас), Color Overlay (Н ало­
жение цвета), Gradient Overlay (Наложение градиента) va Pattern  
Overlay (Наложение узора). Effektlarni istalgan paytda istalgancha 
xohlagan qatlamga qoilash mumkin.
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Eslatma: Uslublar va effektlarni bir-biri bilan chalkashtirib 
yubormang. Uslub (Стиль) -  bu bir qancha qatlam effektlarini ha- 
mohangligidir.

Effektlarni qo‘yish Layer Style (Стиль слоя) muloqot oynasi orqali 
amalga oshiriladi.

Effekt yonidagi belgi bu effekt shu qatlamga qo'llanilganini 
ko'rsatadi. Qatlam effektlarini asosiy fon uchun qoilash  m um kin emas.

Hamma qatlamlarni birgalikda ishlatish

Agar Opsiyalar panelida quyidagi uskunalar ishlatilayotgan bolsa: 
Blur (Размытие), Sharpen (Резкость), Smudge (Палец), Paint Bucket 
(Ведро с краской), M agic Eraser (Волшебный ластик) yoki Magic 
Wand (Волшебная палочка) unda Use All Layers (Использовать 
все слои) bo lim iga bayroqchani o 'rnating shunda rang va boshqa 
o lcham lar olinayotganda mavjud boigan  ranglarga yaqin boigan 
tuslar birinchi navbatta ko'rinadi. Faqat faol bo igan qatlamda ranglar 
o'zgaradi.

Ikki qatlamni birlashtirish

1. Birlashtirmoqchi bo igan  ikki qatlamdan qaysi birisi oldinroq 
b o lsa  uni belgilang.

2. Layers (Слои) menyusidan Merge Down (Слить с ниж­
ним) buyrug in i bering yoki Ctrl+E tugm alarini birgalikda bosing. 
Faol qatlam o'zidan pastda turgan qatlam bilan birlashadi. Bir qancha 
belgilangan qatlam larni birlashtirish uchun Merge Layer Set (Слить 
набор слоев) b u y ru g in i bering.

Qatlamlarni birlashtirish

Eslatma: Flatten Image (Плоское изображение) buy rug' i qat­
lam larni pastdan boshlab birlashtiradi va yashirilgan qatlam larni 
avtomatik tarzda o'chiradi.

Hamma qatlam lar ko'rinib turganligiga amin b o ling  va qaysi 
qatlam faol bo iish i muhim emas. Layers (Слои) menyusidan Flatten  
Image (Плоское изображение) buyru g in i bering. Agar dasturda 
bekitilgan qatlamlar b o lsa  unda ogohlantirish beriladi va OK tugm asini



hosing va birlashtirishni davom ettiring. A garda pastki qatlam larda 
ko‘rinm aydigan nuqtalar bo‘lsa ular oq ranga kiradi.

Layers (Слои) menyusidan keraksiz qatlam nom ini tanlang. So‘ngra 
Trash (Корзина) tugm asini bosilgandan keyin Yes (Да) tugm asini ham 
bosing.

Qatlam ni o 'chirishni yana bir usuli keraksiz qatlam  nomi ustiga 
olib borib sichqonchani o‘ng tugm asini bosing va m enyudan Delete 
Layer (Удалить слой) buyrug‘ini tanlang ham da Yes tugm asini
bosing.

Savol va topshiriqlar:

1. Qanday usulda qatlamlar hosil qilinadi?
2. Qatlamlarga qanday effektlar qoilash mumkin?
3. Ajratilgan qismda yangi qatlamni hosil qilishni ko‘rsatib bering.
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V-bob. COREL DRAW DASTURI

5.1. COREL DRAW dasturi bilan tanishuv

Kanadaning Corel nomi bilan ataluvchi firmasi dasturiy ta’minot 
bilan shug’ullanuvchi peshqadam lardan biri hisoblanadi. Corel 
firmasining dasturiy ta’minoti asosini tashkil etuvchi CorelDRAW
11 2002-yilning avgustida ishlab chiqarildi. U reklama mahsulotlarini 
ishlab chiqarishda, nashrlarni tayyorlashda, hamda Web-sahifalari 
uchun tasvirlarni yaratishda katta imkoniyatga ega.

Corel DRAW -  bu grafikli dastur bo'lib, uning yordamida vektorli 
tasvirlarni, grafikli m atnlarni, ham da sizning tassavvuringizdagi barcha 
ijodiy g'oyalaringizni amalga oshirishga yordam beradi.

Corel DRAW dasturi ishlaydigan barcha tasvirlar ikki sinfga 
bo'linadi: nuqtali va vektorli. Vektorli grafikada tasvirning asosiy 
elementi sifatida chiziq qaraladi. Rastrli grafikada bunday chiziqlar 
nuqtalar (piksellar) yordamida yaratilsa, vektorli grafikada esa 
tasvirlar yaratishda nuqtaga nisbatan umumiyroq bo'lgan chiziqlardan 
foydalaniladi va shuning hisobiga tasvirlar aniqroq bo'ladi.

Vektorli grafikaning ixtiyoriy tasviri chiziqlardan tashkil 
topadi va oddiy chiziqlardan m urakkablari hosil qilinadi. Vektorli 
grafikaning m atem atik asosini geom etrik  figuralarning xossasini 
o 'rganish tashkil qiladi. Vektorli tasvirlarni kom pyuter xotirasida 
ifodalanishi nuqtaliga qaraganda m urakkabroq. N uqtali tasvirn ing 
kam chiligi -  kom pyuter xotirasida ularni saqlash katta joy  talab 
etiladi. N uqtali tasv irlar bilan yuqori aniqlikda ishlashda, u larga mos 
fayllarning o 'lcham i yuzlab m egabaytlarni tashkil etadi. K o'pincha, 
bunday katta obyektlar bilan ishlaganda zamonaviy kom pyuterlarning 
tezligi yetm ay qoladi. Vektorli tasv ir bilan ishlash ju d a  ham  oson. 
Uni katta  yoki kichik qilish uchun, faqat uni boshqaradigan tasvir
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purametrini o 'zgartirish  m um kin. Bunda vektorli tasv ir faylining 
" Ichami bir baytga ham  oshmaydi.

Ma’lumotlar tasvirlar orqali berilganda ularni tahlil qilish va 
qabul qilish tezligi, m a’lumotni eshitish kanallari orqali berilgan 
ma'lumotlardan ko‘ra ancha yuqori bo'ladi. Shuning uchun ham 
lasvirdan iborat birgina reklam a plakati (osongina kerakli ta’sirni bera 
oladigan) tomosha qilayotgan odamga bir necha qator e ’londan ko'ra 
luichli ta’sir ko'rsatadi.

Har qanday hajmdagi m a’lumot ko'rish kanali orqali uzatilsa odam 
tomonidan yaxshi qabul qilinadi (bolalarga rasmlafdan iborat kitoblar 
yoqadi). Boshqa fonnatda esa bunday m a’lumotni qabul qilib boim aydi 
(hirjalardagi jadvallar). Shu sababli ham grafikli m a’lumotlarga bo igan  
ehtiyoj kundan kunga ortib bormoqda.

Bunday grafiklar va tasvirlar bilan ishlashga m oijallangan dasturiy 
vositalar juda ham  ko'p va xilma-xil. Ana shunday dasturlardan biri 
CorelDRAW dasturidir.

CorelDRAW ning 12 versiyasi o'zida zamonaviy imkoniyatlarni 
birlashtirgan bo'lib 2004-yilda ishlab chiqarilgan. Bu dastur sanoat 
ilizaynida, reklam a m ahsulotlarini ishlab chiqishda, nashriyot tizim- 
larida va web sahifalar uchun turli tasvirlar yaratishda ishlatiladi. 
Corel DRAW dasturi paket dastur hisoblanib o'z ichiga bir nechta qism 
dasturlarni oladi. Bu dasturlar o 'zaro m a’lumot alm ashishning yengil 
kechishini ta ’minlaydi.

Paketning yaxlitligi uning tarkibiga kiruvchi dasturlarning ma’­
lumotlarni yengil alm ashinishi yoki shu ma’lumotlar ustida ketma-ket 
turli xil vazifalarni bajarishi bilan belgilanadi.

«Obyektga yo'naltirilgan» -  atamasi tasvirlarni yaratish va o'zgar­
tirish jarayonidagi barcha operatsiyalar, rasm ning o 'zi yoki uni tashkil 
qilgan piksellar bilan emas balki tasvirni tashkil qilgan semantik 
belgilangan elementlar ustida boradi. Standart obyektlarni qollagan 
holda (aylana, to 'g ‘ri to 'rtburchak, matn va boshqalar) foydalanuvchi 
murakkab obyektlar qurishi va ularni birlashtirib yagona butun obyekt 
sifatida qarashi mumkin. Shu tarzda, rasm iyerarxik tuzilishga ega 
bo'lib, eng yuqorisida butun vektorli tasvir bo'lgan, eng quyida esa 
standart obyektlardan iborat bo'ladi.
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Paket obyektga yo‘naltirilishining yana bir afzalligi har bit 
obyektlarning standart sinfiga boshqaruv param etrlari yoki atributl;ti 
o inatilad i. M asalan, to‘rtburchak balandligi 200 mm va eni 300 mm. 
ko‘k rang bilan to ld irilgan, qalinligi 3 punkt bo igan  sariq rangdagi 
chiziq bilan chegaralangan. Joylashuvi vertikal bo'yicha 150 mm. 
gorizontal bo‘yicha 250 mm, 32 gradusga burilgan kabi boshqaruv 
param etrlariga ega.

Paketning obyektga vo'naltirilishining uchinchi afzalligi obyekl 
larning har bir standart sinfiga standart operatsiyalar ro‘yxati bel- 
gilangan. M asalan, yuqoridagi to’rtburchakni burish. o icham larini 
o'zgartirish, burchaklarini o’zgartirish, boshqa sin f obyektlarig;i 
aylantirish kabi amallar. CorelDRAW ning obyektga yo'naltirilganli{.’i 
foydalanuvchiga ish vaqtida obyektlar ustida cheksiz o‘zgaruvchanlik 
am allarini bajarish imkonini beradi. Agar buyurtm achi ishning oxirgi 
bosqichida o‘z fikrini o‘zgartirsa va reklam a plakatidagi olma o‘rniga 
anorni tasvirlashni xohlab qoldi, bunday holatda ishni boshidan 
boshlash shart emas. Buning uchun ayrim obyektlarni almashtirish 
kifoya. Bunday holatda bir m arta qurilgan obyektni saqlab qo‘yib 
keyingi yangi ishlarda foydalanish mumkin.

CorelDRAW paketi quyidagi dasturlardan iborat: Corel CAPTURE:, 
Corel BARCODE W IZARD, CorelDRAW, Corel Photo-PAINT. Corel 
OCR-TRACE, CorelTRACE, Corel V ENTU RA , Corel SCRIPT Editor. 
Corel SCRIPT Dialog Editor.

Corel CAPTURE dasturi CorelDRAW dasturi oynasi va uning 
qismlarini rasmga olish uchun ishlatiladi. Uning yordamida dastur 
oynasi ayni ko‘rinishini to iiq  yoki menyu ko‘rinishini ham da biror 
qismni to 'rtburchak shaklda, aylana yoki ellips shaklida va ixtiyoriy 
shaklda aylantirib belgilab olish mumkin.

Corel BARCODE W IZARD das­
turi esa shtrix-kod bilan ishlashga 
m oijallangan. Unda berilgan standart- 
lardan birini tanlab, so‘ng keltirilgan 
nam una bo‘yicha raqam va xarflarni 
kiritamiz.

Corel Photo-PAINT dasturi esa 
rasm lar chizishga m oijallangan.
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CorelDRAWni ishga tushirish. Corel DRAW 12 grafik muharririni 
ishga tushirish uchun Пуск > Программы > Corel DRAW 12 buyrug'i 
beriladi yoki Windows XP ish stolida uning yorlig‘i ustida sichqoncha 
chap tugmasi ikki marta bosiladi.

CorelDRAW dasturini ishga tushirish Windowsning standart 
usullari singari: asosiy menyu orqali (unda paketni o‘rnatganda 
CorelDRAWni yuklash buyrugini o'z ichiga olgan yangi buyruqlar 
guruhi paydo boiadi) yoki ish stolida joylashgan yorliq yordamida 
hamda CorelDRAW dasturida yaratilgan fayllar ustida sichqoncha 
chap tugmasini ikki marta bosish yo ii bilan ishga tushiriladi. Bunday 
fayllarni biz albatta uning kengaytmasidan bilib olamiz. CorelDRAW 
dasturida yaratilgan fayllar .CDR, .CMX, .WMF kabi kengaytmalarini 
oladi.

Kengaytmalar haqida 5.2-jadvaldan batafsil ma’lumot olishingiz 
mumkin.

5.2-jadval

CorelDRAW dasturida kengaytmalarning ro‘yxati

№ Kengaytma Izoh

1. CDR CorelDRAW

2. CDT CorelDRAW shabloni

3. CGM Kompyuter grafikasi metafayli

4. CMX Corel Presentation Exchange 5.0.

5. CMX Corel Presentation Exchange

6. CSL Corel simvollari kutubxonasi

7. DES Corel DESIGNER

8. DWG AutoCAD

9. DXF AutoCAD

10. EMF Kengaytirilgan Windows metafayli

11. FMV Vektorli freym metafayli

12. GEM GEM fayli
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13. PAT Uzor fayli

14. PCT Macintosh PICT rasmlari

15. PLT HPGL plotter fayli

16. SVG Masshtablanadigan vektor grafikasi

17. SVGZ Siqi SVG

18. WMF Windows metafayli

19. WPG Corel WordPerfect grafikasi fayli

20. CLK Corel R.A.V.E.

Dastur yuklangandan so‘ng ekranda foydalanuvchi interfeysining 
asosiy elementlaridan iborat CorelDRAW oynasi paydo bo'ladi (5.1- 
rasm).

Atributlar paneliMenyu qatori Standart uskunalar paneli 
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5.1-rasm. CorelDRAW  oynasin ing ko'rinishi.

12 -  Pedagogik web-dizayn

Palitra
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CorelDRAWda ishchi muhitni sozlash mexanizmi juda rivojlangan. 
Windows standartidan farqli oynaning sarlavha satri ostida menyu 
qatori joylashgan.

5.2. Corel DRAW dasturi oynasi q ism lari

□ Sarlavha satri. Bu yerda: Corel DRAW 12 -  dasturning nomi.
[Risunok 1] -  hujjatning formal nomi. Ish yakunida formal nomg;i

real (haqiqiy) nom beriladi.
□ Menyu satri.
Windows standartlariga mos bo‘lgan menyu satri. CorelDRAWdn 

menyu satri murakkab bo‘lib, qism menyu va ularga mos buyruqlardan 
iborat. Boshqa dasturlardagi kabi bu menyu ham Corel Drawning 
ko‘pchilik funksiyalariga kirishni ta’minlaydi. Lekin ko‘pchilik ha- 
rakatlar u siz ham bajarilishi mumkin. M enyuni sozlashning 
chegaralanmagan imkoniyatlari foydalanuvchini chalkashtirib yuboradi. 
Foydalanuvchi xohlagan vaqtda CorelDRAWning har qanday buyruq 
va uskunalarini boshqa menyuga ko‘chirish mumkin. Shuning uchun 
keyingi paragraflarda birinchi navbatda menyusiz ishlash yo'llarini. 
zarur bo'lganda uning buyruqlariga murojat qilishni o‘rganami/ 
Menyu satri 11 ta menyudan iborat. Har bir menyu o‘ziga xos buyruqlai 
to‘plamidan tashkil topgan. Corel DRAWr menyusi m urakkab tuzilgan 
bo‘lib, har bir menyuda bir necha ichki menyular bo‘lishi mumkin.

Standart uskunalar paneli

Menyu satrining ostida Standart uskunalar paneli joylashgan. Bu 
satrda eng ko‘p bajariladigan buyruqlarga mos boshqarish elementlari 
joylashgan. Masalan, Открыть (ochish), Закрыть (yopish), Сохраниn  
(saqlash) buyruqlari, tizimli almashtirish buferining operatsiyalari, 
rasmlarni ko‘rish holati uskunalari joylashgan.

, T f  u  «  8p Я . «  * -  rjti Cjp -- SJj I 100% v  • Привядать к ^  1

I ..I II. I I .I 1 ..1.......I l l  .........1... .....
1 2 3 4 5 6 7 8 9 10 11 12 13 14

Standart uskunalar paneli tugm achalarining vazifalari: 

l -  yangi hujjat yaratish: 2 -  mavjud hujjatni ochish: 3 — hujjatni saqlash; 4 -  
hujjatni chop qilish; 5 -  qirqish; 6 -  nusxa olish; 7 -  qo'yish; 8 — oxirgi harakatni



bekor qilish; 9 -  oxirgi harakatni takrorlash; 10 -  import (bir hujjatni ikkinchisiga  
ulash); 11 -  eksport (fayllarni jo ‘natish); 12 -  ilovani yuklanish moduli; 13 -  Corel 
DRAW ning savtiga kirish; 14 -  masshtabni kattalashtirish darajasi.

□ Atributlar paneli.
Standart uskunalar panelining ostida «atributlar paneli» (панель 

атрибутов) satri joylashgan. U belgilangan obyektning parametrlarini 
o'zgartiradigan boshqarish elementlari to‘plamidan iborat. Atributlar 
paneli ichidagi elementlar belgilangan obyektning shakliga qarab 
o'zgarib turadi. Bu panel foydalanuvchining asosiy ish paneli deb 
ataladi.

J x: 83,';43 им 

Ij у: 163,895 мм

>*•♦< 17,698 мм t 31,891 мм
юо.о & 
100,0 % О 0,0 Bit-, W~ 0 5  •; 12, 0,2 мм V; О

Ranglar palitrasi. Oynaning o‘ng chegarasi bo‘ylab «Палитра цве­
тов» (ranglar palitrasi) paneli joylashgan. U rangni toldirish va rasmli 
obyektlarning atrofini himoyalash, aylantirib bo‘yash uchun qollaniladi.

Uskunalar paneli. Ish maydonining chap qismida uskunalar toLplami 
(toolbox) oynasi joylashgan. Undagi kerakli uskunani tanlash uchun 
lining ustida sichqoncha chap tugmasi bosiladi. Kerakli uskunani 
tanlash bilan foydalanuvchining tasvir ustida barcha harakatlari 
boshlanadi.

Набор инструментов

-т -j a*, i—L ч -j. (ai u j  t i l  r:A uA чГлI Г I ..i T i ■ i i i(Aj □  %

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

Uskunalar panelidagi asosiy uskunalar va ularning vazifalari:

I -  Указатель (ko‘rsatkich), tasvirni belgilaydi: 2 -  Ф орма (shakl) uskunasi; 3 -  
Вырезать (Qirqib olish); 4 -  М асш таб (oicham ). Obyektni ko‘rinishini o‘zgartiradi 
(kattalashtiradi va kichiklashtiradi); 5 -  Свободная рука. Ixtivoriy shakldagi 
chiziqlarni chizadi; 6 -  Авторисование uskunasi. Erkin chiziqlarni hosil qiladi; 7 -  

Прямоугольник uskunasi. To‘rtburchaklar sinfini hosil qiladi; 8 -  Aylana va uning  
sinfiga tegish li obyektlarni chizadi; 9 -  М ногоугольник (ko‘pburchak) uskunasi. 
ko'pburchaklarni chizadi; 10 — П росты е формы (oddiy formalar); 11 — Текст 
(matn) uskunasi: 12 -  Таблица. Jadval uskunasi; 13 -  Интерактивное перетекание  
uskunasi; 14 -  П ипетка uskunasi; 15 -  Контур uskunasi; 16 -  Заливка uskunasi; 
17 -  Интерактивная заливка uskunasi.
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5.2-rasm. Fill uskunasining yoyilgan paneli.

Uskunalar panelidagi ayrim tugmalarning pastki o‘ng burchagida 
uchburchak shakli berilgan. Bu ko‘rsatkich tugmachaga aslida bitta 
emas balki bir nechta uskuna o‘rnatilganligini bildiradi. Tugmaga 
tegishli boshqa uskunalarni birga ko‘rish uchun uni sichqoncha chap 
tugmasi yordamida bosamiz.

5.2-rasmda Fill (Заливка) uskuna tugmasi ostida joylashgan panel 
ko‘rsatilgan.

Ochilgan paneldan zarur tugmani tanlash va bosish yoii bilan turli 
vazifalar bajariladi.

CorelDRAW oynasining pastki qismida holat qatori joylashgan 
(status bar). Unda ish jarayonida belgilangan obyekt haqidagi va 
dasturning ish rejimi haqidagi boshqa yordamchi m aium otlar beriladi. 
Holat qatorini ish stolining ixtiyoriy joyiga ko‘chirish mumkin. Ammo 
tajribalarning ko‘rsatishicha holat qatorini ish stolining pastki qismiga 
joylashtirgan ma’qul.

CorelDRAW ish maydonining asosiy qismida hujjatlar oynasi 
(drawing windows) joylashtirilgan. CorelDRAW yangi hujjat yaratish 
buyrug‘i berilgandan so‘ng illyustratsiya joylashtiriladigan sahifa paydo 
bo‘ladi. Sahifaning chegaralari ramka ko‘rinishida joylashtirilgan bo‘lib 
ular tasvirning elementlari hisoblanmaydi. Bolajak illyustratsiyani 
tashkil qiluvchi obyektlari ana shu ramkalar ichida joylashgan bo‘lishi 
lozim. Illyustratsiya oynasining qolgan maydoni ish stoli deb nomlanib, 
ulardan obyektlarni vaqtincha saqlash maqsadlarida foydalaniladi. 
CorelDRAW ish stoli o'lchami uning ekranda ko‘rinib turgan qismidan 
ko la  juda ham katta. Oynaning ko‘rinmaydigan qismini ko‘rish uchun 
o‘ng va pastki tomonda ikkita prokrutkalar joylashgan. Gorizontal 
prokrutkadan chapda ko‘p betli hujjatlarning alohida betlariga o lish  
imkonini beruvchi (harakatlanish) tugma va yorliqlardan (betning nomi 
berilgan) iborat boshqaruv elementlari joylashgan. Ularni birgalikda 
navigator deb ataladi.
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Hujjat oynasining chap va yuqori chegaralarida koordinatali 
ch izg ich lar  (rulers) joylashtirilgan. Ular yordamida obyektlarning 
koordinatalarini va joylashuvi yo‘nalishini aniqlab olinadi.

CorelDRAW interfeysida birlashgan (dockers) oynasi ulkan 
ahamiyatga ega. Bu oyna yig‘ilgan paytida nomlangan yorliqlardan 
iborat bo'lib, ranglar palitrasidan chapda joylashgan. Ular o'zining 
funksiyasiga k o ia  muloqot oynasini eslatadi. Ammo ularning muloqot 
oynasidan farqli tomoni ish muhitida doimo ko‘rinib turishidadir.

5.3. Hujjatlar bilan ishlash

Yangi hujjat yaratish

Har doim CorelDRAW dasturi yuklangandan so‘ng yangi hujjat 
ochiladi. Agar ish jarayonida yana bitta yangi hujjat yaratish kerak 
bolsa u holda, File (Файл) menyusidan New (Новый документ) 
buyrugini bering yoki standart uskunalar panelining chap qismida 
joylashgan New (Новый документ) tugmasini sichqoncha chap tugmasi 
yordamida bosing.

Agar uskunalar panelidagi tugmalarni vazifalarini yaxshi bil- 
masangiz yoki unutib qo'ygan boisangiz u holda. shu tugma ustida 
sichqon ko'rsatkichini biroz ushlab tursangiz, uning ustida nomi aks 
etgan eslatma paydo boiadi.

Hujjatni ochish va yopish

CorelDRAW dasturida avvaldan tayyorlab quyilgan hujjatlar 
Windowsning boshqa amaliy dasturlari singari quyidagi yo'llar bilan 
ochiladi: CorelDRAWda yaratilgan faylni bosib ochish orqali yuklash; 
File (Файл) menyusidagi Open (Открыть) buyrugini berish orqali 
yoki standart uskunalar panelidagi Open (Открыть) tugmasini bosish 
orqali amalga oshiriladi. Oxirgi ikki holatda ekranda Open Drawing 
(Открыть документ) muloqot oynasi paydo boladi (5.3-rasm). Bu 
muloqot oynasida Windowsning barcha amaliy dasturlaridagi hujjatlarni 
ochish oynasining standart elementlari mavjud. Undan tashqari, 
fayllar ro‘yxatining o'ng tomonida (Preview (Предварительный про­
смотр) belgisi faollashganda) tanlangan faylda saqlanayotgan tasvirni 
ko'rish mumkin. Bu esa biz ochmoqchi boigan faylni aynan shu tasvir
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5.3-rasm. Open Drawing muloqot oynasi.

ekanligini bilib olish uchun imkon beradi. CorelDRAW hujjatlarini 
saqlashda berilgan kalit so‘zlar yoki eslatmalar Keywords (Ключевые 
слова) va Notes (Замечания) maydonida paydo boladi.

Hujjatlarni yopish uchun esa File > Close buyrugini berish yoki 
ekranning yuqori o‘ng burchagida joylashgan Close tugmasini bosish 
kerak. Shundan so‘ng agar hujjat yaratilgandan keyin unda biror 
o‘zgarish boigan boisa u holda hujjatni saqlash yoki saqlamaslik 
haqida oyna chiqadi. Agar bu oynada Да tugmasi bosilsa, Save 
muloqot oynasi (hujjatni saqlash oynasi) paydo boiadi. Aks holda, Her 
bosilsa, u holda hujjatdagi barcha o‘zgarishlar saqlanmasdan o‘chib 
ketadi. Bu ogohlantirish oynasida ikki tugma bilan birga uchinchi
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Щцта Cancel ham mavjud. Ayrim hollarda hujjatni bekitishga buyruq 
lu i ilgandan so‘ng muloqot oynasi avtomatik holda chiqqandan keyin, 
luydalanuvchining fikri o'zgarib yuqoridagi ikki holatdan birini 
i mas, balki uchinchi holat, ya’ni hujjatga qaytib, ishni davom ettirishi 
mumkin. Buning uchun Cancel tugmasini bosish kerak.

Hujjatni saqlash

CorelDRAW hujjatini saqlash standart uskunalar panelidan Save 
(Сохранить) buyrug‘ini berish orqali bajariladi. Agar avval bu hujjat 
.;iqlanmagan boisa, ekranda 5.4-rasmda berilgan Save Drawing (Co- 
\ ранить документ) muloqot oynasi paydo bo‘ladi.

Hujjatni saqlash uchun File name (Имя файла) maydoniga fayl 
nomini kiritish, fayl saqlanishi kerak bo'lgan papkani tanlash va 
Siive (Сохранить) tugmasini bosish kerak. Shuningdek Save (Co-

I s a v e  O ra w io g *1
Папка: : ^  Мои документы З ;  '1 ... У ” СЗ-

Сетевое
окружение

„ jU fiO .y n ed  Site I 

•v’H m q h  рисунки 

музыка

Version; 

.Version 12.0 

Thumbnail:

j  10K (coior)

Pite name: j Graphic 1 *

Save as type: COR - CorelDRAW - Advanced...

Sort type: | Default -

Keywords:

Notgs: ^ e b _ s a fe ji le  names

Embed Fonts using TrueOoc (TM)

1BHBBSi*Ш Ш Ш Ш
5.4-rasm. Save Drawing muloqot oynasi.
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хранить) tugmasini bosishdan oldin muloqot oynasidagi Keyword, 
va Notes maydonchalariga kalit so‘zlar va eslatmalarni kiritib saqlash 
ham mumkin (yuqorida aytilganidek fayllarni ochish paytida bu 
maiumotlardan foydalanish mumkin).

Endi diqqatingizni ochiluvchi Version (версия) ro‘yxatiga qaratinji. 
Bu ro‘yxatdan siz faylni CorelDRAWning avvalgi versiyalarulti 
saqlamoqchi boisangiz, u holda bu ro‘yxatdan o‘zingizga kerakli 
alternativ versiyani tanlashingiz kerak bo‘ladi. Agar fayl av\nl 
saqlangan boisa, u holda diskda takroriy saqlashda Save Drawing (Co* 
хранить документ) muloqot oynasi ochilmasdan amalga oshiriladi 
Agar faylning nusxasini olishingiz kerak boisa, u holda uni boshqn 
papkaga saqlang. Options tugmasi saqlash rejimining ikkinchi darajali 
funksiyalaridan iborat boshqaruv elementlarini ochish yoki yopisli 
imkonini beradi.

5.4. Sahifaning parametrlarini o‘zgartirish

Yangi hujjat yaratilgandan so'ng gohida uning oicham ini o7- 
gartirishga to‘g‘ri keladi. Buning uchun atributlar panelining clc- 
mentlariga murojat qilinadi. Rasmda birorta ham obyekt bo I 
gilanmagan boisa, u holda atributlar panelida sahifaning oicham 
larini o'zgartirishga imkon beruvchi elementlar paydo boiadi (5.5« I 
rasm).

Qog‘oz formati Sagifa oriyentatsiyasi Ko'p qatorli hujjat re j ini i

Sahifa o ‘ lchami

L 2

Oichov birligi

Property Bar: No Selection

, 4 ' ,  t f  £97.0 rnrn *  ( 
10 210.0 mm ’  *

1  □  '—1 '—1 QoO Units: millimeters w

mm 5 8  i l l  I ; * z  *■ * 1 $  s \ m Ц ! л  4  S

5.5-rasm. B elgilangan obyektlar bo'lm agan h o ld a  atributlar panelining ko'rinishi 
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Hujjatning chop etiladigan sahifa o icham i atributlar panelining 
eng chap qismida joylashgan Paper Type/Size (Тип/формат бума­
ги) bekiladigan ro‘yxatdan tanlanadi. Chop etiladigan sahifaning 
o'lchami illyustratsiya chop etiladigan qog‘ozning fonnatiga mos 
kelishi shart emas. Faqatgina illustratsiya qog‘ozning oMchamidan 
ortib ketmasa boldi. Agar chop etiladigan sahifa oMchami 
qog‘ozning o4chamidan kichik bo‘lsa, u holda qog‘ozning chetida 
toza bo'sh joy qoladi. Shuning uchun chop etiladigan sahifaning 
oicham ini boiajak  illyustratsiya o‘lchamidan (standart qog‘ozning 
o'lchamlaridan emas) kelib chiqib oldindan belgilab olinadi. Agarda 
illyustratsiyaning o‘lchami kichik bo'lsa, u holda bitta qog‘ozga bir 
nechta nusxani joylashtirib chop etish maqsadga muvofiq. Bunga 
misol qilib, kichik taklifnomalar, tashrif qog‘ozlarini aytish mumkin. 
Nostandart oicham da chop etiladigan sahifani yaratish uchun uning 
o ichamlarini qog‘oz formatlari ro'yxatidan o‘ngda joylashgan Paper 
Width and Height (Ш ирина и высота листа) maydoniga kiritiladi. 
Undan yana o'ngda esa chop etiladigan sahifaning orientatsiyasini 
(kitob yoki albom ko‘rinishi) belgilashda ishlatiladigan Portrait 
(Книжная) va Landscape (Альбомная) tugmasi joylashgan. Bu 
tugmalarda standart A4 qog‘ozning tasviri nomiga mos ravishda 
vertikal va gorizontal ko'rinishda joylashtirilgan. Shuningdek 
Drawing Units (Единицы измерения) ochiladigan ro‘yxatdan 
CorelDRAWda koordinatani va oicham larni aniqlash uchun o‘lchov 
birligini o‘zgartirish mumkin.

5.5. CorelDRAWda oddiy shakllarni chizish imkoniyatlari

To‘g'riburchaklar chizish

Yuqorida aytilganidek CorelDRAWda tasvirlar bilan ishlashning 
asosini obyektlar tashkil qiladi. Buni quyidagilarda ham ko‘rish 
mumkin: bu dasturda foydalanuvchi tomonidan bajarishi lozim bo‘lgan 
barcha grafikli obyektlarni ikkita kategoriyaga ajratish mumkin -  
chiziqlar va belgilar (matnlardan tashqari).

Berilgan obyektlardan eng chapda -  «классик» to‘g‘ri burchak. 
Ib‘g‘riburchaklar yaratilgandan keyin aynan shunday namoyon boladi. 
Ikkinchi obyekt esa yaratilganidan keyin 45° ga burilgan ko‘rinishi.
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5.6-rasm. To'g'ribuichaklilar sinfi elementlari.

Uchinchi obyektda esa yaratilgandan keyin, to'rttadan uchta burchagi 
dumaloqlangan.

Agarda sizda biror chizilgan obyektning qaysi tipga tegishliligiga 
shubha o‘yg‘onsa, u holda o‘sha obyektni sichqoncha yordamida 
belgilang va holat qatoriga qarang. Holat qatorida Rectangle on 
Layer 1 (Прямоугольник на слое 1) xabari paydo bolsa, u holda 
uning to^riburchaklar sinfiga tegishli ekanligiga hech qanday shubha 
qolmaydi. CorelDRAWda barcha primitivlar tegishli uskunalar 
yordamida quriladi. Yuqorida biz uskunalar paneli bilan tanishib 
chiqdik. Shuningdek uskunalar orasida Rectangle (Прямоугольник) 
tugmasini ham ko‘rib o‘tdik. Endi shu uskuna yordamida birinchi 
obyektimizni quramiz.

To'g'riburchak chizish

Ushbu mashqni bajarish bilan biz to‘g"riburchak qurishning asosiy 
imkoniyatlari va shu bilan birga CorelDRAW 12 ish muhitining 
qo‘shimcha elementlari bilan tanishamiz.

1. Yangi hujjat yarating. Bu mashqni bajarish uchun ixtiyoriy 
o‘lchamdagi sahifa qog'ozini olish mumkin.

2. Uskunalar panelidan Rectangle (Прямоугольник) uskuna tug­
masini bosing. Shundan keyin sichqon ko‘rsatkichi ekranda krcsi 
shakliga o‘tib, uning oldida to‘g‘riburchak ham paydo boladi (5.7-rasm) 
Bu esa ayni vaqtda to‘g'riburchak chizish uskunasi faolligini bildiradi.

Rectangle (Прямоугольник) uskunasini boshqa yo‘l bilan ham 
faollashtirish mumkin, masalan, sahifaning bo'sh joyida sichqonchaniii!' 
o'ng tugmasini bosish va kontekstli menyudan F6 buyrug‘ini oling.
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R am k a li be lg ilash  m arkerla ri

Obyekt markazidagi marker

Obyekt uzeli

□
_ Rectangle uskunasi uchun 

sichqoncha ko'rsatkichi

Rectangle oil Layer 1

5.7-rasm. B elgilangan to‘g ‘riburchak va holat qatoridagi xabar.

To‘g‘riburchak chizishda diqqatingizni holat qatoriga qaratsangiz, 
и yerda chizilayotgan to‘g‘riburchakning bo‘yi va eni o‘lchamlari 
(pikselda) ko‘rsatiladi. Ekranda esa chizilayotgan to'g'riburchakning 
iloimiy o‘zgarib borayotgan ko‘rinishi tasvirlanadi. Holat qatorida 
>'sa yuqorida aytilganidek uning olchamlari to‘xtovsiz o‘zgarib 
borayotgan ini ko'rishingiz mumkin. Chizilayotgan to‘g‘ri burchak 
loydalanuvchi xohlagandek yuzaga ega boiganda sichqoncha tugmasi 
qo'yib yuboriladi. Bunda esa to‘g‘riburchak shu oxirgi o‘lchamdagi 
holatda ekranda paydo bo‘ladi. Sichqoncha tugmasini qo‘yib 
\ uborgunga qadar to‘g‘riburchak bo'yi va enini o‘zingiz xohlagandek 
n’lchamga yaqinroq qilib chizib olishingiz mumkin.

Ellips uskunasi (Ellipse)

Ellips uskunasi ellipslar va aylanalar chizish uchun moijallangan. 
Ellips o‘ziga tashqi chizilgan to‘rtburchak burchaklaridan boshlab 

ilii/iladi. Ellipsni chizish uchun markazda <Shift> tugmasi, aylana
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uchun <Ctrl> bosilishi lozim. Obyekt xossalari paneli yordamida ellip 
parametrlarini o‘zgartirish mumkin. Ellips tugmachasining yuqoii 
qismidagi belgi orqali ellipsning tipini tanlash mumkin. Ellips, Seklt i 
Yoy tugmalari xossalari uskunalar qatorida qaytariladi.

Uchta uskuna, ko'pburchak (многоугольник), Spiral (Cun 
раль), Koordinata sahifasi (Разлинованная бумага), obyekt guruhign 
yig‘ilgan bo'lib uskunalar panelidan alohida panel ko‘rinishida ajralisli 
mumkin.

Spirallar yaratish uchun moijallangan yoki uzluksiz egri chi- 
ziqlar shaklidagi geometrik shakllarni chizish mumkin. Spira I 
chizish jarayoni to'rtburchak chizish jarayoni bilan bir xil. Faqatgiiiii 
foydalanuvchi semetrik va logorifmik tugmalar orqali spiral turini 
tanlash mumkin. Muntazam spiral yaratish uchun Ctrl tugmasini bosih 
turish kerak. Spiral parametrlarini atributlar panelidan o‘zgartirish 
mumkin.

1. Dasturda kvadrat chizish uchun qaysi standart tugma bosiladi?
2. To‘g‘ri to‘rtburchak uskunasi yordamida nimalar chizish mumkin?
3. Dasturda geometrik figuralar qanday yaratiladi?
4. Kontur va tayanch nuqtalar haqida ma’lumot bering?

5.6. COREL DRAW dasturida m urakkab chiziqlar va shakllar

nalar bor: Chizish (Freehand), Bez’e 
(Vezier), Pero (Natural Pen), Chiziq 

o'lchami (Dimension), Bog‘lovchi chiziq (Connector Line) va Bogiovchi 
(Connector).

Spiral uskunasi

Savol va topshiriqlar:

Egri chiziqlar guruhi uskunalari (Curve)

Egri chiziqlar guruhi usku­
nalari panelida quyidagi usku-
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Ko‘pburchak uskunasi (Многоугольник)

Ko'pburchakni kerakli tomonlarga ega boigan geometrik obyekt 
sifatida tushunish mumkin. Ko'pburchakning bir varianti sifatida 
Milduzchani olish mumkin. Bunda ichki chizilgan ko'pburchakni 
maydonini kesib o iadi. Ko‘pburchakni yoki yulduzchani chizish 
toitburchak chizishdan farqi yo‘q. Ctrl tugmasini bosib turgan holda 
muntazam ko'pburchak chiziladi. Ko‘pburchak parametrlarini atributlar 
paneli orqali o'zgartirish mumkin.

Ko'pburchak belgisini tanlab atributlar panelida uning qirralar 
sonini kiritish mumkin. Qirralar o'tkirligi maydonida shartli birliklarda 
qirraning o ik irlik  darajasini kiritish mumkin.

Koordinata qog'ozli uskunasi (Разлинованная бумага)

Kordinata qog‘ozli uskuna berilgan parametrli panjara yaratish 
imkonini beradi. Bunday panjarani grafiklar yoki diagrammalar uchun 
koordinatali asos qilib olish mumkin. Bu instrument parametrlarini, 
parametrlar muloqot oynasida koordinatali qog‘oz boiim ida o‘zgartirish 
mumkin. Katakchalar soni maydonida eniga (Number of cells wide) 
bo'yiga (Number of cells high) ko‘ra katakchalar miqdorini o'zgartirish 
mumkin. Kvadrat katakchali panjaralarni tayyorlash uchun <Ctrl> 
tugmasini bosib turish kerak.

Chizish uskunalari (Freehand)

Chizish uskunalari istalgan chiziqlarni chizish uchun moijallangan. 
Bu uskuna ishi natijasida vektorli kontur hosil boiib, bu kontur tayanch 
nuqtalari dastur yordamida avtomatik qo‘yiladi. Bu konturlar ustida 
erkin tahrirlash imkoni mavjud. Bu uskunalarda chizayotgan paytda 
chiziqlar qalinligi va rangini o'zgartirish mumkin.

Chizib boiingan chiziqni istalgan paytda davom ettirish mumkin. 
Buning uchun kursorni uning oxirgi nuqtasiga olib kelib (kursorning 
egri chiziqlari koisatkichga aylanadi), sichqoncha chap tugmasini 
bosgan holda chiziqni davom ettirish hamda chizish uskunalari 
yordamida to‘g‘ri chiziq chizish mumkin.

Безье uskunasi yordamida maksimal aniqlik va maksimal rat- 
sionallik bilan ixtiyoriy konturni yaratish mumkin. Bu uskuna
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foydalanuvchini grafik dizaynda barcha narsani hal qiluvchi Forma 
yaratuvchisiga aylanishiga imkon beradi.

To‘g‘ri chiziqli segmentlar tuzish

To‘g‘ri chiziq yaratish uchun Безье uskunasi qulay keladi. Buning 
uchun Безье uskunasini tanlash kerak. Kursorni boshlangich nuqtaga 
olib kelish va sichqonchaning chap tugmasini bosish kerak. Tugma 
bosilgan joyda segmentning boshlangich tayanch nuqtasini ifodalovclu 
qora nuqta paydo boiadi. U keyingi nuqta yaratilgunga qadar faol boiib 
turadi. So‘ng kursorni keyingi nuqta joylashadigan yangi joyga olib 
o‘tish kerak. Ikki nuqta to‘g‘ri chiziq bilan tutashadi.

Tayanch nuqtalarning turlari

Bir necha segmentlarning tutashishida tayanch nuqtalari Corel Drav\ 
dasturida uch tipli boiishi mumkin:

1. Ikki egri chiziqni «bukilishda» tutashtiruvchi tayanch nuqtasi 
-  burchak tayanch nuqtasi deyiladi. Bunday tayanch nuqtasida boshqa 
ruvchi chiziqlar ham yo‘nalishi ham uzunligi bo‘yicha mustaqildir.

2. Ikki egri chiziqni sinishsiz tutashtiruvchi tayanch nuqtasi -  silliq 
tayanch nuqtasi deyiladi. Bunday tayanch nuqtalarda boshqaruvchi 
chiziqlar bir-biridan faqat oichami bilangina mustaqil, yo‘nalishi 
bo‘yicha esa umumiy tutashuvchi to‘g‘ri chiziqni tashkil qiladi. 
Boshqaruvchi chiziqlardan birining o iin  almashishi ikkinchisining ham 
o‘rin almashishiga olib keladi.

3. Sinishsiz va bir xil qiyalik bilan tutashgan tayanch nuqtasi 
simmetrik tayanch nuqtasi deyiladi. Bunday tayanch nuqtalarda 
boshqaruvchi chiziqlar bir-biriga yo'nalishi bilan bogiiq boiadi.

Savol va topshiriqlar:

1. Egri chiziqlar guruhi uskunalari panel ida qanday uskunalar bor?
2. Dasturda ko‘pburchaklar qanday yaratiladi?
3. Koordinata qog'ozli uskunasi (Graph Paper)ning imkoniyatlari?

5.7. COREL DRAW dasturida ranglar bilan ishlash

Imitatsiya uskunasi nuqtali grafika dasturlarida ko‘proq ishlatiladi 
Shunga qaramay vektorli dastur ham bu uskunani taqdim etadi. Bu
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uskuna orqali Peroda chizish o in in i bosa oladi, shu bilan birga bezakli 
shtamp o‘rnini ham bosadi. Bu uskunaning ajoyibligi shundaki u asosiy 
konturni chizib, bu kontur bo'ylab turli obyektlar joylashib manzarali 
va grafik effektlarni beradi.

Namuna rejimida shunday obyektlarni yaratish mumkinki, bunda 
bu obyektlar tayyor namunalarga qarab o‘z shaklini o‘zgartiradi. Bu 
rejimda shaklli chiziqlarni ishlatish mumkin.

Muyqalam rejimi (Brush) -  bu rejimda murakkab tuzilishga ega 
bo'lgan bezakli shakllarni yaratish mumkin.

Purkagich rejimi (Object Sprayer) kontur trayektoriyalari bo‘ylab 
turli grafik obyektlarni joylashtiradi. Bu rejim murakkab ramkalar, 
bezakli qatorlarni yaratish uchun mo'ljallangan.

Kalligrafiya rejimi (Calligraphic) -  bu rejimda qalin pero yoki 
enli muyqalam egri chiziqlarini chizish mumkin.

Rgessure rejimi -  bu rejimda shunday chiziqlarni chizish mum- 
kinki bu chiziqlarni klaviatura orqali boshqarish mumkin.

Xossalar uskunalar qatorida bu rejim tanlansa quyidagi para- 
metrlarga ega bolamiz: tekislash maydoni (Freehand Smoothing) asosiy 
chiziqni 0 dan 100 diapazonigacha tekislash imkoniyati (rasmda 1 
raqami bilan ko‘rsatilgan).

O'lcham maydoni (Size) (2 raqam) bezakli shtrixlarning o‘lchamini 
foizlar hisobida o‘zgartish imkonini beradi 1 dan 99% gacha.

Obyektlar ro'yxati maydoni (3 raqam) -  bu ro‘yxatda turli for- 
inatdagi purkaladigan obyektlarning namunalari keltirilgan.

Save tugmachasi (4 raqam) muyqalam rejimida ish yuritish bilan bir
xil.

0 ‘chirish tugmachasi (Delete) ro'yxatdagi xohlagan variantlardan 
birini o‘chiradi.

M i l s  /  ’2 
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5.8-rasm. P roperty Bar paneli.
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Purkash tartibi (Srau Order) obyektning kontur bo'ylab joylashish 
ro‘yxatini taqdim etadi: tasodifan (Ramdom), ketma-ketli (Sequentially), 
yo‘nalish bo‘ylab (By Direction).

Obyektlar ro‘yxatiga qo‘shish tugmasi (Add to SprayList) 
obyektlar ro‘yxatiga yangi elementlarni qo‘shish imkoniyatini beradi. 
Ulardan keyinchalik «Ijrochi» qatorini (play list) tashkil qilish 
mumkin.

Savol va topshiriqlar:

1. Imitatsiya uskunasi (Artistic Media) -  deganda nimani tushunasiz?
2. Kalligrafiya rejimi (Calligraphis)da qanday chiziqlarni chizish mum­

kin.
3. Obyektlarni purkash nima?
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Vl-bob. FLASH DASTURI HAQIDA

Flash MX -  Web sahifalaridagi animatsiyalar, bezaklar va 
boshqa m anbalarni o‘z ichida saqlagan yuqori darajali dizaynlar 
yaratish uchun m oijallangan dasturiy vosita hisoblanadi. Flash MX 
dasturi yuqori darajadagi imkoniyatlari mavjud boigan  texnologik 
vositalar sirasiga kirib uni bir so‘z bilan Flash texnologiyasi deb 
atashimiz mumkin. Flash texnologiya yordamida animatsiyalar, 
W eb-saytlar va ular uchun bannerlar, har-xil multimediali prezen- 
tatsiyalar yaratish mumkin. Flash texnologiyasi yordamida yaratil­
gan turli loyiha va mahsulotlar -  har doim harakatni yorqin aks 
ettirib, undagi tovush va video ko‘rinishlar Internet loyihalarida 
harakatliligi bilan ajralib turadi. Shuning uchun bu texnologiya 
yordamida saytlar yaratish imkoniyati juda yuqori [5], [6], [7]. 
Lekin Flash texnologiyasining Internet tizim ida ishlashda ayrim 
kamchiliklari mavjud. Jumladan:

1. Flash elementlarini saytda tasvirlab berish uchun, brauzerda 
Flash-player o‘rnatish zarur. Internet Explorerda esa dastlabki o‘r- 
natishdan keyin Flash-player oinatiladi. Agarda siz boshqa brauzerlarni 
qoilaydigan bo'lsangiz, u holda Flash-playerni oinatishga to‘g‘ri keladi.

2. Flash-saytlari HTML saytlariga qaraganda katta hajmni egal- 
laydi, shuning uchun ularning yuklanishi birmuncha sekin.

3. Flash-texnologiyani ko'pincha reklama maqsadida qoilaniladi. 
Shuning uchun informatsion portallarda qoilashga tavsiya qilinmaydi. 
Chunki bunday portallar hajmi juda kattalashib ketadi.

4. Flash-saytni yaratish biroz mehnat talab qiladi. Shuning uchun 
ham bunday saytlarning narhi, HTML saytlar narhiga qaraganda ancha 
yuqori baholanadi.
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Ayrim hollarda juda chiroyli saytlar o'zining tashrif buyuruvchilarim 
vaqtning hisobiga yo‘qotadi. Ya’ni sayt kompyuter ekranida to‘lii| 
tasvirlanib bo'lgunga qadar ketgan vaqtning evaziga foydalanuvchi la mi 
yo‘qotadi. Ammo bunday saytlar har qanday foydalanuvchini o‘zininj’ 
yuqori darajali grafikasi, ko‘pqirrali imkoniyatlari, rang-baranglij’i 
bilan foydalanuvchilarning asosiy qismini yo‘qotgani yo‘q. Natijada 
Flash dasturi Web -  ishlab chiquvchilar orasida o‘zining keng qamrovli 
o'rniga ega bo'lib bormoqda.

Flash usulida tayyorlangan prezentatsion saytlar yuqori darajadagi 
grafik almashinuvlar, boy interfaol g‘oyalari va rasmlarning yuklanish 
tezligi yaxshiligi bilan tashrif buy uruvchilarda katta taassurot qoldiradi. 
Bundan tashqari harakatlanuvchi panellar, dinamik harakatlar, 
sinxron tovushli kliplar ham har qanday foydalanuvchini diqqatiui 
o'ziga tortadi. Siz xattoki informatsion sayt yaratayotgan bo'lsangiz 
ham, flash-texnologiyani qisman qoilash yo'li bilan ham. tashril 
buyuruvchilaringiz uchun yaxshi taassurot qoldiradigan Internet resurs 
yaratishingiz mumkin.

Umumiy m aiumot va yordamchi jihozlar

Flash dasturi bilan tanishishni boshlaymiz. Bu yerda roliklar ustida 
ish olib boradigan oynani ko'rish mumkin, shuningdek uskunalar 
paneli va bir necha yordamchi panellar mavjud. Bu yordamchi panellar 
obyektlarning turli xossalarini tanlashga yordam beradi (masalan, rang, 
qalinligi va kontur ko‘rinishi va boshqa xususiyatlar). Flash dasturi 
boshqa dasturlar kabi o‘zining yorlig‘iga ega.

Sctvol va topshiriqlar:

1. Flash qanday tip dasturlarga kiradi?
2. Flash dasturidan nima maqsadlarda foydalanish mumkin?
3. Flash texnologiyasini Internet tizimida ishlashining qanday kam- 

chiliklari mavjud?
4. Flash saytlari oddiy saytlardan nimasi bilan farqlanadi?

6.1. Flash MX dasturining oynasi qismlari

Flash dasturi oynasi bir nechta qismdan iborat. Ular bilan 
tanishib chiqamiz. Dastur oynasining asosiy qismlaridan biri uning 
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6.1-rasm. Flash dasturi oynasi ko'rinishi.

ish maydonidir. Ish maydonida biz obyektlarni chizish, tahrirlash, 
harakatlantirish imkoniyatini amalga oshiramiz. Undan yuqorida 
esa -  vaqt diagrammasi yoki vaqt shkalasi (timeline) joylashgan (6.1- 
rasm).

Uskunalar paneli

Uskunalar paneli rasmda ko‘rsatilgandek to‘rt qismdan iborat. 
Yuqoridagi qismida Tools (uskunalar) obyektlarni yasash (chizish) va 
ularni transformatsiyaiaydigan uskunalar joylashgan. Keyinroq ular 
bilan batafsil tanishib chiqamiz. Keyin tasvirni Viev (Вид) boshqaruvchi 
uskunalar keladi: bu qo‘l (Hand tool) rasmi va lupa (Zoom tool).
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6.2-rasm. Tools uskunalar paneli.
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Bu uskunalar boshqa dasturlarda ham tez-tez uchrab turadi. Qo'l 
uskunasi yordamida ishchi sohani ko'chirish mumkin. Lupa uskunasi 
yordamida kattalashtirsa yoki kichiklashtirsa bo‘ladi (kichraytirish 
uchun ishchi sohada ALT tugmasini bosish kerak). Bu uskunalar faqal 
rolik tasvirini boshqaradi uning mazmuniga ta’sir o‘tkazmaydi.

Endi dastur oynasining navbatdagi qismlari bilan tanishib chiqamiz. 
Ular quyidagilar:

Yorliq qatori: dastur nomi va faol fayl nomini tasvirlab turadi.

Dasturning gorizontal menyu qatori

Flash MX dasturining gorizontal menyu qatori quyidagilardan 
iborat: File, Edit, View, Insert, M odify, Text, Control, Window, Help.
Endi menyulardagi asosiy buyruqlar ketma-ketligi, ularning vazifalari 
va ularning mos funksional tugmalar bilan tanishib chiqamiz.

6.1-jadval
File menyusi buyruqlari

Buyruqlar tugmalar (Windows)

New Yangi film <Ctrl>+<N>

Open Ochish <Ctrl>+<0>

Close Yopish <Ctri>+<W>

Save Saqlash <Ctrl>+<S>

Import Import qilish <Ctrl>+<R>

Export Movie Eksport qilish <Ctrl>+<Alt>+<Shift>+<8>

Publish Settings Nashr oichamlari <Ctrl>+<Shift>+<F12>

Publish Preview Nashrni ko'rish <F12>

Print Chop etish <Ctrl>+<P>

Exit Dasturdan chiqish <Ctrl>+<Q>
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E dit m en yu si b u yruq lari

6.2-jadval

Buyruqlar tugmalar (Windows)

Undo Bekor qilish <Ctrl>+<Z>

Redo Takrorlash <Ctrl>+<Y>

Cut Qirqib olish <Ctrl>+<X>

Copy Nusxa olish <Ctrl>+<C>

Paste Qo‘yish <Ctrl>+<V>

Clear Tozalash <Backspace>, <Delete>

Duplicate Aynan nusxa olish <Ctrl>+<D>

Select All Hammasini belgilash <Ctrl>+<A>

Deselect All belgilanishni bekor qilish <Ctrl>+<Shift>+<A>

Cut Frames Kadrlarni qirqib olish <Ctrl>+<Alt>+<X>

Copy Frames Kadrlardan nusxa olish <Ctrl>+<Alt>+<C>

Paste Frames Kadrlarni qo‘yish <Ctrl>+<Alt>+<P>

Edit Symbols Simvollarni tahrirlash <Ctrl>+<E>

6.3-jadval

View menyusi buyruqlari

Buyruqlar tugmalar (Windows)

Goto kadrga o‘tish -

Zoom In masshtabni kattalashtirish <Ctrl>+<=>

Zoom Out masshtabni
kichiklashtirish

<Ctrl>+<-> .

Magnification kattalashtirish -
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davom I

100% 100% <Ctrl>+<l> |

Show Frame kadrni ko'rsatish <Ctri>+<2> Щ

Show All hammasini ko'rsatish <Ctrl>+<3>

Outlines Konturlar <Ctrl>+<Alt>+<Shift>+<0>

Fast tez <Ctrl>+<Alt>+<Shift>+<F> I

Timeline vaqt diagrammasi <Ctrl>+<Alt>+<T>

Work area ish maydoni <Ctrl>+<Shift>+<W>

Rulers chizg'ich <Ctrl>+<Alt>+<Shift>+<R>

Hide Edges qirrani bekitish <Ctrl>+<H>

Hide Panels panelni bekitish <Tab>

6.4-jadval
Insert menyusi buyruqlari

Buyruqlar tugmalar (Windows)

Convert to Symbol simvolni holatini o’zgartirish л00U
m

V

New Symbol yangi simvol <Ctrl>+<F8>

Frame kadr <F5>

Remove Frames kadrlarni o'chirish <Shift>+<F5>

Keyframe bogTangan kadr <F6> \

Blank Keyframe bo‘sh bogTangan kadr <F7>

Clear Keyframe bogTangan kadrni o‘chirish <Shift>+<F6>

Create Motion Tween harakat hosil qilish
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6.5-jadval

M od ify  m en yu si bu yru q lari

Buyruqlar tugmalar (Windows)

Layer... qatlam parametrlari <Ctrl>+<F>

Scane ... sahna parametrlari <Ctrl>+<M>

Document hujjat parametrlari <Ctrl>+<Alt>+<Shift>+<C>

Transform ko'rinishni o'zgartirish -

Scale oichamni o'zgartirish 
uchun belgilash

<Ctrl>+<Alt>+<S>

Rotate Burish

Frames kadrlar ustida amallar

Lock bekitish (qulflash) <Ctrl>+<Alt>+<L>

Unlock All bekitish (qulflash)ni bekor 
qilish

<Ctrl>+<Alt>+<Shift>+<L>

Group Guruhlash <Ctrl>+<G>

Ungroup guruhni bolaklash <Ctrl>+<Sh ift>+<G>

6.6-jadval
Text menyusi buyruqlari

Buyruqlar tugmalar (Windows)

Font shriftni o'zgartirish -

Size shrift oichamini o'zgartirish <Ctrl>+<Shift>+<B>

Style shrift stilini o'zgartirish <Ctrl>+<Shift>+<l>

Align matnni tekislash -

Scrollable markerni o'rnatish <Ctrl>+<Shift>+<C>
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6.7-jatlvul
C ontrol m en yu si b u yru q lari

Buyruqlar tugmalar (Windows)

Play ijro etish <Enter>

Test Movie filmni ko‘rish <Ctrl>+<Enter>

Test Scene sahnani namoyish qilish <Ctrl>+<Alt>+<Enter> 1

6.8-jaifviit

Window menyusi buyruqlari

Buyruqlar tugmalar (Windows)

New Window yangi oyna <Ctrl>+<Alt>+<N>

Toolbars Panellar -

Tools maiumot <Ctrl>+<Ait>+<!>

Timeline tekislash <Ctrl>+<K>

Properties belgi <Ctrl>+<T>

Actions Protseduralar <Ctrl>+<Alt>+<A>

Movie Explorer filmlarni boshqaruvi <Ctrl>+<A lt>+<M>

Library Kutubxona <Ctrl>+<L>

6.9-jadvd
Help menyusi buyruqlari

Buyruqlar tugmalar (Windows)

What’s new Yangi imkoniyati ar -

Lessons Flash bo‘yicha darslar -

Using Flash Yordam ma’lumotlari FI

Samples Flash faylga misollar -
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Buyruqlardan foydalanishni tegishli bolim larda batafsil ko‘rib 
chiqamiz.

V aqt diagram m asi

Ish maydoni ustida vaqt diagrammasi (Timeline) paneli joylashgan. 
Vaqt diagrammasi, filmning aniq sahnalashtirilishiga xizmat qiladi. 
11 yaratilgan qatlamlarni alohida-alohida sahnaga yozib qo‘yishni 
ta'minlaydi. Sahnada namoyish qilinadigan obyektlarning o‘zgarishi 
ketma-ketligini ifodalaydi. Vaqt diagrammasi shuningdek animatsiya 
yaratishda, film interfaol elementlari xatti-harakatini belgilashda asosiy 
uskuna hisoblanadi. Vaqt diagrammasi murakkab tuzilishga ega boiib, 
ko‘p sonli boshqaruv elementlaridan iborat. Vaqt diagrammasi panelida 
quyidagi umumiy elementlar berilgan (6.3-rasmda):

• filmning mavjud sahnasi uchun qatlamlar ro‘yxati (ustma-ust 
ustun ko‘rinishida) ko‘rsatilgan. Qatlamlarning nomi va atributlari 
ko‘rsatilgan;

• vaqt diagrammasi har bir qatlam uchun kadrlar shkalasidan
iborat;

• vaqt diagrammasidagi kadrlarni formatini o‘zgartirishning yig‘ma 
menyusi;

• filmning ayrim parametrlarini ifodalavdigan vaqt diagrammasidagi 
holat qatori mavjud.

Vaqt diagrammasining kadrlar shkalasi bilan tanishib chiqamiz. 
Shkala sahnaning barcha qatlamlari uchun umumiy boiib, ammo har 
bir qatlam o'zining kadrlar qatoriga ega. Unda kadrlar o‘sish tartibida

I Timeline r  i

« i n 5 10 15 20 25 30 35 H jj ;

Ml T ’
tp Layer S ♦ • □
Q  Layer 5 • * □
IP Layer 1 ♦ * 0

■ь? A  Cl Q f: r.t. %; {•] 1 12 0 (ps 0.0s i J J _>J

6.3-rasm. Vaqt diagramm asi.
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nomerlangani tasvirlangan. Nomerlanish har 5 qadamda berilgan bo'lib, 
kadrlarning har qanday formatida o‘zgartirib boimaydi.

Vaqt diagrammasi ko‘rsatkichi (Play head) animatsiyaning faol 
kadrini ko'rsatadi. Qaysi kadr sichqon yordamida tanlansa, o^sha kadi 
ustida ko‘rsatkich paydo boladi. Ko‘rsatkich faol kadrning nomerini 
ko'rsatib turadi. Bu esa animatsiyaning tasvirlanayotgan jarayong;i 
sinxronligini ta’minlaydi.

Kadrlarni formatlash menyusidagi buyruqlar kadrning katakchasini 
gorizontal bo'yicha oicham ini belgilaydi: Tiny (mayda); Small (kichik); 
Norm al (odatdagi); M edium (o'rta); Large (katta).

Boshqaruv elementlari paneli (Properties)

Yuqorida boshqaruv elementlari panelida berilgan ma’lumotlarga 
qo‘shimcha ravishda quyidagilarni aytish mumkin:

• matnli maydonda URL ish maydoni matnli qismini belgilaymi/, 
va shu maydonda to iiq  Web-manzilni kolsatam iz (URL -  Universal 
Resources Locator). Boglangan resurs uchun siz haqiqiy giperhavolaga 
ega bo'lasiz;

Boshqa vizual tahrirlagichlardan farqli tomoni, gipermatn namoyish 
vaqtida ostiga chizilgan shrift bilan emas balki, shtrixli chiziq bilan 
beriladi. Flash texnologiyada giperhavola hosil qilishning ikkita 
kamchiligi bor: birinchidan, URLni noavtomatik (qolda) yo l bilan 
kiritiladi va ikkinchidan, Flash URLning xatto lokal fayllar uchun 
aniqligini tekshirmaydi;

• Target (Целевой) ro'yxati; u resursni qanday brauzer oynasida 
namoyish qilinishini (yuklanishini) ko‘rsatishda qollaniladi (ko‘r- 
satilgan URL bo‘yicha chaqirilgan resursni). URL maydoniga hech 
bolm aganda bitta simvol kiritilgandan keyin ro‘yxat faollashadi, 
ya’ni o‘nga murojaat qilish mumkin. Ro'yxat quyidagi variantlardan 
iborat (ular HTML tilining TARGET atributi qiymatlari bilan 
o‘xshash):

о -  blank -  chaqirilayotgan hujjat har doim yangi oynada yuklanadi 
(asl oynaning o‘zida emas);

° - s e l f  -  chaqirilayotgan hujjat xuddi shu oynaning o'zida yuk­
lanadi (qaysiki havola o‘rnatilgan oynaning o'zida);
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о -p a ren t -  chaqirilayotgan hujjat bosh oynada yuklanadi; agar 
bu oyna bosh oynaga ega bolm asa, u holda yuklanish xuddi _self 
ko‘rsatkichidagidek bo‘ladi;

о -  top -  chaqirilayotgan hujjat eng yuqori qismdagi oynada yuk­
lanadi (agar ushbu oynaning o‘zi eng yuqori qismda bolsa, u holda _ 
self ko‘rsatkichdagidek yuklanadi);

• Selectable (Выделяемый) tugmasi: bu tugma xuddi bayroqchadek 
qollaniladi: tugmani bosish bilan matnga tegishli xususiyatlar panelini 
o‘rnatish yoki aksincha o'rnatilgan bolsa uni bekor qiladi;

• Change Direction of Text (matn yo'nalishini o'zgartirish) foyda­
lanuvchi menyuni ochib matnning yo‘nalishini tanlab olishi mumkin: 
gorizontal yoki vertikal. Menyu o‘z ichiga quyidagi uchta buyruqni 
oladi:

° Horizontal (Горизонталь);
° Vertical, Left to R ight (Вертикаль, chapdan o‘ngga);
0 Vertical, Right to Left (Вертикаль. o‘ngdan chapga);
Matnning vertikal yo‘nalishini o'rnatishda formatlashning tugmalar 

tarkibi o‘zgaradi va undan tashqari Rotation faollashadi:
• Rotation (burish) tugmasi bayroqcha vazifasini bajaradi va 

matndagi simvol joylashuv holatini o‘zgartirishni ta’minlaydi;
• Use Device Font belgisi -  agar belgi o'rnatilgan bolsa, Flash -  

pleyerda filmni namoyish qilish mobaynida o‘quvchining brauzeri uchun 
o‘rnatilgan shriftlar qo'llaniladi. Bu film fayli oichamini kichraytiradi 
va kichik shriftning qulay o‘qilishini ta’minlaydi.

Xususiyatlar paneli o‘ng chegarasi yaqinida Format (Формат) 
tugmasi joylashgan. Uni bosish bilan, qo‘shimcha muloqot oynasi 
ochiladi va undan fovdalanib matn maydonini formatlash parametrlarini 
0‘rnatish mumkin.

Format Option oynasi to'rtta matnli maydondan tarkib topgan:
• Indent -  yangi qator uchun abzatsning olcham i (pikselda);
• Line Spacing -  yon atrofdagi qatorlar bilan joylashuvi (satrlar 

orasidagi interval); vertikal matnlar uchun bu parametr matnning 
ustunlari orasida beriladi:

• Left M argin (chap maydon) -  matn maydonining chap chegarasi 
va qatorning birinchi simvoli orasidagi masofa;
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• R ight M argin (o‘ng maydon) -  matn maydonining o‘ng tonmn 
chegerasi va qatorning oxirgi simvoli orasidagi masofa.

Format Option muloqot oynasi matn maydonining har qandn\ 
ko'rinishi uchun o'rinli.

Dasturning ish maydoni va uning ko‘rsatkichlarini o'zgartirish

Agar ishchi maydonida birorta ham obyekt tanlab olinmagan bo'lsn 
yoki umuman mavjud bolmasa, u holda boshqaruv paneli xossalai i 
filmning umumiy parametrlarini ko‘rsatadi. Qandaydir obyeklm 
olsangiz uning formati avtomatik ravishda o'zgaradi.

• Document (Документ) matn maydoni, tahrirlanadigan fayl nomi 
tasvirlanadi;

• Size (Размер) tugmasi, ish stoli oichamini tasvirlab beruvchi 
tugma;

• Publish (Публикация) tugmasi; uni bosish bilan avval o‘rnatilgan 
parametrlar asosida film nashrini boshlaydi;

• Background (Фон) tugmasi; uni bosish bilan filmning fon rangini 
tanlash palitra oynasi hosil boladi. Shu oynadan filmning kerakli foni 
rangi tanlab olinadi;

• Frame Rate (Скорость кадров) matnli maydon, animatsiyaning 
kadrlar almashish tezligini belgilaydi;

• ? (so‘roq) belgisi tasvirlangan tugma HTML-formatidagi kontekst­
li ma'lumotnomani chaqirib beradi;

• Yulduzchalar tasvirlangan tugma. Bu tugmani bosish bilan 
Accessibility (Доступность) panelini ochiladi. Bu panel filmning 
barcha elementlari uchun qo‘shimcha xususiyatlarni o‘rnatishga moljal- 
langan.

Ish maydoni oynaning butun markaziy qismini egallaydi. Ish 
maydonida obyektlar ustida har qanday tahrirlash ishlarini amalga 
oshirish mumkin. Faqatgina montaj stolining tegishli kadriga obyektlar 
mos kelsa maqsadga muvofiq boladi. Ish maydoni keng bo'lishidan 
maqsad:

• sahnadan tashqari ishlarni bajarish;
• obyektni sahnaga kirishidan oldin yoki chiqib ketgandan keyingi 

holatlarni hosil qilish uchun zarur bo’ladi;
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• ish maydoni ostida unga tegishli uskunalar paneli joylashgan. 
Unda quyidagi interfeys elementlari joylashgan:

• strelkali tugma butun sahnani tahrirlash rejimiga qaytishni 
ta'minlaydi; agar siz alohida simvol ustida tahrirlash rejimida ish- 
layotgan boisangiz, tugma faollashadi;

• tahrirlanadigan sahna nomli matnli maydon;
• sahnani tanlash tugmasi; bu tugmani bosish bilan film sah- 

nalaridan tashkil topgan ro‘yxatli menyu ochiladi;
• simvolni tanlash tugmasi; bu tugmani bosish bilan film tugma- 

laridan tashkil topgan ro‘yxatli menyu ochiladi;
• masshtab, uning yordamida ish maydonini tasvirlash masshtabi 

tanlanadi.
Ish maydonining ixtiyoriy joyida sichqon o‘ng tugmasi bosilsa, ish 

maydonining parametrlarini o'zgartirishga moijallangan buyruqlar 
to‘plamini o‘z ichiga olgan kontekstli menyu ochiladi. Bu menyu 
hammasi boiib  yigirmaga yaqin buyruqlarni o‘z ichiga oladi.

Scene paneli yordamida siz quyidagi imkoniyatlarga ega boiasiz:
• filmning sahnalari ro'yxatini koiish; sahnalarning filmda na­

moyish qilinish ketma-ketligi;
• filmning ro'yxatidagi har qanday sahnasiga o‘tish;
• tanlangan sahnadan nusxa olish (asl sahnadan keyin nusxa hosil 

boiadi);
• yangi (bo'sh) sahna qo'shish (tanlangan sahnadan keyin bo‘sh 

sahna qo‘shiladi);
• tanlangan sahnani 0‘chirish.

Ish maydoni ko‘rsatkichlarini o'zgartirish

Flash MXda ish maydoni ko‘rsatkichlarini o'zgartirish uchun 
Modify menyusidan Document Properties buyrugi beriladi. Xuddi shu 
vazifani ish maydoni ustida sichqonning o‘ng tugmasini bosib kontekstli 
menyudan Document Properties buyrugi tanlanadi. Natijada rasmdagi 
Document Properties muloqot oynasi hosil boiadi.

Bu oynadan foydalanib. ish maydonining bo‘yi (height), eni (width) 
peksillarda ko'rsatiladi. Ish maydoniga quyiladigan rang Background 
Colorni tanlash orqali oinatish, shuningdek kadrlar almashish chas- 
totalarini (Frame Rate) belgilash mumkin.
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Flash dasturida kutubxonadan foydalanib quyidagi funksiynliiinl 
bajarish mumkin:

• import qilinadigan va hosil qilinadigan simvollarni avtonuillk 
ravishda film kutubxonasiga qo'shilishi;

• fayllar tizimining butunligini nazorat qilish va avtomatik kuzaluv
• simvollarning nomlari bir xillarini yo‘qotmaslik;
• to‘giidan-to‘g‘ri manipulyatsiya qilish texnologiyasi asosida yimfi 

simvollar yaratish (drag-and-drop).
Kutubxona oynasida simvollar bilan ishlashning ko'pgina imku 

niyatlari faqat kontekstli menyu orqali amalga oshiriladi. Masalan 
simvolni nusxasini hosil qilish uchun, kontekstli menyudan tegishli 
buyruqni berish kifoya.

Kutubxonaning yangi koiinishlari

Flash MXda ikki ko‘rinishga bo’lingan kutubxonalar mavjud 
(Shared Library):

Author-tim e -  kutubxonasi, simvollar qayta ishlash vaqti bo'yiclu 
bo‘lingan;

Rim-time -  qo‘yilgan vaqti bo‘yicha bolingan kutubxona.

Save I va topshiriqlar:

1. Dastur oynasi nechta qismdan iborat?
2. Dastur oynasining vaqt diagrammasi nima vazifani bajaradi?
3. Uskunalar paneli nima vazifalarni bajaradi?
4. Dasturning kutubxonasi qanday imkoniyatlarga ega?

6.2. Flash MXda qatlamlar bilan ishlash

Boshqa dasturlarda boMgani kabi Flashda ham animatsiyalar hosil 
qilishda yangi obyektlar yaratilib, ularni alohida harakatlantirishga 
to'g‘ri keladi. Flashda ushbu imkoniyatni ta’minlab berish, ya’ni 
obyektlar ustida ishlash, ularga alohida harakatlar biriktirish uchun 
qatlamlardan (слои -  layer) foydalaniladi. Soddaroq qilib aytganda, 
har bir obyekt qo'yilishidan oldin unda alohida qatlam hosil qilinadi.

FLASH da kutubxona bilan ishlash
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I liming uchun rasmda koisatilgan Insert layer tugmasini bosish kerak 
bo’ladi.

Tugma bosilgandan keyin qatlamlar orasiga yangi qatlam qo‘shiladi. 
Yangi qatlamga foydalanuvchi xohishiga ko‘ra chizish yo ii bilan 
\oki obyektlarni import qilish yo ii bilan biror obyekt biriktiriladi. 
( )byektlarni har birini alohida vaqt mobaynida, bir-biridan keyin, har- 
\il katta kichiklikda harakatlanishi, hosil boiishi yoki yo‘qolib ketishi 
imkoniyatlarini ta’minlaydi. Bunga quyidagi sodda animatsiyani misol 
qilib beramiz:

>  Flash ishga tushganda yangi ish maydonida bitta qatlam bo‘- 
ladi.

>  o‘sha qatlamni birinchi kadrini belgilab biror aylana chizamiz. 
llosil bo igan  aylana shu qatlamga tegishli bo lad i. Navbatdagi 
qatlamlarni qo‘yganda adashib ketmaslik uchun qatlam nomini 
obyekt nomiga o‘zgartirgan ma’qul. Buning uchun qatlamning layer 
matni ustida sichqonni chap tugm asini ikki m arta bosish bilan 
nomini o‘zgartirishga imkon beradi. Qatlam nomini aylana deb 
olamiz.

>  endi navbatdagi qatlamni qo‘yamiz. Buning uchun Insert 
layer tugmasini bosamiz. Hosil boigan qatlamga endi to‘rtburchak 
jonlantiramiz.

>  Ikkala qatlamning ham birinchi kadrlari ustida sichqonning o‘ng 
tugmasini bosib, menyudan Create Motion Tween (harakat hosil qilish) 
buyrugini beramiz.

>  navbat bilan qatlamlarda bir necha kadrdan keyin Insert 
Ketframe buyrugini beramiz; qatlamlarda kadrlar orasida harakat hosil 
boladi.

>  faqat uni sezilarli boiishi uchun yangi qo‘yilgan kadrni 
tanlab tegishli obyektni kerakli yo’nalishda harakatlantiriladi. Ya’ni 
koordinatalari o‘zgartiriladi. Buning uchun Properties panelidan X va 
U koordinatalari keraklicha o'zgartiriladi.

> animatsiyani ko'rish vaqtida dastlabki kadrda obyekt joyida 
boiadi, oxirgi kadrga o lguncha esa obyektning harakati hosil 
boladi.

Quyidagi rasmlarda yuqoridagi aylana pastga qarab harakatlanib 
kattalishib boradi, toitburchak esa aksincha.
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Savol va topshiriqlar:

1. Flashda qatlamlar va ularning vazifalari nimalardan iborat?
2. Yangi qatlam qo‘yish uchun qanday buyruq beriladi?
3. Qatlamning nomi qanday o‘zgartiriladi?
4. Qanday holatlarda yangi qatlam qo’yiladi?

6.3. Obyektlarni chizish imkoniyatlari

Dasturning grafik imkoniyatlari ham ko'pqirralidir. Dasturning 
barcha grafiklar bilan ishlash imkoniyatlari Tools uskunalar panelida 
joylashgan. Ushbu paneldan foydalangan holda turli xil rasmlarni 
chizish mumkin. Line Tool uskunasi yordamida to‘g‘ri chiziq, siniq 
chiziqlar, botiq chiziqlar va xatto ko‘pburchaklar chizish mumkin. Oval 
Tool uskunasi yordamida oddiy aylana, ellipslar chizish va ulardan 
boshqa aylanaga o‘xshash shakllar hosil qilish mumkin. Rectangle 
Tool uskunasi esa to‘rtburchak, kvadrat kabi shakllarni chizish uchun 
ishlatiladi. Pencil Tool oddiy qalam kabi chizish vazifasini bajaradi. 
Brush Tool uskunasi aylana shaklidagi har xil o‘lcham bilan rasm 
chizish, bo‘yash imkoniyatlarini beradi. Paint Bucket Tool uskunasi 
tanlangan rangni quyish imkoniyatini beradi. Eyedropper Tool ish 
maydoni boshqa qismidagi biror rangni tanlab berish imkoniyatini 
beradi. Eraser Tool chizilgan rasmlarni biror qismini o‘chirish uchun 
ishlatiladi.

Chizishdan oldin rang tanlash

Uskunalar panelida Colors ranglarni tanlash vositalari joylashgan. 
Bu uskunalar yordamida osonlik bilan obyekt konturi rangi va uning 
ichiga quyiladigan ranglarini tanlash imkoniyati mavjud.

Kontur rangini tanlash uchun Stroke color uskunasini tanlang. Agar 
sichqoncha tugmasini darrov qo‘yib yuborilsa rang tanlash palitrasi 
ochiladi va sichqoncha ko‘rsatkichi pipetka koiinishini oladi. Palitra 
216 xil rangni o‘zida saqlaydi.

216 xil rang palitraning chap tomonida va o‘ng tarafida esa 
qora ustunlar joylashgan. Chap yon ustun standart 6 ta kulrang 
gradatsiyalarni (qora va oqdan tashqari), shuningdek 6 ta kompyuter
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ranglarini (qizil, yashil, ko‘k, sariq, havo rang (cyan) va pushtirang 
(magenta)) o‘z ichiga oladi. Albatta bular 216 xil rang ichida bor lekin 
qulaylik uchun chap kolonkada nusxalari o‘rnatilgan.

Kontur rangini tanlash oynasi

Rasmlarning katta elementlari va qalin konturlarini bo‘yashda 
oldindan jarayonni obyektiv baholash kerak.

Windows operatsion tizimi uchun rang tanlash standart oynasida 
16 million True Color ranglardan ixtiyoriysini tanlash mumkin. 
Bundan tashqari Color oynasining o'ngida ranglarni och yoki 
to'qligini belgilovchi chizg’ich mavjud. Shuningdek rangning sonli 
parametrlarini ham berish yoki «tur -  to‘yinganlik -  och yoki to‘qligi» 
(shunday nomlanadigan shkala HSB: Hue Saturation, Brightness), yoki 
kompyuterdagi RGB «standart» formatida, qizil, yashil, ko'k ranglarni 
tashkil qiladigan kattaliklarni ko‘rsatadi.

Masalan, qizil ranglarni tashkil qiladigan 255 (maksimum), yashil 
va ko‘kdan -  0 (boMarni qisqacha shunday yozish mumkin: RGB 255,
0. 0). Natijada faqat qizil rangga ega bo‘lamiz. RGB 0, 255, 0-yashilni. 
RGB 0, 0, 255 ko‘k rangni beradi.

Har rangning ochiqligi 0 dan 255 gacha o‘zgaradi. Masalan, RGB
0, 0, 127 ifodani ko‘rsatib biz to‘q-ko‘k rangga ega bo‘lamiz. Qizil va 
yashil ranglarni teng proportsiyalarda aralashtirib (RGB 255, 255, 0), 
biz sariq rangga ega bo‘lamiz. RGB shkala bilan ishlash juda nozik 
bo'lganligi uchun ko‘pgina kompyuter dizaynerlari va rassomlari HSB 
shkaladan foydalanishadi.

Windows operatsion tizimining standart ranglar tanlash oynasi 
odatda tus burchak ifodasiga ega (0° dan 360°), rangning to‘qligi esa 0 
dan 1 oraliqdagi oraliqda o‘zgaradi. Lekin Windows muloqot oynasida 
bu parametrlar 0 dan 240 oralig'ida o‘zgaradi.

Quyiladigan rangni tanlash

Demak. yuqori sifatli rang tanlash oynasi yordamida yangi kontur 
ranglarini ham hosil qilish mumkin. Obyekt ichiga quyiladigan rangini 
tanlash uchun (Fill color), Заливка belgisi yonida sichqoncha tugmasini
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bosiladi. Bunda deyarli shunday rang tanlash oynasi chiqadi. Rang 
tanlash xuddi yuqoridagidek amalga oshiriladi.

Chiziqli gradient

Agar bu oynaga diqqat bilan qaralsa bir qancha farqlarni sezish 
mumkin. Flashda rang quyish nafaqat bir ranglarni balki gradiyentli 
ham bo‘lishi mumkin. Bu degani bir hil rang suzib boshqasiga oiadi.

Doiraviy gradiyent

Gradiyentlar nafaqat chiziqli balki doiraviy ham boiishi mumkin. 
Quyiladigan rangni tanlash oynasi pastki qismida bir nechta tayyor 
gradiyent) to‘plami bor: uchta chiziqli va 4 ta doiraviy. Bundan tashqari 
216 xil ranglar palitrasi oynasidan foydalanishingiz mumkin.

Savol va topshiriqlar:

1. Dasturda grafiklarni chizish uchun qaysi panel uskunalaridan foy­
dalaniladi?

2. Line Tool, Oval Tool, Rectangle Tool, Pencil Tool, Brush Tool 
uskunalarining vazifalarini aytib bering?

3. Grafiklar chizishda rang tanlashning qanday imkoniyatlari bor?

6.4. Grafikli formatlarni konvertatsiyasi

Flash -  filmlari nafaqat harakatli fayllarni balki, oddiy rasm 
ko‘rinishidagi fayllarni ham import, eksport qilish imkoniyatiga 
ega. Quyida Flashda qoilanilishi mumkin boigan grafikli formatlar 
keltirilgan.

6.10 -jadval

Flashda qollanadigan ayrim grafikli formatlar

Fayl turi Kengaytmasi Eksport Import

Adobe Illustrator (6.0-yoki 
oldingi versiyalari)

.eps, .ai + +
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Bitmap .bmp + +

Enhanced Windows Metafile .emf + +

FreeHand .ft7, .ft7, .fog, J8, 
.fli9, ,ft9

+ +

GIF •gif + +

JPEG JPg + +

PNG ■Png + +

Flash Player .swf + +

Windows Metafile .wmf +

Agar kompyuteringizda QuickTime 4 o‘rnatilgan bo'lsa.
qo‘shimcha ravishda quyidagi fayllarni qo‘llash mumkin:

PhotoShop .psd + +

QuickTime Image .qtif + +

Silicon Graphics .sai +

TIFF .tiff + +

Flash -  filmlarni eksport qilish

Flashda yaratilgan filmlardan boshqa dasturlarda foydalanish uchun 
ularni eksport qilib, har xil formatlarda saqlash mumkin. Buning uchun 
File > Export Movie yoki Export Image buyruqlaridan foydalaniladi. 
Bu yerda Export Movie filmni harakatli fayllarga (swf, avi, gif, spl, 
wav va boshqalar) aylantirish uchun ishlatiladi. Export Image esa 
rasmli fayllarga (bmp. jpg, gif, png va boshqalar) aylantirish uchun 
ishlatiladi.

Quyidagi ketma-ketlikda Flash -filmdan gif -  animatsiya eksport 
qilish ketma-ketligini ko‘rib chiqamiz:

о avval yuqorida ko'rsatilgan misollardan foydalanib, Flash -  film 
yarating;
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о uni saqlab boigach, File > Export Movie buyrugini bering. 
Export Movie muloqot oynasi hosil boladi.

0 oynada faylga nom berib. Тип файла bandidan gif faylni 
ko‘rsatib, «Сохранить» tugmasini bosing.

Natijada kiritilgan nomdagi va tipdagi fayl ko‘rsatilgan joyda hosil 
boladi. Hosil boigan fayldan boshqa turli maqsadlarda foydalanish 
mumkin. Bu imkoniyatdan Web-tahrirlagichlar bilan ishlashda saytlarni 
chiroyini boyitishda keng foydalanish mumkin.

Flash MX obyektlarini boshqa dasturlarga 
qo‘yish va ulardan foydalanish

Flashda yaratilgan swf filmlar yoki gif animatsiyalar Web- 
sahifalarni yuqori darajadagi dizaynga ega boiishi uchun xizmat 
qilib kelmoqda. Qaysiki saytga qaramang, Flash-filmlari yoki Gif 
animatsiyalari har qanday foydalanuvchini o‘ziga tortadi. Web- 
saytlarning nafaqat biror qismi, hattoki sahifaning butun qismi Flashda 
tayyorlanayotgani dasturning keng qamrovli ekanidan dalolat beradi. 
Flash-saytlarga bir nechta misollar keltiramiz: www.flash-art.ru, www. 
costroff.r-vision.ru, www.artflasher.com. www.rusmaster.com, www. 
jasmin.ru

Web-sahifalarda esa Flashning sw f yoki G if animatsiyalari oddiy 
rasmni joylagandek qo‘yiladi. Swf faylini Dreamweaver dasturida 
qo'yish ketma-ketligi bilan tanishib chiqamiz:

о buning uchun avval web sahifani yaratib olib kerakli joyiga 
ko‘rsatkichni qo‘yib Insert > M edia > Flash buyrugi beriladi;

о Select File muloqot oynasi hosil boladi. Oynadan qo‘ynioqchi 
boigan sw f faylni koisatiladi;

о Sw f fayl web-sahifaga qo‘yilganda, ya’ni tahrirlash vaqtida 
ishlamaydi. Web-sahifani saqlab, bekitgandan keyin, faqat ko‘rish 
rejimida, ya’ni Internet Explorer yordamida ko‘rishimiz mumkin.

G if animatsiyani esa Dreamweaverda biroz osonroq, xuddi oddiy 
rasm qo‘ygandek qo‘yiladi. Buning uchun quyidagi ketma-ketlik 
bajariladi:

° Insert > Image buyrugi beriladi;
° hosil boigan Select Image Source muloqot oynasidan qo‘yi- 

ladigan fayl koisatiladi;
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о Web-sahifani saqlab yopiladi;
о Web-sahifani ko‘rish uchun Internet Explorer dasturida ochiladi 

va yaratilgan faylning ko'rinishi paydo boladi.

FLASHda tayyor fayllarni qo‘yish

Flashda obyektlarni chizish imkoniyatidan tashqari yana tayyor 
rasmlar, videolar va boshqa ma’lumotlarni fayllardan qo‘yish 
imkoniyati bor. Ya’ni tayyor faylni import qilish imkoniyati mavjud. 
Buning uchun File menyusidan Im port buyrug’i beriladi. Natijada 
Import muloqot oynasi hosil boladi. Oynadan foydalanib import 
qilmoqchi boigan faylni ko'rsatib, Откры ть tugmasi bosilsa, tegishli 
qatlamga tanlangan faylda saqlanayotgan rasm yoki boshqa obyektni 
qo'yib beradi.

Import qilingan rasmlar ustida bir qancha amallar bajarish mumkin. 
Ekranda import qilingan rasmni belgilang. Insert > Convert to 
Symbolni yoki F8 ni bosing. Klipga nom bering. Uni klip (Movie clip) 
yoki grafik (Grafts) shaklida joylang va OK tugmasini bosing.

Endi rasm ustida bir qancha tahrirlash ishlari olib borish imkoni 
bor. Effektlar panelini oching Proporties > Colors va ro'yxatdan 
«Advanced» buyrugini tanlang. Bir qarashda bu qiyindav tuyulishi 
mumkin, lekin buning ortida matematik mantiq yotadi. U quyidagilarni 
anglatadi:

>  Flash har bir kanal uchun rang belgisiga ega boladi. Masalan, R 
(qizil) va uning belgisi 255 (to‘q qizil).

>  Flash foizli belgisini tekshiradi va qizil rangni yangi belgisini 
hisoblaydi. Masalan, R uchun belgi —100% bu normal holat hisob­
lanadi.

>  Flash «qo‘shimcha» maydonga yangi belgi bilan qo'shadi. Bu 
misolda qo'shimcha maydon belgisi 0 ga teng, demak qizil rang belgisi 
R 255 ga teng boiib qolaveradi.

>  Analogik ravishda obyektning boshqa rang kanallari -  
yashil (G), ko'k (B). Ko'rinib turibdiki bu misolda hamma kanallar 
aslidagidek qoladi. Agar ular o‘rnatilishiga biroz o'zgartirish kiritsak 
nima boladi?

Keyingi bandlarda bu savolga javob topishingiz mumkin.
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Ranglarni saralashning oson yo‘llaridan biri kanallardan ba'/i 
birlarini o‘chirish kerak. Masalan, quyidagi belgilarni ishlatib ko‘- 
ring:

Rang kanallarini saralanishi

Kanal Qiymati Qo‘shimcha qiymatlari

Red 100% 0 4

Green 0% 0

Blue 0% 0

Alpha 100% 0

Yashil va ko’k kanallarni saralab qizil tusdagi rangga ega bolamiz. 
Kanallardan birini qo’shsak bu ajovib natijaga olib keladi:
Masalan:

Kanal Qiymati Qo‘shimcha qiymatlari

Red 100% 0

Green 100% 0

Blue 0% 0

Alpha 100% 0

Bundan keyin sariq imidjga ega bolamiz.

Rang kanallari manipulyatsivasi

Yuqoridagi kanallarni saralash har doim ham yaxshi natija 
beravermaydi. E'tiborli odam darrov olingan imidj kamchiliklardan 
holi emas ekanligini payqaydi. Bunda kontrast, yorug‘lik va ba’zi 
chegara chiziqlari yo‘qolib ketadi. Lekin kanal saralanishini bir necha 
manipulyatsiyalari mavjud. Misol uchun hamma kanallarni bir vaqtning 
o‘zida o‘zgartiramiz.
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Kanal Qiymati Qo‘shimcha qiymatlari

Red 200% 0

Green 200% 0

Blue 200% 0

Alpha 100% 0

Bu imidjni yorqinroq qilishga yordam beradi.
E slatm a. % belgisi orqali 0% dan 100% gacha belgilarni o‘r- 

natish mumkin. Lekin tahrirlangan maydonda 200 ni ham o‘rnatish 
mumkin. Yuqori darajali animatsiya foizlari 0% dan 100% gacha
o'zgarishi mumkin. 
mumkin.

Masalan:

Kanallarni manfiy qiyniatlarini ham berish

Kanal Qiymati Qo‘shimcha qiymatlari

Red -100% 256

Green -100% 256

Blue -100% 256

Alpha 100% 0

Amaliy misollar:
«Haqiqiy» kontrast

Kanal Qiymati Qo‘shimcha qiymatlari

Red 600% -5/2

Green 600% -5/2 .

Blue 600% -5/2

Alpha 100% 0
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«Haqiqiy» yorqinlik

Kanal Qiymati Qo‘shimcha qiymatlari

Red 100% 256

Green 100% 256

Blue 100% 256

Alpha 100% 0

Sariq

Kanal Qiymati Qo‘shimcha qiymatlari

Red 200% -20

Green 200% -90

Blue 200% -256

Alpha 100% 0

Pushti rang

Kanal Qiymati Qo‘shimcha qiymatlari

Red 250% -50

Green 250% -183

Blue 250% -50

Alpha 100% 0

Moviy rang

Kanal Qiymati Qo‘shimclia qiymatlari

Red 250% -256

Green 250% -200

Blue 250% -52

Alpha 100% 0
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Ikki kanal aralashmasi -  1

Kanal Qiymati Qo‘shimcha qiymatlari

Red 100% 256

Green 100% 0

Blue 100% 256

Alpha 100% 0

Ikki kanal aralashmasi -  2

Kanal Qiymati Qo‘shimcha qiymatlari

Red 100% 256

Green -100% 256

Blue -100% 256

Alpha 100% 0

Relef

Kanal Qiymati Qo‘shimcha qiymatlari

Red -100% 256

Green -100% 256

Blue -100% 256

Alpha 50% 0

Yana rasmlar ustida olib boriladigan ishlardan biri bilan tanishib 
chiqamiz. Bu imkoniyat rasmni turgan joyidan yo'qolib ko‘rinmay 
qolish yoki aksincha rasm yo‘q joydan asta-sekin hosil bo‘lishini 
ta’minlaydi. Buning uchun quyidagi ketma-ketlikni ko'rib chiqamiz:
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• rasmni import qilib olib, Insert > Convert to Symbol buying'ini 
yoki F8 tugmasini bosing;

• Properties > Color > Alpha bandini tanlang.
«Alpha»ning ko'rsatkichini o'zgartirish natijasida rasm quyidagicha 

o‘zgaradi:

Kanal Qiymati Ko‘rinish darajasi

Alpha 0% ko'rinmaydi

Alpha 50% 50% ga noaniq ko‘rinadi

Alpha 100% toiiq ko'rinadi

Xuddi shu effektlardan o‘xshash obyektlarni bir-biriga aylantirish- 
da foydalanish mumkin.

Savol va topshiriqlar:

1. Grafikli formatlar konvertatsiyasi deganda nimani tushunasiz?
2. Fayllarni import qilish nima?
3. Fayllarni eksport qilish nima?
4. Flashda qanday formatdagi fayllarni import qilish mumkin?

6.5. Flashda oddiy harakatlar hosil qilish

Flashda animatsiyalarni o‘rganishni eng sodda harakatlarni ko‘rish- 
dan boshlaymiz.

1-misoi. Dastlab biror chizilgan obyektni bir koordinatadan boshqa 
koordinataga o‘tish jarayoni bilan tanishib chiqamiz:

о File > New buyrugini berish bilan yangi ish maydoni hosil 
qilamiz:

о ish maydonidagi yagona qatlamning (layer) birinchi kadrini 
sichqon chap tugmasi bilan bosib belgilaymiz;

о endi sichqonni Tools paneliga olib kelib chizish uchun 
moijallangan ixtiyoriy uskunani tanlaymiz;
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о sichqon yordamida ixtiyoriy rasm chizamiz; 
о qatlamning kadri ustiga sichqon ko‘rsatkichini qo‘yib, o‘ng 

tugmasini bosamiz. Hosil bo‘lgan menyudan Create Motion Tween 
buyrug'ini beramiz.

о sichqon ko‘rsatkichini bir nechta kadrdan keyinga qo‘yib Insert 
Keyframe buyrugi beriladi. Xuddi shu Keyframeni belgilagan holatda 
rasmni o‘zini kerakli koordinataga o‘tkazamiz. Buning uchun Properties 
panelidan X va Y koordinatalarini o'zgartiramiz.

о harakatni ko‘rish uchun Control > Test Movie buyrug‘i beriladi. 
Natijada dastlabki nuqtada turgan rasm biroz vaqt ichida boshqa 

koordinataga o‘tadi.
2-m isol. 1-misolni biroz o'zgartirsak, shu obyektni kattalashganini 

kuzatishimiz mumkin:
о yuqoridagi misolning 5 ta qadamini bajarib bolgach, rasmning 

koordinatasi o‘zgargan kadr ustiga sichqon tugmasini bosish bilan 
belgilaymiz;

о natijada rasm belgilanadi, rasmni kattalashtiramiz. Buning uchun 
Properties panelidan W: va H: qiymatlarini kattalashtiramiz;

о harakatni ko‘rish uchun Control > Test Movie buyrug‘i beriladi. 
Natijada aylana harakatlanib boshqa koordinataga o‘tish bilan 

kattalashib boradi.
3-m isol. Navbatdagi misolda esa xuddi 1-misoldagi chizilgan shar 

boshqa koordinataga o‘tishi bilan rangi o'zgarib boradi. Buning uchun 
quyidagi ketma-ketlik bajariladi:

о 1-misoldagi birinchi 5 ta bandini bajarib bo‘lgach, rasmning 
koordinatasi o‘zgargan kadr ustiga sichqon tugmasini bosish bilan 
belgilaymiz;

о natijada rasm belgilanadi, keyin Properties panelidan Color 
ro‘yxatidan Advanced buyrug‘i beriladi:

о ekranda hosil bo‘lgan Advanced Effect oynasidan o‘zimizga 
kerakli rang ko'rsatkichlarini tanlab OK tugmasini bosamiz;

о harakatni ko‘rish uchun Control > Test Movie buyrugi beriladi.
4-m isol. Endigi misolda obyektlarni harakatlanish bilan biror 

burchakka burilishi bilan tanishib chiqamiz. Buning uchun quyidagi 
ketma-ketlik bilan tanishib chiqamiz:
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о l-misoldagi birinchi 5 ta bandini bajarib bo'lgach, rasmning 
koordinatasi o‘zgargan kadr ustiga sichqon chap tugmasini bosish bilan 
belgilaymiz;

о natijada rasm belgilanadi, M odify > Transform > Scale anil 
Rotate buyrug‘i beriladi;

о ekranda hosil bo‘lgan Scale and Rotate muloqot oynasida tegishli 
burchak qiymatini ko‘rsatib. OK tugmasini bosamiz;

о ko‘rsatilgan burchakka rasm buriladi.

Savol va topshiriqlar:

1. Oddiy harakat hosil qilish ketma-ketligini tushuntirib bering?
2. Flashda oddiy harakat hosil qiling?
3. Obyektning harakati natijasida kattalashishi animatsiyasini hosil qil­

ing?
4. Obyekt harakatlanishi natijasida boshqa ranga o‘tish animatsiyasini 

hosil qiling?

6.6. Dasturning tovushlar bilan ishlash imkoniyatlari

Flashda filmlarga tovush ham berish mumkin. Kompyuterda 
saqlanayotgan tovush fayli yoki tovushni yozdirish orqali ham har xil 
tovush fayllarini import qilish yo‘li bilan qo‘yish mumkin. Buning 
natijasida Flashda tovushli film hosil boiadi. Ya'ni animatsiya namoyish 
qilinayotgan vaqtda harakat bilan birga unga mos yoki unga tegishli 
tovush ham ijro qilinadi. Buning uchun quyidagi ketma-ketlik amalga 
oshiriladi:

■ avval Flashda ixtiyoriy film yaratiladi;
■ filmga o‘rnatilishi lozim boigan tovushni maxsus dasturlar 

yordamida kompyuterga yoziladi yoki kompyuter xotirasida tayyor 
tovush saqlanayotgan boisa, undan ham foydalanish mumkin;

■ tovushni tayyorlab olgandan so‘ng, File menyusidagi Import 
buyrugi beriladi;

■ natijada Import muloqot oynasi hosil boladi. Oynadan foy- 
dalanib o‘rnatmoqchi boigan tovush faylini ko'rsatamiz. Natijada 
tovush fayli import qilinadi.
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Sichqon yordamida ixtiyoriy qatlamdagi birinchi kadrni tanlab, 
Properties panelidan Sound ro‘yxatini ochamiz. Ro‘yxatdan o‘zimiz 
import qilgan tovush faylini tanlaganimizda, o'sha qatlamda tovush 
o‘rnatiladi.

Eslatma. Filmdagi tovush bilan animatsion harakat sinxron ravishda 
berilishi ustida test o‘tkazish kerak. Agar ular sinxron bo‘lmasa filmdagi 
animatsiya qatlamlaridagi kadrlar sonini ko‘paytirish (buning uchun 
kadrlar orasiga sichqon chap tugmasini bosib, F5 tugmasini bosish yo‘li 
bilan kadr qo‘yiladi. Natijada animatsiyaning namoyish vaqti cho’zilib 
tovushga yaqinlashadi) yoki kamaytirish yo‘li bilan sinxronlashtirish 
mumkin.

Tovushli tugmalar yaratish

Yuqorida ko‘rsatilgan misoldan foydalanib tugmalarga ham to­
vush berish mumkin. Buning uchun quyidagi ketma-ketlik amalga 
oshiriladi:

■ avval tugma qo'yiladi yoki Flashning o‘ziga chizish yo ii bilan 
hosil qilinadi;

■ qo‘yilgan yoki chizilgan rasmni tugmaga aylantirish uchun 
uriing ustida sichqon chap tugmasini bosish yo ii bilan belgilanadi. 
Sbhqonchaning o‘ng tugmasi bosilganda quyidagi menyu hosil boladi;

■ menyudan Convert to Symbol buyrugi beriladi. Convert to 
Sjmbol muloqot oynasi hosil boladi. Oynadan Button bandi tanlanadi. 
Naijada tanlangan rasm tugmaga aylanadi;

■ tugma ustida sichqon chap tugmasi ikki marta bosiladi;
■ hosil boigan oynada Over ko'rsatkichi ostidagi katakka yangi 

kacr qo‘yamiz;
■ shu kadrni belgilab olamiz;
■ File > Import buyrugi yordamida tugmaga o‘rnatmoqchi 

bo‘kan tovush faylini import qilamiz (import qilingan tovush avtomatik 
ravthda Properties panelining Sound 10‘yxatida hosil boiadi);

i Properties panelining Sound ro‘yxatidan tovushni tanlaymiz 
(bu >ilan biz tegishli tugmaga shu tovushni o'rnatgan bolamiz);

i bo igan  o‘zgarishlarni saqlab. film ni k o iish  uchun Control
> Tist M ovie buyrug in i beramiz; film namoyishi vaqtida tugma
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ustiga sichqon ko'rsatkichini olib kelsangiz o‘rnatilgan tovush 
eshitiladi.

Xuddi shu yo‘l bilan tugma ustiga sichqon ko‘rsatkichini olib 
kelinganda yoki bosilganda faqat tovush chiqishi bilan chegaralanib 
qolmasdan, balki tugma boshqasiga aylanishi ham hosil qilish mumkin. 
Bu bilan foydalanuvchi menyudan tanlangan tugmani boshqasidan 
ajralib turishini ta’minlaydi. Buning uchun yuqoridagi misolni biroz 
davom ettirish zarur. Ya’ni, vaqt diagrammasining Over katakchasiga 
kadr qo‘yib, unga shu tugmaning boshqa ranglisini o‘rnatamiz. Down 
katakchasiga esa boshqa rangli tugmachani o‘rnatib, filmni ko'rish 
uchun Control > Test Movie buyrugini beramiz. Namoyish vaqtida 
tugma ustiga sichqon ko'rsatkichini olib borsak, tugmacha boshqa 
rangga o‘tadi, uni bosadigan bo‘lsak yana boshqa rangga o‘tadi. 
Bu bilan biz menyudagi tugmalardan qaysi biri ustida ko‘rsatkich 
turganini yoki qaysi tugma bosilganini osongina ajratib olishin.iz 
mumkin.

Savol va topshiriqlar:

1. Chizilgan obyektni tugmaga aylantirish uchun qaysi buyruqdan 
foydalaniladi?

2. Tugmaga tovush biriktirish ketma-ketligini aytib bering?
3. Filmga tovush biriktirish uchun dastlab qaysi buyruqcan 

foydalaniladi?
4. Filmga tovush berish ketma-ketligini sanab bering?

6.7. Obyekt harakati trayektoriyasini boshqarish

Flashda asosiy qatlam -  Guide Layer tushunchasi mavjud. Asisiy 
qatlamlar ikkita xususiyatga ega:

• birinchidan, siz unga faqat tahrirlash rejimida ko’rinadigan izchlar 
joylashingiz mumkin. Bu izohlar SWF formatiga eksport qilinmydi; 
shu ma’noda Guide so\zini «boshqarish», «ko'rsatma» deb tushinish 
mumkin;

• ikkinchidan, asosiy qatlam yordamida obyektning bir jc/dan 
ikkinchi joyga ko‘chish harakati trayektoriyasini boshqarish mtmkin 
(tweened-animatsiya harakati yordamida).
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Guide qatlamni yaratish uchun quyidagi ketma-ketlikni amalga 
oshirish kerak:

1. Vaqt diagrammasi panelida qatlamlar ro‘yxatidan ixtiyoriy 
qatlam ustida sichqon o‘ng tugmasini bosing va kontekstli menyudan 
Insert Layer buyrug'ini bering.

2. Yangi hosil qilingan qatlam ustida sichqon o‘ng tugmasini bosing 
va kontekstli menyudan Guide bandini tanlang. Natijada qatlamlar 
ro‘yxatida qatlam nomi yaqinida bolg‘acha ko'rinishidagi belgi hosil 
boladi. Bu belgi faqat tahrirlash uchun mo'ljallanganini bildirib, 
foydalanuvchilar buni ko‘rishdan mustasno.

Yuqorida avtilganidek bosh qatlamning ikkinchi ko‘rinishi 
harakatlanayotgan obyekt trayektoriyasini (bosib o‘tishi kerak bo‘lgan 
yo'lni chizmasini) belgilaydi.

Obyektni ko'rsatilgan trayektoriyada harakatlantirish uchun quyidagi 
ketma-ketlikni bajarish kerak:

1. Animatsiyalangan obyekt qatlamining nomi ustida sichqon o'ng 
tugmasini bosing.

2. Kontekstli menyudan A dd  M otion Guide buyrug‘ini bering. 
Natijada qatlamlar ro'yxatida maxsus belgi ostida asosiy qatlam hosil 
bo'lladi.

3. Asosiy qatlamni faollashtirish uchun uni nomi ustida sichqoncha 
chap tugmasi bilan bosamiz.

4. Chizishning ixtiyoriy uskunasi yordamida (Pen, Pencil, Oval, 
Brush, Rectangle) obyekt harakatlanish trayektoriyasini tasvirlang.

5. Animatsiyaning birinchi kadri katakchasini sichqoncha chap 
tugmasi bilan belgilang va Properties panelidan Orient to Path 
(marshrut bo'yicha mo'ljal olish) bayroqchasini o'rnating.

6. Animatsiyaning oxirgi kadri katakchasini sichqon chap tugmasi 
yordamida belgilang va kadrning Properties panelidan xuddi shu 
bayroqchani o'rnating.

7. Animatsiyalangan obyektdan belgilashni olib tashlab, filmni 
namoyish qilish uchun Control > Test Movie buyrug'ini bering.

Eslatma. Agar siz kesishadigan trayektoriya hosil qilgan bo'l­
sangiz, u holda obyekt kesishish natijasida hosil qilgan yo‘l bo'yicha 
harakatlanadi.
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Savol va topshiriqlar:

1. Asosiy qatlam nima va uning qanday xususiyatlari bor?
2. Obyektni belgilangan yo‘nalishda harakatlantirish uchun qaysi 

buyruqlardan foydalaniladi?
3. Biror obyekt olib uni ixtiyoriy yo‘nalish bo‘ylab harakatlantiring?

6.8. Flashda niqobli animatsiyalar yaratish

Niqob o'z ichiga oddiy qatlamlarni oladi. Faqat bitta qatlam niqobli 
(bekitadigan) qatlam bo'lib, u faqat o'zining ostidagi qatlamga tegishli 
obyektni bekitadi (niqoblaydi). Qatlamlardan niqob hosil qilish uchun, 
quyidagi ketma-ketliklarni bajarish kerak:

1. Niqob qo'ymoqchi bo'lgan qatlamning nomi ustida sichqonning 
o‘ng tugmasini bosilib, kontekstli menyudan Insert Layer buyrug'ini 
bering (qo'yilgan yangi qatlam endi niqob o'rnida xizmat qiladi).

2. Niqob qatlamiga rang quying. Agar animatsiyali niqob 
yaratmoqchi bo'lsangiz, unda faqat bir marta rang quyilgan bo'lishi 
kerak.

3. Niqob qatlami nomi ustida sichqon o'ng tugmasini bosing, 
kontekstli menyudan M ask (Маска) buyrug'ini bering. Shu daqiqadan 
boshlab yangi qatlam niqobga aylanadi. Shundan keyin qatlamlar 
to'plamida quyidagi o'zgarishlar bo'ladi:

о qatlamli niqob nomidan chapda niqobga tegishli belgi hosil 
bo'ladi;

о niqoblangan qatlamning nomi o'ngga suriladi va uning yonida 
ham shuningdek yangi belgi paydo bo'ladi;

0 ikkala qatlam ham avtomatik ravishda bekitiladi (qatlamning 
nomidan o'ngda hosil bo'lgan qulf belgisi shundan dalolat beradi).

Niqobga biriktirilgan rangning asli ko'rinm asdan, balki uning 
harakati natijasida ortidagi qatlamning ochilishi kuzatiladi. Bosh­
qacha aytganda bekitilgan obyekt niqob orqali harakat bilan ochiladi. 
Siz niqobning holatini, ko'rinishini har doim o'zgartirishingiz 
mumkin. Uni tahrirlash holatiga keltirish uchun qulf belgisi 
ustida sichqonni chap tugmasini bosish kifoya. Bu bilan siz qulfni 
avtomatik ravishda olib tashlagan bo'lasiz. Tahrirlash rejimini ishga
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tushirish uchun niqobli qatlam nomini sichqon o'ng tugmasi bilan 
bosish va kontekstli menyudan Show All (Hammasini ko'rsatish) 
buyrug'ini bering.

Niqobni ko'rish rejimini yoqish uchun, sichqon o'ng tugmasini 
niqobli qatlam nomiga yoki niqob ostidagi qatlam nomiga bosish va 
kontekstli menyudan Show M asking buyrug'ini berish kerak.

Savol va topshiriqlar:

1. Niqob hosil qilish ketma-ketligini aytib bering?
2. Animatsiyalashgan niqob hosil qiling?
3. Qo'shimcha fonli niqob hosil qilish ketma-ketligini aytib bering?
4. Animatsiyalashgan niqob va qo'shimcha fonli niqoblarning farqlari 

nimada?
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XULOSA

Xulosa qilib aytganda, jamiyatning barcha jabhalarida ro‘y be- 
rayotgan hamma yangiliklar, kashfiyotlar va rivojlanishning to'xtovsiz 
o‘sishi zamirida ta’lim tizimida erishilayotgan yutuqlar yotadi. Bunga 
ta’lim tizimida erishilayotgan yutuqlar samaralari deb baho berish 
mumkin. Faqat ta’lim tizimidagina jamiyatning barcha jabhalari uchun 
zarur yuksak bilimli, iqtidorli kadrlar tayyorlanadi. Ta’lim tizimida 
samaradorlikka erishish uchun esa professor-o'qituvchilardan o;z ustida 
tinimsiz ishlash, fan-texnika yangiliklaridan o‘z vaqtida xabardor 
bolish va ularni o‘z mehnat faoliyatiga tatbiq qilish, chet tillarini bilish, 
axborot texnologiyalaridan oqilona foydalana olishlari talab etiladi.

Axborot texnologiyalari va uning eng so'nggi yutuqlaridan xabardor 
bo‘lish va ularni o‘z sohalariga tatbiq qilib samarali mehnat faoliyatini 
tashkil qilish muhim ahamiyat kasb etadi. Yuqorida aytilganidek, ta’lim 
tizimida o'quv materiallarining vizuallashishi bilan ta’lim samaradorligi 
ortib boradi. Bunda esa elektron o'quv resurslaridan (EO'R) keng 
foydalaniladi. Turli fanlar bo‘yicha EO'Rlarini yaratish va joriy qilish 
orqali ta’lim tizimida o'qitish samaradorligiga erishiladi. EO'Rlarini 
yaratish uchun esa avvalo boshlangich kompyuter savodxonligiga ega 
bolish, shu bilan birga maxsus dasturiy vositalardan foydalanish va bir 
qancha dasturlash tillarini bilish talab qilinadi. Boshlangich kompyuter 
savodxonligi informatika va axborot texnologiyalari fanlarini o'qitish 
orqali o'rgatilsa, EO'Rlarini yaratish esa Web-dizayn kabi fanlarni 
o'qitish orqali o'rgatiladi. Shu maqsadda ushbu qoilanmada ham 
EO'Rlari uchun turli illustratsiyalar tayyorlashga moijallangan grafik 
muharrirlar, web saytlarni yaratishga moijallangan dasturiy vositalar, 
animatsiyalar tayyorlashga moijallangan dasturlarni o'rgatishga oid 
ma’lumotlar keltirilgan.
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